FCC: Customer instructions

The Remote Office 9150 unit complies with Part 68 of the FCC rules. On the bottom side of the equipment is a label that contains, among other information, the FCC registration number and ringer equivalence number (REN) for this equipment. If requested, this information must be provided to the telephone company.

The Remote Office 9150 unit uses the following standard connections and codes: USOC Code: RJ21X, Facility Interface Code: 02DU5-64, and Service Order Code: 6.0F.

The REN number shown on the label is used to determine the number of devices that can be connected to the telephone line. Excessive RENs on the telephone line can result in the devices not ringing in response to an incoming call. The sum of the RENs should not exceed five (5.0). To be certain of the number of devices that can be connected to a line, as determined by the total RENs, contact the local telephone company.

If the equipment causes harm to the telephone network, the telephone company will notify you in advance that temporary discontinuance of service might be required. However, if advance notice is not practical, the telephone company will notify you as soon as possible. Also, you will be advised of your right to file a complaint with the FCC if you believe it is necessary.

The telephone company may make changes in its facilities, equipment, operations, or procedures that could affect the operation of the equipment. If this happens, the telephone company will provide advance notice in order for you to make necessary modifications to maintain uninterrupted service.

No repairs can be performed by you. If you experience trouble with this equipment, please contact the following for repair and warranty information:

Nortel Networks
Product Service Center
640 Massman Drive, Nashville, TN  31210
Phone: 1-800-251-1758

If the equipment is causing harm to the telephone network, the telephone company might request that you disconnect the equipment until the problem is resolved.

This equipment cannot be used on public coin phone service provided by the telephone company. Connection to party line service is subject to state tariffs. Contact the state public utility commission, public service commission, or corporation commission for information.
Industry Canada: Equipment attachment limitation

NOTICE: The Industry Canada Label identifies certified equipment. This certification means that the equipment meets telecommunications network protective, operational, and safety requirements as prescribed in the appropriate Terminal Equipment Technical Requirements document(s). The Department does not guarantee that the equipment will operate to the user’s satisfaction.

Before installing this equipment, you should ensure that it is permissible to be connected to the facilities of the local telecommunications company. The equipment must also be installed using an acceptable method of connection. You should be aware that compliance with the above conditions might not prevent degradation in service in some situations.

Repairs to certified equipment should be coordinated by a representative designated by the supplier. Any repairs or alterations made by the user to this equipment, or equipment malfunctions, can give the telecommunications company cause to request you to disconnect the equipment.

You should ensure, for your own protection, that the electrical ground connections of the power utility, telephone lines, and internal metallic water pipe system, if present, are connected together. This precaution can be particularly important in rural areas.

Caution: You should not attempt to make such connections yourself, but should contact the appropriate electric inspection authority, or electrician, as appropriate.

NOTICE: The Ringer Equivalence Number (REN) assigned to each terminal device provides an indication of the maximum number of terminals allowed to be connected to a telephone interface. The termination on an interface can consist of any combination of devices subject only to the requirements that the sum of the Ringer Equivalence Numbers of all the devices does not exceed 5.
Publication history

September 2001

This is the Standard 2.0 issue of the Remote Office 9150 Installation and Administration Guide for Remote Office 9150 Release 1.3.0. Support for Succession for Communication Server 1000 has been added along with new and enhanced feature information that was formerly published in the Remote Office and RLC Release Notes.

March 2000

This is the Standard 1.0 issue of the Remote Office 9150 Installation and Administration Guide for Remote Office 9150 Release 1.0.
## Contents

About this document  
- About this guide ................................................... xiv  
- Skills you need .................................................... xv  
- Related information products ............................... xvii  
- Conventions used in this guide ............................. xix

1 Remote Office 9150 description  
  - Overview .............................................................. 2  
  - Section A: Product description ......................... 7  
  - What is Remote Office 9150? ............................. 8  
  - Remote Office 9150 hardware description ............ 11  
  - Add-on modules description ............................... 15  
  - Connection options ........................................... 17  
  - How the Remote Office 9150 unit works ............... 19  
  - Section B: Features description ....................... 29  
  - System security .................................................. 30  
  - Trunking, connection types, and call timers ........... 32  
  - Telephones ....................................................... 35  
  - Voice over IP features ....................................... 37  
  - Quality of Service transitioning technology .......... 39  
  - Port management ............................................... 40  
  - Station priority .................................................. 41  
  - Connection bandwidth ....................................... 43  
  - Local calling ..................................................... 44  
  - Online/offline table .......................................... 46  
  - Other supported features ................................. 47  
  - Administration software ................................... 48

2 Planning for installation  
  - Installation checklist ........................................... 52  
  - Physical environment ......................................... 56  
  - Administration PC ............................................. 61  
  - Network considerations ....................................... 66

Installation and Administration Guide
## Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Managing trunk connections</td>
<td>70</td>
</tr>
<tr>
<td>Station configuration</td>
<td>73</td>
</tr>
<tr>
<td>Security</td>
<td>77</td>
</tr>
<tr>
<td>Planning for future growth</td>
<td>79</td>
</tr>
<tr>
<td>Deployment options</td>
<td>82</td>
</tr>
<tr>
<td>Planning the configuration</td>
<td>87</td>
</tr>
<tr>
<td>Installing the Remote Office 9150 unit</td>
<td>91</td>
</tr>
<tr>
<td>General safety</td>
<td>92</td>
</tr>
<tr>
<td>Required tools</td>
<td>94</td>
</tr>
<tr>
<td>Unpacking and inspecting the equipment</td>
<td>95</td>
</tr>
<tr>
<td>Removing the Remote Office 9150 unit cover</td>
<td>97</td>
</tr>
<tr>
<td>Installing a trunk interface or DSP application module</td>
<td>100</td>
</tr>
<tr>
<td>Mounting the Remote Office 9150 unit</td>
<td>106</td>
</tr>
<tr>
<td>Connecting the Remote Office 9150 unit</td>
<td>113</td>
</tr>
<tr>
<td>Powering up the Remote Office 9150 unit</td>
<td>119</td>
</tr>
<tr>
<td>Installing the software</td>
<td>122</td>
</tr>
<tr>
<td>Using the Configuration Wizard to perform initial configuration</td>
<td>124</td>
</tr>
<tr>
<td>Testing the network connections</td>
<td>138</td>
</tr>
<tr>
<td>Configuring the Remote Office 9150 unit</td>
<td>183</td>
</tr>
<tr>
<td>Configuring the system settings</td>
<td>184</td>
</tr>
<tr>
<td>Configuring International Tones</td>
<td>190</td>
</tr>
<tr>
<td>Configuring the Remote Office 9150 unit’s IP interface</td>
<td>195</td>
</tr>
<tr>
<td>Configuring the RLC connection information</td>
<td>198</td>
</tr>
<tr>
<td>Configuring the PSTN connection number</td>
<td>202</td>
</tr>
<tr>
<td>Configuring the security level</td>
<td>204</td>
</tr>
</tbody>
</table>
Contents

Configuring trunks and trunk groups ........................................ 208
Configuring BRI trunks ....................................................... 211
Configuring trunk groups ................................................... 215
Configuring stations .......................................................... 219
Defining stations ................................................................... 225
Configuring a fax station ....................................................... 231
Configuring DSP resources ................................................... 235

6 Using Remote Office 9150 stations .......................................... 239
   Modes of operation ......................................................... 240
   Placing and receiving calls ............................................... 244
   Indicator updates .......................................................... 248
   Display messages ......................................................... 250
   Telephone features operation .......................................... 253
   Going online and offline .................................................. 257

7 Administration ...................................................................... 259
   Changing the administration password ................................ 260
   Section A: Performing backups and restores ..................... 265
      Creating a backup configuration file .............................. 266
      Restoring the configuration ......................................... 268
   Section B: Working with system logs ............................... 273
      Displaying logs ........................................................ 274
      Resizing logs .......................................................... 276
      Clearing logs ......................................................... 277
   Section C: Viewing statistics ............................................. 279
      Trunk Connection Statistics screen .............................. 280
      Bandwidth Connection Statistics screen ...................... 282
      Caller Information Statistics screen ............................ 284
      Hardware Statistics screen ........................................ 287
      DSP screen ............................................................. 289
      Ethernet Interface Statistics screen ............................ 292
      BRI Statistics screen ................................................ 295
      Local Call Statistics screen ........................................ 297
      Remote Call Statistics screen .................................... 299
      Device Information screen .......................................... 301
      ISDN Module Information screen ............................... 303
      Network Statistics screen .......................................... 305
### Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Pages</th>
</tr>
</thead>
<tbody>
<tr>
<td>Section D: Performing upgrades</td>
<td>309</td>
</tr>
<tr>
<td>Verifying the firmware and software version</td>
<td>310</td>
</tr>
<tr>
<td>Obtaining the latest upgrade file</td>
<td>312</td>
</tr>
<tr>
<td>Extracting upgrade files from the download file</td>
<td>313</td>
</tr>
<tr>
<td>Performing a firmware upgrade</td>
<td>315</td>
</tr>
<tr>
<td>Performing a software upgrade</td>
<td>320</td>
</tr>
</tbody>
</table>

### 8 Troubleshooting

<table>
<thead>
<tr>
<th>Topic</th>
<th>Pages</th>
</tr>
</thead>
<tbody>
<tr>
<td>Before you begin</td>
<td>322</td>
</tr>
<tr>
<td>Remote Office 9150 LEDs</td>
<td>323</td>
</tr>
<tr>
<td>Digital telephone</td>
<td>325</td>
</tr>
<tr>
<td>Device connectivity</td>
<td>330</td>
</tr>
<tr>
<td>Software problems</td>
<td>334</td>
</tr>
<tr>
<td>Using Configuration Manager’s Ping</td>
<td>336</td>
</tr>
<tr>
<td>Recovering from a catastrophic failure</td>
<td>339</td>
</tr>
</tbody>
</table>

### A Planning forms

<table>
<thead>
<tr>
<th>Topic</th>
<th>Pages</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview</td>
<td>342</td>
</tr>
<tr>
<td>Completing the Remote Office 9150 forms</td>
<td>344</td>
</tr>
<tr>
<td>Configuration Information—Stations</td>
<td>346</td>
</tr>
<tr>
<td>Configuration Information—ISDN BRI Modules</td>
<td>350</td>
</tr>
<tr>
<td>Configuration Information—Network Connections</td>
<td>353</td>
</tr>
<tr>
<td>Configuration Information—Dialing Plans</td>
<td>354</td>
</tr>
<tr>
<td>System expansion worksheet</td>
<td>355</td>
</tr>
</tbody>
</table>

### B Sample configuration files

<table>
<thead>
<tr>
<th>Topic</th>
<th>Pages</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example of a network</td>
<td>360</td>
</tr>
<tr>
<td>Voice port configuration on the Meridian 1 PBX</td>
<td>362</td>
</tr>
<tr>
<td>Data port configuration on the Meridian 1 PBX</td>
<td>364</td>
</tr>
<tr>
<td>RLC configuration</td>
<td>366</td>
</tr>
<tr>
<td>Remote Office 9150 unit</td>
<td>370</td>
</tr>
</tbody>
</table>

### C Connection pin-out tables

<table>
<thead>
<tr>
<th>Topic</th>
<th>Pages</th>
</tr>
</thead>
<tbody>
<tr>
<td>TELCO 1 connector pin-out table</td>
<td>374</td>
</tr>
<tr>
<td>TELCO 2 connector pin-out table</td>
<td>376</td>
</tr>
<tr>
<td>Ethernet connector pin-out table</td>
<td>378</td>
</tr>
<tr>
<td>Admin (serial) connector pin-out table</td>
<td>379</td>
</tr>
<tr>
<td>Power connector pin-out table</td>
<td>380</td>
</tr>
</tbody>
</table>
D  Display log definitions  381
   Display logs ........................................ 382

Glossary  445

Fields index  467

Index  471
Preface

About this document

In this preface

About this guide        xiv
Skills you need         xv
Related information products xvii
Conventions used in this guide xix
The Remote Office 9150 Installation and Administration Guide describes how to install, configure, and manage the Remote Office 9150 unit in a branch office.

Who should read this guide

This guide is for the following individuals who are responsible for the installation, configuration, and day-to-day management of the Remote Office 9150 unit system:

- Nortel Networks distributors
- telecom network managers and administrators
- data network managers and administrators
- branch office managers and administrators

Assumptions

This document assumes that you have the skills listed on page xv.

How to use this guide

This guide explains, step-by-step, how to install, configure, and use the Remote Office 9150 unit product. To get an overview of what you need to do, review this guide before beginning Remote Office 9150 unit installation and configuration.

When you are ready to begin, follow the steps in the order in which they are presented. This helps you to achieve a successful installation.
Skills you need

This section describes the skills and knowledge you need to use this guide effectively.

Nortel Networks product knowledge

Knowledge of, or experience with, the following Nortel Networks products is helpful when working with the Remote Office 9150 unit:

- the Meridian 1, MSL-100, Succession Communication Server for Enterprise 1000 switches
- Meridian digital telephones

Telecommunications experience

Knowledge of, or experience with, telecommunications is helpful when working with the Remote Office 9150 unit:

- Extended Digital Line Cards (XDLCs) and how they work
- configuring voice and data ports
- configuring ISDN BRI, PRI (or other types of trunks)
- establishing telephone connections

Data networking experience

Knowledge of, or experience with, data networking is required when working with the Remote Office 9150 unit:

- networking fundamentals and concepts
- IP protocol
- network addressing and routing
- network traffic analysis and provisioning
- network security
- Voice over IP (general knowledge)
PC experience or knowledge

Knowledge of, or experience with, the following PC tasks is helpful when administering the Remote Office 9150 unit:

- general knowledge of Microsoft Windows
- software installation
- network configuration
Related information products

This section lists information products where you can find additional information.

Meridian 1 documents

The following documents describe how to establish telephone and trunk connections between the Remote Office 9150 unit and the BIX in-building cross-connect system:

- *Meridian 1 Installation planning* (NTP 553-3001-120)
- *Telephone and attendant console installation* (NTP 553-3001-215)
- *BIX* In-Building Cross-Connect System Material Installation and Servicing (Wall-Mounted System) (NTP 631-4511-200)

Remote Office 9150 and RLC documents

Remote Office and RLC Release Notes (NTP 555-8421-102)
The *Release Notes* describe the features and known problems for the Reach Line Card (RLC) and Remote Office 9150 branch office system.

The printed copy might supersede the copy provided on the CD-ROM. You can obtain the most up-to-date version by clicking on the Customer Support, Document, North America links at the following website:

[www.nortelnetworks.com](http://www.nortelnetworks.com)

Reach Line Card Installation and Administration Guide (NTP 555-8421-210)
This document, written for both the installer and administrator, explains how to install and configure the Reach Line Card on the host PBX.

Installer’s Notes
The following Installer’s Notes are quick reference documents that are provided with the component discussed in the document:
Each document summarizes the installation and configuration procedures for the component and provides cross-references to other documents for more detailed information.

**Note:** You cannot order these documents separately.

**CD-ROMs**

The *Remote Office Product CD-ROM*, contains

- documentation in Adobe Acrobat Reader (PDF) format
- firmware
- Configuration Manager software

**How to obtain the product documentation and CD-ROMs**

You can order the printed documentation and CD-ROMs from your Nortel Networks distributor.

You can also download the documentation in Adobe Acrobat Reader (PDF) format from the Nortel Networks web site. For more information, refer to the *Remote Office and RLC Release Notes* (NTP 555-8421-102).
Conventions used in this guide

This section describes the conventions used in this guide.

Precautionary messages

**Note:** A note describes the secondary results of procedures or commands, or special conditions under which you must use a procedure or command.

**ATTENTION** Provides information essential to the completion of a task.

**CAUTION**
Risk of data loss or equipment damage
Cautions you against unsafe practices or potential hazards, such as equipment damage, service interruption, or loss of data.

**WARNING**
Risk of minor personal injury
Warns you of a potentially hazardous situation that can result in minor or moderate injury.

**DANGER**
Risk of death or serious personal injury
Alerts you to an immediate hazard that can result in death or serious injury.
How this guide presents instructions for selecting menu options

To simplify the instructions for selecting options from the menu, this guide abbreviates the selection path. For example, if a procedure requires you to choose Over IP from the Remote Connectivity menu, which is under the Tests menu, this guide uses the following style:

From the menu, choose Tests ➝ PSTN Connectivity ➝ Over IP.

How this guide presents instructions for displaying property sheets

To simplify the procedures for accessing property sheets throughout this guide, the instructions for displaying a particular property sheet are summarized in a “Getting there” statement.

The procedure for displaying the screen that you need depends on whether you are

- performing an online configuration (that is, you are connected to a node by serial port or Telnet)
- performing an offline configuration (that is, you are not connected to a node)

Example

Getting there 9150 ➝ Configuration Manager ➝ IP Configuration

The long instruction for this example is shown on the next page.
1. Do the following:

<table>
<thead>
<tr>
<th>IF</th>
<th>THEN</th>
</tr>
</thead>
<tbody>
<tr>
<td>you are performing an offline configuration</td>
<td>select the device type as described in “Selecting the device type for offline configuration” on page 167.</td>
</tr>
<tr>
<td>you are performing an online configuration</td>
<td>connect to, and then log on to the node as described in “Logging on to a unit” on page 169.</td>
</tr>
</tbody>
</table>

2. In the left pane, click the plus sign beside Configuration Manager to expand the node list.

3. Click IP Configuration.

Result: The IP Configuration property sheet for the Remote Office 9150 unit appears in the right pane.
Chapter 1

Remote Office 9150 description

In this chapter

Overview 2
Section A: Product description 7
Section B: Features description 29
Overview

The Remote Office 9150 unit provides full-featured host PBX services to as many as 32 users located in your office.

The Remote Office 9150 solution consists of the following components:

- **Reach Line Card (RLC)**
  The RLC is installed in the PBX at the host location and relays voice and signaling information from the digital telephones connected at the Remote Office 9150 site to the PBX at the host site.

- **Remote Office 9150 unit**
  The Remote Office 9150 unit is installed in your office. It relays voice and signaling information between the digital telephones in your office to the PBX at the host location.

- **10BaseT Ethernet and ISDN Basic Rate Interface (BRI) connections**
  These connections provide the voice and data connections between the Remote Office 9150 unit and the host PBX.

- **ISDN BRI trunk interface modules are supported for the following:**
  - U interface
  - S/T interface
  - optional Digital Signal Processor (DSP) application modules
    You can add these modules to increase the system’s voice processing capacity.

**Supported platforms**

The following PBX platforms support the Remote Office 9150 solution:

- Meridian 1
- MSL-100
- Succession Communication Server for Enterprise 1000

The term “host PBX” refers to any of the above supported platforms.
What does the Remote Office 9150 unit do?

The Remote Office 9150 unit uses the Voice over IP technology to route voice conversation and phoneset control signals between your office and the host PBX over your existing IP data network. The Remote Office 9150 unit can also route calls over the PSTN.

This is accomplished using the following components:
- the Remote Office 9150 unit located in your office
- the RLC located on the PBX at the host site

These two components, along with the 10BaseT Ethernet and ISDN BRI connections, extend the host PBX services to users in your office.

The illustration below shows the connection between a Remote Office 9150 unit and an RLC.
**Note:** Nortel Networks does not support a Remote Office system as a free-standing key system.

### Telephone call modes

Calls can be placed through the Remote Office 9150 unit in any of the following modes:

- **host-controlled mode**
  
  When a call is processed through the host PBX, the call is in host-controlled call mode. The call can be routed over the IP network or the PSTN.

- **locally controlled call mode**
  
  When a call is processed through the local PSTN, the call is in locally controlled call mode.

### Product features

The Remote Office 9150 unit offers the following features:

- system security that supports three security levels—no security, calling line identification (CLID), and security identifier
- trunking allocation that automatically allocates trunk bandwidth as it is needed
- support for Meridian digital telephones, telephone modules, and standard calling features
- Voice over IP features that automatically switch from the IP network to the PSTN when the voice Quality of Service (QoS) falls below a predetermined threshold, and back to the IP network when the QoS returns to normal
  
  Voice packet features include:
  
  - voice compression
  - jitter attenuation
  - silence suppression.

- **permanent or demand connection**
  
  If the connection is defined as on demand, then you can configure minimum call duration and idle timers.
- single user ports, multi-user ports, and dynamic port pooling that assigns users to the first available port
- the ability to ensure QoS for specific users
  This is done by assigning more priority to those users. There are four levels of priority:
  - high
  - normal
  - IP only
  - circuit-switched only
- the ability to set the Differentiated Services (DiffServ) code-point to Nortel Network’s standards for Voice over IP and add the 802.1p priority header
- local calling that allows you to place calls to other extensions within your office, or to telephones in your local community
- Bridge ports to allow you to use Call Forward, Transfer and Conference PBX features with local incoming PSTN calls
- an online/offline table that is configured on the RLC for scheduling periods of times during which:
  - the ISDN BRI connection to the host PBX is made available to the Remote Office 9150 site
    **Note:** When the Remote Office 9150 unit is in offline mode, calls cannot be made or received through the host PBX over the IP or PSTN.
  - all telephones in your office can use only the local PSTN service
  This allows you to ensure that unwanted ISDN BRI telephone calls through the host PBX are disabled after business hours.
- an emergency service number that can be programmed with your local emergency number
- an analog port that can send and receive faxes
- 56/64K dynamic adaptation to detect and adjust bandwidth
- support for NAT routers
- administrative capabilities that allow you to perform a variety of administrative tasks, such as:
  - changing the administration password
  - making configuration changes
- viewing the system logs and statistics
- performing upgrades, backups, and restores
Section A: Product description

In this section

What is Remote Office 9150? 8
Remote Office 9150 hardware description 11
Add-on modules description 15
Connection options 17
How the Remote Office 9150 unit works 19
What is Remote Office 9150?

Remote Office 9150 is a product that provides full-featured host PBX services to as many as 32 users located in your office.

The Remote Office 9150 unit uses the Voice over IP technology to route voice conversation and phoneset control signals between your office and the host PBX over your existing IP data network.

The Remote Office 9150 unit can also use the PSTN to route calls if

- the voice QoS degrades below predefined thresholds
  In this case, Nortel Networks’ patented QoS transitioning technology automatically transitions calls to the PSTN when the voice QoS degrades. Calls transition back to the IP network when the QoS returns to normal.
- you are not yet ready to use the IP network to route voice calls
  You can configure the Remote Office 9150 unit to use only the PSTN, and implement the IP network functionality when you are ready.

This section provides a brief description of each component used in a Remote Office 9150 system.

Reach Line Card

The Reach Line Card (RLC) is installed in the PBX at the host location. The RLC provides service for up to 16 ports on a 1-slot card, or 32 ports on a 2-slot card. It emulates a standard digital line card (XDLC), providing PBX functionality for telephones at remote locations (including sites using the Remote Office 9150 unit).

The RLC relays voice and signaling information between the digital telephones connected at the Remote Office 9150 site to the PBX at the host site. Like the Remote Office 9150 unit, the RLC can route calls over the IP network or the PSTN, or both when the QoS transitioning technology feature is configured.

For a more detailed description, refer to the Reach Line Card Installation and Administration Guide (NTP 555-8421-210).
Remote Office 9150 unit

The Remote Office 9150 unit installed in your office provides PBX functionality for up to 32 digital telephones. Voice and signaling information between the digital telephones connected at your office and the RLC installed on the PBX at the host location is relayed over one or both of the following:

- IP network
- PSTN

10BaseT Ethernet and ISDN BRI connections
These connections provide the voice and data connections between the Remote Office 9150 unit and the host PBX. See “Connection options” on page 17 for a more detailed description.

Optional trunk interface modules
You can install up to four ISDN BRI U or S/T interface modules in the Remote Office 9150 unit. They provide the interface to the ISDN BRI lines provided by your telephone service provider, and are used to route calls over the PSTN.

Optional Digital Signal Processor application modules
You can install up to three Digital Signal Processor (DSP) application modules to increase the Remote Office 9150 unit’s voice processing capacity. (See “Add-on modules description” on page 15).

Configuration Manager

Use the following tools to configure the Remote Office 9150 unit:

- for first-time configuration: Configuration Wizard
  The Configuration Wizard provides the ability to configure only the minimum information needed to get the Remote Office 9150 unit up and running.
  For more details, see “Using the Configuration Wizard to perform initial configuration” on page 124.
- for ongoing configuration and administration: Configuration Manager
  For more details, see the following:
  - Chapter 4, “Configuration Manager overview”
- Chapter 5, “Configuring the Remote Office 9150 unit”
- Chapter 7, “Administration”
Remote Office 9150 hardware description

The Remote Office 9150 unit is installed in your office and can be mounted on a desk, in a rack, or on the wall. This section describes the LED displays, power supply, cables, and connectors for the unit.

LEDs on the Remote Office 9150 unit

The following diagram shows the LEDs on the front panel of the Remote Office 9150 unit.

![Remote Office 9150 LED Diagram]

*Note:* The V.35 LEDs are for future use.
The operational status of the Remote Office 9150 unit is indicated by these LEDs as described in the following table.

<table>
<thead>
<tr>
<th>LED type</th>
<th>LED name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power</td>
<td>On</td>
<td>When lit, this LED indicates that power is present.</td>
</tr>
<tr>
<td>Ethernet</td>
<td>TX</td>
<td>When flashing, this LED indicates that data is being transmitted by the Remote Office 9150 unit over the Ethernet network.</td>
</tr>
<tr>
<td></td>
<td>RX</td>
<td>When flashing, this LED indicates that data is being presented to the Remote Office 9150 unit over the Ethernet network.</td>
</tr>
<tr>
<td></td>
<td>COLL</td>
<td>When flashing, this LED indicates that a collision has occurred on the Ethernet network.</td>
</tr>
</tbody>
</table>
| Module    | L1 and L2| L1 LED:  
- not lit: there is no D-channel activity  
- flashing: the D-channel is active but the B-channel is not active  
- lit solid: both the D- and B-channels are active  
L2 LED:  
- not lit: the B-channel is not active  
- lit: the B-channel is active |
| V.35      | TX       | For future use. |
|           | RX       | For future use. |
| Boot status | Status | Indicates the condition of the Remote Office 9150 unit. This LED stays lit when the power on self-test is successful. If it goes out, there is a problem. |
Note: Since Ethernet traffic has a nominal speed of 10 Mbps, the flashing Ethernet COLL, TX, RX LEDs are cosmetic. They do not reflect real-time traffic patterns or packets.

Connectors

The following connections are made from the rear panel of the Remote Office 9150 unit to the telephone and data networks:

- Two 25-pair connectors (labeled TELCO 1 and TELCO 2) provide tip and ring connections to user stations (telephones) and central office trunks (ISDN BRI).
  These connections provide the interface to the telephone network and the Public Switched Telephone Network (PSTN).
- An RJ-45 connector (labeled ETHERNET) provides a 10BaseT Ethernet connection.
  This connection provides the ability to pass both voice and data traffic over the existing Ethernet network.
- A DB-9 connector (labeled ADMIN) provides an RS-232 serial port connection.
  You can use this serial port connection to configure a Remote Office 9150 unit that is directly connected to a PC.
- The DB-25 connector (labeled V.35) is for future use.

Refer to Chapter 2, “Planning for installation,” for a detailed description of cables and connectors.

Mounting options

The Remote Office 9150 unit can be mounted on a desk, in a rack, or on the wall.

Universal power supply

The Remote Office 9150 unit includes an auto-sensing 110/220 V power supply that is compatible with commercially available UPS systems. See the diagram on page 14.
Remote Office 9150 power supply
Add-on modules description

The Remote Office 9150 unit can support trunk interface modules, such as ISDN BRI U or S/T interfaces, and up to three DSP application modules.

Optional trunk interface modules

The Remote Office 9150 unit can support up to four U or S/T ISDN BRI interfaces. Each module supports one ISDN BRI line (with two B-channels) from the local telephone service provider.

Initially, the Remote Office 9150 unit ships with no ISDN BRI modules installed.

ISDN BRI module
Optional DSP application modules

DSPs convert voice and fax into digital data for transport over the IP and PSTNs. Initially, the Remote Office 9150 unit ships with the ability to support up to eight simultaneous calls through a DSP that is built into the Remote Office 9150 unit’s motherboard. To add support for up to 32 simultaneous calls, you must install DSP application modules. Up to three DSP application modules are supported. Each module provides up to eight more simultaneous calls.

In addition, you can configure the Remote Office 9150 unit for blocking with only enough modules to support the maximum number of simultaneous calls. For example, a Remote Office 9150 unit that is equipped with a single DSP application module supports 16 simultaneous calls, for a ratio of 2:1 blocking. For more details, see “Planning for future growth” on page 79.

DSP application module
Connection options

Communications between the Remote Office 9150 unit in your office and the host PBX take place using 10BaseT Ethernet or ISDN BRI connections, or both. This section provides a description of each of these connections.

10BaseT Ethernet interface

Voice over IP technology is used to carry voice conversation and phoneset control signals over your IP network to the host PBX. The voice data is forwarded as UDP/IP packets, and the signaling data is forwarded as TCP/IP packets.

ISDN BRI lines to PSTN

The PSTN provides a cost-effective alternative to leased lines. You can use ISDN BRI lines at the Remote Office 9150 site to make local calls without involving the host PBX. You can also choose to use the ISDN BRI lines instead of the IP network to route calls through the host PBX.

To use ISDN BRI lines, you must install trunk interface modules. The Remote Office 9150 unit can support up to four U or S/T ISDN BRI trunk interface modules. (See “Add-on modules description” on page 15.)

Quality of Service transitioning technology

If both the IP network and ISDN BRI lines are used, you can use the QoS transitioning technology to reroute calls from the IP network to the PSTN when the QoS on the IP network degrades. When the QoS returns to normal, the QoS transitioning technology automatically moves the calls back to the IP network.

The Remote Office 9150 unit monitors the QoS on the IP network. If the QoS falls below preprogrammed acceptable thresholds, calls are dynamically and transparently switched to the ISDN BRI lines. See “Quality of Service transitioning technology” on page 39 for additional details.
Analog port for fax machines

The Remote Office 9150 unit has one analog port that you can use as a fax connection. See “Fax support” on page 47 for more detailed information.
How the Remote Office 9150 unit works

There are two major components to the Remote Office 9150 product:

- the Remote Office 9150 unit located in your office
- the RLC located on the PBX at the host site

These two components, along with the connection options described on page 17, extend the host PBX services to users in your office.

Network diagram

The following diagram shows a RLC and Remote Office 9150 network.
Outgoing call process

To place outgoing calls, users can either pick up the handset on the telephone or press a line appearance key. There are two types of line appearance keys:

- **host call appearance key**
  Use this key to make a call through the host PBX.

- **local call appearance keys**
  Use these keys to make calls to other stations in your office, or to make and receive calls through the local PSTN. You can define up to two local call appearance keys on each digital telephone.

For a detailed description of the outgoing call process, see the sample illustrations beginning on page 22.

Incoming call process

When a user places a call through the host PBX to a user at the Remote Office 9150 site, a connection is made from the RLC to the Remote Office 9150 unit and the host PBX completes the call. If a connection cannot be established, then the call rings until it is forwarded to voice mail by the host PBX. See Chapter 6, “Using Remote Office 9150 stations,” for a more detailed description of the incoming call process.

When someone places a call through the PSTN to a user at the Remote Office 9150 site, a connection is made from the central office to the Remote Office 9150 unit. The number that outside callers dial is the number assigned by the ISDN service provider to the ISDN BRI B-channel on which the incoming call is received.

You can configure an unanswered incoming local call to Call Forward to a DN on the host PBX. The Bridge Port connects the call to the host PBX and it can then transfer to voicemail.

Bridge Port

A Bridge Port is a proxy port that represents a local or inbound PSTN call to the host PBX. When a local incoming call on a Remote Office 9150 unit needs PBX services, the Bridge Port obtains a PBX presence on behalf of the local call.
Bridge Ports can represent the following types of local calls:

- **Call Forward**: A Local and Remote call made to another Local and Remote telephone uses Call Forward to connect to a third telephone on the PBX.
- **Call Transfer**: A Local call to a Local and Remote telephone uses Call Transfer to connect to a local trunk or a host-based set.
- **Conference**: A Remote call to a host telephone can connect to trunk call(s), or if you are on a call to a local trunk, you can connect to host telephone(s) to create three-or-more-party telephone calls.

To configure Remote Office 9150 Bridge Ports refer to page 225.

**Host controlled call mode**

When a user places a call to someone at the host site, or when someone from the host site calls the Remote Office 9150 site, the call is in host-controlled call mode. Calls in host-controlled mode are routed through the host PBX. See the sample illustrations on pages 22 and 24.

**Locally controlled call mode**

When a user places a call from a local call appearance key, or the call is to another telephone at the Remote Office 9150 site, the call is in locally controlled mode. Calls that are initiated from the local call appearance key are routed through the local PSTN. Calls to other extensions in the Remote Office 9150 site are routed only through the Remote Office 9150 unit.

The host PBX is not involved in locally controlled mode calls. See the sample illustration on page 26.

**Quality of Service transitioning technology**

If the QoS on the IP network falls below a predefined threshold, you can configure the Remote Office 9150 unit to automatically route voice traffic away from the IP network connection to the circuit-switched connection. See “Quality of Service transitioning technology” on page 39 for a detailed description.
Call scenario 1: host-controlled—internal corporate call

The following diagram shows how a call is routed when making a host-controlled call to the corporate office.

The network that is used to route the host-controlled call is transparent to the user, and the dialing requirement is the same for both. Calls work the same way in reverse, from host PBX site to the Remote Office 9150 site.
Voice over IP network call

1. User 1 presses the host call appearance key.
   Result: User 1 hears a dial tone. This indicates that the connection to the
   RLC over the IP network was successful.

2. User 1 dials a telephone number (such as the extension number of host
   station 1).
   Result: The dialed digits are sent by the Remote Office 9150 unit as
   packets across the Ethernet network. The RLC converts the packets to the
   format required by the PBX. The PBX then converts the data to voice and
   routes the call to host station 1.

PSTN call

1. User 3 presses the host call appearance key.
   Result: User 3 hears a dial tone. This indicates that the connection to the
   RLC over the PSTN was successful.

2. User 3 dials the telephone number (such as the extension number of host
   station 3).
   Result: Dialed digits are sent across the PSTN then sent through the host
   PBX to host station 3.
Call scenario 2: host-controlled—external corporate call

The following diagram shows how a call is routed when making a host-controlled call to a party outside the organization.

The network used to route the call is transparent to the user, and the dialing requirement is the same for both. Calls work the same way in reverse, through the host PBX site to the Remote Office 9150 site.
Voice over IP network call

1. User 1 presses the host call appearance key.
   Result: User 1 hears a dial tone. This indicates that the connection to the RLC over the IP network was successful.

2. User 1 dials the external telephone number.
   Result: The dialed digits are sent by the Remote Office 9150 unit as packets across the Ethernet network. The RLC converts the packets to the format required by the PBX. The PBX then converts the data to voice and routes the call through the PSTN to the called party.

PSTN call

1. User 3 presses the host call appearance key.
   Result: User 3 hears a dial tone. This indicates that the connection to the RLC over the PSTN was successful.

2. User 3 dials the external telephone number.
   Result: Dialed digits are sent across ISDN BRI through the PSTN, through the host PBX to the called party.
Call scenario 3: locally controlled mode—local call

The following diagram shows how a call is routed when making a call within your local area.
Local call

1. User 1 presses the local call appearance key and hears a dial tone from the Remote Office 9150 unit.

2. User 1 then dials a trunk access code (such as #61) and hears a dial tone from the Central Office (PSTN).
   
   Note: If all trunks are busy and unavailable, then User 1 hears a fast busy signal.

3. User 1 dials the telephone number (the pizza parlor in this example). The dialed digits are sent across the ISDN BRI connection through the PSTN to the called party.
Section B: Features description

In this section

System security 30
Trunking, connection types, and call timers 32
Telephones 35
Voice over IP features 37
Port management 40
Station priority 41
Connection bandwidth 43
Local calling 44
Online/offline table 46
Other supported features 47
Administration software 48
System security

This section describes the security levels that are supported for controlling access from the Remote Office 9150 unit to the RLC on the host PBX.

No security

When no security measures are used, the RLC accepts all incoming calls from the Remote Office 9150 site.

Use this level with caution as it can be prone to unauthorized use. For example, a user in your site could accidentally, or intentionally, enter a trunk number for another site and place long distance phone calls through this connection.

Caller Identification (ID)

When Caller ID is used, and the PSTN routes the call, the RLC identifies the Remote Office 9150 unit’s calling line identification (CLID). If the CLID matches the remote number configured on the port assigned to the Remote Office 9150 unit, access is granted. If the incoming call’s CLID does not match, access is denied.

Note: Caller ID authentication cannot be performed over the IP network.

Provision ID

You can use Provision Identification (ID) authentication over the IP network or PSTN. When you choose Provision ID, the Remote Office 9150 unit sends its 10-digit security identifier (password) for each connection request. The RLC compares the security identifier with the one configured on the RLC port where the Remote Office 9150 unit is assigned. If the security identifiers match, access is granted.

If the security identifiers do not match then an event is recorded in the Remote Office 9150 unit system log, which can be viewed in Configuration Manager. The telephone that was used to make the call displays a message indicating that communications with the host PBX are down.
You must configure two security identifier passwords on the Remote Office 9150 unit:

- inbound security identifier: This is the RLC’s security identifier. It is presented on incoming calls.
- outbound security identifier: This is the Remote Office 9150 unit’s security identifier. It is presented to the RLC on outgoing calls.

You must configure the same security identifiers in reverse on the RLC port to which this Remote Office 9150 unit is assigned.
Trunking, connection types, and call timers

This section describes the features that are supported on the PSTN.

Trunk connections

The following digital trunk connections are supported:

- ISDN BRI from the Remote Office 9150 unit to the PSTN
- ISDN PRI from the PSTN to the RLC at the host site

Remote Office supports Multiple Subscriber Numbering (MSN). If the Central Office provides each B-channel with a unique DN then the first B-channel you configure defines the number for both B-channels.

64K (56K) dynamic adaptation

With some carriers, 64K calls routed over a 56K PSTN infrastructure may cause errors. The dynamic adaptation feature allows the Remote Office 9150 unit and the RLC to dynamically detect the limitation of the bandwidth. The call is then downgraded from 64K to 56K.

Bandwidth allocation

The RLC automatically allocates trunk bandwidth to the Remote Office 9150 connection as needed. For example, as calls are initiated and bandwidth requirements increase, additional trunk connections are established. Likewise, as calls terminate and bandwidth requirements drop, connections to idle trunks are terminated.

Connection types

The Remote Office 9150 connection to the RLC can be defined on the RLC as permanent or on demand. A permanent connection means that the ISDN connection to the host PBX always remains open. An on demand connection means that the ISDN connection is established only when a connection with the host PBX is required.
If the connection is defined as demand, then you can configure minimum call duration and idle timers on the RLC to help reduce call charges.

Minimum call duration timer

Most ISDN tariffs specify a minimum length of time for which you are charged when you open the line, regardless of the call duration. This is the same as the minimum call charges listed on long distance telephone bills.

The minimum call duration timer is used in circuit-switched mode only and specifies the minimum length of time that each circuit-switched call to the host PBX remains active, regardless of telephone activity or inactivity. The timer should be configured on the RLC to drop inactive connections just before an additional charge period is incurred. For example, if the timer is set to 59 seconds and your call lasts only 20 seconds, the ISDN connection drops when the timer reaches 59 seconds.

If another call is made to the host PBX before the timer expires, the timer is reset. The timer tracks the current call.

Idle timer

The idle timer identifies the maximum length of time during which an ISDN connection remains idle before it closes. Idle means that a voice connection exists but is not active, and buttons are not being pressed on digital telephones.

For example, if the idle timer is set on the RLC to 60 seconds, the ISDN call remains open for 60 seconds after you hang up. If you or someone else dials another number before 60 seconds have passed, another ISDN connection is not opened.

How the timers work to control ISDN costs

The minimum call duration and idle timers work together to control ISDN charges. The following examples describe what happens when the minimum call duration timer is set to 59 seconds and the idle timer is set to 60 seconds.
Example 1
If the call lasts for 20 seconds and no other calls are made, the ISDN connection drops when the minimum call duration timer reaches 59 seconds. The minimum call duration timer expires before the idle timer.

Example 2
If the call lasts for 65 seconds and no other calls are made, the ISDN connection drops after another 60 seconds has passed without activity. Since the ISDN call exceeded 59 seconds, the minimum call duration timer no longer applies. The idle timer is used, in this case, to prevent further ISDN charges.
Telephones

This section lists the telephones, features, and modules supported by the Remote Office 9150 unit.

Supported digital telephones

The following Meridian digital telephones are supported:

- M2008D
- M2008HFD
- M2216D
- M2616D
- M2616CT
- M2016HFD
- M2216D
- M2616D
- M2616CT

Note: The M2006 and M3901 telephones are also supported, but can be used only for locally controlled calls. These telephones do not have displays, which are required for host PBX functionality.
You cannot dial directly from the Call Log of M3900 series telephones because the Trunk Access code and country code may not be displayed.

Supported telephone modules

The following telephone modules are supported:

- add-on modules (to add more keys)
- application modules that provide more functionality
- Meridian Communication Adapters (MCA)
- Analog Telephone Adapters (ATA)

Note: You cannot dial directly from the Call Log of M3900 series telephones because the Trunk Access code and country code may not be displayed.

Computer telephony integration applications

There are two types of computer telephony integration (CTI) applications:
first-party CTI applications that use the Symposium Desktop TAPI Service Provider

third-party CTI applications that use Symposium TAPI Service Provider for Meridian 1

Both types can be used with the Remote Office 9150 unit.

<table>
<thead>
<tr>
<th>TAPI Type</th>
<th>Supported CTI Application</th>
</tr>
</thead>
<tbody>
<tr>
<td>Symposium Desktop TAPI Service Provider 1.6</td>
<td>■ Symposium FastView 1.6</td>
</tr>
<tr>
<td></td>
<td>■ Symposium FastCall 1.6</td>
</tr>
<tr>
<td></td>
<td>■ Symposium Call Manager 5.0</td>
</tr>
<tr>
<td></td>
<td>■ other TAPI-compliant applications</td>
</tr>
<tr>
<td>Symposium TAPI Server Provider for Meridian 1 Release 2.1</td>
<td>■ Symposium Agent 1.1</td>
</tr>
<tr>
<td></td>
<td>■ Symposium Call Manager 5.0</td>
</tr>
<tr>
<td></td>
<td>■ other Symposium Partner products</td>
</tr>
</tbody>
</table>

You can use first-party CTI applications with the Remote Office 9150 unit if

■ your PC is equipped with a Symposium Communicator card version 1.2 with software version 2.0
■ your digital telephone is equipped with a Meridian Communications Adaptor (MCA)

**Note:** The Symposium Communicator card is not available in all countries. Check with your Nortel Networks distributor for availability.

**Automatic Call Distribution (ACD) applications**

The Remote Office 9150 unit supports all Nortel Networks ACD applications.
Voice over IP features

You can configure the Remote Office 9150 unit to use the following Voice over IP features:

- Convert analog voice into digital data for transmission as voice packets over the network for calls to or from the fax machine or other analog device that is connected to the analog port on Telco 1.
- Automatically switch from the IP network to the PSTN when the voice QoS falls below a predetermined threshold, and back to the IP network when the QoS returns to normal.

Packetized voice

DSPs located in the Remote Office 9150 unit convert voice into digital data packets and, if compression is used, compresses them. The data is constructed as UDP/IP voice packets for transmission over the IP network.

When voice packets are compressed, they consume less bandwidth, leaving more bandwidth for data or other voice or fax communications. The following algorithms are supported:

- G.711: Packets are transmitted at 64 Kbps (that is, they are not compressed).
- G.726: Packets are compressed and transmitted at 32 Kbps.
- G.729A: Packets are compressed and transmitted at 8 Kbps.

G.729A is the default algorithm on both the RLC and the Remote Office 9150 unit.

In addition to voice compression, the Remote Office 9150 unit supports the following additional packetized voice features:

- A voice jitter attenuation buffer removes the variable delays from the voice packets sent across the IP network, thus avoiding awkward-sounding speech.
- Packet loss handling techniques accommodate missing packets or packets received too late to be processed.
Silence suppression prevents packet transmission during periods when there is no voice data present. Comfort noise is inserted to assure the user that the line is still active.

Silence is determined when the difference between the adaptable noise floor and the detected signal is less than 9 dB. To prevent clipping, silence must be present for a minimum of 250 milliseconds.
Quality of Service transitioning technology

Communications between the Remote Office 9150 unit in your office and the host PBX take place across the IP network using a 10BaseT Ethernet interface. You can configure the Remote Office 9150 unit to switch automatically from the IP network to the PSTN when the voice QoS falls below a predetermined threshold. Within the QoS settings you can also enable Differentiated Services (DiffServ) and 802.1p mapping to give priority to voice over IP traffic on your network.

Both the RLC and the Remote Office 9150 unit monitor the IP network’s QoS constantly. If the IP network QoS degrades, causing poor voice quality, the Remote Office 9150 unit moves, or transitions, the call to the PSTN. When the QoS returns to normal, the Remote Office 9150 unit transitions the call back to the IP network.

For detailed instructions on configuring the thresholds, refer to the Reach Line Card Installation and Administration Guide (NTP 555-8421-210). For guidelines on evaluating and adjusting the QoS on your IP network, see the Remote Office Network Engineering Guidelines (NTP 555-8421-103).

Log reports and statistics
Configuration Manager provides a statistics log that identifies the number of QoS transitions (see “Caller Information Statistics screen” on page 284).

See Chapter 7, “Administration” for a detailed description of log and statistic reports.
Port management

You can assign Remote Office 9150 stations to one of the following types of RLC ports:

- single-user ports
- multi-user voice ports
- dynamic port pool

Port types are assigned on the RLC. Refer to the *Reach Line Card Installation and Administration Guide* (NTP 555-8421-210) for detailed instructions.

Single-user ports

Each port that is defined as a single-user (dedicated) port on the RLC supports one Remote Office 9150 station.

Multi-user ports

Ports that are defined on the RLC as multi-user ports allow multiple stations on different Remote Office 9150 units to time-share a single port on the host PBX.

Up to eight persons can share the same RLC port, but not at the same time. All stations that use this type of port must respond to the same DN and have identical phoneset configurations. This port type is especially useful for employees who work mutually exclusive shifts.

Dynamic port pool

Dynamic port pooling is similar to a multi-user port except that the persons who share ports in a dynamic pool are assigned to the next available port in the RLC port pool. There is no correlation between the station and the port on the RLC.

This feature is especially useful in free-seated ACD environments where agents log on to the host PBX using their agent IDs.
Station priority

You can define the priority of a RLC port to which a station is assigned as normal, high, IP only, or circuit only.

Normal priority

When both the IP and PSTN networks are used to route calls, calls to and from the station are routed primarily over the IP network. Calls transition between the IP and PSTN networks whenever voice QoS levels change. (The voice QoS levels are defined on the Quality of Service screen on the RLC for your Remote Office 9150 unit.)

High priority

When you define an RLC port as high priority, the associated station has the following benefits:

- If allowed to use the IP network to process calls (this is transparent to the user), an active call on that station is always one of the first to transition to PSTN trunks when Voice over IP QoS degrades. (This transition is accomplished using the QoS Transitioning Technology.)
- Call blocking is reduced because bandwidth is always available to these stations.

  Note: If the reserved bandwidth is being used by other high priority stations, then new calls are processed using unreserved bandwidth.

The number of stations that you can configure as high priority depends on the amount of available bandwidth. Ensure that enough bandwidth is available to process calls on normal priority stations.

IP only

Calls to and from the station are routed over the IP network only. QoS transitioning is not available for stations that are defined as IP only.
Remote Office 9150 description

Circuit only

Calls to and from the station are routed over the PSTN network only. Circuit only stations never experience voice QoS degradation.
Connection bandwidth

On the connection between the RLC and the Remote Office 9150 unit, you can configure the following:

- when to open additional B-channels (referred to as extra bandwidth)
- how much bandwidth to reserve for high priority stations (referred to as priority reserved bandwidth)

For instructions, refer to “Configuring ports” in the Reach Line Card Installation and Administration Guide (NTP 555-8421-210).

Extra bandwidth

When available bandwidth is no longer sufficient to process active calls, additional B-channels are opened according to the extra bandwidth setting. For example, if you configure the extra bandwidth setting as 16 Kbps, another B-channel opens when existing bandwidth is reduced to 16 Kbps or less.

Priority reserved bandwidth

The priority reserved bandwidth setting defines how much bandwidth to reserve for high priority stations. The reserved bandwidth cannot be used by stations configured as normal, IP only, or circuit-only priority. High priority stations consume priority reserved bandwidth before consuming unreserved bandwidth.

For example, if you configure the priority reserved setting as 16 Kbps, then only high priority stations can use this reserved bandwidth. When the reserved bandwidth is being used for active high priority calls, additional calls from high priority stations are processed using unreserved bandwidth. If no bandwidth is available, calls to or from high priority stations are blocked until bandwidth becomes available.
Local calling

The Remote Office 9150 unit allows you to place calls to other extensions within your office or to telephones in your local community. This is accomplished through the use of up to two local call appearance keys. See Chapter 6, “Using Remote Office 9150 stations,” for a detailed description of the local call appearance keys.

Local extension calling

When you place a call to another telephone in your office using the local call appearance key, it is handled by the Remote Office 9150 unit, not the host PBX.

Note: If the call is initiated from the host call appearance key, then the station-to-station call requires transmission of signaling data through the host PBX.

Local SwitchOver

Local SwitchOver is a mechanism by which the Remote Office 9150 unit determines that a PBX controlled call that originated on the Remote Office 9150 unit is actually destined for a DN on the same Remote Office unit.

Note: The DN Discovery feature is necessary for the Local SwitchOver feature to work properly. Refer to the Reach Line Card Installation and Administration Guide (NTP 555-8421-210) for more information.

In this situation, the Remote Office 9150 unit switches to a local 64K channel and cross-connect the voice-paths of the phone without using wide area bandwidth.

There are times, however, when the Remote Office 9150 unit does not know that an incoming and outgoing call are part of the same call (for example, you transfer/forward a call within the same PBX, or redial the last number). Although the call still functions, it consumes Wide Area bandwidth.

Local SwitchOver is not available if the call is answered with the Handsfree button on M39xx telephones.
Local calls through PSTN

The Remote Office 9150 unit allows you to make outgoing and answer incoming PSTN calls over the ISDN BRI connection.


Bridge Port

Bridge Ports are proxy ports that represent local calls or inbound PSTN calls to the PBX. When a local call on a Remote Office 9150 unit needs PBX services, the Bridge Port obtains a PBX presence on behalf of the local call.

Call restrictions

To prevent outgoing calls to certain types of numbers (for example, 1-976), you can disable outgoing calls to specific digit sequences.

Telephone features that are supported

The following Meridian telephone features are supported for locally controlled calls:

- Paging
- Call Waiting
- Hold for calls that appear on local call appearance keys
- Call Transfer (blind and announced) for station-to-station calls only
- Release
- Handsfree
- calling line identification (CLID) and calling party name display (CPND)

Telephone features that are not supported

The Conference and Call Forward features require a host PBX connection, and, therefore are not supported in locally controlled mode.
Online/offline table

The online/offline table is configured on the RLC and allows you to schedule times

- when the ISDN BRI connection to the host PBX is made available to the Remote Office 9150 site
  
  **Note:** When the Remote Office 9150 unit is in offline mode, users cannot make or receive calls through the host PBX over the IP or PSTN.

- when all telephones at the Remote Office 9150 site revert to normal telephone service

This allows you to ensure that unwanted ISDN BRI telephone calls through the host PBX are disabled after business hours.

How the table works

You can define up to eight entries per day, every day of the week, for each remote site. You can define each entry as online, offline, or undefined for each time period entered.

Users at the Remote Office 9150 site can override the settings of the online/offline table, should the table attempt to suspend access to the host PBX in the middle of a business call. Each user station at the remote site is alerted by a buzz and a display message at 30, 20, and 10 seconds before the connection is terminated. To override connection termination, the user must enter the online SPRE (Special Prefix) code on the telephone.

Configuration

The online/offline table is configured for each remote site on the RLC. Refer to the *Reach Line Card Installation and Administration Guide* (NTP 555-8421-210) for configuration information.

For a description of how to go online or offline at the Remote Office 9150 site, see Chapter 6, “Using Remote Office 9150 stations.”
Other supported features

Fax support

The Remote Office 9150 unit contains one analog port that can be used to send and receive faxes. You can send and receive faxes in both host- and locally controlled call modes over the IP or PSTN. Faxes are sent uncompressed (that is, you require 64 Kbps of bandwidth).

To support faxing through the host PBX, the fax port on the Remote Office 9150 unit must be associated with a port on the RLC that is configured on the host PBX with voice capability.

Emergency activation code

If your community has implemented an emergency service number (such as 911) to call the police, fire department, or ambulance, you can configure that number on the Remote Office 9150 unit. This allows users in your office to dial the emergency number and be connected directly to the local emergency dispatch center through the PSTN. The call is automatically routed through the local PSTN without having to dial a local trunk access code.

When you configure an emergency activation code on the Remote Office 9150 unit, you also prevent the call from being automatically routed through the host PBX, which could be in a different city. An emergency call that is routed through the host PBX can result in emergency support being dispatched to the wrong location.

ATTENTION
If you are using only the IP network to route calls, you should make emergency service calls on a telephone that is directly connected to a PSTN line. If you make an emergency service call from a station that is connected to the Remote Office 9150 unit, the call is routed through the host PBX, which could be in a different city.
Administration software

Configuration and administration of the Remote Office 9150 unit is performed with Configuration Manager software, a Windows-based application that is installed on your PC.

The software is provided on the Remote Office Product CD-ROM. You can obtain the CD from your Nortel Networks distributor or click on the Customer Support and Software Distribution links at the following website:

www.nortelnetworks.com

Administration PC connection options

You can connect the administration PC to the Remote Office 9150 unit through the following:

- an RS-232 connection to the administration PC’s serial port
- a 10BaseT Ethernet interface connection

What you can do with Configuration Manager

Configuration Manager allows you to configure the Remote Office 9150 unit. Configuration Manager also provides the Configuration Wizard for first-time configuration. The Configuration Wizard prompts you for the minimum information that is needed to get the Remote Office 9150 unit communicating with the RLC on the host PBX.

After the initial configuration is completed, use Configuration Manager to administer the Remote Office 9150 unit. Administration tasks include the following:

- viewing the system status
- performing upgrades, backups, or restores
- making configuration changes
- changing the administration password
**Note:** Configuration Manager alerts you when you must restart after you have made a configuration change.

**Command line interface**

When the administration PC is connected to the Remote Office 9150 unit through the serial port, you can view the command line interface using an application such as Telnet or HyperTerminal. However, the command line interface is not documented in this guide. Configuration Manager is the supported tool for administering the Remote Office 9150 unit over both the serial port and Ethernet connections.
Chapter 2
Planning for installation

In this chapter
Installation checklist 52
Physical environment 56
Administration PC 61
Network considerations 66
Managing trunk connections 70
Station configuration 73
Security 77
Planning for future growth 79
Deployment options 82
Planning the configuration 87
Remote Office 9150
Installation checklist

Use this checklist to ensure that all installation tasks are completed.

<table>
<thead>
<tr>
<th>Check</th>
<th>Task</th>
<th>For details, see</th>
</tr>
</thead>
<tbody>
<tr>
<td>☐</td>
<td>Ensure you have the latest firmware and software.</td>
<td><em>Remote Office and RLC Release Notes</em> (NTP 555-8421-102)</td>
</tr>
<tr>
<td>☐</td>
<td>You can route calls over the IP network, the PSTN, or both. Determine, at a high level, what you must do to implement these call routing methods.</td>
<td>“Deployment options” on page 82.</td>
</tr>
</tbody>
</table>
| ☐ | If you want to use the IP network to route calls, evaluate the IP network to determine if the network infrastructure can support voice traffic. | ■ your data network administrator  
■ *Remote Office Network Engineering Guidelines* (555-8421-103) |
| ☐ | If you want to use the PSTN to route calls, order trunks from the central office to the Remote Office 9150 unit site. | “ISDN BRI information” on page 88.  
**Note:** The Remote Office 9150 unit supports ISDN BRI trunks (S/T or U interface). |
| ☐ | Obtain the cables that you need to establish the network connections. | “Cables you must supply yourself” on page 59. |
| ☐ | Decide on the administration PC setup. | “Administration PC” on page 61. |

52
**Remote Office 9150 unit**

**Installation checklist**

<table>
<thead>
<tr>
<th>Check</th>
<th>Task</th>
<th>For details, see</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Gather the configuration information (network addresses, connection</td>
<td>“Deployment options” on page 82</td>
</tr>
<tr>
<td></td>
<td>numbers, online/offline schedule, QoS thresholds, and so on).</td>
<td>Appendix A, “Planning forms”</td>
</tr>
<tr>
<td></td>
<td>Install DSP application and trunk interface modules into the Remote</td>
<td>“Installing a trunk interface or DSP application module” on page 100.</td>
</tr>
<tr>
<td></td>
<td>Office 9150 unit.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Choose a suitable location for the Remote Office 9150 unit.</td>
<td>“Choosing a suitable location” on page 106.</td>
</tr>
<tr>
<td></td>
<td>Install the Remote Office 9150 unit in the chosen location.</td>
<td>“Mounting the Remote Office 9150 unit” on page 106.</td>
</tr>
<tr>
<td></td>
<td>Connect the Remote Office 9150 unit to the power source, administration</td>
<td>“Connecting the Remote Office 9150 unit” on page 113.</td>
</tr>
<tr>
<td></td>
<td>PC, and network.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Power up the Remote Office 9150 unit and observe LED behavior.</td>
<td>“Powering up the Remote Office 9150 unit” on page 119.</td>
</tr>
<tr>
<td></td>
<td>The Status LED remains lit when the power-up cycle completes successfully.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Install the software from the product CD-ROM or the Nortel Networks</td>
<td>“Installing the software” on page 122.</td>
</tr>
<tr>
<td></td>
<td>web site.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Configure the IP address, subnet mask, and default gateway on the</td>
<td>“Using the Configuration Wizard to perform initial configuration” on page 124.</td>
</tr>
<tr>
<td></td>
<td>Remote Office 9150 unit.</td>
<td></td>
</tr>
</tbody>
</table>
### Remote Office 9150 unit

#### Installation checklist

<table>
<thead>
<tr>
<th>Check</th>
<th>Task</th>
<th>For details, see</th>
</tr>
</thead>
</table>
| ☐     | Configure the following items, as required, to create the communication paths between the Remote Office 9150 unit and the RLC:  
  - IP network: RLC’s IP address  
  - PSTN:  
    - RLC’s telephone number  
    - primary trunk  
    - security level and, if required, security identifier  
  | “Using the Configuration Wizard to perform initial configuration” on page 124  
  “Configuring the security level” on page 204 |
| ☐     | Ping the Remote Office 9150 unit and ensure that it is recognized as a device on the network. | “Testing the network connections” on page 138. |
| ☐     | Ensure that the Remote Office 9150 unit’s connection information is completed on the RLC. | the *Reach Line Card Installation and Administration Guide* (NTP 555-8421-210). |
| ☐     | Configure user stations with appropriate calling permissions and features. | “Defining stations” on page 225. |
| ☐     | Configure ports on the RLC. | the *Reach Line Card Installation and Administration Guide* (NTP 555-8421-210). |
Remote Office 9150 unit
Installation checklist

<table>
<thead>
<tr>
<th>Check</th>
<th>Task</th>
<th>For details, see</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Configure network devices</td>
<td>• your data network administrator.</td>
</tr>
<tr>
<td></td>
<td>• so that voice traffic is not constrained or congested</td>
<td>• <em>Remote Office Network Engineering Guidelines</em></td>
</tr>
<tr>
<td></td>
<td>• to maximize network efficiency for Voice over IP service</td>
<td>(555-8421-103)</td>
</tr>
<tr>
<td></td>
<td>Ensure that voice calls can be sent or received over the following:</td>
<td>your data network administrator.</td>
</tr>
<tr>
<td></td>
<td>• IP network</td>
<td>• your data network administrator.</td>
</tr>
<tr>
<td></td>
<td>• PSTN</td>
<td>• your telecom network administrator</td>
</tr>
<tr>
<td></td>
<td>Ensure that processing of voice and data traffic over the IP network performs as expected. Adjust QoS transitioning settings, if required.</td>
<td>• <em>Remote Office Network Engineering Guidelines</em></td>
</tr>
<tr>
<td></td>
<td></td>
<td>(555-8421-103)</td>
</tr>
<tr>
<td></td>
<td>Ensure that calls can be made and received on each station.</td>
<td>“Testing the network connections” on page 138.</td>
</tr>
<tr>
<td></td>
<td>Plan for administration training and technical support.</td>
<td>• Chapter 7, “Administration”</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Chapter 8, “Troubleshooting”</td>
</tr>
</tbody>
</table>
Physical environment

This section provides the space, temperature, cabling, and mounting information you need to know before you install the Remote Office 9150 unit.

Space

Ensure that the Remote Office 9150 unit is installed in a location that is dry and provides plenty of air circulation.

The chosen location should be within cable-length distance from the following:
- the administration PC (if the serial connection is used)
- the Ethernet hub
- trunk and telephone connection interfaces

The Remote Office 9150 unit can be installed up to
- 1230.7 meters (4000 feet) from the digital telephones
- 307.7 meters (1000 feet) from the analog device

It is recommended that you install the Remote Office 9150 unit in the same room where your communications equipment is installed.

Temperature and humidity

The following table describes the temperature and humidity conditions that the Remote Office 9150 unit can withstand without any performance degradation or damage.
### Specification

<table>
<thead>
<tr>
<th>Normal operation</th>
<th>Minimum</th>
<th>Maximum</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Recommended:</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Temperature</td>
<td>15°C (59°F)</td>
<td>30°C (86°F)</td>
</tr>
<tr>
<td>Relative humidity</td>
<td>20%</td>
<td>55% (non-condensing)</td>
</tr>
<tr>
<td>Absolute:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Temperature</td>
<td>10°C (50°F)</td>
<td>45°C (113°F)</td>
</tr>
<tr>
<td>Relative humidity</td>
<td>20%</td>
<td>80% (non-condensing)</td>
</tr>
<tr>
<td>Short term (less than 72 hours):</td>
<td>-40°C (-40°F)</td>
<td>70°C (158°F)</td>
</tr>
<tr>
<td>Rate of change</td>
<td>Less than 1°C (33.8°F) per 3 minutes</td>
<td></td>
</tr>
</tbody>
</table>

### Storage

| Recommended temperature | -20°C (-4°F) | 60°C (140°F) |
| Relative humidity       | 5%           | 95% (non-condensing) |
| Non-condensing          | -40°C (-40°F) | 70°C (158°F) |

### Temperature shock

| In 3 minutes | -40°C (-40°F) | 25°C (77°F) |
| In 3 minutes | 70°C (158°F) | 25°C (77°F) |
| Non-condensing| -40°C (-40°F) | 70°C (158°F) |
Mounting options

You can place the Remote Office 9150 unit on a desk or in a rack, or you can mount it on the wall.

The Remote Office 9150 unit dimensions are
- 42.5 cm (17 in.) wide (without rack-mounting brackets)
- 29.4 cm (11.75 in.) deep
- 4.4 cm (1.75 in.) high

Mounting the Remote Office 9150 unit in a rack
If you want to install the Remote Office 9150 unit in a rack, the rack slot must
- be large enough to provide air circulation to keep the Remote Office 9150 unit cool
- allow you to securely fasten the Remote Office 9150 unit to the rack using the rack-mount brackets

Mounting the Remote Office 9150 unit on the wall
If you want to install the Remote Office 9150 unit on the wall, you can mount it so the cables from the rear panel are directed either right or left. Ensure that the chosen location allows you to easily view the LEDs on the front panel.

ATTENTION You must complete wall installation using standard telephony installation practices.

Connections

The following connections are made from the rear panel of the Remote Office 9150 unit to the telephone and data networks:

- Two 25-pair connectors (labeled TELCO 1 and TELCO 2) provide tip and ring connections to stations (telephones) and central office trunks (ISDN BRI). These connections provide the interface to the telephone network and the PSTN.
An RJ-45 connector (labeled ETHERNET) provides a 10BaseT Ethernet connection. This connection provides the ability to pass both voice and data administration traffic over the existing Ethernet network.

A DB-9 connector (labeled ADMIN) provides an RS-232 serial port connection. You can use this serial port connection to configure a Remote Office 9150 unit that is directly connected to a PC.

The DB-25 connector (labeled V.35) is for future use.

Cables included with the Remote Office 9150 unit

The Remote Office 9150 unit package includes the following cables:

- power cord and power supply

  Notes:
  - In North America, the power cord and power supply are included inside the Remote Office 9150 box. In all other regions, the power supply is provided inside the box. However, the power cord for your region is provided outside the box.
  - When the North American power cord and power supply are connected together, they are 3.2 meters (10.4 feet) in length.
  - If you connect the Remote Office 9150 unit to an uninterruptible power supply then the UPS must have a minimum of 100 Watts available.

- RS-232 serial cable
  If the RS-232 cable is not long enough, you can supply your own cable, up to 15.38 meters (50 feet) in length.

Cables you must supply yourself

The cables used to establish the telephone and Ethernet network connections are industry-standard cables. They are not provided in the Remote Office 9150 package. You must obtain them from your local cable supplier.

Telephone network cables
The telephone network cables establish the telephone and trunk connections.

One end of the cable must provide a male 50-pin connector. (This end connects to the Remote Office 9150 unit.)
Ensure that the other end of the cable matches the connectors needed to connect to the telephones or trunks. (For example, if you are using a BIX block to establish the telephone connections, you might need to cut off the connector to expose the wires inside.)

Notes:

- Two telephone cables may be required, based on how many telephones and ISDN BRI lines you plan to connect. (Each telephone cable provides support for up to 16 digital telephones, and two ISDN BRI lines providing two B-channels each. The Telco 1 cable also provides support for one analog station such as a fax machine.)
- The Telco 1 and 2 connections are the opposite gender of the connections for an Meridian 1 IPE or Option 11 cabinet line card slot. Therefore, you must use different cables when connecting to the Remote Office 9150 than those used to connect to Meridian 1 line cards.
- Digital telephones should be located no further than 1230.7 meters (4000 feet) from the Remote Office 9150 unit.
- The analog device should be located no further than 307.7 meters (1000 feet) from the Remote Office 9150 unit.

Ethernet cable
If you are connecting the Remote Office 9150 unit to a hub, you need a standard CAT5 unshielded twisted-pair (UTP) straight-through Ethernet cable. The cable should be no longer than 100 meters (325 feet) in length.
Administration PC

The administration software is Windows-based and is installed on a PC. This section describes ways that you can connect an administration PC to the Remote Office 9150 unit. It also describes the hardware and software requirements for using the administration software.

Connection options

The Remote Office 9150 product includes the Configuration Manager software that enables you to configure, administer, and upgrade the Remote Office 9150 unit. You can perform these tasks over one of the following:

- an RS-232 serial connection (required for first-time configuration only)
- a 10BaseT Ethernet connection (for ongoing administration and upgrades)

Serial connection

You must use the serial connection when you first install and configure the Remote Office 9150 unit. You must establish a serial connection to the Remote Office 9150 unit to enter the IP interface information.

See the following diagram.

You can continue using the serial connection for ongoing administration of the Remote Office 9150 unit, if you wish. However, if this is the only connection option used, you cannot administer the Remote Office 9150 unit remotely or perform upgrades.
Note: When the administration PC is connected to the Remote Office 9150 unit through the serial port, you can view the command line interface using an application such as Telnet or HyperTerminal. However, the command line interface is not documented in this guide. Configuration Manager is the supported tool for administering the Remote Office 9150 unit over the serial port.

Ethernet connection
Once you configure the Remote Office 9150 unit with its IP interface information, the following can happen:

- Communication can be established between the Remote Office 9150 unit and the RLC (that is, calls can be routed over the IP network).
- You can administer and upgrade the Remote Office 9150 unit over the IP network.

This means you do not have to install an administration PC in the same location as the Remote Office 9150 unit.

See the following diagram.
Administering multiple nodes in the network

If you are responsible for administering one or more Remote Office 9150 units and the RLC on the host PBX, you can access the Remote Office 9150 unit and the RLC from anywhere on the network. The following diagram shows an example of an assembled network with administration PCs.

Note: You do not have to install separate administration PCs for the RLC and the Remote Office 9150 unit. You can use one administration PC to administer all units in the Remote Office network.
Windows PC requirements

To use Configuration Manager, the administration PC must:

- be an IBM-compatible PC
- use Windows 95, Windows 98, or Windows NT Workstation (Service Pack 5 or later) with the Microsoft TCP/IP networking component installed  
  **Note:** Windows 2000 is not supported.
- be equipped with a CD-ROM drive
- be equipped with a 10BaseT Ethernet interface card (this provides access to the Ethernet network)
- have an available COM port if you wish to use the RS-232 serial port to establish a direct serial connection
- be equipped with a pointing device (mouse)
- have 32 Mbytes of RAM for Windows 95 and 98, or 64 Mbytes of RAM for Windows NT
- have 48 Mbytes of available storage for Windows 95 and 98, or 64 Mbytes of available storage for Windows NT

Trivial File Transfer Protocol server

The administration PC must have a Trivial File Transfer Protocol (TFTP) server application installed to perform firmware upgrades and configuration uploads.

You can use any TFTP server application. TFTP server applications are available from the Internet.

Year 2000 compliance

The Remote Office 9150 unit and Configuration Manager software are Year 2000 compliant. However, you must ensure that the administration PC is Year 2000 compliant by verifying that the Windows operating system is listed in this table:

<table>
<thead>
<tr>
<th>Operating system</th>
<th>Year 2000 compliance requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows NT Workstation</td>
<td>Service Pack 5 or higher</td>
</tr>
<tr>
<td>Windows 95</td>
<td>Version 95b</td>
</tr>
</tbody>
</table>
Meridian Administration Tools and Configuration Manager

Meridian Administration Tools (MAT) and Configuration Manager are not guaranteed to operate simultaneously on the same administration PC. Simultaneous operation of these two applications on the same PC has not been tested and therefore, is not supported.
Network considerations

The Remote Office 9150 unit communicates through both the IP and telecommunications network using a host PBX.

To use the Remote Office 9150 unit in these networks, you must consider the issues described in this section.

IP addressing and routing

To make and receive calls over the IP network, the Remote Office 9150 unit must be:

- physically connected to the IP network
- assigned a subnet mask, default gateway, and unique IP address
  
  **Note:** Similarly, a subnet mask, gateway, and unique IP address must be assigned to the RLC on the host PBX.
- able to send and receive traffic to and from the RLC on the host PBX
Network diagram

The following diagram shows the Remote Office 9150 unit’s position in an IP network.

![Network Diagram](image)

**Note:** For placement of one or more administration PCs, see “Administration PC” on page 61.

**Quality of Service**

The routers used on your IP network must be capable of handling voice traffic, with little or no congestion and few delays. If the network is congested or subjected to many delays, voice quality is affected.

For more information, see the *Remote Office Network Engineering Guidelines* (555-8421-103).
Numbering plans

Each trunk groups at the Remote Office 9150 unit site must be assigned a trunk access code (that is, the number dialed to obtain an outgoing trunk). In addition, special prefix (SPRE) codes must be defined for the following features if you want to use them:

- paging
- local calling on ATA-equipped analog devices
- to go online or offline (for more details, see “Online/offline table” on page 46)
- registration and deregistration for multi-user or dynamic ports

All trunk access and SPRE codes are automatically defined in Configuration Manager with a pound prefix (# in North America) so that there are no conflicts with host PBX dialing plans. For a list of the default trunk access and SPRE codes, refer to the “Remote Office 9150 Configuration Information—Dialing Plans” form on page 354.

Numbering plan for local stations
You should consider the numbering plan on the host PBX when setting up the numbering plan for local stations at the Remote Office 9150 unit site. This ensures that station-to-station calls through the host PBX complete correctly.

Call blocking

Call blocking can occur when there are more users installed and more calls being processed than can be supported by the Remote Office 9150 unit’s DSP application and trunk interface modules.

The voice processing capacity of the Remote Office 9150 system depends on the number of DSP application and trunk interface modules installed in the Remote Office 9150 unit and the amount of bandwidth available to process calls. If bandwidth is not available, additional calls are blocked. (This setting is configured on the RLC for each site). This voice processing capacity defines how many calls can be active at one time.
The Remote Office 9150 unit ships with the ability to support up to 32 users, with up to 8 simultaneous calls (providing a 4:1 call blocking ratio). By adding additional DSP application or trunk interface modules, you can reduce or eliminate call blocking.

Reducing call blocking between the Remote Office 9150 unit and the host PBX
Each DSP application module provides the ability to support eight more simultaneous calls when voice traffic is routed over the IP network. Up to three more DSP application modules can be installed in the Remote Office 9150 unit, allowing 32 active calls at one time.

**Note:** If you add DSP capacity to the Remote Office 9150 unit, you must add the same DSP capacity to the RLC on the host PBX.

Trunks are required for the Remote Office 9150 unit to operate in circuit-switched mode (that is, over the PSTN instead of the IP network). Trunks are used to route calls between the Remote Office 9150 unit and the host PBX or the local PSTN.

By default, the Remote Office 9150 unit ships with no trunks installed. Trunks can be provided by installing trunk interface modules.

The number of trunks you can install depends on the type of trunk interface modules used on the Remote Office 9150 unit. For example, if ISDN BRI trunks are used, each trunk interface module provides one BRI trunk (providing two B-channels). You can install up to four trunk interface modules in the Remote Office 9150 unit.

**Note:** The Remote Office 9150 unit supports only ISDN BRI S/T or U trunks.

Calculating system requirements
To determine how many DSP application or trunk interface modules are needed to reduce or eliminate call blocking, use the “Remote Office 9150 System expansion worksheet” on page 355.
Managing trunk connections

You can manage trunk connections to the host PBX in several ways:

- Put the Remote Office 9150 unit into offline mode, so that it cannot receive or make calls through the host PBX when operating in circuit-switched mode.
- Define call duration and idle timers, if the trunk connection is defined as on-demand.
- Define minimum and maximum bandwidth allocation settings.
- Use the QoS transitioning technology.

Quality of Service transitioning technology

On IP networks, traffic congestion or delays can occur that result in poor voice quality or lost connections. The RLC can be configured to transition call processing from the IP network to the PSTN when the Quality of Service degrades. When Quality of Service on the IP network returns to normal, call processing can be transitioned back to the IP network.

The points at which the transition occurs are determined by the Quality of Service thresholds (level and duration) defined on each RLC port. To determine appropriate thresholds for each site in your network, you should consult your data network administrator. For more information, see the Remote Office Network Engineering Guidelines (555-8421-103).
Online/offline schedule

You can configure an online/offline schedule on the RLC to control when the Remote Office 9150 unit can make and receive calls through the host PBX. When the Remote Office 9150 unit is in offline mode, calls cannot be made or received through the host PBX over the IP or PSTN.

You should configure offline entries:

- for times when the connection to the host PBX should not be active, such as during evenings and weekends
- to prevent the Remote Office 9150 unit from staying online permanently, thereby eliminating unwanted ISDN BRI charges

When the RLC processes an offline entry, it instructs the Remote Office 9150 unit to go offline for a specified number of hours and minutes. The number of hours and minutes the Remote Office 9150 unit stays offline is the difference between the offline entry being processed and the next online entry.

For example, an offline entry is configured at 6:00 p.m. The next online entry is configured at 9:00 a.m. the following day. When the RLC processes the 6:00 p.m. entry, it instructs the Remote Office 9150 unit to go offline for 15 hours.

When going offline, a timer is activated within the Remote Office 9150 unit. When the timer expires (in the example above, at 9:00 a.m.), the Remote Office 9150 unit automatically initiates a “going online” request to the host PBX. If the RLC successfully receives the request, the Remote Office 9150 unit and its connected telephones go online.

Changing the online/offline mode

Whether an online/offline schedule is used or not, you can put the Remote Office 9150 unit into online or offline mode at any time by dialing the online or offline SPRE code at any phoneset connected to the Remote Office 9150 unit. The SPRE codes are configured on the Remote Office 9150 unit.
Trunk bandwidth allocation

The Remote Office 9150 unit can dynamically allocate available trunk bandwidth to active calls in circuit-switched mode. As calls are initiated and bandwidth requirements increase, additional trunk connections are established. Similarly, as calls terminate and bandwidth requirements drop, calls are aggregated and idle trunks are shut down.
Station configuration

When planning the stations at the Remote Office 9150 site, you must think about the call capabilities required by each station.

Each station at the Remote Office 9150 site inherits settings such as voice compression and priority from the RLC port with which it is associated. At the Remote Office 9150 site, the station is configured with the ability to make locally controlled calls, host-controlled calls, or both local- and host-controlled calls. For stations defined with local- or local- and host-controlled capability, specific features can be enabled or disabled.

RLC settings

You must define the following on each RLC port:

- port allocation as dedicated, multi-user, or dynamic
- whether voice compression will be used
- priority level

Port allocation

Assign each user at the Remote Office 9150 site to one port on the RLC on the host PBX. You can configure an RLC port in one of the following ways:

- as a dedicated port (one port per remote user)
- as a multi-user port (one port shared by multiple users)

Up to eight persons can share the same RLC port, but not at the same time. All stations that use this type of port must respond to the same DN and have identical phoneset configurations. This port type is especially useful for employees who are working in mutually exclusive shifts.
as part of a dynamic pool

Dynamic port pooling is similar to a multi-user port except that the persons who share ports in a dynamic pool are assigned to the next available port in the RLC port pool. There is no correlation between the station and the port on the RLC.

This feature is especially useful in free-seated ACD environments where agents log on to the host PBX using their agent IDs.

Voice compression
If calls are to be routed over the IP network, you must select one of the following voice compression algorithms on each RLC port:

- **G.711**: Voice is transmitted at 64 Kbps (no compression).
- **G.726**: Voice is compressed and transmitted at 32 Kbps.
- **G.729A**: Voice is compressed and transmitted at 8 Kbps.

G.729A is the default voice compression algorithm used by the RLC. This allows

- up to six simultaneous voice calls to be processed over the first ISDN BRI B-channel (16 Kbps are reserved for signaling data)
- up to eight simultaneous voice calls to be processed over the remaining ISDN BRI B-channels

Each Remote Office 9150 station inherits its compression algorithm from the RLC port to which it has been assigned.

Station priority
You can configure each RLC port that is assigned to each station as normal priority, high priority, circuit-switched only, or IP only.

When the port is configured as high priority and the priority reserved setting is configured on the connection between the RLC and Remote Office 9150 unit, you can ensure voice Quality of Service for calls to and from those stations.

For more details, see “Station priority” on page 41 and “Connection bandwidth” on page 43.
Notes:
1. Each Remote Office 9150 station inherits its priority setting from the RLC port to which it has been assigned.
2. The number of RLC ports that you can configure as high priority depends on the amount of available bandwidth. The RLC administrator must ensure that enough bandwidth is available to process calls on normal priority ports.

Remote Office 9150 settings
You can define the following settings for each Remote Office 9150 station:
- port type as local, remote, or both
- extension (directory) number (on local stations only)
- key placement (on local stations only)

Port types
On the Remote Office 9150 unit, you can define each station with one of the following capabilities:
- local control only (local)
  You can use stations defined as local to make and receive calls through the local PSTN. You can also make station-to-station calls at the Remote Office 9150 site. Calls through the host PBX are not allowed.
- host control only (remote)
  If a particular station is not allowed to make or receive calls through the local PSTN, that station is configured as remote only. All calls are routed through the host PBX, except for emergency calls (such as 911). If the emergency service number is configured on the Remote Office 9150 unit, calls made to the emergency number are routed through the local PSTN so the emergency service receives the correct location information.
- both local and remote control
  You can use stations defined as local and remote to make and receive calls through both the host PBX and the local PSTN. You can also make station-to-station calls at the Remote Office 9150 site.
Outgoing calls are routed according to the call appearance key used to initiate the call. Calls initiated on the key defined as the primary or host call appearance key are routed through the host PBX. Calls initiated on the key defined as the local call appearance key are routed through the local PSTN, if a trunk access code was dialed before the telephone number.

When a station is configured with local control capability, further configuration of the station is required to:

- enable or disable certain features
- disable outgoing calls or single-digit dialing, if required
- define key placement on the telephone

User extension configuration
Each station is assigned a local directory number (DN). The Remote Office 9150 unit uses the DN to route the incoming call to the correct station.

Stations that are configured with host-controlled call capability are associated with a port number on the RLC. The RLC and the Remote Office 9150 unit use this port number to establish the communication path between the host PBX and the station.

Placement of local call appearance and feature keys
When determining the placement of the local call appearance key on a station, ensure that the key position is not already configured for a specific feature on the host PBX. If you configure a PBX-configured feature key as a local call appearance key, the user cannot use that feature.

If the station is configured with local control capability, you can also configure the placement of other keys, such as Transfer, Call Waiting, and Make Set Busy.
Security

The RLC and Remote Office 9150 unit offer the following types of security:

- security level and, if required, security identifier to prevent toll fraud on the host PBX
- two levels of administration passwords to secure node configurations

Toll fraud

You can minimize toll fraud on the PBX by implementing one of the following levels of security:

- Caller ID
  When Caller ID is selected, the Remote Office 9150 unit’s calling line identification (CLID) is compared with its PSTN number configured on the RLC port when a connection to the host PBX is attempted. If they match, the connection is established. If they do not match, the host PBX drops the call.
  Caller ID authentication cannot be performed over the IP network.

- security identifier
  You can use security identifier authentication over the IP or PSTN. If this level is chosen, a security identifier must be configured on both the Remote Office 9150 unit and the RLC port to which the unit is assigned. When a connection between the host PBX and Remote Office 9150 unit is attempted, the security identifiers are compared. If they match, the connection is established. If they do not match, the host PBX drops the call.

Data network security

The Remote Office 9150 solution does not provide for data network security. If security on the data network is an issue, security must be implemented on the data network devices.
System configuration

The RLC and Remote Office 9150 unit configurations are protected by two layers of security:

- administration password
  The administration password is required when starting the Configuration Manager software. If the password is not known, the person attempting to use the Configuration Manager cannot log on to any Remote Office node.
  **Note:** A node is any RLC or remote site connected to the RLC.

- node password
  The node password is required before the configuration of a particular node can be displayed or modified.
Planning for future growth

The Remote Office 9150 unit can change or grow along with your telecommunication needs. This section describes planning for accommodating those needs.

Adding DSP modules

The Remote Office 9150 unit ships with the ability to support up to 32 stations (which must all be assigned to one RLC). Up to eight simultaneous voice calls can be supported when calls are routed over the IP network.

You can increase the voice processing capability of the Remote Office 9150 unit by installing up to three more DSP modules. Each DSP module adds support for up to eight more simultaneous calls (to a maximum of 32).

To determine how many DSP application modules you need to install, use the “Remote Office 9150 System expansion worksheet” on page 355. For instructions on installing additional DSP modules, see “Installing a trunk interface or DSP application module” on page 100.

Refer to “Configuring DSP resources” on page 235 for configuration information.

Note: When installing additional DSP modules on the Remote Office 9150 unit, you must also increase voice processing capability on the RLC. The number of modules that need to be added on the RLC depend on the requirements of other remote units connecting to the same RLC. If only this Remote Office 9150 unit is connecting to the RLC, then the same number of DSP modules must be installed on both the Remote Office 9150 unit and the RLC. To calculate the RLC’s DSP refer to the expansion worksheet in the Reach Line Card Installation and Administration Guide (NTP 555-8421-210).
Adding trunk interface modules

Initially, the Remote Office 9150 unit ships with no trunks. As connection needs change, you can add up to four ISDN BRI S/T or U trunk interface modules.

To determine how many trunk interface modules you need to install, use the “Remote Office 9150 System expansion worksheet” on page 355. For instructions on installing or replacing existing trunk interface modules, see “Installing a trunk interface or DSP application module” on page 100.

Maximum configurations

The following table identifies the maximum configurations for the Remote Office 9150 solution:

<table>
<thead>
<tr>
<th>Component</th>
<th>Maximum</th>
</tr>
</thead>
<tbody>
<tr>
<td>RLC connections</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> You must assign all users at the Remote Office 9150 site to the same RLC.</td>
</tr>
<tr>
<td>DSP application modules</td>
<td>3</td>
</tr>
<tr>
<td>ISDN BRI modules</td>
<td>4</td>
</tr>
<tr>
<td>ISDN BRI lines</td>
<td>4</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Each line is associated with one ISDN BRI module and provides two B-channels.</td>
</tr>
<tr>
<td>Trunk groups</td>
<td>10</td>
</tr>
<tr>
<td>Digital telephones</td>
<td>32</td>
</tr>
<tr>
<td>Analog telephone or fax machine</td>
<td>1</td>
</tr>
<tr>
<td>MCAs or ATAs</td>
<td>■ 4 if the Remote Office 9150 unit is connected to a 1-slot RLC (supporting 16 users).</td>
</tr>
<tr>
<td></td>
<td>■ 7 if the Remote Office 9150 unit is connected to a 2-slot RLC (supporting 32 users).</td>
</tr>
</tbody>
</table>
**Component** | **Maximum**
---|---
MCAs or ATAs (continued) | Notes:
- You can have eight MCAs or ATAs installed if an analog telephone or fax machine is *not* installed.
- The total number of digital telephones and ATAs cannot exceed 32.
Deployment options

You can install and configure the RLC on the host PBX and Remote Office 9150 unit to initially use

- only the IP network (Voice over IP)
- only the PSTN (for example, ISDN BRI trunks)
- both networks (which provides the ability to perform QoS transitions)

If you choose not to use both networks initially, this section suggests how you can gradually phase in Voice over IP and QoS transition functionality.

**ATTENTION** Even if you plan to route calls over the PSTN only, you must assign an IP address and gateway to the Remote Office 9150 unit and RLC. This allows you to administer both these nodes from an administration PC that is located elsewhere on the network.

Port and station assignment

Regardless of which network you use initially to route calls, you must plan RLC port and user station assignment. For this release, each user at the Remote Office 9150 site must be assigned to one RLC port that is configured on the host PBX with voice capability.

**Exception:** You must assign the fax machine and stations that use ATAs or MCAs for data transmission to ports that are configured on the host PBX with data capability.

If the PSTN will be used to route calls, one data port on the host PBX must be dedicated to the Remote Office 9150 site to establish the call connections.

Use the following forms to plan port and station assignment:

- “Remote Office 9150 Configuration Information—Stations” on page 346


To implement circuit-switched mode

In a network using circuit-switched mode only, all incoming and outgoing calls are processed through the PSTN

- to or from the host PBX (host-controlled mode)
- to or from other PSTN customers (locally controlled mode)

To use this scenario, follow these steps:

1. Determine how many simultaneous calls you want to process over the PSTN. This will help you determine how many trunk interface modules and DSP application modules to install on the Remote Office 9150 unit.

   To do this, complete the "Remote Office 9150 System expansion worksheet" on page 355.

   Similarly, you must calculate how many DSP application modules to install on the RLC (if any), using the "Reach Line Card System expansion worksheet" in the *Reach Line Card Installation and Administration Guide* (NTP 555-8421-210).

2. Arrange for ISDN BRI lines from the PSTN to the Remote Office 9150 site, if they are not already present.

3. Install ISDN BRI trunk interface and DSP application modules on the Remote Office 9150 unit, if needed. Up to four ISDN BRI modules and up to three DSP application modules can be installed.

   Similarly, install DSP application modules on the RLC, if needed.

   Note: The Remote Office 9150 unit does not ship with trunk interface modules or DSP application modules installed. The RLC does not ship with DSP application modules installed.

4. Obtain the ISDN BRI information for each line from the Remote Office 9150 site's PSTN service provider. This information must be configured on the Remote Office 9150 unit.
5 Identify the telephone number assigned to the B-channel that will be used as the primary trunk connection to the RLC on the host PBX. This telephone number must be configured on the RLC, and is used by the RLC to establish connections with the Remote Office 9150 unit.

6 Similarly, obtain the telephone number assigned to the RLC port to which this Remote Office 9150 unit is assigned. This telephone number must be configured on the Remote Office 9150 unit, and is used by the Remote Office 9150 unit to establish connections with the RLC.

To implement Voice over IP mode

In Voice over IP mode, all incoming and outgoing calls are processed across the IP network to or from the host PBX. Calls that are made to external parties through the host PBX are routed to the PSTN using the host PBX’s trunks. Both internal and external calls that are made through the host PBX are referred to as host-controlled calls.

**Note:** You can implement support for local PSTN calls at the Remote Office 9150 site by adding ISDN BRI lines at that site. Local PSTN calls are referred to as locally controlled calls.

To implement Voice over IP mode in host-controlled mode, follow these steps

1 Determine how many simultaneous calls you want to process. This will help you determine how many DSP application modules to install on the Remote Office 9150 unit. To do this, complete the “Remote Office 9150 System expansion worksheet” on page 355.

   Similarly, you must calculate how many DSP application modules to install on the RLC (if any), using the “Reach Line Card System expansion worksheet” in the *Reach Line Card Installation and Administration Guide* (NTP 555-8421-210).

2 Install DSP application modules on the Remote Office 9150 unit, if needed. Up to three DSP application modules can be installed.

   Similarly, install DSP application modules on the RLC, if needed.

3 Obtain an IP address assigned for the Remote Office 9150 unit. This IP address must be configured on the RLC, and is used by the RLC to establish connections with the Remote Office 9150 unit.
4. Similarly, obtain the IP address assigned to the RLC. This IP address must be configured on the Remote Office 9150 unit, and is used by the Remote Office 9150 unit to establish connections with the RLC.

5. If IP mode is stage 2 in your network implementation, run this stage with a minimal number of users until you are sure that:
   - your IP network can handle the additional traffic
   - you can identify the kinds of configuration adjustments you need to make to the IP network to handle that traffic

6. When you are satisfied with the IP network performance, continue with implementing the QoS transitioning technology.

To implement a Remote Office 9150 unit behind a NAT router

Some network routers run the Network Address Translation protocol to allow multiple devices in an Ethernet network to share the same broadband Ethernet address. An alternative to running the NAT protocol is to have the network administrator provide each device with its own broadband Ethernet address. Remote Office 9150 units support NAT functionality. Only a single Remote Office 9150 unit may be connected behind a NAT router. Multiple Remote Office 9150 units may be connected behind a PNAT router. A PNAT router is a port number and network address translation router.

For a Remote Office 9150 unit connected behind a NAT router you must:
   - configure a permanent IP signaling connection
   - assign a static IP address

Refer to “Configuring the RLC connection information” on page 198 for the procedure.

To implement the Quality of Service transitioning technology

When the QoS transitioning technology is implemented, calls transition
   - to the PSTN when IP QoS degrades
   - back to the IP network when IP QoS returns to normal
1. To implement the QoS transitioning technology, you must understand what your IP network is doing, such as:
   - when the busy times are on the network
   - how much traffic is processed (during normal and busy traffic periods)
   - how to evaluate and adjust your network’s Quality of Service

For more details, consult with your data network administrator and refer to the Remote Office Network Engineering Guidelines (555-8421-103).

2. Once you have this information and understand it, determine what the QoS settings should be, and then configure them on each RLC port.

For instructions, refer to the Reach Line Card Installation and Administration Guide (NTP 555-8421-210).

3. If IP mode is the last stage in your network implementation, run this stage with a minimal number of users until you are sure that your IP network’s Quality of Service is acceptable.

4. When you are satisfied with QoS transitioning performance, deploy the QoS transitioning capability to the rest of the network.
Planning the configuration

Before you configure the Remote Office 9150 unit, it is strongly recommended that you complete the data entry forms shown in Appendix A, “Planning forms.”

This section describes the information you can configure on the Remote Office 9150 unit.

Data entry form completion sequence

You should complete the data entry forms in the following sequence:

1. Remote Office 9150 Configuration Information—Stations form
2. Remote Office 9150 Configuration Information—ISDN BRI Modules form
3. Remote Office 9150 Configuration Information—Network Connections form
4. Remote Office 9150 Configuration Information—Dialing Plans form

For more details, see Appendix A, “Planning forms.”

Station assignments and configuration

You must assign each telephone in your office to one of the 32 ports provided by the Remote Office 9150 unit. You can configure stations with the ability to make locally controlled calls (local), host-controlled calls (remote), or both (local and remote).

If a station will be configured with the ability to make host-controlled calls, then that station is mapped to a RLC port (which, in turn, is mapped to telephone port configuration on the host PBX).

If a station will be configured with the ability to make locally controlled calls (including station-to-station dialing), you must take the numbering plan on the host PBX into consideration. You need to ensure that when users dial another station in the same office in host-controlled mode, the call routes correctly.
Stations that will be used for locally controlled calls can be further configured with features and their key locations.

ISDN BRI information

Providing information to your service provider
To ensure that you get the correct ISDN service for the Remote Office 9150 unit, tell your service provider how the ISDN line should be provisioned. Request the following:

- two B-channels providing voice and data capability
  Both B-channels must be Circuit Switched Voice and Data.
- Calling Line Identification (CLI) or Caller ID
  CLI provides the caller’s telephone number when you receive a call. This information is provided by the network and not the caller, so it can be used as a security measure to identify calls to be accepted and rejected.
- 64 Kbps clear channel
  Note: A 64 Kbps clear channel is also required on the ISDN PRI connection between the host PBX and the PSTN. A 56 Kbps channel does not provide enough bandwidth to process one call using G.711 compression.

Receiving information from your service provider
In return for providing the ordering information, your service provider gives you directory numbers and, if used in your area, Service Profile Identifiers (SPIDs). SPIDs are not provided for the AT&T 5ESS Custom service.

A directory number is the address or ISDN telephone number for the ISDN line assigned by the service provider. Each ISDN line receives at least one telephone number, called the Primary Directory Number.

If used in your area, your service provider provides you with the SPIDs. These are associated with the service you have ordered, and you must use these as part of the configuration for the Remote Office 9150 unit before any ISDN connections can be made (except for AT&T Custom). The SPID is similar to the ISDN telephone number and its format is unimportant as long as the information is entered correctly when configuring the Remote Office 9150 unit.
IP addresses

If you want to administer the Remote Office 9150 unit over the IP network, the following information is required for the Remote Office 9150 unit:

- IP address (it must be unique)
- subnet mask
- default gateway

If you want to route voice traffic over the IP network, you also need the RLC’s IP address. The Remote Office 9150 unit uses these IP addresses to establish the connection with each other.

Connection between the RLC and Remote Office 9150 unit information

If you want to route voice traffic over the PSTN, the telephone numbers for each end of the network are required. If security is being implemented, the security authentication information (Caller ID or security identifier) is also needed.

Online/offline schedule

You can configure each port on the RLC with a schedule that identifies when a remote site is online (connected to the corporate PBX) or offline. When the Remote Office 9150 unit is in offline mode, calls cannot be made or received through the host PBX over the IP or PSTN.

You can configure only one online/offline schedule for the RLC port. This schedule affects all stations at the Remote Office 9150 site. You should create offline entries

- for times when the connection to the host PBX should not be active, such as during evenings and weekends
- to prevent the Remote Office 9150 unit from staying online permanently, thereby eliminating unwanted ISDN BRI charges

To help you plan the online/offline schedule configuration on the RLC, use the “Reach Line Card Online/Offline Table Configuration” form in the Reach Line Card Installation and Administration Guide (NTP 555-8421-210).
Trunk configuration information

Trunk configuration on the Remote Office 9150 unit consists of defining the ISDN BRI lines from the central office and assigning one or more B-channels, if desired, to trunk groups.

Numbering plan

You must assign a trunk access code to each trunk group at the Remote Office 9150 unit site. A trunk access code is the number that must be dialed to obtain an outgoing trunk. In addition, you must define special prefix (SPRE) codes for the following features if you want to use them:

- paging
- to go online or offline (for more details, see “Online/offline table” on page 46)
- local calling
  This allows analog or ATA-equipped station users to change the outgoing call mode to locally controlled mode. (Host-controlled mode is the default mode when users go offhook on analog or ATA-equipped stations.)
- registration and deregistration
  The registration SPRE code is used to register the station user with a multi-user or dynamic port.
  The deregistration SPRE code disengages the user from the port so that another user can use it. The user is put into not logged in mode.

All trunk access and SPRE codes are automatically defined in Configuration Manager with a pound sign (# in North America) so that there are no conflicts with host PBX dialing plans. The maximum length of each code is three digits in addition to the pound sign. For a list of the default SPRE and trunk access codes, refer to the “Remote Office 9150 Configuration Information—Dialing Plans” form on page 354.

Note: You can change the defaults if you wish.
Chapter 3

Installing the Remote Office 9150 unit

In this chapter

- General safety 92
- Required tools 94
- Unpacking and inspecting the equipment 95
- Removing the Remote Office 9150 unit cover 97
- Installing a trunk interface or DSP application module 100
- Mounting the Remote Office 9150 unit 106
- Connecting the Remote Office 9150 unit 113
- Powering up the Remote Office 9150 unit 119
- Installing the software 122
- Using the Configuration Wizard to perform initial configuration 124
- Testing the network connections 138
General safety

This section describes the general safety guidelines recommended by Nortel Networks. You must follow these safety guidelines whenever you perform installation or maintenance tasks on the Remote Office 9150 unit.

Precautionary messages

This guide provides warnings when risks related to hardware installation and handling are known. For a description of the types of warnings this guide provides, see “Conventions used in this guide” on page xix. Do not ignore these warnings.

Safety precautions

To avoid damage or injury, follow these safety precautions at all times.

Plug the Remote Office 9150 unit into a properly grounded power source to reduce the possibility of electric shock and damage to the unit or network.

---

DANGER

Risk of electric shock

Disconnect the power as well as the Telco 1 and Telco 2 cables before you perform any hardware troubleshooting or add ISDN BRI or DSP application modules to the Remote Office 9150 unit.

If you do not disconnect the Telco 1 and Telco 2 cables from the Remote Office 9150 unit, you can receive a lethal shock if an external telco line is accidentally severed.

Ensure that nothing rests on connection cables, and that cables cannot be tripped over or stepped on.
Electrostatic discharge safety precautions

Electrostatic discharge (ESD) affects the performance and decreases the useful life of system components. ESD can seriously damage component parts, such as circuit cards.

Implement the following precautions, which are recommended by computer and telephone equipment manufacturers:

- Remove items that generate static charge from the installation site.
- Use antistatic spray if the site is carpeted.
- Ground yourself before handling any equipment. (For example, wear an antistatic wrist strap attached to any unpainted metal surface that is connected to an electrical ground.)
Required tools

This section identifies the tools you need to perform Remote Office 9150 unit installation and maintenance tasks.

Hardware installation tools

You need the following tools to install the Remote Office 9150 unit, or to install or replace DSP application or trunk interface modules:

- an antistatic ESD wrist strap (recommended)
- a Phillips (cross-head) screwdriver
- a pen or pencil for
  - noting the installation location (if mounting on a wall)
  - noting cable lengths
  - labeling cables
- cable tie wraps
- cable identification labels
- a tape measure
- four wood screws if you want to mount the Remote Office 9150 unit on the wall

Software installation or upgrade tools

In addition, if you are performing a first-time installation or a maintenance upgrade, you need the following items:

- the Remote Office Product CD-ROM
- a PC with a CD-ROM drive or an Internet connection for obtaining software, firmware, and documentation updates
- a TFTP server application installed on the PC
  The TFTP server is required for performing firmware upgrades. If a TFTP server is currently not installed, you can obtain one from the Internet.
Unpacking and inspecting the equipment

Before you install the Remote Office 9150 unit, ensure that the package contents are all present and are not damaged.

Before you begin

Before you unpack the equipment, ensure that your work area is safe from electrostatic discharge. For more details, see “Electrostatic discharge safety precautions” on page 93.

To inspect the package contents

1. Inspect the box in which the Remote Office 9150 unit was shipped for damage.
2. Open the box and remove its contents.
3. Verify that, in addition to this guide, the following items are present:

<table>
<thead>
<tr>
<th>Check Item</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote Office 9150 unit</td>
</tr>
<tr>
<td>Package containing rubber feet and rack-mounting brackets with screws</td>
</tr>
<tr>
<td>Power cord and power supply</td>
</tr>
<tr>
<td>Note: In North America, the power cord and power supply are included inside the Remote Office 9150 box. In all other regions, the power supply is provided inside the box and the power cord for your region is provided outside the box.</td>
</tr>
<tr>
<td>RS-232 serial cable</td>
</tr>
</tbody>
</table>
Installing the Remote Office 9150 unit

Check Item

☐ Remote Office and RLC Release Notes (NTP 555-8421-102)

☐ Remote Office Product CD-ROM

4 Visually inspect each item for obvious faults or damage.

What to do if damage is found

If any component is damaged, report the damage immediately to your Nortel Networks distributor and the carrier who delivered the equipment.

What's next?

When you have verified that all components are present and are undamaged, do the following:

- Install DSP application and trunk interface modules, if required.
  For instructions, see “Installing a trunk interface or DSP application module” on page 100.

- Install the Remote Office 9150 unit in its chosen location.
  For instructions, see “Mounting the Remote Office 9150 unit” on page 106.
Removing the Remote Office 9150 unit cover

As you increase or change the voice processing capability of the Remote Office 9150 unit, you need to perform one or more of the following tasks:

- Install additional trunk interface modules.
- Install additional DSP application modules.

To perform these tasks, you must remove the Remote Office 9150 unit cover.

To remove the Remote Office 9150 unit cover

**DANGER**

Risk of electric shock

Disconnect the power as well as the Telco 1 and Telco 2 cables before you perform any hardware troubleshooting or add ISDN BRI or DSP application modules to the Remote Office 9150 unit.

If you do not disconnect the Telco 1 and Telco 2 cables from the Remote Office 9150 unit, you can receive a lethal shock if an external telco line is accidentally severed.

1. Use a Phillips screwdriver to remove the following screws from the Remote Office 9150 unit cover:
   - two screws from the sides
   - four screws from the top
   - eight screws from the bottom

See the diagram on page 98.
2 Place the screws in a safe place where they cannot be lost.
3 Ensure the Remote Office 9150 unit is placed top side up.
4 Remove the cover as follows:
   a. Grasp both sides of the Remote Office 9150 unit.
   b. Slide the cover toward you.
   c. Lift the cover off the unit.
   d. Put the cover aside.
5 Turn the Remote Office 9150 unit so the rear panel faces you.
6 This allows you to read the labels on the Remote Office 9150 unit circuit board.
7 Perform module installation as required.
   For instructions, see “To install a trunk interface or DSP application module” on page 103.
8 Replace the cover as described in “To replace the Remote Office 9150 unit cover” below.

To replace the Remote Office 9150 unit cover
1 Carefully slide the top cover into position over the circuit board so that the holes along the top edge of the rear panel are aligned.
2 Replace the four screws on the top.
3 Replace the two screws on the sides.
4 Turn the Remote Office 9150 unit over and replace the eight screws on the bottom.
5 Continue with “Mounting the Remote Office 9150 unit” on page 106.
Installing a trunk interface or DSP application module

The Remote Office 9150 unit ships from Nortel Networks with
- no trunk interface modules installed
- one Digital Signal Processor (DSP) built into the Remote Office 9150 unit’s motherboard

What trunk interface modules do
Trunk interface modules route calls over the PSTN. The number of modules you must install depends on the number of simultaneous calls you want to process in host-controlled or locally controlled mode.

**Note:** To determine how many trunk interface modules you need for your calling requirements, use the “Remote Office 9150 System expansion worksheet” on page 355.

What DSP application modules do
DSP application modules convert voice and fax into digital data for transport over the IP and PSTN.

Initially, the Remote Office 9150 unit ships with the ability to support up to eight simultaneous calls through a DSP that is built into the Remote Office 9150 unit’s motherboard. To add support for up to 32 simultaneous calls, you must install DSP application modules. Up to three DSP application modules are supported. Each module provides up to eight more simultaneous calls.

**Note:** To determine how many DSP application modules you need for your calling requirements, use the “Remote Office 9150 System expansion worksheet” on page 355.
When to install trunk interface or DSP application modules

Perform the procedures in this section when you

- need to expand the Remote Office 9150 unit’s voice processing capability and have ordered additional modules (up to four trunk interface modules or three DSP application modules)
- need to replace a module because it is faulty

Before you begin

Before you can install a trunk interface or DSP application module, you must remove the cover from the Remote Office 9150 unit. For instructions, see “Removing the Remote Office 9150 unit cover” on page 97.

**ATTENTION** DSP application and trunk interface modules are sensitive pieces of electronic equipment and must be handled as such. Ensure that you follow the electrostatic discharge safety precautions described on page 93.

Where the modules can be installed

Each module position is labeled on the Remote Office 9150 unit circuit board as shown in the following table:

<table>
<thead>
<tr>
<th>Module type</th>
<th>Valid module positions</th>
</tr>
</thead>
<tbody>
<tr>
<td>DSP application module</td>
<td>MOD 1</td>
</tr>
<tr>
<td></td>
<td>MOD 2</td>
</tr>
<tr>
<td></td>
<td>MOD 3</td>
</tr>
<tr>
<td>Trunk interface module</td>
<td>Telco 1 connector (phone lines 1 through 16):</td>
</tr>
<tr>
<td></td>
<td>MOD 4</td>
</tr>
<tr>
<td></td>
<td>MOD 5</td>
</tr>
</tbody>
</table>
The following diagram shows where you can install the trunk interface and DSP application modules on the Remote Office 9150 unit circuit board:

Nortel Networks recommends that you populate each module position in sequential order. Install trunk interface modules according to the Telco 1 or Telco 2 connections used.
Note: The Remote Office 9150 unit contains a dongle socket located in the middle of the circuit board. This dongle is not being used.

To remove a trunk interface or DSP application module

Note: Perform this procedure only if you need to replace a trunk interface or DSP application module.

1 Use one hand to firmly grasp the long sides of the module that you want to remove.

2 Gently lift one side of the module up until it is free of the connectors on the Remote Office 9150 unit circuit board.

3 Lift the module up and away from the Remote Office 9150 unit circuit board, and place it to one side.

Note: If you are replacing this module, put it inside the replacement module’s protective wrapper for storage or return it to Nortel Networks for repair.

To install a trunk interface or DSP application module

1 Remove the trunk interface or DSP application module from its protective wrapper.

2 Compare the connectors on the module with the connectors in the location where you want to install the module.

   The connectors are keyed so that you can install the module in one way only. Ensure you hold the module so that the orientation of the connector keys match.

   See “Where the modules can be installed” on page 101, and the diagram on page 104.
3 Align the connectors on the module with the connectors on the Remote Office 9150 unit circuit board.

4 Use both hands to grasp the module firmly and push down until it snaps into place.

5 Visually inspect the module connectors to ensure there is no gap between the module connectors and the Remote Office 9150 motherboard connectors.

6 Ensure the module is securely installed by placing one finger beneath the module and tugging upward. The module should not move.
What’s next?

After you have installed the trunk interface or DSP application modules, replace the Remote Office 9150 unit cover, and then install the unit in its chosen location. For instructions, see the following:

- “To replace the Remote Office 9150 unit cover” on page 99
- “Mounting the Remote Office 9150 unit” on page 106

Module configuration
To associate the ISDN BRI line from your ISDN service provider with a particular trunk interface module, you must configure the trunk interface modules in Configuration Manager.

If you have installed one or more modules as part of your first-time installation, complete the remaining procedures in this chapter. Then, complete configuration as required and described in “Configuring BRI trunks” on page 211.
Mounting the Remote Office 9150 unit

The Remote Office 9150 unit can be installed
- on a desk (see below)
- on a wall (see page 108)
- in a rack (see page 110)

The Remote Office 9150 unit package contains the following hardware:
- rubber feet for installing the Remote Office 9150 unit on a desk
- brackets with screws for installing the Remote Office 9150 unit in a rack

If you want to mount the Remote Office 9150 unit on a wall, you must provide your own mounting hardware.

Choosing a suitable location

The Remote Office 9150 unit dimensions are
- 42.5 cm (17 in.) wide (without rack-mounting brackets)
- 29.4 cm (11.75 in.) deep
- 4.4 cm (1.75 in.) high

For guidelines on where to install the Remote Office 9150 unit, see “Physical environment” on page 56.

Note: It is recommended that you install the Remote Office 9150 unit in the same room where your communications equipment is installed. The Remote Office 9150 unit should be located no further than
- 1230.7 m (4000 ft) from the digital telephones
- 307.7 m (1000 ft) from the analog device
To install the Remote Office 9150 unit on a desk

1. Turn the Remote Office 9150 unit bottom side up.
2. Affix the rubber feet to the Remote Office 9150 unit as shown in the following diagram:

3. Ensure the rubber feet are securely fastened.
4. Place the Remote Office 9150 unit in the desired location.
To install the Remote Office 9150 unit on the wall

Do not affix the rubber feet to the bottom of the Remote Office 9150 unit. Otherwise, the unit cannot be mounted flush against the wall.

To mount the Remote Office 9150 unit on the wall, you must provide your own screws. You need suitable size screws that are long enough to ensure the Remote Office 9150 unit is securely mounted.

When mounting the Remote Office 9150 unit on the wall, you must use standard telephony installation practices. The unit is mounted so that

- the cables are at right angles to the unit
- the rear (connection) panel faces left or right

Ensure that

- the LEDs on the front panel can be viewed easily
- the chosen location provides enough space to accommodate the cables when they are connected to the Remote Office 9150 unit

See the diagram on page 109.
1. Choose the location on the wall where you want to mount the Remote Office 9150 unit.

2. Use the predrilled screw slots on the bottom of the Remote Office 9150 unit as a guide to measure and mark the location on the wall for each mounting screw.

   The measurements between the screw slots are as follows:
   - from front to back panels: 15 cm (6 in.)
   - from side to side: 37.5 cm (15 in.)
Note: Two sets of screw slots are provided. Each set allows you to route the cables to the left or right when the Remote Office 9150 unit is correctly mounted. Ensure you use the same screw slot orientation for each location that you mark on the wall.

3 Mount the screws.

Note: Do not screw the screws all the way in. The heads should be screwed to about 5 mm (1/8 in.) from the wall.

4 Mount the Remote Office 9150 unit on the screws, and then gently pull it down so the screws slide into the narrow portion of the screw slots.

Do not let go yet!

5 Ensure the Remote Office 9150 unit is securely mounted.

WARNING

Risk of personal injury or equipment damage
Ensure the Remote Office 9150 unit is securely fastened to the wall. Otherwise, it can fall, be damaged, and cause injury to yourself or others.

6 When you are satisfied that the Remote Office 9150 unit is securely mounted, continue with “Connecting the Remote Office 9150 unit” on page 113.

To install the Remote Office 9150 unit in a rack

The rack slot chosen for the Remote Office 9150 unit must

- be large enough to provide air circulation to keep the Remote Office 9150 unit cool
- allow you to securely fasten the Remote Office 9150 unit to the rack using the rack-mount brackets
1 Attach the rack-mount brackets as shown in the following illustration.

2 Slide the Remote Office 9150 unit into the rack slot.
3  Secure the Remote Office 9150 unit to the rack with nuts and bolts.

4  When you are satisfied that the Remote Office 9150 unit is securely installed, continue with “Connecting the Remote Office 9150 unit” on page 113.

What’s next?

When you have completed the installation of the Remote Office 9150 unit in its chosen location, attach the cables. For instructions, see “Connecting the Remote Office 9150 unit” on page 113.
Connecting the Remote Office 9150 unit

When you establish the cabling connections, you are connecting the Remote Office 9150 unit to the:

- power source
- telephones and ISDN BRI trunks
  
  **Note:** If you are connecting the Remote Office 9150 unit to a Meridian 1 in-building cross-connect system, you need a QCBIX1A BIX block.

- Ethernet network
- administration PC

Remote Office 9150 ISDN BRI Interface information—
for Norway and Sweden only

EN 60950:1992 Annex ZB, Special National conditions, Clause 6.2.1.2 states that in Norway and Sweden, supplementary insulation for a primary circuit is required between any TNV circuit and any circuit that has a connection to a protective earthing terminal.

The Remote Office 9150 has the ability to support up to a maximum of 4 ISDN BRI connections. To comply with the aforementioned specification for supplemental insulation, an isolation adapter must be placed between each of the 9150 BRI inputs and the BRI lines from the service provider.

Isolation adapters are available from local vendors. Alternatively, you may order this part from Nortel Networks as a merchandise item. The Nortel Networks part number is P0935714.

Cables you must provide

Ensure that you have obtained the telephone and Ethernet cables for your network. These cables are not supplied in the Remote Office 9150 unit package.

The cables must meet the following requirements:
Installing the Remote Office 9150 unit

- telephone cable: One end of the cable must provide a male 50-pin connector. (This end connects to the Remote Office 9150 unit.)
  Ensure the other end of the cable matches the connectors needed to connect to the telephones or trunks. (For example, if you are using a BIX block to establish the telephone connections, the wires inside must be exposed.)

Notes:
- Two telephone cables are required, depending on how many telephones and trunks are installed. (Each telephone cable provides support for up to 16 digital telephones, and two ISDN BRI lines providing two B-channels each. The Telco 1 cable also provides support for one analog station such as a fax machine.)
  Nortel Networks recommends that you use straight-through Amphenol cables instead of side-entry Amphenol cables. (See “Cable attachment” on page 116.)
- Digital telephones should be located no further than 1230.7 meters (4000 feet) from the Remote Office 9150 unit.
- The analog device should be located no further than 307.7 meters (1000 feet) from the Remote Office 9150 unit.
- Ethernet cable
  If you are connecting the Remote Office 9150 unit to a hub, you need a standard CAT5 unshielded twisted-pair (UTP) straight-through Ethernet cable. The cable should be no longer than 100 meters (325 feet) in length.

Connector and pin-out reference

The following table identifies where to find the pin-out table for each connector:

<table>
<thead>
<tr>
<th>Connector</th>
<th>Connection type</th>
<th>For the pin-out table, see</th>
</tr>
</thead>
<tbody>
<tr>
<td>TELCO 1</td>
<td>25 TIP and RING pairs</td>
<td>page 374.</td>
</tr>
<tr>
<td>TELCO 2</td>
<td>25 TIP and RING pairs</td>
<td>page 376.</td>
</tr>
<tr>
<td>ETHERNET</td>
<td>RJ-45</td>
<td>page 378.</td>
</tr>
<tr>
<td>ADMIN</td>
<td>DB-9</td>
<td>page 379.</td>
</tr>
<tr>
<td>Power</td>
<td>DIN</td>
<td>page 380.</td>
</tr>
</tbody>
</table>
More information

The following documents describe how to establish telephone and trunk connections using the Meridian 1 BIX in-building cross-connect system:

- Meridian 1 Installation planning (NTP 553-3001-120)
- Telephone and attendant console installation (NTP 553-3001-215)
- BIX* In-Building Cross-Connect System Material Installation and Servicing (Wall-Mounted System) (NTP 631-4511-200)

Remote Office 9150 unit connection panel

The following diagram shows the connectors on the back panel of the Remote Office 9150 unit.

![Diagram of Remote Office 9150 unit connection panel]

**Note:** The V.35 connector is for future use.

**Note:** If you want to connect the Remote Office 9150 unit to an uninterruptible power supply (UPS), ensure the UPS has a minimum of 100 Watts available.
Cable attachment

Nortel Networks recommends that you use straight-through Amphenol cables instead of side-entry Amphenol cables.

The following diagram shows cable attachment.

**Note:** The Remote Office 9150 Telco 1 and 2 connections provide the opposite gender of that provided by an Meridian 1 IPE or Option 11 cabinet line card slot. Therefore, different cables must be used when connecting to the Remote Office 9150 than cables used to connect to Meridian 1 line cards.
To connect the Remote Office 9150 unit to the network

WARNING
Risk of electric shock or damage to equipment
To reduce the risk of electric shock to yourself or damage to the Remote Office 9150 unit, ensure that the power source to the unit is turned off until the Telco 1 and Telco 2 connections have been completed.

1. Connect the male 50-pin connector of the telephone cable to the TELCO 1 connector on the Remote Office 9150 unit.
   Secure the cable connection by snapping the wire tabs into place or by inserting screws.

2. Refer to the pin-out table in “TELCO 1 connector pin-out table” on page 374 (in Appendix C) for establishing the connections to the telephones and trunks.

3. If you want to route calls over the IP network, or administer the Remote Office 9150 unit from another location on the IP network, connect the Remote Office 9150 unit to the Ethernet network by doing the following:
   a. Connect one end of the RJ-45 Ethernet cable to the ETHERNET connector on the Remote Office 9150 unit.
   b. Connect the other end to an Ethernet hub.

4. Connect the male 50-pin connector of the other telephone cable to the TELCO 2 connector on the Remote Office 9150 unit.
   Secure the cable connection by snapping the wire tabs into place or by inserting screws.

5. Refer to the pin-out table in “TELCO 2 connector pin-out table” on page 376 (in Appendix C) to establish the connections to the telephones and trunks.
6 Connect the ADMIN connector on the Remote Office 9150 unit to the administration PC as follows:
      Note: You may need to provide an RS-232 adapter if the available RS-232 port on your PC does not match the connector on the serial cable.
   b. Connect the other end to an available COM port on the PC.

7 Connect the Remote Office 9150 unit to the power source as follows:
   a. Connect the four-pin plug on the power transformer to the POWER connector on the Remote Office 9150 unit.
      Note: Ensure the arrow on the four-pin plug faces up.
   b. Connect the AC cord to the AC power receptacle on the power transformer.
   c. Plug the AC cord into a 110 V or 220 V uninterruptible power source (UPS) or wall outlet.

8 Proceed with “Powering up the Remote Office 9150 unit” on page 119.
Powering up the Remote Office 9150 unit

As soon as you connect the Remote Office 9150 unit to the power source, the unit begins to power up.

**Note:** If you are connecting a Remote Office 9150 unit to a UPS (uninterruptible power supply), ensure that the UPS has a minimum of 100 Watts available.

What happens during power-up

During power up, the following events occur:

- The Remote Office 9150 unit performs a self-test that verifies all critical functionality.
- An LED test sequence is performed.

**Power-up self-test**

During power-up, the Remote Office 9150 unit performs a self-test that verifies all critical functionality, including:

- RAM memory test
- EPROM checksum validation
- flash checksum validation
- DSP health
- interface loopbacks

The power-up cycle also automatically detects if one or more DSP application or trunk interface modules have been installed. If trunk interface modules have been installed, you can configure them in Configuration Manager.

The power-up cycle takes about 60 seconds to complete.
LED test sequence

The following diagram shows the LEDs on the front panel.

During the power-up cycle, the LEDs behave as follows:

1. All LEDs light for about 15 seconds.
2. The Module LEDs light individually in sequence (1 through 8).
3. All LEDs light.
4. All LEDs except the Status LED go out. The Status LED remains lit.

Note: Steps 2 through 4 take about 4 to 5 seconds.

After this point, the Remote Office 9150 unit is functional.

Notes:

- The ETHERNET TX and RX and module (ISDN BRI) LEDs flash only when transmit and receive activity is present on those interfaces.
- The ETHERNET COLL LED flashes when a data collision occurs on the line.

Note: The V.35 LEDs are for future use.
What's next?

If the power-up cycle completes successfully (indicated by a lit Status LED), your hardware installation is successful. Continue with “Installing the software” on page 122.

If the power-up cycle was not successful (indicated by the Status LED going out), contact your Nortel Networks distributor. There is a possible hardware problem.
Installing the software

You use the Configuration Manager software to configure and administer the Remote Office 9150 unit. This software is located on the CD-ROM provided in the package. You must install the software on the administration PC.

To install the software

1. Insert the CD-ROM in the applicable drive on your PC.
   
   Result: If autorun is enabled on your PC, a Welcome screen appears listing available options.

2. If autorun has started, select the Install option; otherwise, navigate to the software directory, and then locate and double-click setup.exe.

   Result: The InstallShield prepares for installation, and then the Welcome screen appears.
3 Click Next, and then follow the screen prompts.
   Result: Once the software has been installed, messages appear confirming that the Windows registry has been updated and that the installation was successful.

4 Click OK to the next message.
   Result: The Setup Complete screen appears.

Note: You might be prompted to restart your computer. If you are, then click Yes, I want to restart my computer.

5 Click Finish.
   Result: The InstallShield closes.

What’s next?

After you install the software on the administration PC, start Configuration Manager and run the Configuration Wizard. The Configuration Wizard allows you to perform initial configuration quickly and easily.

For instructions, see “Using the Configuration Wizard to perform initial configuration” on page 124.

Note: DLL files installed by the Configuration Manager InstallShield should be left in the Windows system directory. Do not move these files to any other directory.
Using the Configuration Wizard to perform initial configuration

The Configuration Wizard option in Configuration Manager allows you to configure the minimum information needed for establishing communications between the Remote Office 9150 unit and the RLC at the host site. The Configuration Wizard does not provide all the configuration settings that are available in Configuration Manager. By using the Configuration Wizard, the Remote Office 9150 unit can be up and running within 10 minutes.

You can use the Configuration Wizard in offline mode or while connected and logged on to the Remote Office 9150 unit (online mode).

What you can configure with the Configuration Wizard

The Configuration Wizard allows you to configure the following:

- the Remote Office 9150 unit’s IP address, subnet mask, and default gateway
  This information must be valid for your IP network.
  Note: If you will not be using the IP network to route calls, you must still enter this information for administration purposes. If you do not have an IP network in place, you can use the sample information provided in the procedure on page 129.

- for Voice over IP capability: the IP address for the RLC at the host site

- for PSTN capability:
  - the telephone number of the RLC at the host site
  - information provided by your ISDN service provider for each ISDN BRI trunk interface module (telephone numbers, SPIDs, and switch type)

Ensure you have this information ready before you begin.

Note: If, after completing configuration with the Configuration Wizard, you want to modify any settings, you must use Configuration Manager.
To start Configuration Manager

1. Click Start ➝ Programs ➝ Remote Office ➝ Configuration Manager.
   Result: The Configuration Manager opens and you are prompted for the logon name and password.

2. Enter admin into the Login Name box.

3. Enter root into the Password box.
   Note: This is the default password. It might be different.

4. Click on the OK button.
   Result: You are informed if the logon was successful.

5. Click OK.
   Result: The logon status dialog box disappears.
6 Do one of the following:

<table>
<thead>
<tr>
<th>IF you want to</th>
<th>THEN</th>
</tr>
</thead>
<tbody>
<tr>
<td>perform an offline config</td>
<td>do the following:</td>
</tr>
<tr>
<td></td>
<td>a Choose View → Device Type → 9150.</td>
</tr>
<tr>
<td></td>
<td>b Continue with “To perform configuration with the Configuration Wizard” on page 129.</td>
</tr>
<tr>
<td>perform an online config</td>
<td>continue with “To establish a serial connection” below.</td>
</tr>
</tbody>
</table>

**To establish a serial connection**

**Note:** If you want to perform an offline configuration, ignore this procedure. Go to “To perform configuration with the Configuration Wizard” on page 129.

1 From the menu, choose Connect → Login board → Serial.

Result: The Serial Port Configuration dialog box appears.
2 Enter the COM port to which the Remote Office 9150 unit is connected, and then click OK.

Result: The User Authentication for Serial Mode dialog box appears.

3 Type guest for the logon name.

4 Type guest123 for the password.

Note: This is the default password. It might be different if it was changed.

5 Click OK.

Result: The connection attempt is initiated. Trying to Connect via Serial Port <port number> might appear.

IF the logon attempt failed THEN

the following message appears:
SERIAL CONNECTION FAILED
Check the serial connection and ensure it is good. Then, go back to step 1.
IF the logon attempt succeeded

THEN

the User Logged In dialog box appears.

Click OK.

Result: The following dialog box appears:

The following messages appear above the progress bar at the bottom of the dialog box:

- Reading Hardware Information
- Reading DSP Load Data
- Reading Configuration Data

These messages mean that Configuration Manager is obtaining the unit's configuration information from flash memory.

When initialization completes, click on the Close button.

6 Continue with “To perform configuration with the Configuration Wizard.”
To perform configuration with the Configuration Wizard

**Note:** The screen examples in this procedure use information from the sample network diagram in “Example of a network” on page 360.

1. Choose Configuration Wizard from the menu.
   
   **Result:** The following screen appears:

   ![Configuration Wizard Screen]

   This wizard will guide you through the minimum Remote Office configuration required to start using the Remote Office System. While the wizard includes only a sub-set of the options available, most users will find that it covers all of the settings needed for their system. For users with more specific requirements, the Configuration Manager provides access to all user-settable parameters. This Wizard is intended to be used in the offline mode of operation.

2. After reviewing the message, click Next.
   
   **Result:** The following screen appears:
3 Verify that the Currently Logged in Device box shows 9150, then click Next. If it does not show 9150, then select 9150 from the list box.

Result: The Local Unit Configuration screen appears.

Note: A completed example is shown on page 131.

4 Complete the fields on this screen as described in the following table:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set the unique Unit ID of the unit</td>
<td>Enter the number from 1–255 that uniquely identifies the Remote Office 9150 unit you are configuring for a particular RLC. Note: Each unit connected to a RLC must be given a unique unit ID. This implies that Remote Office 9150 units that connect to different RLCs in the network can have the same unit ID.</td>
</tr>
<tr>
<td>Enter a node name that identifies the unit</td>
<td>Enter a name that uniquely identifies the Remote Office 9150 unit you are configuring.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter the local IP Address of the unit</td>
<td>Enter the IP address assigned to the Remote Office 9150 unit. Note: If you do not have a valid IP address, type the sample IP address: 10.1.1.2.</td>
</tr>
<tr>
<td>Enter the Local IP Mask of the unit</td>
<td>Enter the subnet mask. Note: If you do not have a valid subnet mask, type the sample subnet mask: 255.255.0.0.</td>
</tr>
</tbody>
</table>
| Enter the Local IP Gateway of the unit     | Enter the IP address of the gateway between the Remote Office 9150 unit and the network. Note: If there is no router between the Remote Office 9150 unit and the network, then the administration PC acts as the gateway. Type 10.1.1.10.  
  - as the IP address on the administration PC  
  - as the gateway on the Remote Office 9150 unit |

The following is a completed example:

![Local Unit Configuration](image)

The IP information allows you to administer the Remote Office 9150 unit from any location on the network.
5  Click Next.

   Result: The Set the Configuration for the Remote Unit screen appears.

   Note: A completed example is shown on page 133.

6  Complete the fields on this screen as described in the following table:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set the Unit ID of the RLC to connect to</td>
<td>Enter the RLC's unit ID.</td>
</tr>
</tbody>
</table>
| Wish to Enable IP Voice Connection to Remote| ▪ Accept Yes if the IP network will be used to route calls. Then, enter the IP address of the RLC to which this Remote Office 9150 unit is connected.  
   ▪ Click No if the IP network will not be used. The IP Address boxes are dimmed. |
| Wish to Enable PSTN Connection to Remote    | ▪ Accept Yes if the PSTN will be used to route calls. Then, enter the telephone number that must be dialed to connect to the RLC.  
   The telephone number can include the following digits or characters: 0 through 9, #, *, comma (,), period (.), and dash (-).  
   ▪ Caller ID separator: “.” (period)  
   ▪ Caller ID separator and 1/2 second delay: “,” (comma)  
   ▪ null separator: “-” (dash)  
   ▪ Click No if the PSTN will not be used. The PSTN Number box is dimmed. |
September 2001 Installing the Remote Office 9150 unit

Field | Description
--- | ---
Wish to configure Multiple 9150 Ports | 
- Click Yes if you want to assign Remote Office 9150 ports to digital telephones now. Then, do the following:
  - Enter the first RLC port number to assign.
  - Note: Nortel Networks recommends that ports be configured so that the RLC port number matches the Remote Office 9150 unit’s port number.
  - Enter the number of telephones connected to the Remote Office 9150 unit.
  - Click No if you want to complete port assignment at a later time with Configuration Manager.

The following is a completed example:

Click Yes to allow voice calls over IP, then enter the RLC’s IP address.

Click Yes to allow voice calls over the PSTN, then enter the RLC’s phone number.

Click Yes to automatically assign Remote Office 9150 unit ports to RLC ports, then enter the information as described previously.

7 Click Next.

Result: The Enter the BRI module data screen appears.

Note: A completed example is shown on page 135.
8. Complete the fields on this screen as described in the following table:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Which module would you wish to configure</td>
<td>Click the number identifying the trunk interface module that you are configuring. The number you select must match the position where the module has been installed in the Remote Office 9150 unit.</td>
</tr>
<tr>
<td>Module Status</td>
<td>This box identifies if a module has been physically installed on the Remote Office 9150 unit.</td>
</tr>
<tr>
<td>Select the Switch Type</td>
<td>Select the type of switch used by your ISDN service provider.</td>
</tr>
<tr>
<td>Select the ISDN Line Type</td>
<td>Select the ISDN variant used in your country.</td>
</tr>
<tr>
<td>Enter the PSTN Number (B channel 1 and B channel 2)</td>
<td>Enter the telephone number provided by your ISDN service provider for this B-channel.</td>
</tr>
<tr>
<td>Enter the SPID Number (B channel 1 and B channel 2)</td>
<td>Enter the Service Profile Identifier (SPID) provided by your ISDN service provider for this B-channel.</td>
</tr>
<tr>
<td>B Channel Usage (B channel 1 and B channel 2)</td>
<td>Select one of the following connection types:</td>
</tr>
<tr>
<td></td>
<td>- Local: This trunk is used for local PSTN calls only.</td>
</tr>
<tr>
<td></td>
<td>- Remote: This trunk is used only for calls to and from the host PBX.</td>
</tr>
<tr>
<td></td>
<td>- Local &amp; Remote: This trunk can route both types of calls.</td>
</tr>
</tbody>
</table>
The following is a completed example.

Select the module you want to configure.

Specify the ISDN line and switch type. (Get this information from your service provider.)

Enter the DN and SPID for each B-channel. Then, specify whether the B-channel will be used to process locally controlled calls, host-controlled calls, or both.

9 Repeat step 8 for each ISDN BRI module you want to configure.

10 Click Next.

Result: The following screen appears:
11 Do the following:

<table>
<thead>
<tr>
<th>IF you are performing an offline configuration</th>
<th>THEN</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Click Save to File.</td>
<td></td>
</tr>
<tr>
<td>Result: You are prompted to specify the directory path and file name for the configuration file.</td>
<td></td>
</tr>
<tr>
<td>2 Specify the directory path and file name for this configuration.</td>
<td></td>
</tr>
<tr>
<td>Note: The file name is automatically defaulted with the name you entered as the node name.</td>
<td></td>
</tr>
<tr>
<td>3 Ensure the Files of type box shows Text File (*.TXT).</td>
<td></td>
</tr>
<tr>
<td>4 Click Save to complete the Save to File.</td>
<td></td>
</tr>
<tr>
<td>Result: The file is saved, and then you are asked if you want to configure another board. If you do, click Yes, and continue with step 3 on page 130.</td>
<td></td>
</tr>
<tr>
<td>The information in this file can be opened in Configuration Manager, and then sent to and saved in the Remote Office 9150 unit’s flash memory at another time. For instructions, refer to “Working with configuration files” on page 163.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>online configuration</th>
<th>1 Click Save to Flash.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Result: The information entered is written to the flash memory of the Remote Office 9150 unit you are configuring.</td>
<td></td>
</tr>
<tr>
<td>If successful, the following message appears:</td>
<td></td>
</tr>
<tr>
<td>Data Sent Successfully</td>
<td></td>
</tr>
<tr>
<td>Note: Nortel Networks recommends that you also save the configuration to a file.</td>
<td></td>
</tr>
<tr>
<td>2 Restart the Remote Office 9150 unit.</td>
<td></td>
</tr>
</tbody>
</table>
What's next?

Now that you have configured the minimum information required for network connectivity, you can do the following:

- Test the network connections. For instructions, see “Testing the network connections” on page 138.
- Perform additional configuration, if needed. For instructions, see Chapter 5, “Configuring the Remote Office 9150 unit.”
Testing the network connections

After you have installed the hardware and performed initial configuration, verify that network connectivity is present by performing the tests described in this section.

To verify IP network connectivity using PING

To test the Ethernet connection between the administration PC and the Remote Office 9150 unit, you can use PING. To do this test, the Remote Office 9150 unit and the administration PC must be physically connected to the IP network.

1. From the menu in Configuration Manager, choose Tests ➜ Ping.
   Result: The PING Test dialog box appears.

2. Enter the IP Address of the unit you want to ping.

3. In the Number of Cycles box, enter the number of times you want to ping the unit.
   The number must be in the range of 1–100.

4. Click OK.
   Result: The PING test results screen appears, showing the ping results.
The following is an example of a successful ping:

![Successful Ping Example](image1.png)

The following is an example of an unsuccessful ping:

![Unsuccessful Ping Example](image2.png)

5 Click Close.

Result: The Ping test screen closes.
What to do if the ping did not work

1. Use Configuration Manager to ensure you have entered the IP address, subnet mask, and default gateway correctly.
   Note: For instructions, see “To enter the IP addresses” on page 196.
2. Ping the gateway to see if it responds.
3. If the ping still does not work, contact your data network administrator.

To verify the telephone network connectivity

1. Look at the digital telephone display.
   Does it display the correct time and date? If yes, then the connection paths between the digital telephone, Remote Office 9150 unit, and the RLC are working.
2. Lift the telephone handset, or press the host call appearance key to go off hook.
   Did you receive a dial tone? If yes, then the connection path between the Remote Office 9150 unit and the RLC is working.
3. Initiate an outgoing call through the host PBX.
   Did the call proceed as expected? If yes, then the connection path between the Remote Office 9150 unit and the RLC is working.
4. Press the local call appearance key to go off hook.
   Did you receive a dial tone? If yes, then the connection path between the Remote Office 9150 unit and the digital telephone is working.
5. Initiate an outgoing call through the PSTN.
   Did the call proceed as expected? If yes, then the ISDN BRI lines to the PSTN are working.

What to do if the telephone connection tests do not work

1. Ensure the Remote Office 9150 unit completed its power-up cycle successfully. If it did, the Status LED remains lit.
2. Verify the connections between the telephone network and the Remote Office 9150 unit.
3 Ensure that the placement of ISDN BRI modules within the Remote Office 9150 unit correspond with the Telco 1 and Telco 2 cable connections.  
   Note: Refer to the Telco 1 and Telco 2 cable pin-out tables in Appendix C, “Connection pin-out tables.”

4 Use Configuration Manager to verify that the following configuration is correct on the Remote Office 9150 unit, as appropriate:
   - IP addresses (Remote Office 9150 unit, subnet mask, and default gateway, as well as the RLC’s IP address, if the IP network is being used to route calls)
   - the telephone number used to establish connections to the RLC, if the PSTN is being used to route calls
   - the security IDs of both the Remote Office 9150 unit and the RLC, if a security ID is required to authenticate connection attempts
   - DNs and SPIDs assigned to the ISDN BRI modules installed in the Remote Office 9150 unit
   - station configuration, to ensure that the telephone you are using has the calling capabilities needed to complete the tests (that is, verify that the station is correctly configured as local only, remote only, or both local and remote)
   
   Note: For instructions on using Configuration Manager, see Chapter 5, “Configuring the Remote Office 9150 unit.”

5 Work with the administrator at the host PBX site to ensure that
   - the RLC is enabled and working in its PBX slot (restart the RLC, if necessary)
   - the configuration of the IP address, telephone number, and security ID on the RLC port are correct (if these items are used)

6 Verify that both the telecom and data networks are routing voice calls as expected (that is, calls are not being blocked in any way).

What to do if nothing works

If you cannot get the system to work, contact your Nortel Networks distributor for assistance.
What's next?

Once you have confirmed that the Remote Office 9150 unit can be recognized on the network, you can fine-tune the configuration. Nortel Networks recommends that you also change the passwords used for logging on to the Configuration Manager and the Remote Office 9150 unit.

<table>
<thead>
<tr>
<th>For</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>a description of Configuration Manager</td>
<td>Chapter 4, “Configuration Manager overview.”</td>
</tr>
<tr>
<td>instructions on how to modify the configuration</td>
<td>Chapter 5, “Configuring the Remote Office 9150 unit.”</td>
</tr>
<tr>
<td>instructions on how to change passwords</td>
<td>“Changing the administration password” on page 260.</td>
</tr>
</tbody>
</table>
Chapter 4
Configuration Manager overview

In this chapter
Starting Configuration Manager 144
Configuration Manager description 147
Using the online Help 155
Configuration files description 156
Working with configuration files 163
Selecting the device type for offline configuration 167
Logging on to a unit 169
Logging off from a unit 176
Performing a system restart or shutdown 177
Closing Configuration Manager 180
Starting Configuration Manager

To perform administrative tasks, you must first start the Configuration Manager software.

To start Configuration Manager

1. Click Start ➔ Programs ➔ Remote Office ➔ Configuration Manager.

   Result: The Configuration Manager opens and you are prompted for the logon name and password.
2 Type admin in the Login Name box.

3 Type root in the Password box.
   Note: This is the default password. It might be different.

4 Click OK.
   Result: You are informed if the logon was successful.

5 Click OK.
   Result: The Login Name dialog box disappears.

6 Proceed as follows:

<table>
<thead>
<tr>
<th>To perform an</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>online configuration</td>
<td>“Logging on to a unit” on page 169.</td>
</tr>
<tr>
<td>offline configuration</td>
<td>“Selecting the device type for offline configuration” on page 167.</td>
</tr>
</tbody>
</table>

7 To view the system tree, click the plus sign beside Configuration Manager in the left pane.
   Result: Based on the system type you are working with, the system tree expands, showing you the types of configuration you can work with. An example is shown on page 146.
Note: When you first logon to Configuration Manager, the default system tree shows RLC configuration sheets.
Configuration Manager description

This section describes each part of the Configuration Manager screens.

Parts of the Configuration Manager screen

The Configuration Manager is divided into three parts— a menu and two panes.

- The menu across the top of the screen lists various administrative tasks you can perform. These tasks are common to all Remote Office units.
- The pane on the left lists the property sheets you can work with. In this guide, the left pane is called the system tree.
- The pane on the right displays the screen associated with an item you selected from the system tree. In this guide, the right pane is called the property sheet.

Menu

The menu across the top of the screen provides access to system display and reporting options.

When you click an option on the menu, a drop-down list appears. When you select an option from the drop-down list, the screen associated with that option appears.

Note: Options that appear dimmed cannot be used for the unit you are working with, or if you are working offline (that is, when you are not logged on to any unit).
How this guide presents instructions for selecting menu options

To simplify the instructions for selecting options from the menu, this guide abbreviates the selection path. For example, if a procedure requires you to choose Over IP from the Remote Connectivity menu, which is under the Tests menu, this guide uses the following style:

From the menu, choose Tests → Remote Connectivity → Over IP.

System tree

The left pane of the Configuration Manager lists property sheets you can work with. To view a list of all the property sheets associated with a system, click the plus sign to expand the list. (To hide the list, click the minus sign.)

The following example shows an expanded system tree for the Remote Office 9150 unit:

![System Tree Example]

You can hide the system tree. To do this, choose View → Tree Bar. The screen redisplay, showing only the property sheet pane.

To display the system tree again, choose View → Tree Bar.

Property sheets

When you are logged on to a particular system (that is, a Remote Office 9150 unit, a Remote Office 911x series unit, or RLC), and you click an item in the system tree, the associated property sheet appears in the right pane. For instructions on selecting a device type when not logged on, see “Selecting the device type for offline configuration” on page 167.
The following is an example of the property sheet associated with the 9150 System Configuration system tree option:

![Property Sheet Example](image)

How this guide presents instructions for displaying property sheets
To simplify the procedures for accessing property sheets throughout this guide, the instructions for displaying a particular property sheet are summarized into a “Getting there” statement.

The procedure for displaying the screen you need depends on whether you are
- performing an online configuration (that is, you are connected to a unit by serial port or Telnet)
- performing an offline configuration (that is, you are not connected to a unit)
- working with the system tree visible
Example

Getting there  9150 → Configuration Manager → IP Configuration

The following is the long instruction for this example:

1  Do the following:

   IF you are performing an offline configuration THEN select the 9150 device type as described in “Selecting the device type for offline configuration” on page 167.

   online configuration connect to, and then log on to the Remote Office 9150 unit as described in “Logging on to a unit” on page 169.

2  Navigate to the IP Configuration screen as follows:

   IF the system tree is visible THEN do the following:
   a  Click the plus sign beside Configuration Manager to expand the system tree.
   b  Click IP Configuration.

   hidden from the menu, choose Display ➜ IP Configuration.

Result: The IP Configuration property sheet appears in the right pane.

Drop down list boxes

Boxes that provide a limited list of values are called *drop down list boxes*. To view the values available for a list box, click the down arrow for that list box. To select an item from the list, move the cursor until the desired item is highlighted, and then click the item. The item you select appears in the list box.
In some cases, selecting a particular list item causes the property sheet contents to change as follows:

- Some fields appear dimmed (disabled) because they cannot be configured in the context of the list item you selected.
- Other fields are re-enabled (no longer appear dimmed).
- One or more values on the property sheet are replaced with values that are specific to the item you selected.

Check boxes

Fields that contain a blank box beside them are called check boxes. These check boxes are used to enable or disable the feature associated with that field. To enable the feature, click the check box. A check mark appears. When you click the check box again, the check mark disappears (thereby disabling the feature).

Option buttons

Some fields can have two or more options from which to select. The options contain a circle beside them, which are called option buttons. For these fields, only one option can be selected.

To enable an option, click the button for the option you need. If the option you selected is a change, the button for the previously selected option is cleared.

In some cases, selecting a particular option button causes the property sheet contents to change as follows:

- Some fields appear dimmed (disabled) because they cannot be configured in the context of the option you selected.
Other fields are re-enabled (no longer appear dimmed).

One or more values on the property sheet are replaced with values that are specific to the option you selected.

Scroll boxes

Boxes that contain data with up and down arrows beside them are called scroll boxes. When you click the data, and then the up arrow, the selected data increases in value. When you click the down arrow, the selected data decreases in value.

You can also change the data by manually entering it. To do so, highlight the data you want to change, and then type over it.

The following screen is an example of a scroll box:

![Scroll Box Example]

Scroll bars

If your monitor’s display settings are configured so that not all the information can be displayed at once, horizontal and vertical scroll bars might appear in Configuration Manager. Some fields and buttons might be hidden. An example is shown on the next page.

The Configuration Manager software application is best viewed when your monitor settings are configured as 1024 by 768 pixels using Small Fonts at 96 dpi. This ensures that all fields and buttons are visible.

For instructions on changing your display settings, refer to the Windows online Help on your PC.
The following command buttons appear on all property sheets:

- **OK**
  OK accepts any changes you make and stores them in a temporary file on your PC until you are ready to update the unit’s flash memory. For more details, see “OK” on page 159.

- **Default**
  Default replaces the values displayed on the property sheet with default values.

- **Send**
  Send updates to the buffer of the unit to which you are logged on with any changes you have made to the configuration. For more details, see “Send” on page 160.
**Retrieve**
Retrieve downloads the unit’s configuration from flash memory and displays it in Configuration Manager on your PC. For more details, see “Retrieve” on page 160.

**Help**
Help displays online Help for the property sheet you are working with. For other methods of displaying Help, see “Using the online Help” on page 155.

**Note:** If the command buttons are not visible, use the vertical scroll bar to scroll through the screen.
Using the online Help

While using Configuration Manager, you might have questions about what certain boxes and buttons do, as well as how to complete certain tasks. Online Help provides brief answers to such questions.

To access Help

1 Use one of the following methods:
   - Method 1: Click Help on the property sheet for which you need help.
   - Method 2: From the Help menu, choose Help → Help Topics.
   - Method 3: Click ? in the toolbar.
   - Method 4: Press F1 on the keyboard.

2 If you selected methods 2, 3, or 4, go to one of the following tabs, based on how you want to search for a topic:
   - To see a list of Help topics, click the Contents tab.
   - To look up a subject alphabetically, click the Index tab.
   - To do a full-text search to find topics that contain the words you enter, click the Find tab.
Configuration files description

This section describes configuration files and the ways in which you can work with them.

Configuration Manager: File operations diagram

The following diagram shows how configuration information is stored. A detailed description of each file type and operation follows.
Types of files

There are four types of files that you can work with in Configuration Manager. Each file is identified by one of the following file name extensions as described in the following table:

<table>
<thead>
<tr>
<th>File name</th>
<th>File type</th>
<th>When it is created and used</th>
</tr>
</thead>
</table>
| EVENT.DAT | Log file  | This file records all activities (and messages associated with those activities) that you perform while running Configuration Manager, such as:
- logging on to Configuration Manager
- logging on to a unit (by serial or Telnet connection)
- logging off from the unit
- performing configuration changes
- performing firmware upgrades

This file can be very useful when performing troubleshooting for system problems. If you need technical support, you might be asked to provide this file.

Note: Information is appended to this file each time you start a new Configuration Manager session.

|      |   | The text file is created when you do one of the following:
|      |   | - Click Save to File while running the Configuration Wizard.
|      |   | - Click File ➔ Save As while working in Configuration Manager.
|      |   | - Choose Upload/Download ➔ Download Configuration to save a unit’s configuration in a text file on the administration PC. |
To view or make changes to the text file (while in online or offline mode), do one of the following to open the file:

- Click Open while running the Configuration Wizard.
- Click File ➝ Open while running Configuration Manager.
- Choose Upload/Download ➝ Upload Configuration to load the configuration file to the unit’s buffer.

For more details about these tasks, see
- “Working with configuration files” on page 163
- “Performing backups and restores” on page 265.

**Note:** You can view or edit the contents of the text file by opening it in a word processing application, such as WordPad.

<table>
<thead>
<tr>
<th>File name (continued)</th>
<th>File type</th>
<th>When it is created and used</th>
</tr>
</thead>
<tbody>
<tr>
<td>*.txt</td>
<td>Text</td>
<td>To view or make changes to the text file (while in online or offline mode), do one of the following to open the file:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Click Open while running the Configuration Wizard.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Click File ➝ Open while running Configuration Manager.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Choose Upload/Download ➝ Upload Configuration to load the configuration file to the unit’s buffer.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For more details about these tasks, see</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- “Working with configuration files” on page 163</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- “Performing backups and restores” on page 265.</td>
</tr>
</tbody>
</table>

**Note:** You can view or edit the contents of the text file by opening it in a word processing application, such as WordPad.

| *.UPG     | Upgrade | Use this file type when performing firmware upgrades. For more details, see “Performing upgrades” on page 309. |
Configuration Manager: File operations description

The following table describes each operation shown in the previous diagram:

<table>
<thead>
<tr>
<th>Operation</th>
<th>Description</th>
</tr>
</thead>
</table>
| OK         | When you click OK, the following occurs:  
  - The changes you make are checked for errors. If errors are found, an error dialog box appears. Make the necessary changes, and then click OK again.  
  - The changes you make are stored in the event.dat file on your PC. For more information about the event.dat file, see “Types of files” on page 157.  
  To update the flash memory of the unit to which you are logged on, you must click Send, and then perform a Save to Flash. For more details, see “Send” on page 160.  
  Note: If you do not click OK on a property sheet before displaying another property sheet, all changes made on the property sheet are lost and must be reentered. |
| File ➔ Open | When you choose File ➔ Open from the Configuration Manager menu, you can open a previously saved configuration file. This is useful for preparing and storing configuration files in a central location before they are deployed to the network.  
  Note: To open a file, the file type must be text (.txt). |
| File ➔ Save As | When you choose File ➔ Save As from the Configuration Manager menu, the unit’s configuration is saved to a configuration file on your PC. You specify the file name and directory location.  
  After you save the file, you can open and modify the file at another time.  
  Notes:  
  - The file is saved as a text (.txt) file.  
  - If you close Configuration Manager without performing a File ➔ Save As, all changes you made are lost. |
### Operation Description

<table>
<thead>
<tr>
<th>Operation</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Send**     | When you click Send on the current property sheet, any changes you make to this property sheet are sent to the buffer on the unit to which you are connected. If the send is successful, Data Sent Successfully appears.  
**Note:** You must perform a Save to Flash from the Upload/Download Menu to save the changes in the unit’s flash memory. For more details, see Save to Flash below. |
| **Send All** | When you choose Upload/Download ➔ Send All on any property sheet, changes for all property sheets are sent to the buffer on the unit to which you are connected. If the send is successful, Data Sent Successfully appears.  
**Note:** You must perform a Save to Flash from the Upload/Download Menu to save the changes in the unit’s flash memory. For more details, see Save to Flash below. |
| **Retrieve** | When you click Retrieve on a property sheet, the configuration stored on the unit to which you are connected appears in Configuration Manager.  
If the retrieve is successful, Data Received Successfully appears. |
| **Save to Flash** | When you choose Upload/Download ➔ Save to Flash, the information stored in the unit’s buffer is saved to flash memory. This prevents the configuration from being lost if a power loss occurs on the unit.  
While in progress, Save to Flash in Progress appears in the status bar at the bottom of the screen. When the save to flash is completed, the Data Stored to Flash dialog box appears.  
**Note:** You must perform a Send or Send All before you perform a Save to Flash. You should perform a Save to Flash as often as required. |
When you choose Upload/Download ➔ Upload Configuration from the Configuration Manager menu, the configuration file you specify is uploaded and written to the buffer on the unit to which you are connected.

Use this option if you need to restore or replace an entire configuration.

You must perform a Save to Flash from the Upload/Download Menu to save the changes in the unit’s flash memory. If you do not perform a Save to Flash and a power loss occurs on the unit, the changes are lost.

While in progress, Save to Flash in Progress appears in the status bar at the bottom of the screen.

When the Save to Flash is completed, the Data Stored to Flash dialog box appears.

Notes:

- To upload a configuration file, the file type must be text (.txt).
- To perform a configuration upload over the IP network, a TFTP server application must be running on your PC. Uploads over the serial port are not supported.
- The upload operation does not affect the event.dat file on the PC.
- The new configuration does not take effect until you restart the unit. For instructions on how to restart the unit, see “Performing a system restart or shutdown” on page 177.

### Table: Operation Description

<table>
<thead>
<tr>
<th>Operation</th>
<th>Description</th>
</tr>
</thead>
</table>
| Upload Configuration | When you choose Upload/Download ➔ Upload Configuration from the Configuration Manager menu, the configuration file you specify is uploaded and written to the buffer on the unit to which you are connected. Use this option if you need to restore or replace an entire configuration. You must perform a Save to Flash from the Upload/Download Menu to save the changes in the unit’s flash memory. If you do not perform a Save to Flash and a power loss occurs on the unit, the changes are lost. While in progress, Save to Flash in Progress appears in the status bar at the bottom of the screen. When the Save to Flash is completed, the Data Stored to Flash dialog box appears. Notes:  
  - To upload a configuration file, the file type must be text (.txt).  
  - To perform a configuration upload over the IP network, a TFTP server application must be running on your PC. Uploads over the serial port are not supported.  
  - The upload operation does not affect the event.dat file on the PC.  
  - The new configuration does not take effect until you restart the unit. For instructions on how to restart the unit, see “Performing a system restart or shutdown” on page 177. |
When you choose Upload/Download ➔ Download Configuration from the Configuration Manager menu, the configuration stored on the unit to which you are connected is saved to a file on the PC.

Use this option if you want to create a backup of the unit’s configuration.

**Notes:**
- The downloaded file is saved as a text file (.txt).
- The download operation does not affect the event.dat file on the PC. Therefore, if you make changes and do not save them, they are lost.
Working with configuration files

This section explains how to
- create a configuration file (see page 164)
- open a configuration file in Configuration Manager (see page 165)
- perform a configuration upload (see page 166)
- perform a configuration download (see page 166)

When to use the Configuration Manager file operations

<table>
<thead>
<tr>
<th>You can use</th>
<th>When you are</th>
</tr>
</thead>
<tbody>
<tr>
<td>OK, File ➔ Open,</td>
<td>working in offline mode</td>
</tr>
<tr>
<td>File ➔ Save As</td>
<td>or</td>
</tr>
<tr>
<td></td>
<td>connected and logged on to a unit.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> When working in offline mode, you must save</td>
</tr>
<tr>
<td></td>
<td>the configuration to a file. However, when you are</td>
</tr>
<tr>
<td></td>
<td>connected and logged on to a unit, the file save</td>
</tr>
<tr>
<td></td>
<td>operation is optional when you use Send or Send All</td>
</tr>
<tr>
<td></td>
<td>to update the unit’s flash memory.</td>
</tr>
<tr>
<td></td>
<td>one of the following:</td>
</tr>
<tr>
<td></td>
<td>- Send</td>
</tr>
<tr>
<td></td>
<td>- Send All</td>
</tr>
<tr>
<td></td>
<td>- Retrieve</td>
</tr>
<tr>
<td></td>
<td>- Upload</td>
</tr>
<tr>
<td></td>
<td>- Download</td>
</tr>
<tr>
<td></td>
<td>- Configuration</td>
</tr>
<tr>
<td></td>
<td>- Configuration</td>
</tr>
<tr>
<td></td>
<td>connected and logged on to a unit.</td>
</tr>
</tbody>
</table>
To create a configuration file on the PC

1. Start Configuration Manager.
2. Make the required changes on each property sheet.
   
   Note: You do not have to be logged on to a unit to make configuration changes. When you are not logged on to a unit, you are performing an offline configuration.
3. From the menu, choose File → Save As.
   
   Result: The Save As dialog box appears.
   
   ![Save As dialog box](image)

   4. Enter a descriptive name for the file.
      
      It should identify the type of configuration it contains.

      Example 1: If the file contains basic configuration that will be used for all similar-type units, you can type template as the file name.

      Example 2: If the file contains configuration that is unique to a specific unit, enter the unit’s name or number as the file name.

   5. Ensure the Save as type box shows Text Files (*.TXT).

   6. Specify the folder where the file is to be saved.
To open a configuration file

1. Start Configuration Manager.
2. If you want to work in online mode, log on to the unit. Otherwise, ensure that you have selected the device type.
3. From the menu, choose File → Open. 
   Result: The Open dialog box appears.

   ![Open dialog box](image)

4. Ensure the Files of type box shows Text Files(*.TXT).
5. Navigate to the folder containing the file you need.
6. Select the file, and then click Open.  
   Result: The contents of the configuration file are loaded into Configuration Manager.
7. View the configuration details by clicking each item in the system tree to display the associated property sheet.
8 Make changes as necessary, and then do one of the following:
   a. Save the file.
   b. Click Send to update the unit, and then perform a Save to Flash.

To upload a configuration to a unit

   For instructions, see “Restoring the configuration” on page 268.

To download a configuration from a unit

   For instructions, see “Creating a backup configuration file” on page 266.
Selecting the device type for offline configuration

If you are not logged on to a particular system (that is, an RLC, a Remote Office 911x series system, or a Remote Office 9150 system), you must select the type of device with which you want to work.

When you select the device type, it causes the Configuration Manager application to automatically reorganize the system tree with the screens associated with that device type.

To select the device type

1. Start Configuration Manager as described in “Starting Configuration Manager” on page 144.

2. Do the following:

<table>
<thead>
<tr>
<th>To view the system tree for</th>
<th>Do the following</th>
</tr>
</thead>
<tbody>
<tr>
<td>the RLC</td>
<td>Choose View → Device Type → RLC.</td>
</tr>
<tr>
<td>the Remote Office 9150 unit</td>
<td>Choose View → Device Type → 9150.</td>
</tr>
</tbody>
</table>

3. Click the plus sign beside Configuration Manager in the left pane.

Result: The system tree expands, showing you the types of configuration you can work with, as shown in the example on page 168.
System tree
Logging on to a unit

If you want to update the flash memory on a unit as you make configuration changes, or view statistics and logs, you must log on to the unit. Each unit has its own administration ID and password.

You can log on to the unit by using one of the following connection methods:

- Telnet (over the IP network)
- serial port

**Connection types**

If the RLC or Remote Office 9150 unit is connected to the administration PC by the RS-232 cable, you can establish a connection through the serial port.

If Ethernet connectivity has been established between the administration PC and the RLC or Remote Office 9150 unit, you can establish an IP connection with Telnet.

**Connection history**

The Configuration Manager maintains a history of past unit connections. You can select and then connect to a unit from the history list that appears in the Connect menu.

**Note:** The connection history list is deleted each time you upgrade the Configuration Manager software.

**Default logon ID and password**

The default logon ID is **guest**. It cannot be changed.

The default password is **guest123**. The password can be different if it was changed.
Auto logoff

If the connection has remained active with no activity for 15 minutes or more, you are automatically logged off and the Session Timed Out message appears. This helps to secure the configuration in the event that you walk away from the administration PC while logged on to a unit.

To log on to a unit using the connection history

1. From the menu, choose Connect ➔ IP address of the unit to which you want to log on.
   
   Result: The User Authentication for Telnet Mode dialog box appears.

   ![User Authentication for Telnet Mode dialog box](image)

2. Enter your logon name and password, and then click OK.
   
   Result: The connection attempt is initiated. **Trying to Connect to <IP address>** message might appear.

   **IF** the logon attempt **THEN**

   failed
   
   the following message appears:

   10060 TELNET CONNECTION FAILED
   
   Go back to step 1.
IF the logon attempt succeeded THEN the User Logged In dialog box appears. Click OK.

Result: The following dialog box appears:

The following messages appear above the progress bar at the bottom of the dialog box:

- Reading Hardware Information
- Reading DSP Load Data
- Reading Configuration Data

These messages mean that Configuration Manager is obtaining the unit’s configuration information from flash memory.

When initialization completes, click on the Close button.
To log on to a unit using Telnet

**Note:** If someone else is already logged on to the unit, you cannot log on.

1. From the menu, choose Connect ➔ Logon Unit ➔ Telnet.
   Result: The Telnet Configuration dialog box appears.

   ![Telnet Configuration dialog box](image)

2. Enter the IP Address of the unit to which you want to connect and click OK.
   Result: The User Authentication for Telnet Mode dialog box appears.

   ![User Authentication for Telnet Mode dialog box](image)

3. Enter your logon name and password, and then click OK.
   Result: The connection attempt is initiated. The message **Trying to Connect to <IP address>** message might appear.

   **IF the logon attempt failed**
   **THEN**
   
   1. The following message appears:
   2. 10060 TELNET CONNECTION FAILED
   3. Go back to step 1.
IF the logon attempt succeeded then the User Logged In dialog box appears. Click OK.

Result: The following dialog box appears:

![Startup Information]

The following messages appear above the progress bar at the bottom of the dialog box:
- Reading Hardware Information
- Reading DSP Load Data
- Reading Configuration Data

These messages mean that Configuration Manager is obtaining the unit’s configuration information from flash memory.

When initialization completes, click on the Close button.
To log on to a unit using the serial port

1. From the menu, choose Connect → Logon Unit → Serial.
   Result: The Serial Port Configuration dialog box appears.

   ![Serial Port Configuration dialog box](image1.png)

2. Enter the COM port number to which the unit is connected, and then click OK.
   Result: The User Authentication for Serial Mode dialog box appears.

   ![User Authentication for Serial Mode dialog box](image2.png)

3. Enter your logon name and password, and then click OK.
   Result: The connection attempt is initiated. The message Trying to Connect via Serial Port <port number> might appear.

   IF the logon attempt failed THEN the following message appears:
   SERIAL CONNECTION FAILED
   Check the serial port connection and ensure it is good. Then, go back to step 1.
To access property sheets associated with the unit

1. Click the plus sign beside Configuration Manager.
   Result: This expands the system tree.

2. Click the name of the property sheet with which you want to work.
   Result: The property sheet appears in the right pane.
Logging off from a unit

When you are finished using Configuration Manager to make configuration changes, or to view logs and statistics, you should log off from the unit. Logging off secures the unit’s configuration.

To log off from the unit

1. From the menu, choose Connect ➔ Logoff Unit.
   Result: The Log off dialog box appears.

2. Click Yes.
   Result: The following dialog box appears:

3. Click OK.
Performing a system restart or shutdown

Configuration Manager allows you to perform a controlled system restart or shutdown.

When to perform a restart

You must perform a system restart each time you change the configuration or upgrade the firmware.

When to perform a shutdown

You must perform a system shutdown when
- you want to install DSP application or trunk interface modules
- you need to power down the system for any reason

To perform a system restart

1. From the menu, choose Connect → System Reset → Restart.

   Result: The System Restart dialog box appears.

   ! This will restart your system. Are you Sure?

   ![System Restart dialog box]

2. Click Yes.
Result: The following status dialog box appears:

![Restarting the system. Please wait...](image)

The following message also appears in the status bar at the bottom of the screen:

**Restarting the System**

The status continues to show Online. When the system restart is completed, the following dialog box appears to inform you that the system restart was successful and that you were logged off:

![Configuration Manager](image)

3. Click OK.

Result: You are prompted to log back on using the previous connection method (Serial or Telnet).

**To perform a system shutdown**

**ATTENTION** Do not perform this procedure if you do not have physical access to the unit. To recover from the system shutdown, you must power the unit off, and then power it back on.

1. Choose Connect ➔ System Reset ➔ Shutdown.

Result: The System Shutdown dialog box appears.
2 Click Yes.

Result: Your logon session is disconnected, and the following message appears in the status bar at the bottom of the screen:

Shutting Down the System

The status shows Offline.

3 Turn the power off.

Note: You must turn the power off before you can power the unit back up.
Configuration Manager overview  

**Closing Configuration Manager**

When you have completed all the configuration modifications you want to make, or are done viewing unit logs and statistics, close the Configuration Manager application. This secures the configuration, preventing others from accessing it if you walk away from the administration PC while logged on to a unit.

**To close Configuration Manager**

**CAUTION**

Risk of configuration loss

If you close Configuration Manager without saving the changes you made to a file on your PC, or without updating the flash memory of the unit you were working on, all changes are lost. You must reenter any changes you made.

1. Ensure that you have saved all configuration changes by doing one or more of the following:
   - From the menu, choose File ➔ Save As, and then specify the name for the configuration file. The file is saved on the administration PC hard disk.
   - Update the flash memory of the unit to which you are connected by doing one of the following:
     - Click Send on any property sheet, and then choose Upload/Download ➔ Save to Flash.
     - Click Send All on any property sheet, and then choose Upload/Download ➔ Save to Flash.
   - If you have saved the changes to a file, choose Upload/Download ➔ Upload Configuration. For instructions, see “Restoring the configuration” on page 268.
2 Log off by choosing Connect ➔ Logoff Unit.
3 From the menu, choose File ➔ Exit.
   Result: The Configuration Manager closes.
Uninstalling the Configuration Manager software

If you need to remove the Configuration Manager software from your administration PC, do the following:

1. Click Start > Settings > Control Panel.
2. Double-click Add/Remove Programs.
3. Select Remote Office from the list, and then click Add/Remove.

Result: The following dialog box appears:

![Confirmation dialog box](image)

4. Click Yes.

Result: The Uninstall Shield begins the uninstall and displays the progress. When the uninstall is completed, the screen appears as follows:

![Uninstall shield](image)
Chapter 5

Configuring the Remote Office 9150 unit

In this chapter

Configuring the system settings 184
Configuring International Tones 190
Configuring the Remote Office 9150 unit’s IP interface 195
Configuring the RLC connection information 198
Configuring the PSTN connection number 202
Configuring the security level 204
Configuring trunks and trunk groups 208
Configuring stations 219
Configuring a fax station 231
Configuring DSP resources 235
Configuring the system settings

This section describes the settings that apply to the system rather than to the RLC port or Remote Office 9150 trunks or stations.

Getting there  9150 → Configuration Manager → 9150 System Configuration

System Configuration sheet

```
<p>| | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>SYSTEM CONFIGURATION</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Unit ID</td>
<td>1</td>
<td>Node Name</td>
<td>9150</td>
</tr>
<tr>
<td>DSP Gain</td>
<td>0</td>
<td></td>
<td>0</td>
</tr>
<tr>
<td>Time Offset</td>
<td>0</td>
<td></td>
<td>0</td>
</tr>
<tr>
<td>Emergency Activation Code</td>
<td>911</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SPRE Codes</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Online</td>
<td>0</td>
<td>Paging</td>
<td>0</td>
</tr>
<tr>
<td>Offline</td>
<td>0</td>
<td>Local Calling</td>
<td>0</td>
</tr>
<tr>
<td>Trunk Support</td>
<td>54K</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Companding Algorithm</td>
<td>Automatic</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>OK</td>
<td>Default</td>
<td>Send</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Retrieve</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Help</td>
</tr>
</tbody>
</table>
```
To configure the Remote Office 9150 system settings

1. Complete the fields as described in “9150 System Configuration field descriptions” on page 186.
2. Click OK to save the information in the temporary work file.
3. To update the Remote Office 9150 unit with the new information, click Send.

| IF you are logged on to the Remote Office 9150 unit | THEN the changes are written into the Remote Office 9150 unit’s buffer. To save the changes in flash memory, choose Upload/Download ➔ Save to Flash. |
| IF you are not logged on to the Remote Office 9150 unit | THEN the Connection not Established dialog box appears: Do one of the following:  
  - Log on to the Remote Office 9150 unit, and then click Send again.  
  - Save the changes to a file on your administration PC. |
### 9150 System Configuration field descriptions

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unit ID</td>
<td>Enter a unique number between 1 and 255 to identify this Remote Office 9150 unit. This number must be different from:</td>
</tr>
<tr>
<td></td>
<td>- the number assigned to the RLC where this Remote Office 9150 unit connects</td>
</tr>
<tr>
<td></td>
<td>- the numbers assigned to other remote units connected to the same RLC</td>
</tr>
<tr>
<td>Node Name</td>
<td>Enter your site name.</td>
</tr>
<tr>
<td></td>
<td>The node name uniquely identifies this Remote Office 9150 site in the RLC network.</td>
</tr>
<tr>
<td>Time Offset</td>
<td>Click the up or down arrows to change the time zone difference between this Remote Office 9150 unit and the RLC.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Time Offset is in 15-minute intervals to a maximum of, plus or minus, 24 hours.</td>
</tr>
<tr>
<td>Emergency Activation Code</td>
<td>If you are using the PSTN to route calls, then enter the number your community dials to reach an emergency service.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Only enter the Emergency Activation Code (for example, 911 in North America). Do not include the trunk access code because the Emergency Activation code dials out directly on the PSTN.</td>
</tr>
<tr>
<td></td>
<td>If you are using only the IP network to route calls, leave this field blank.</td>
</tr>
</tbody>
</table>
### SPRE Codes: Online

Enter the SPRE code that is used to put your site into online mode, or accept the default. The default is #99.

**Note:** The SPRE code is automatically prefixed with the pound sign (# in North America). This means users must dial # before the SPRE code when going into online mode.

Maximum length: 3 digits in addition to the pound sign.

Refer to “Online/offline table” on page 46 for more information.

### SPRE Codes: Paging

Enter the SPRE code that is used to announce pages to other stations in your office, or accept the default code. The default is #05.

**Note:** The SPRE code is automatically prefixed with a pound sign (#). This means users must dial # before the SPRE code when initiating a page.

Maximum length: 3 digits in addition to the pound sign.

### SPRE Codes: Registration

Enter the SPRE code that allows a multi-user or port-sharing participant to begin a session, or accept the default code. The default is #97.

**Note:** The SPRE code is automatically prefixed with a pound sign (#). This means users must dial # before the SPRE code when registering for a port.

Maximum length: 3 digits in addition to the pound sign.

### SPRE Codes: Offline

Enter the SPRE code that is used to put your site into offline mode, or accept the default code. The default is #98.

**Note:** The SPRE code is automatically prefixed with the pound sign (# in North America). This means users must dial # before the SPRE code when going into offline mode.

Maximum length: 3 digits in addition to the pound sign.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SPRE Codes: Online</td>
<td>Enter the SPRE code that is used to put your site into online mode, or accept the default. The default is #99. <strong>Note:</strong> The SPRE code is automatically prefixed with the pound sign (# in North America). This means users must dial # before the SPRE code when going into online mode. Maximum length: 3 digits in addition to the pound sign. Refer to “Online/offline table” on page 46 for more information.</td>
</tr>
<tr>
<td>SPRE Codes: Paging</td>
<td>Enter the SPRE code that is used to announce pages to other stations in your office, or accept the default code. The default is #05. <strong>Note:</strong> The SPRE code is automatically prefixed with a pound sign (#). This means users must dial # before the SPRE code when initiating a page. Maximum length: 3 digits in addition to the pound sign.</td>
</tr>
<tr>
<td>SPRE Codes: Registration</td>
<td>Enter the SPRE code that allows a multi-user or port-sharing participant to begin a session, or accept the default code. The default is #97. <strong>Note:</strong> The SPRE code is automatically prefixed with a pound sign (#). This means users must dial # before the SPRE code when registering for a port. Maximum length: 3 digits in addition to the pound sign.</td>
</tr>
<tr>
<td>SPRE Codes: Offline</td>
<td>Enter the SPRE code that is used to put your site into offline mode, or accept the default code. The default is #98. <strong>Note:</strong> The SPRE code is automatically prefixed with the pound sign (# in North America). This means users must dial # before the SPRE code when going into offline mode. Maximum length: 3 digits in addition to the pound sign.</td>
</tr>
</tbody>
</table>
Configuring the Remote Office 9150 unit  Standard 2.0

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SPRE Codes: Local Calling</td>
<td>Enter the SPRE code that allows analog or ATA-equipped station users to change the outgoing call mode to locally controlled mode. The default is #8.</td>
</tr>
<tr>
<td>Note:</td>
<td>The SPRE code is automatically prefixed with a pound sign (#). This means users must dial # before the SPRE code when initiating a local call on an analog or ATA-equipped station.</td>
</tr>
<tr>
<td>Maximum length: 3 digits in addition to the pound sign</td>
<td></td>
</tr>
<tr>
<td>SPRE Codes: DeRegistration</td>
<td>Enter the SPRE code that will allow a multi-user or port sharing participant to end a session, or accept the default code. The default is #96.</td>
</tr>
<tr>
<td>Note:</td>
<td>The SPRE code is automatically prefixed with a pound sign (#). This means users must dial # before the SPRE code when disengaging from a port.</td>
</tr>
<tr>
<td>Maximum length: 3 digits in addition to the pound sign</td>
<td></td>
</tr>
<tr>
<td>Trunk support</td>
<td>Choose 56K if you know that your Remote Office 9150 unit is in a PSTN network that can only transport at 56K. Choose 64K if you know that your Remote Office 9150 unit is in a PSTN network that supports speeds that vary from 64K to 56K. The Remote Office system dynamically adapts and downgrades a call to 56K if 64K is not available.</td>
</tr>
</tbody>
</table>
### Local SwitchOver
Select Enable to automatically route through the Remote Office 9150 unit, the voice path for local station-to-station calls that are made on the host call appearance key. The signaling data is routed through the host PBX. However, the voice path is routed through the Remote Office 9150 unit to:
- prevent tromboning between the RLC and Remote Office 9150 unit
- save connection bandwidth
Select Disable to route the voice path through the PBX. Note: You must enable the DN Discovery feature in order for the Local SwitchOver feature to work. Refer to the *Reach Line Card Installation and Administration Guide* (NTP 555-8421-210) to enable DN Discovery.

### Companding Algorithm
Select the companding algorithm for the Remote Office 9150 unit.
Valid options are: Mu-law, A-law, Automatic
Note: A-law is standard for Europe and most areas outside of North America. Mu-law is standard for Japan and North America.

### Multiple Subscriber Number
Choose Enable if the Central Office has given a separate DN number to each B-channel.
Choose Disable if the Central Office has given a separate DN number to each B-channel.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Local SwitchOver           | Select Enable to automatically route through the Remote Office 9150 unit, the voice path for local station-to-station calls that are made on the host call appearance key. The signaling data is routed through the host PBX. However, the voice path is routed through the Remote Office 9150 unit to: prevent tromboning between the RLC and Remote Office 9150 unit
|                             | Select Disable to route the voice path through the PBX. Note: You must enable the DN Discovery feature in order for the Local SwitchOver feature to work. Refer to the *Reach Line Card Installation and Administration Guide* (NTP 555-8421-210) to enable DN Discovery. |
| Companding Algorithm       | Select the companding algorithm for the Remote Office 9150 unit. Valid options are: Mu-law, A-law, Automatic Note: A-law is standard for Europe and most areas outside of North America. Mu-law is standard for Japan and North America. |
| Multiple Subscriber Number | Choose Enable if the Central Office has given a separate DN number to each B-channel. Choose Disable if the Central Office has given a separate DN number to each B-channel. |
Configuring International Tones

The Tone Code field on the International Tones Support dialog box specifies the frequency and levels for the NT8D17 TDS card.

When configuring International Tones, consider the following:

- International Tone configuration uses NT8D17 card Tone Codes. These codes are valid for all countries and Option11/IPE Controller cards.

- To configure the four international tones, you need to obtain the following FTC values for DIAL, RGBK, BUSY and OVFL from LD 56 of your PBX:

```plaintext
>ld 56
REQ prt
TYPE FTC
...
DIAL
XTON 129
XCAD 000
RGBK
XTON 132
XCAD 32
BUSY
XTON 130
XCAD 30
OVFL
XTON 130
XCAD 0
```

Look for the DIAL, RGBK, BUSY and OVFL values

Enter the XTON value as the “Tone Code” value for this tone

XCAD is used below to determine the Repeat, No. of Cycles and Cadence Time
In the following example there are three different values for XCAD. Collect the LD 56 WCAD details for each different XCAD value.

>ld 56
REQ prt
TYPE FCAD
WCAD 0   for XCAD 0
CDNC 00000 00000 00000 00000 00000 00000 00000 00000 00000 00000
END OFF
WTON NO

REQ prt
WCAD 30
CDNC 100 50 00000 ...
END REPT
CYCS 1
WTON NO

REQ prt
WCAD 32
CDNC 102 102 205 819 00000 ...
END REPT
CYCS 1 2
WTON NO

Note the values printed for CDNC, END, and CYCS.

If END = REPT, then the value entered into the End Repeat field is “Repeat”. CYCS usually has “1” or “1 2”. Enter the largest number as the No. of Cycles. Enter the non-zero CDNC values into the Cadence Time fields.
Getting there  9150 → Configuration Manager → 9150 System Configuration

International Tones Support property sheet

To configure International Tones

1. Click on the International Tones button in the System Configuration sheet.
2. Complete the fields as described in “International Tone field descriptions” on page 193.
3. Click OK to save the information in the temporary work file.
## International Tone field descriptions

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Tone Type** | Enter the Tone Type for your country. Valid options are: Dial, RGBK, BUSY, OVFL. 
  Dial: dial tone signifies that the telephone is ready to receive dialed digits. 
  RGBK: ringback signifies that the dialed line is ringing. 
  Busy: busy signal signifies that the dialed line is not ready to receive calls. 
  Ovfl: overflow (congestion) tone signifies that there are no channels available. |
| **End Repeat**| Select Off if you want the tone type you selected to be a constant tone. 
  Select Repeat if you want the selected tone type to have on and off phases. 
  **Note:** If you chose End Repeat: Off, then the No of Cycles and Cadence Time fields are dimmed. |
| **Tone Code** | Enter the four letter LD 56 Tone Codes that you want this Remote Office 9150 unit to use for the tone type you selected. |
| **No of Cycles** | Enter the number of cycles that you want in the tone type you selected. 
  Two boxes in the Cadence Time field become active for each cycle you request. 
  Valid options are: 1, 2, 3, 4 |
| **Cadence Time** | Enter the length, in milliseconds, of the phases of the cadence that you want to configure for the tone type you selected. 
  Refer to the X11 Administration Guide (NTP 553-3001-311) for more information. |
**Note:** Refer to the Configuration Manager Help file for more information about International Tones.
Configuring the Remote Office 9150 unit’s IP interface

This section explains how to enter the IP address, subnet mask, and default gateway for the Remote Office 9150 unit.

Differentiated Services (DiffServ)

This setting modifies the IP Header and is applicable across the entire WAN. If enabled, this feature allows the Remote Office 9150 unit to set the DiffServ code-point to Nortel Network’s standards for Voice over IP: EF ( Expedited Forwarding).

802.1p

This setting inserts an additional tag at the Media Access Control (MAC) layer of IEEE 802.3 and therefore ends at the first router. Refer to RFC 2474.

Getting there  9150 → Configuration Manager → IP Configuration
To enter the IP addresses

1. Enter the IP address assigned to the Remote Office 9150 unit into the IP Address boxes.
2. Enter the subnet mask into the IP Network Mask boxes.
3. Enter the IP address of the network gateway into the IP Gateway boxes.
4. To enable DiffServ, click on the **Enable** option button in the DiffServ CodePoint field.
5. To enable 802.1p mapping, click on the **Enable** button in the 802.1p Mapping field.
6. Click OK to save the information in the temporary work file.
7 To update the Remote Office 9150 unit with the new information, click Send.

<table>
<thead>
<tr>
<th>IF you are</th>
<th>THEN</th>
</tr>
</thead>
<tbody>
<tr>
<td>logged on to the Remote Office 9150 unit</td>
<td>the changes are written into the Remote Office 9150 unit’s buffer.</td>
</tr>
<tr>
<td></td>
<td>To save the changes in flash memory, choose Upload/Download → Save to Flash.</td>
</tr>
<tr>
<td>not logged on to the Remote Office 9150 unit</td>
<td>The Connection not Established dialog box appears.</td>
</tr>
<tr>
<td></td>
<td>Do one of the following:</td>
</tr>
<tr>
<td></td>
<td>■ Log on to the Remote Office 9150 unit, and then click Send again.</td>
</tr>
<tr>
<td></td>
<td>■ Save the changes to a file on your administration PC.</td>
</tr>
</tbody>
</table>

8 Restart the Remote Office 9150 unit.

Note: For instructions on how to restart the Remote Office 9150 unit, see “Performing a system restart or shutdown” on page 177.
Configuring the RLC connection information

This section describes how to configure information needed by the Remote Office 9150 unit to establish connections with the RLC on the host PBX.

Getting there  9150 ➔ Configuration Manager ➔ RLC Connection Configuration

RLC Connection Configuration sheet
To configure the RLC connection information

1. Complete the fields as described in “RLC Connection Configuration field descriptions” on page 200.

2. Click OK to save the information in the temporary work file.

3. To update the Remote Office 9150 unit with the new information, click Send.

<table>
<thead>
<tr>
<th>IF you are</th>
<th>THEN</th>
</tr>
</thead>
<tbody>
<tr>
<td>logged on to the Remote Office 9150 unit</td>
<td>the changes are written into the Remote Office 9150 unit’s buffer.</td>
</tr>
<tr>
<td></td>
<td>To save the changes in flash memory, choose Upload/Download ➔ Save to Flash.</td>
</tr>
<tr>
<td>not logged on to the Remote Office 9150 unit</td>
<td>The Connection not Established dialog box appears.</td>
</tr>
<tr>
<td></td>
<td>Do one of the following:</td>
</tr>
<tr>
<td></td>
<td>- Log on to the Remote Office 9150 unit, and then click Send again.</td>
</tr>
<tr>
<td></td>
<td>- Save the changes to a file on your administration PC.</td>
</tr>
</tbody>
</table>
## RLC Connection Configuration field descriptions

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Unit ID**     | Enter the number (between 1 and 255) assigned to the RLC to which this Remote Office 9150 unit is connected. The RLC’s unit ID must be different from  
|                 | - this Remote Office 9150 unit’s ID  
|                 | - the IDs of other units that are also connected to the RLC  
|                 | **Note:** This Unit ID must be entered on the Remote Connection Configuration property sheet on the RLC to create the communication path between this Remote Office 9150 unit and the RLC. |
| **IP Connection** | Select Enable if you want to route calls over your IP network.  
|                 | Select Disable if you do not want to route calls over your IP network. |
| **IP Address**  | Enter the RLC’s IP address. The Remote Office 9150 unit will use this IP address to connect to the RLC over the IP network. |
| **IP Signaling** | Select Enable if you want to set the IP signaling connection to permanent mode on the Remote Office 9150 unit.  
|                 | Refer to “Deployment options” on page 82 for more information. |
| **PSTN Connection** | Select Enable if you want to route calls over the PSTN.  
|                 | Select Disable if you do not want to route calls over the PSTN. |
### Block Incoming Local Call on Primary B Channel

Select Enable if incoming local calls *should not* be received on the first B-channel.
Select Disable if the first B-channel *should* receive incoming local calls.
Configuring the PSTN connection number

The PSTN number corresponds to the dedicated network port on the RLC for your Remote Office 9150 unit. The PSTN number to connect to the RLC must be configured in a specific manner. If you select Caller ID as the security level, then the PSTN number that you enter for the Remote Office 9150 unit to connect to the RLC is compared with the telephone number configured on the RLC for your site. If the two numbers do not match, the call is dropped.

**Note:** Enter the PSTN number to connect to RLC exactly as it must be dialed by the Remote Office 9150 unit, including 1 for long distance and 9 for Centrex trunk access.

**Getting there** 9150 → Configuration Manager → RLC Connection Configuration

**RLC Connection Configuration sheet**
To configure the PSTN number

1. Enable the PSTN Connection option.
2. Enter the telephone that the Remote Office 9150 unit will dial to connect to the RLC in the PSTN Number to Connect to RLC field.
3. Click OK to save the information in the temporary work file.
4. To update the Remote Office 9150 unit with the new information, click Send.

<table>
<thead>
<tr>
<th>IF you are</th>
<th>THEN</th>
</tr>
</thead>
<tbody>
<tr>
<td>logged on to the Remote Office 9150 unit</td>
<td>the changes are written into the Remote Office 9150 unit's buffer. To save the changes in flash memory, choose Upload/Download → Save to Flash.</td>
</tr>
</tbody>
</table>
| not logged on to the Remote Office 9150 unit | The Connection not Established dialog box appears. Do one of the following:  
  - Log on to the Remote Office 9150 unit, and then click Send again.  
  - Save the changes to a file on your administration PC. |
Configuring the security level

It is recommended that you implement a security authentication method on both the RLC and the Remote Office 9150 unit to prevent toll fraud.

The security level defines what type of security authentication is used between the Remote Office 9150 unit and the host PBX. The information used to perform security authentication depends on the security level chosen. There are three levels of security:

- No security (default setting)
- Caller ID
- Provision ID

For a detailed description of these security levels refer to “System security” on page 30.

Getting there  9150 → Configuration Manager → RLC Connection Configuration
To configure the security level

1. Select one of the following security level settings from the Security Level list box:
   - No Security
   - Caller ID
   - Provision ID
2 If you selected Caller ID or Provision ID security levels, do one of the following:

<table>
<thead>
<tr>
<th>IF you selected</th>
<th>THEN</th>
</tr>
</thead>
<tbody>
<tr>
<td>Caller ID</td>
<td>click CallerID.</td>
</tr>
</tbody>
</table>

Result: The List of Caller IDs dialog box appears.

In the Caller ID box, enter the telephone number from which the Remote Office 9150 unit can accept calls. Ensure that the telephone number you enter matches the Caller ID actually presented by the RLC. Click OK, and then click Add from the pop-up menu that appears.

Result: The telephone number appears in the blank box.
<table>
<thead>
<tr>
<th>IF you selected</th>
<th>THEN</th>
</tr>
</thead>
<tbody>
<tr>
<td>Provision ID</td>
<td>the Security ID fields are enabled.</td>
</tr>
<tr>
<td></td>
<td>Do the following:</td>
</tr>
<tr>
<td></td>
<td>■ Enter the RLC’s security identifier (must be a 10 digit password) in the Inbound Security ID field.</td>
</tr>
<tr>
<td></td>
<td>■ Enter the Remote Office 9150 unit’s security identifier (must be a 10 digit password) in the Outbound Security ID field.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> You must configure the same security identifiers in reverse on the RLC port to which this Remote Office 9150 unit is assigned.</td>
</tr>
</tbody>
</table>

3 Click OK to save the information in the temporary work file.

4 To update the Remote Office 9150 unit with the new information, click Send.

<table>
<thead>
<tr>
<th>IF you are</th>
<th>THEN</th>
</tr>
</thead>
<tbody>
<tr>
<td>logged on to the Remote Office 9150 unit</td>
<td>the changes are written into the Remote Office 9150 unit’s buffer.</td>
</tr>
<tr>
<td></td>
<td>To save the changes in flash memory, choose Upload/Download ➝ Save to Flash.</td>
</tr>
<tr>
<td>not logged on to the Remote Office 9150 unit</td>
<td>The Connection not Established dialog box appears.</td>
</tr>
<tr>
<td></td>
<td>Do one of the following:</td>
</tr>
<tr>
<td></td>
<td>■ Log on to the Remote Office 9150 unit, and then click Send again.</td>
</tr>
<tr>
<td></td>
<td>■ Save the changes to a file on your administration PC.</td>
</tr>
</tbody>
</table>
Configuring trunks and trunk groups

This section explains how to configure your trunks to connect with the RLC at the host site, or to make calls through the local PSTN. The procedure to configure BRI trunks can be found on page 211. The procedure to configure trunk groups can be found on page 215.

Trunks

A trunk is the straight connection between the PSTN and the Remote Office 9150 unit. Each ISDN BRI line (up to four are supported by the Remote Office 9150 unit) provides two B-channels. In Remote Office 9150 unit context, each B-channel equals one trunk.

Each B-channel can be defined as a local trunk, remote trunk, or both.

**Note**: Remote Office 9150 units support MSN. If each B-channel has a unique DN then the configuration of the first B-channel defines both b-channels.

Local trunk
The trunk is used to make local calls over the PSTN.

Remote trunk
A remote trunk is used to establish a connection to the RLC from the Remote Office 9150 unit.

Local and remote trunk
A B-channel that is defined as both local and remote can be used to make calls through both the local PSTN, as well as through the RLC on the host PBX.

Primary trunk on the Remote Office 9150 unit
The primary trunk on the Remote Office 9150 unit is one of the following:

- the lowest-numbered B-channel defined as Remote only
- the lowest-numbered B-channel defined as Local and Remote
Since a local call can cause blocking of an incoming host-controlled call on a B-channel defined as Local and Remote, or prevent QoS transitions from occurring, Nortel Networks recommends that you configure the primary trunk as Remote only. For example, Module 4 first B-channel.

Do not include the primary trunk in any trunk groups.

Trunk groups

A trunk group consists of one or more B-channels that are logically grouped. You can configure up to eight trunk groups. For example, you can configure

- each B-channel as a different trunk group
- two or more B-channels as a trunk group

A B-channel can be a member of more than one trunk group.

Trunk access codes

Trunk access codes are numbers that are used by the Remote Office 9150 unit to determine which trunk group to use when routing the call. You must define a trunk access code for each trunk group.

For example, you can assign trunk access codes #61 and #62, as shown below:

<table>
<thead>
<tr>
<th>Group 1</th>
<th>Group 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trunk 1</td>
<td>Trunk 3</td>
</tr>
<tr>
<td>Trunk 2</td>
<td>Trunk 4</td>
</tr>
<tr>
<td>Trunk access code: #61</td>
<td>Trunk access code: #62</td>
</tr>
</tbody>
</table>

If a user dials trunk access code #61, the call is routed (or processed) using trunks 1 or 2. If trunks 1 and 2 are both busy, the user’s call is blocked (the user receives a fast busy signal).

Note: All trunk access codes are automatically defined in Configuration Manager with a pound prefix (# in North America) so that there are no conflicts with host PBX dialing plans. Trunk access codes must be between one and three digits in length in addition to the pound sign.
For a list of the default trunk access codes, refer to the “Remote Office 9150 Configuration Information—Dialing Plans on page 354.

ISDN configuration
In order to configure European ISDN, the PSTN must support the following features:

- Multiple Subscriber Numbering (MSN)
- Two directory numbers (one per B channel)

The default configuration setting for BRI SPIDs is NC (Not Configured). Ensure that no supplemental ISDN services, (for example, Call Waiting) are provided as this may disrupt the data path and drop calls.

European ISDN
When configuring EuroISDN and ETSI variants, the BRI Configuration SPIDs must be set to NC (not configured).

To change EuroISDN SPID values, complete the following procedure:

1. Go to Configuration Manager > 9150 > BRI Configuration.
2. Click on the Default button.
3. Configure the DNs, SPIDs, and ISDN line type.

Note: Only A-Law configuration is fully supported with ETSI configurations.

National ISDN
If you select National ISDN as the line type, there are minor protocol differences between National ISDN -1, -2, -3, and -4. The Proprietary Switch line type is more general and should be used if problems are encountered.
Configuring BRI trunks

This topic shows you how to configure the BRI trunks. See “Configuring trunks and trunk groups” on page 208 for a detailed explanation of BRI configuration settings.

Getting there  9150 ➔ Configuration Manager ➔ BRI Configuration

BRI Configuration sheet
To enter the BRI settings

1. Complete the fields as described in “BRI Configuration field descriptions” on page 213.
2. Click OK to save the information in the temporary work file.
3. To update the Remote Office 9150 unit with the new information, click Send.

<table>
<thead>
<tr>
<th>IF you are</th>
<th>THEN</th>
</tr>
</thead>
<tbody>
<tr>
<td>logged on to the</td>
<td>the changes are written into the Remote</td>
</tr>
<tr>
<td>Remote Office 9150</td>
<td>Office 9150 unit’s buffer.</td>
</tr>
<tr>
<td>unit</td>
<td>To save the changes in flash memory, choose Upload/Download → Save to Flash.</td>
</tr>
<tr>
<td>not logged on to the</td>
<td>The Connection not Established dialog box appears.</td>
</tr>
<tr>
<td>Remote Office 9150</td>
<td>Do one of the following:</td>
</tr>
<tr>
<td>unit</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## BRI Configuration field descriptions

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Module #**                               | Select the number identifying the trunk interface module that you are configuring.  
**Note:** The number you select must match the module position where the module has been installed.  
Valid options: 4 through 7 |
| **ISDN Line Type**                         | Select the ISDN variant used in your country.  
Get this information from your ISDN service provider. |
| **Switch Type**                            | Select the type of switch used by your ISDN service provider for this trunk.  
Get this information from your ISDN service provider. |
| **Status (B channel 1 and B channel 2)**   | Select Enable to activate the ISDN BRI channel.  
Select Disable to deactivate it. |
| **Type (B channel 1 and B channel 2)**     | Select the type of connection—local, remote, or local and remote.  
- Local: This trunk is used for local PSTN calls only.  
- Remote: This trunk creates a circuit-switched connection path to the host PBX.  
- Local & Remote: This trunk can route local PSTN calls and host PBX calls.  
**Note:** If you select Local or Local & Remote, then the Allocation field is enabled. |
### PSTN Number (B channel 1 and B channel 2)

Enter the full telephone number provided to you by your ISDN service provider for this B-channel. Include access codes, dialing prefix, and area code if necessary. When entering the area code, always enter it directly before the main telephone number. Do not use a hyphen (-) as a separator because hyphens are reserved for subaddressing.

### SPID (B channel 1 and B channel 2)

Enter the Service Profile Identifier (SPID) provided to you by your ISDN service provider for this B-channel.
Configuring trunk groups

This section shows you how to enable and create trunk groups for use with the Remote Office 9150 unit. For more information, see “Trunk groups” and “Trunk access codes” on page 209.

Getting there  9150 ➔ Configuration Manager ➔ Trunk Group Configuration

Trunk Group Configuration sheet

To configure trunk groups

1. Complete the fields as described in “Trunk Group Configuration field descriptions” below.
2. Click OK to save the information in the temporary work file.
3 To update the Remote Office 9150 unit with the new information, click Send.

<table>
<thead>
<tr>
<th>IF you are</th>
<th>THEN</th>
</tr>
</thead>
<tbody>
<tr>
<td>logged on to the Remote Office 9150 unit</td>
<td>the changes are written into the Remote Office 9150 unit’s buffer. To save the changes in flash memory, choose Upload/Download → Save to Flash.</td>
</tr>
</tbody>
</table>
| not logged on to the Remote Office 9150 unit | The Connection not Established dialog box appears. Do one of the following:  
   - Log on to the Remote Office 9150 unit, and then click Send again.  
   - Save the changes to a file on your administration PC. |
### Trunk Group Configuration field descriptions

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group No</td>
<td>Select a group number. You can create up to ten groups.</td>
</tr>
<tr>
<td>Status</td>
<td>Select Enable to activate the trunk group. Select Disable to deactivate the trunk group.</td>
</tr>
<tr>
<td>Trunk Access Code</td>
<td>Enter the trunk access code that you want to assign to the trunk group, or accept the default.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The trunk access code is automatically prefixed with a pound sign (# in North America). This means users must dial the # before the trunk access code when making an outgoing local call.</td>
</tr>
<tr>
<td></td>
<td>Maximum length: 1 to 3 digits in addition to the pound sign</td>
</tr>
<tr>
<td>Local DNs to Alert:</td>
<td>Select the Not Configured box if you want all sets to ring for incoming local calls.</td>
</tr>
<tr>
<td>Not Configured</td>
<td>If you want incoming calls to ring on specific telephones only, then enter the DNs of those telephones.</td>
</tr>
<tr>
<td></td>
<td>If you do not configure DNs for a particular trunk group then all of the DNs (both Local only and Local and Remote) will alert.</td>
</tr>
<tr>
<td></td>
<td>If you configure DNs but the trunk group is disabled, then all of the DNs (both Local only and Local and Remote) will alert.</td>
</tr>
</tbody>
</table>
Field | Description
--- | ---
Trunk Group B Channels | Click Trunk Group B Channels.
 **Result:** The Trunk Group B-Channel dialog box appears.

![Trunk Group B Channels](image)

**Trunk Group B Channels (continued)**

Complete the fields as follows:

- **Module:** Displays trunk interface module numbers.
- **Device:** Displays the internal device number for each B-channel provided by the module.
- **B Channel:** Displays B-channel numbers.
- **Check boxes:** Click the check box for each B-channel you want to include in this trunk group.

**Note:** A B-channel can be a member of more than one trunk group.

Click OK.
Configuring stations

This section explains how to configure the Remote Office 9150 unit so that it can:

- route calls between the stations at your site and the host PBX
  Each station is associated with a port on the RLC, and can be configured with different capabilities.
- make calls through the local PSTN or to other stations at the Remote Office 9150 site

If resources on the RLC on the host PBX allow, you can configure up to 32 telephone stations plus one analog device (such as an analog telephone or fax machine). This configuration assumes that none of the stations are equipped with Analog Telephone Adapters (ATAs) or Meridian Communication Adapters (MCAs).

Bridge Ports

Bridge Ports are proxy ports that represent local calls or inbound PSTN calls to the PBX. When a local call on a Remote Office 9150 unit needs PBX services, the Bridge Port obtains a PBX presence on behalf of the local call.

When configuring Bridge Ports:

- Consider the number of simultaneous remote service telephone calls and the number of bridge ports in use when determining PSTN or IP bandwidth needs.
- Remember that every local ISDN call reduces the PSTN bandwidth available for remote service telephone calls and bridge ports when determining needed PSTN bandwidth.
Notes: You can configure a maximum of sixteen (16) Bridge Ports. You must configure at least one SCR key on the set for the Bridge Port feature to work.

You must configure Bridge Port parameters on both the RLC and Remote Office 9150 unit. For information regarding Bridge Port configuration on the RLC, refer to the Reach Line Card Installation and Administration Guide (NTP 555-8421-210).

Note: Local Only sets do not support conference calls to a local Remote Office 9150 unit or to a host PBX. Local Only sets can dial host PBX DNs using an enabled Bridge Port.

Configuring Bridge Ports reduces the total number of ports available from the RLC.

Call processing capabilities and station settings

Each station can be defined as a telephone that can process
- local calls only
- remote calls only
- local and remote calls

Stations defined with local call capability are further defined with telephone features and local call appearance keys. Stations that are defined with remote call capability do not need to be further configured because they inherit their features and call appearance keys from their associated port configurations on the host PBX.

Local call capability
Stations defined as local can make and receive calls through the local PSTN or to other stations at the Remote Office 9150 site. Calls through the host PBX are not allowed.

Local stations are not associated with RLC ports.

Remote call capability
Stations defined as remote are associated with RLC ports, and can make and receive calls through the host PBX only. Calls through the local PSTN are not allowed.
Local and remote call capability
Stations defined as *local and remote* are associated with RLC ports, and can
- make and receive calls through both the host PBX and the local PSTN
- make calls to other stations at the Remote Office 9150 site

Outgoing calls are routed according to the call appearance key used to initiate the call.
- Calls initiated on the key defined as the host call appearance key (also referred to as the *primary DN key*) are routed through the host PBX.
- External calls initiated on the key defined as the local call appearance key are routed through the local PSTN.
- Internal calls initiated on the local call appearance key are routed to other stations at the Remote Office 9150 site.

The Remote Office 9150 unit distinguishes an incoming call by its calling line identification, and rings it as follows:
- on the host call appearance key if the call was routed through the host PBX
- on the local call appearance key if the call was routed through the local PSTN or if the call was a station-to-station call

Local station settings
When a station is defined with local capability, you can further configure the station to
- enable or disable certain features (for more details, see “Defining stations” on page 225)
- disable outgoing dialing digit sequences (see “Disabled Outbound Digit Sequence” on page 229)
- identify local call appearance and feature key positions (see “Optional Feature Keys” on page 230)

Remote station settings
When the station is defined with remote capability, you can assign it to a specific port on the RLC (see “Defining stations” on page 225).
Call appearance keys

The host call appearance key is defined for each station on the host PBX. It is not defined for each station on the Remote Office 9150 unit.

The local call appearance keys, on the other hand, must be defined for each station connected to the Remote Office 9150 unit to allow:
- users to make outgoing calls using Remote Office 9150 trunks
- users to make station-to-station calls without host PBX control
- incoming calls on Remote Office 9150 trunks to ring specific stations

The local call appearance keys must be left undefined in the host PBX configuration to avoid indicator conflicts between the host PBX and the Remote Office 9150 unit. Only indicators defined as local call appearances are blocked from the host PBX.

When to configure the local call appearance keys

The local call appearance key positions must be defined when a new station is being configured with local capability, or when a request to change feature key positions has been initiated.

Associating trunk groups with local stations

Each trunk group can be defined to ring only specific stations. This feature allows you to route certain types of calls (such as incoming calls on a 1-800 number) to specific stations.

Private lines

A private line is a telephone line that is used by one person only. Calls that are routed to the private line do not ring on any other station in your office. To dedicate a private line to a station, configure a trunk group to ring incoming calls only on that station.

If you are connecting a fax machine to the Remote Office 9150 unit, then configure a private line to the fax. Incoming calls on this line are routed directly to the fax.

For instructions, refer to “Configuring trunk groups” on page 215.
Calling permissions and restrictions

You can consider the ability to make certain types of calls from a station to be a calling permission. Similarly, a certain type of call that is not allowed is a calling restriction.

You can define both permissions and restrictions for each station.

Local and remote calling permissions

When you define a station as a local station, you are granting the station with local calling permission. Calls can be made or received through the local PSTN or to and from other stations. Calls through the host PBX are not allowed.

When you define a station as a remote station, you are granting the station with remote calling permission. Calls can be made or received through the host PBX only. Calls through the local PSTN are not allowed.

**Exception:** If the emergency service number is configured on the Remote Office 9150 unit and you are using the PSTN to route calls, the dialed emergency service number is routed through the local PSTN to the emergency service. This ensures that the emergency service receives the correct calling location information.

When you define a station as a local and remote station, you are granting the station with the ability to make or receive calls through both the local PSTN and the host PBX. Station-to-station calls are also allowed.

Call restriction

You can prevent certain types of calls from being made at a station by disabling the digits that normally allow the call to proceed. This option is available for stations designated as Local or both Local and Remote.

For example, if you want to prevent someone from calling a 1-976 number, enter 1976 as the digits to disable. For more information refer to “Disabled Outbound Digit Sequence” on page 229, in the Local Profile Configuration field description section.
ATA- and MCA-equipped stations and bandwidth requirements

Each station equipped with an MCA requires a full 64 Kbps of bandwidth to the host PBX.

For stations equipped with ATA devices, the bandwidth used by calls processed on those stations is as follows:

<table>
<thead>
<tr>
<th>IF</th>
<th>THEN</th>
</tr>
</thead>
<tbody>
<tr>
<td>G.729 compression is being used and the call is a voice call</td>
<td>the voice call is sent as 8 Kbps to the host PBX.</td>
</tr>
<tr>
<td>G.729/Fax or G.711 compression is being used and the call is a fax call</td>
<td>the fax call is sent as 64 Kbps.</td>
</tr>
<tr>
<td>the call is a local call</td>
<td>the voice call is not compressed. It is sent as 64 Kbps of data across the ISDN BRI B-channel.</td>
</tr>
</tbody>
</table>

The following table identifies the number of MCAs or ATAs that can be connected to the Remote Office 9150 unit:

<table>
<thead>
<tr>
<th>IF the Remote Office 9150 unit is connected to</th>
<th>THEN you can connect</th>
</tr>
</thead>
<tbody>
<tr>
<td>a 1-slot RLC (supporting 16 users)</td>
<td>four MCAs or ATAs to the Remote Office 9150 unit.</td>
</tr>
<tr>
<td>a 2-slot RLC (supporting 32 users)</td>
<td>seven MCAs or ATAs to the Remote Office 9150 unit.</td>
</tr>
</tbody>
</table>

Notes:

- You can have eight MCAs or ATAs installed if an analog telephone or fax machine is not installed.
- The total number of digital telephones and ATAs cannot exceed 32.
Defining stations

To make and receive calls, you must use Configuration Manager to configure each station (telephone or other device such as a fax machine) in your office.

**Note:** To ensure that digital telephones, ATAs, and MCAs operate as expected, you must specify the Phone Type when configuring a station as Local or Remote.

### Getting there
9150 → Configuration Manager → 9150 Port Configuration

### 9150 Port Configuration sheet

![9150 Port Configuration sheet](image-url)
To configure stations

1. Locate the port that you want to configure by clicking the appropriate port range tab, and then scrolling down the list.

   The following table describes port number ranges and how they can be configured:

<table>
<thead>
<tr>
<th>Ports</th>
<th>Can be assigned to</th>
</tr>
</thead>
<tbody>
<tr>
<td>0–15 and 32–47</td>
<td>digital telephones.</td>
</tr>
<tr>
<td></td>
<td>Note: The associated ports on the host PBX must be configured with voice capability.</td>
</tr>
<tr>
<td>16–31 and 48–63</td>
<td>stations equipped with ATAs or MCAs.</td>
</tr>
<tr>
<td></td>
<td>Note: The associated ports on the host PBX must be configured with data capability.</td>
</tr>
<tr>
<td>64</td>
<td>a fax machine or other analog device (without an ATA).</td>
</tr>
<tr>
<td></td>
<td>Note: The associated port on the host PBX must be configured with data capability.</td>
</tr>
</tbody>
</table>

   Note: You can use ports 32–47 and 48–63 only if this Remote Office 9150 unit connects to a 2-slot RLC on the host PBX.

2. Under Port Type, click the call processing capability that this station should have:
   - Local: if only calls through the local PSTN are allowed. This option enables the Configure button for this port.
   - Remote: if only calls through the host PBX are allowed.
   - Local and Remote: if both local and remote calls and local station-to-station calling are allowed. This option enables the Configure button for this port so you can configure local station features and keys. Note: Choose Local and Remote if you want to define a Bridge Port.

3. Accept the default RLC Port to which this station is assigned, or enter a new RLC port number.

   Exception: Do not associate a local-only port with an RLC port.
Notes:

- Generally, the Remote Office 9150 port and RLC port should match to simplify configuration and administration.
- If the station is equipped with an MCA or ATA for data transmission, or if the port is used for fax, the RLC port must be configured on the host PBX with data capability.

4 If you selected Local or Local & Remote, click Configure for the port you are configuring.

Result: The Local Profile Configuration property sheet appears.

5 Complete the fields as described in “Local Profile Configuration field descriptions” on page 228.

6 Once you have completed the Local Profile Configuration, click OK.

Result: The 9150 Device Configuration sheet reappears. The configurations you set are displayed in the port's Description box.
Local Profile Configuration field descriptions

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPND</td>
<td>Enter the calling party name display (CPND) for the user to which the station is assigned.</td>
</tr>
<tr>
<td>DN</td>
<td>Enter the user’s local extension number.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If Auto DN Discovery is enabled on the RLC, then this field is configured to be the same DN as the primary DN configured on the host PBX for this station.</td>
</tr>
<tr>
<td>Phone Type</td>
<td>Select the telephone model type connected to the port. Valid options are: M2006, M2008, M2216, M2616, M2616CT, M3820, M3901, M3902, M3903, M3904, M3905, MCA, ATA, Other.</td>
</tr>
<tr>
<td>Add on Module Type</td>
<td>Select the applicable Add on Module for the M3904 and M3905 telephones. Valid options are: Not Configured, KBA, DBA.</td>
</tr>
<tr>
<td>Auto Hold</td>
<td>Select Enable if active calls should be automatically put on hold when another call appearance key is pressed. Select Disable if active calls should be disconnected when another call appearance key is pressed.</td>
</tr>
<tr>
<td>Paging</td>
<td>Select Enable if this station will be allowed to announce pages. Select Disable if this station will not be allowed to announce pages.</td>
</tr>
<tr>
<td>Bridge Port</td>
<td>Select Enable to inbound PSTN calls access to certain PBX features.</td>
</tr>
<tr>
<td>Forward Busy/No Answer</td>
<td>Select Enable to allow incoming calls to this station to be forwarded if they are not answered by the number of rings configured in the Number of Rings before transfer field or if the station is busy. Select Disable if calls should not be forwarded.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Forward Busy/No Answer: Number of Rings before transfer</td>
<td>Enter the number of times this station rings before transferring the call to the configured DN. Default is four rings.</td>
</tr>
<tr>
<td>Forward Busy/No Answer: Transfer to DN</td>
<td>Enter the DN where calls to this station will be transferred if not answered before the configured number of rings. This DN may be for a voicemail service or the DN of another station.</td>
</tr>
<tr>
<td>Disabled Outbound Digit Sequence</td>
<td>If you want to prevent this station from making a certain type of call, then enter the digits that normally allow that type of call to proceed.</td>
</tr>
<tr>
<td></td>
<td><strong>Example:</strong> Enter 1976 to prevent calls to 1-976 numbers.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> You can configure five digit sequences. In order for calls to be restricted, the dialed number must contain a matching string at the beginning of the number.</td>
</tr>
<tr>
<td>Local Call Keys (Key 1 and Key 2)</td>
<td>The number selected identifies the feature key position on the telephone. Select the feature key you want to use for each local call appearance key. Valid options are: 1-15. NC means not configured.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If the port is configured as local and remote, Key 0 is not recommended. Keys 8 and 9 are recommended. You can select Key 0 if the port is configured as local only.</td>
</tr>
<tr>
<td></td>
<td><strong>Valid options:</strong> 0 through 15</td>
</tr>
</tbody>
</table>
If you configured the port as Local, click this button to assign local features to specific keys.

**Result:** The Key Feature Configuration property sheet appears.

![Key Feature Configuration](image)

**Note:** Ensure that the selected key does not already have a feature assigned to it through the PBX.

- **Key Feature**
  Select the name of the feature you want to configure on this key.
  Valid options: Call Transfer, Call Forward, Auto Dial, Make Set Busy, Not Configured

- **Key Number:**
  The key number identifies the feature key position on the telephone. Select the key you want for the feature you are configuring.
  **Note:** If the station is configured as local and remote, the key number selected for the feature must match the feature key position defined in the PBX voice port configuration.
  Valid options: 0 through 15

- **Key Data**
  Enter the DN to be used by the feature, if applicable.
Configuring a fax station

The Remote Office 9150 unit provides the ability to connect and use a fax machine. You can define port 64 as the fax machine on the Remote Office 9150 unit in one of the following ways:

<table>
<thead>
<tr>
<th>TO allow all fax calls to be made or received through</th>
<th>THEN</th>
</tr>
</thead>
<tbody>
<tr>
<td>the local PSTN only</td>
<td>define the fax machine as a local device.</td>
</tr>
<tr>
<td>the host PBX</td>
<td>define the fax machine as a remote device.</td>
</tr>
<tr>
<td>both the local PSTN and the host PBX</td>
<td>define the fax machine as a local and remote device.</td>
</tr>
</tbody>
</table>

**Note:** When faxes are sent and received through the host PBX, they are sent uncompressed (that is, they require 64 Kbps of bandwidth).

For instructions on configuring the fax port, see “To configure the fax port” on page 232.

For instructions on configuring a trunk group that rings only on the fax machine, see “To configure trunk groups” on page 215.
Getting there  9150 → Configuration Manager → RLC Port Configuration

9150 Port Configuration sheet

To configure the fax port

1. Locate port 64.
2. On port 64, under Port Type, click the call processing capability the fax machine should have:
   - Local: if only faxes through the local PSTN are allowed. This option enables the Configure button for this port.
   - Remote: if only faxes through the host PBX are allowed.
   - Local and Remote: if both local and remote faxing are allowed. This option enables the Configure button for this port so you can configure local station features and keys.
3. Accept the default RLC Port to which this station is assigned, or enter a new RLC port number.

Notes:
- Generally, the Remote Office 9150 port and RLC port should match to simplify configuration and administration.
- For fax transmissions, the RLC port must be configured on the host PBX with data capability.

4. If you selected Local or Local & Remote, click Configure for the port you are configuring.

Result: The Local Profile Configuration dialog box appears.

5. In the Local Features: CPND box, enter a description (for example, FAX).

6. Enter the number used to ring the fax machine in the Local Features: DN box.

7. Click Disable under Local Features for the following:
   - Auto Hold
   - Forward Busy/No Answer
   - Paging
   - Bridge Port (Local and Remote only)
8 If applicable, enter the digits that prevent a certain type of call from proceeding in the Disabled Outbound Digit Sequence box.

9 Specify the positions of the Local Call Keys.
   Note: Key 0 is not recommended for ports defined as local and remote. Keys 8 and 9 are recommended. You can select Key 0 if the port is configured as local only.

10 Click OK to save the information in the temporary work file.

11 To update the Remote Office 9150 unit with the new information, click Send.

IF you are THEN

logged on to the Remote Office 9150 unit the changes are written into the Remote Office 9150 unit’s buffer.
   To save the changes in flash memory, choose Upload/Download ➔ Save to Flash.

not logged on to the Remote Office 9150 unit The Connection not Established dialog box appears.
   Do one of the following:
   ■ Log on to the Remote Office 9150 unit, and then click Send again.
   ■ Save the changes to a file on your administration PC.
Configuring DSP resources

This section shows you how to configure DSP resources on your Remote Office 9150 unit. The Remote Office 9150 unit must provide the same number of voice DSP channels as the maximum number of simultaneous calls your remote services network supports. Each DSP module holds two DSP devices. Currently, each DSP device holds four DSP channels. To add eight DSP channels to your Remote Office system’s voice processing capability, add one DSP application module.

Getting there  9150 ➝ Configuration Manager ➝ DSP Configuration

DSP Configuration property sheet
Module identification

The upper portion of the DSP configuration property sheet displays fields that identify the module you are currently configuring. In the Module Number drop down box, choose the module position on the Remote Office 9150 unit that the DSP module occupies. Module 0 represents the built-in DSP resources on the Remote Office 9150 unit—the equivalent of one DSP application module.

Device configuration

The middle portion of the property sheet displays information describing the DSP loads, and corresponding compression algorithms that you can select for each DSP device.

Configuring DSPs

To configure DSP modules on your Remote Office 9150 unit, complete the following steps:

1. Access the DSP Configuration property sheet.
2. Complete the fields as described in “DSP Configuration field descriptions” on page 237.
3. Click on the OK button to save the information in the temporary work file.
4. Click on the Send button to update the Remote Office 9150 unit with the new information.

Result: The Remote Office 9150 unit writes changes to a temporary file on the administration PC.

Note: To save changes to the Remote Office 9150 unit's flash memory, select Upload ➔ Save to Flash.
## DSP Configuration field descriptions

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Module Number</td>
<td>Select the number of the module DSP position on the Remote Office 9150 unit occupied by the DSP application module you are configuring. Valid options are: 1–4.</td>
</tr>
<tr>
<td>No of Devices</td>
<td>This is a read-only field displaying the number of DSP devices on the application module in the selected module position. Refer to “Configuring DSPs” on page 236 for an explanation of DSP devices versus DSP modules and DSP channels.</td>
</tr>
<tr>
<td>DSP Load</td>
<td>Select the DSP load that you want to enable on this DSP device. Valid options are: G729, AUTO. Note: Nortel Network’s recommends that you select AUTO.</td>
</tr>
<tr>
<td>Compression Algorithms</td>
<td>This read-only field displays the compression algorithms contained in DSP load displayed in the DSP load drop down box. Note: This description applies to both appearances of this field.</td>
</tr>
</tbody>
</table>
Chapter 6
Using Remote Office 9150 stations

In this chapter

- Modes of operation 240
- Placing and receiving calls 244
- Indicator updates 248
- Display messages 250
- Telephone features operation 253
- Going online and offline 257
Modes of operation

Digital telephones at your Remote Office 9150 site can operate in the following modes:

- host-controlled
- locally controlled
- online to host PBX
- offline from host PBX

Host-controlled mode

Host-controlled mode means that the host PBX controls the following:

- some display messages that appear on your telephone
- indicator updates such as the message waiting indicator
- calls that you receive from or place to someone at the host PBX site

In host-controlled mode, a voice path is established to the host PBX and signaling messages are passed between the host PBX and the Remote Office 9150 unit.

**Exception:** If Local Switchover is enabled, and the station-to-station call is completed through the host PBX, signaling messages are passed between the host PBX and Remote Office 9150 unit normally. However, the voice path is established by the Remote Office 9150 unit without consuming host connection bandwidth. The host PBX is aware that the call is active and tracks the status of the phoneset.

If the call cannot be completed through the host PBX, you hear a reorder dial tone.
Locally Controlled mode

Local-controlled mode means that the Remote Office 9150 unit at your site controls the following:

- calls to other stations at this site
- calls that are made to or received from your community through your local telephone service provider

Relationship between host-controlled and locally controlled modes

Both the host-controlled and locally controlled modes can be used at the same time. When placing or receiving calls, the call modes are controlled by the following telephone keys:

- the host call appearance key (also known as the primary DN key)
- the local call appearance key (can sometimes be referred to as the secondary DN key)

Host call appearance key

The host call appearance key is the main key you use to place and receive calls. For example, if someone from Finance at Head Office calls you, the call rings on this key. Similarly, if you need to call someone in Payroll at Head Office, you place the call on this key.

Local call appearance key

The local call appearance key is the key you use to place and receive local calls. For example, if your office is working overtime and everyone wants pizza, you call the pizza delivery place on the local call appearance key. Similarly, you use this key if you want to call one of your customers or suppliers or someone else at your site.

Your telephone can have up to two local call appearance keys. Your system administrator can tell you where these keys are and how they are labeled.
Using Remote Office 9150 stations

Online mode

When in online mode, calls initiated on the host call appearance key are directed through the host PBX. Any long distance charges associated with calls placed through the PBX over the PSTN are charged to the host PBX site. The display on all digital telephones shows “Online Mode.”

Offline mode

When in offline mode, you cannot place calls through the host PBX over either the IP network or PSTN. You can only place calls through your local telephone service provider if your station has been granted locally controlled call capability. The display on all digital telephones show “Offline Mode.”

Why offline mode is important

Your organization is concerned about telephone costs and, as such, wants to ensure that the ISDN BRI line at your site is used for host-controlled calls during business hours only. This is especially important when the ISDN BRI connection between the host PBX and your site is defined as permanent (always on) rather than on demand. A permanent ISDN BRI connection means the line remains active all the time and incurs charges unless it is put into offline mode.

What controls the online and offline modes

The online and offline modes can be controlled by one or both of the following:

- the online/offline schedule configured for your site on the RLC at the host PBX
- special prefix (SPRE) codes configured on the Remote Office 9150 unit at your site

Online/offline schedule at host PBX

If telephone service costs are an issue, your telecom network administrator defines an online/offline schedule on the RLC port to which your site is assigned. The times at which your site is put into online or offline mode are processed by the host PBX.
For example, if your normal business day is from 9:00 a.m. to 5:00 p.m. from Monday to Friday, the schedule for your site instructs the host PBX to put all stations at your site into online mode during those times. For all other time periods, all stations are in offline mode and, therefore, disconnected from the host PBX.

**Note:** If you initiate a call on a host call appearance key on any station, then full functionality is allowed even if the time period is outside the automatic offline periods defined on the RLC.

**SPRE codes used at your site**
If SPRE codes have been defined on the Remote Office 9150 unit at your site, your site can control the times at which stations are put into online or offline modes. You do this by entering one of the following codes on any digital telephone at your site:

- Online SPRE code
- Offline SPRE code

It is recommended that one person at your site be designated as the person responsible for putting the Remote Office 9150 unit (and all stations) into online mode at the beginning of the business day, and into offline mode at the end of the day.

For information about going online or offline, see page 257.
Placing and receiving calls

The way in which you place outgoing calls depends on the call appearance key you use to place the call.

The call appearance key on which calls are received depends on where the call is coming from.

Receiving incoming calls

The calling line identification (CLID) of an incoming call determines which call appearance key accepts the call.

<table>
<thead>
<tr>
<th>IF the call</th>
<th>THEN the call</th>
</tr>
</thead>
<tbody>
<tr>
<td>information contains a Called Party Number Display (CPND) that matches a</td>
<td>is routed to the station based on the DNs to Alert</td>
</tr>
<tr>
<td>telephone number assigned to one of the ISDN BRI B-channels from your</td>
<td>configuration on the trunk group to which the B-</td>
</tr>
<tr>
<td>telephone service provider</td>
<td>channel belongs. If the DNs to Alert fields are</td>
</tr>
<tr>
<td></td>
<td>blank, the call rings on all stations.</td>
</tr>
<tr>
<td></td>
<td>The call rings on the first local call appearance</td>
</tr>
<tr>
<td></td>
<td>key on all stations that have been designated to</td>
</tr>
<tr>
<td></td>
<td>receive calls from this trunk.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If the first call appearance key is</td>
</tr>
<tr>
<td></td>
<td>already busy with a call, the call is presented</td>
</tr>
<tr>
<td></td>
<td>on the second call appearance as a call waiting.</td>
</tr>
<tr>
<td></td>
<td>The indicator flashes and an alert tone sounds.</td>
</tr>
<tr>
<td>comes in on the communication path between the RLC and Remote Office</td>
<td>is routed to the station based on the Remote Office</td>
</tr>
<tr>
<td>9150 unit</td>
<td>9150 station to RLC port assignment in the Remote</td>
</tr>
<tr>
<td></td>
<td>Office 9150 unit’s ports configuration.</td>
</tr>
<tr>
<td></td>
<td>The call rings on the host call appearance key.</td>
</tr>
<tr>
<td>information contains the DN of another station at this site</td>
<td>rings on the local call appearance key.</td>
</tr>
</tbody>
</table>
Methods for placing outgoing calls

You can place an outbound call from a Remote Office 9150 station in one of the following ways.

- Method 1: Pick up the handset.
  This method automatically initiates a host-controlled call.
  **Note:** If you then press the local call appearance key, the dial tone from the host PBX is changed to locally controlled mode, and the host PBX connection is released.

- Method 2: Press a call appearance key.
  When you press the host call appearance key, a host-controlled call is initiated. When you press the local call appearance key, a locally controlled call is initiated.

To place host-controlled calls

1. Pick up the handset or press the host call appearance key.
   Result: A connection is established with the host PBX and you hear dial tone.
   **Note:** If a connection to the host PBX cannot be established within a time-out period or no resources are available to carry the call, you hear a reorder dial tone (a fast busy signal), and the following message appears on the telephone display:
   
   Release and Try Again

2. Dial the number of the party you want to call.
   Result: The host PBX receives and processes the dialed digits and rings the called party.
To place outgoing locally controlled calls

**Note:** You cannot use this procedure to place calls to the host PBX site. If you try, you hear a reorder dial tone (a fast busy signal) and the following message appears on your telephone display:

**Release and Try Again**

1. Do one of the following:

<table>
<thead>
<tr>
<th>IF you are using</th>
<th>THEN</th>
</tr>
</thead>
<tbody>
<tr>
<td>an analog or ATA-equipped station</td>
<td>do the following:</td>
</tr>
<tr>
<td></td>
<td>a  Pick up the handset.</td>
</tr>
<tr>
<td></td>
<td>Result: A connection is established with the host PBX and you hear a</td>
</tr>
<tr>
<td></td>
<td>dial tone.</td>
</tr>
<tr>
<td></td>
<td>b  Dial the Local Calling SPRE code.</td>
</tr>
<tr>
<td></td>
<td>Result: The connection is switched to the Remote Office 9150 unit</td>
</tr>
<tr>
<td></td>
<td>and you hear a dial tone.</td>
</tr>
<tr>
<td>a digital telephone</td>
<td>pick up the handset, and then press a</td>
</tr>
<tr>
<td></td>
<td>local call appearance key.</td>
</tr>
<tr>
<td></td>
<td>Result: A connection is established with the Remote Office 9150</td>
</tr>
<tr>
<td></td>
<td>unit and you hear a dial tone.</td>
</tr>
</tbody>
</table>

2. Dial a trunk access code, if required.

Result: The Remote Office 9150 unit obtains a free trunk and you hear another dial tone.

Note: If a trunk is not available, you hear a reorder dial tone (a fast busy signal) and the following message appears on the telephone display:

**Release and Try Again**

3. Dial the number of the party you want to call.

Result: Your local telephone service provider receives and processes the dialed digits and rings the called party.
To call another station at your site

Station-to-station calls should be attempted through the host PBX to allow all stations configured as multiple appearance DNs (MADNs) to ring and provide access to voice mail if the call is not answered.

If a connection cannot be established through the host PBX, then you can use the local call appearance key to place the station-to-station call.

1. Pick up the handset or press the host call appearance key.
   Result: A connection is established with the Remote Office 9150 unit and you hear a dial tone. The indicator beside the host call appearance key lights.

2. Dial the extension of the party you want to call.
   Result: The host PBX receives and processes the dialed digits, and rings the station as well as any other stations that include the dialed DN as an MADN appearance.

Note: The MADN stations could be located at another site (such as the host PBX site).

<table>
<thead>
<tr>
<th>IF the call is answered by</th>
<th>THEN</th>
</tr>
</thead>
<tbody>
<tr>
<td>an MADN station at another site</td>
<td>a voice path to the host PBX is established and the call proceeds.</td>
</tr>
<tr>
<td>a station at this site</td>
<td>all signaling continues to be processed by the host PBX. However, the actual voice path is connected between the two stations and the Remote Office 9150 unit. No trunk bandwidth back to the host PBX is used for the voice path. Trunk bandwidth previously reserved for the call is released and made available to other calls.</td>
</tr>
</tbody>
</table>
Indicator updates

Digital telephone indicators reflect the current status of the telephone. For example, they identify when calls are waiting, active, or on hold, or, if your office has voice mail, that messages have been received.

Indicators are updated as follows:
- by the host PBX when a connection between the host PBX and Remote Office 9150 unit is active
- by the Remote Office 9150 unit for feature keys defined on stations with local call capability

Host-controlled indicator updates

Indicators for host-controlled features are updated automatically by the host PBX each time
- an incoming call is received by your site from the host PBX
- an outgoing call is made from your site through the host PBX
- a message waiting indicator (MWI) update is received by someone at your site

Note: If the PSTN is being used and the Remote Office 9150 unit is configured with a permanent (always on) connection to the host PBX, the ISDN BRI service is active and telephone indicators are always updated.

If the IP network is being used to route calls, indicators are always updated.

Locally controlled indicator updates

The following indicators are updated by the Remote Office 9150 unit (that is, these indicator updates are locally controlled):
- host and local call appearance key indicators
  The indicator lights when the handset is taken off-hook, or when you press the call appearance key to go off-hook.
**Note:** The Remote Office 9150 unit passes key presses and the on- or off-hook status for the host call appearance key to the host PBX.

- Handsfree
- Mute
Display messages

This section describes the messages that can appear on your digital telephone display.

Message descriptions

<table>
<thead>
<tr>
<th>Message</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Going Offline in 30 Secs</td>
<td>This message warns you that all digital telephones at this site are about to go offline in the number of seconds indicated.</td>
</tr>
<tr>
<td></td>
<td>If any calls are active, they are disconnected when the offline mode is activated.</td>
</tr>
<tr>
<td></td>
<td>To override, enter the Online SPRE code.</td>
</tr>
<tr>
<td>Going Offline in 20 Secs</td>
<td></td>
</tr>
<tr>
<td>Going Offline in 10 Secs</td>
<td></td>
</tr>
<tr>
<td>Hostless Mode</td>
<td>The connection to the host PBX cannot be established. The host PBX might be temporarily unavailable.</td>
</tr>
<tr>
<td></td>
<td>You can still place local calls by using one of the local call appearance keys.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If Hostless Mode persists, contact your system administrator.</td>
</tr>
<tr>
<td>Logged In</td>
<td>If this message appears on your station, then your station is associated with a multi-user or dynamic pool port on the RLC, and it is in logged on status.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This message appears for approximately ten seconds.</td>
</tr>
<tr>
<td>Offline Mode</td>
<td>You cannot place calls through the host PBX over either the IP network or the PSTN.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If you need to place a call through the host PBX while in offline mode, press the host call appearance key. This establishes a connection to the host PBX and puts all digital telephones at your site into online mode.</td>
</tr>
<tr>
<td>Message</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Online Mode</td>
<td>You can place and receive calls through the host PBX.</td>
</tr>
<tr>
<td>Port Already in Use</td>
<td>If this message appears on your station, then your station is associated with a multi-user or dynamic pool port on the RLC.</td>
</tr>
<tr>
<td></td>
<td>This message appears if the port to which you are attempting to log on is already being used by someone else.</td>
</tr>
<tr>
<td>Port Not Logged In</td>
<td>If this message appears on your station, then your station is associated with a multi-user or dynamic pool port on the RLC, but it is in logged off status.</td>
</tr>
<tr>
<td>QoS Recovery</td>
<td>The QoS has returned to normal on the IP network and your active call is being automatically moved to the IP network.</td>
</tr>
<tr>
<td>QoS Transition</td>
<td>The QoS has degraded on the IP network and your active call is being automatically moved to the PSTN.</td>
</tr>
<tr>
<td>Release and Try Again</td>
<td>All Remote Office 9150 trunks are busy or there are not enough DSP resources to process the call. Try again at a later time.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Ensure the call you are placing is initiated from the appropriate call appearance key:</td>
</tr>
<tr>
<td></td>
<td>■ host call appearance key: to call someone at the host PBX site</td>
</tr>
<tr>
<td></td>
<td>■ local call appearance key: to place a local PSTN call or to call another station at your site</td>
</tr>
<tr>
<td>Bandwidth Limit</td>
<td>If you see this message and hear a fast busy signal when you attempt to place a call, then there is insufficient PSTN bandwidth.</td>
</tr>
<tr>
<td></td>
<td>Wait a moment, and then try your call again.</td>
</tr>
<tr>
<td>Message</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>DSP Limit</td>
<td>If you see this message and hear a fast busy signal when you attempt to place a call, then Digital Signal Processor (DSP) resources are all busy.</td>
</tr>
<tr>
<td></td>
<td>Wait a moment, and then try your call again.</td>
</tr>
<tr>
<td>Call Failure</td>
<td>If you see this message and hear a fast busy signal when you attempt to place a call, then the Remote Office 9150 unit failed to establish the PSTN connection to the RLC.</td>
</tr>
</tbody>
</table>
Telephone features operation

This section describes how to use the following digital telephone features in host- or locally controlled modes:

- emergency service calls
- Hold
- Call Waiting
- Call Transfer
- Conference
- Call Forward
- Paging

**Note:** The Conference and Call Forward features are supported for host-controlled calls only.

Emergency service calls

The Remote Office 9150 unit allows an emergency number (for example, 911 in North America) to be programmed by your system administrator.

If the PSTN is used to route calls, and someone dials this emergency service number on any station that is connected to the Remote Office 9150 unit, the call is processed by your local telephone service provider.

You can initiate the emergency service call on either the host call appearance (primary DN) key or local call appearance key. You do not have to dial a trunk access code first.

**ATTENTION**

If only the IP network is being used to route calls, you must use a telephone that is directly connected to the PSTN to place an emergency service call. If you place the call on a station that is connected to the Remote Office 9150 unit, the call is routed through the host PBX, which can in a different city.
Hold

How Hold works in host-controlled mode
When you press Hold on a host-controlled call, the holding party receives the Hold treatment defined on the host PBX. For example, if the host PBX is configured to play music to holding parties, then the holding party hears music.

You can press any available call appearance key to place a new call.

How Hold works in locally controlled mode
Normally, you put a call on hold by pressing Hold. However, you can also put a locally controlled call automatically on hold by pressing the other local call appearance key. To use this feature, Auto Hold must be enabled on your station.

If Auto Hold is not enabled, and you press a local call appearance key while a call is active on the other local call appearance key, that call is disconnected.

When you press Hold on a locally controlled call, the holding party hears silence. You can press any available call appearance key to place a new call.

Call Waiting
Since the Remote Office 9150 unit does not use host-controlled indicators and the locally controlled indicators are not defined on the host PBX, there are never any indicator conflicts when a call is presented to the station.

However, since the host PBX is not aware when locally controlled calls are active, the host PBX might try to present a call and ring your station while you are busy with a locally controlled call. The Remote Office 9150 unit always checks the status of your station before ringing it. If your station is busy with a call, the alert tone is sounded instead.

How Call Waiting works in host-controlled mode
If you are busy with a host-controlled call, incoming calls are handled as follows:

- An incoming host-controlled call is directed to the call waiting key by the host PBX.
- An incoming locally controlled call flashes the local call appearance key indicator and sounds the alert tone.
How Call Waiting works in locally controlled mode

If you are busy with a locally controlled call, incoming calls are handled as follows:

- An incoming host-controlled call flashes the host call appearance key and sounds the alert tone.
- An incoming locally controlled or station-to-station call flashes the next available local call appearance key and sounds the alert tone. If both local call appearance keys are busy, then the call is not presented to your station.

Call Transfer

Call transfer works the same way in both host- and locally controlled modes. The only difference is the treatment the holding party receives, depending on whether the original call is a host-controlled or locally controlled call.

A call on the host call appearance key can be transferred

- to another station that has remote call capability at this site
- to a station at the host PBX site

A call on the local call appearance key can only be transferred to another station at this site. You cannot transfer a call on the local call appearance key to a station at the host PBX site.

For both, you can do an announced or unannounced (blind) transfer.

To transfer a call

1. Press the Transfer key.
   Result: The active call is placed on hold and you hear a dial tone.
2. Dial the number to which you want to transfer the call.
3. Press the Transfer key again to complete the transfer.
   Note: You can press the Transfer key while the call is still ringing, or after the called party answers.
Conference

The Conference feature is supported for host-controlled calls only. You cannot conference in someone who must be called through the local PSTN.

To place a conference call

1. Press the Conference key.
   Result: The active call is placed on hold and you hear a dial tone.
2. Dial the number of the party you want to conference in.
3. When the called party answers, press the Conference key again to complete the conference.

Call Forward

Call Forward is supported for host-controlled calls only. Your station might be programmed to forward all calls, forward calls when your station is busy, or forward calls when you do not answer.

Paging

When you press a local call appearance key, and then dial the Paging SPRE code, you can announce a page to all other stations at your site.

Note: You can disable Paging for any station.
Going online and offline

Stations at the Remote Office 9150 site operate in either online mode or offline mode. This is controlled by one or both of the following:

- SPRE codes to manually toggle all stations at your site between online and offline modes
- an online/offline schedule on the host PBX to automatically toggle all stations at your site between online and offline modes

For a description of the online and offline modes, see “Modes of operation” on page 240.

To use the SPRE code to put all stations into online mode

1. Lift the digital telephone handset, or press one of the local call appearance keys.
2. Dial the pound key (# in North America) followed by the Online SPRE code.
   Note: To learn this code, consult with your system administrator.
   Result: The connection to the host PBX is initiated and negotiated with the host PBX. During this negotiation period (up to 5 seconds), stations at your site cannot be used for host-controlled calls. When negotiation is completed and connection to the host PBX has been established, Online Mode appears on the telephone display.

To use the SPRE code to put all stations into offline mode

1. Lift the digital telephone handset, or press one of the local call appearance keys.
2. Dial the pound key (# in North America) followed by the Offline SPRE code.
   Note: To learn this code, consult with your system administrator.
   Result: Offline Mode appears on the telephone display.
To override an automatic offline event from the host PBX

If the host PBX attempts to process an offline event while you are on a host-controlled call, you are alerted by both an audible alert and a display message indicating that you are about to go offline in 30, 20, or 10 seconds. If you ignore this warning, your call will be disconnected.

To prevent your call from being disconnected, enter the online SPRE code. You can do this without putting your call on hold first. The online SPRE code cancels the offline event, leaving all stations online until the next offline event occurs.
Chapter 7

Administration

In this chapter

- Changing the administration password 260
- Section A: Performing backups and restores 265
- Section B: Working with system logs 273
- Section C: Viewing statistics 279
- Section D: Performing upgrades 309
Changing the administration password

The Remote Office 9150 unit’s configuration is protected by two layers of password security. If you want to secure the Remote Office 9150 unit’s configuration so that others cannot make configuration changes, you should change the following:

- the Configuration Manager password
  This password prevents unauthorized offline configuration changes from being performed.
- the Remote Office 9150 unit’s password
  This password prevents unauthorized online changes of the configuration residing in the Remote Office 9150 unit’s flash memory.

ATTENTION
Ensure that you record the passwords and store them in a safe, secure place. If you forget or lose the password, you must contact your Nortel Networks technical support representative.

Getting there  9150 ➔ Configuration Manager

To change the Configuration Manager password

1. From the menu, choose Connect ➔ Change Password ➔ Local.
   Result: The Change Password - Local dialog box appears.
2. Complete the fields as described in “Password dialog box field descriptions” on page 263.

3. Click OK.

IF the password change was successful THEN

the following appears:

![Configuration Manager dialog box with message 'Password Changed Successfully', OK button]

Click OK.

IF the password change was not successful THEN

one of the following messages appears:

![Configuration Manager dialog box with message 'Incorrect Old Password', OK button]

Click OK.

IF the password change was not successful (continued) THEN

![Configuration Manager dialog box with message 'ReEnter New Password', OK button]

Click OK, and then try again.
To change the Remote Office 9150 unit's password

1. From the menu, choose Connect ➔ Change Password ➔ Node.

   Result: The Change Password - Node dialog box appears.

2. Complete the fields as described in “Password dialog box field descriptions” on page 263.

3. Click OK.

   IF the password change was successful THEN

   the following appears:

   ![Configuration Manager dialog box]

   Bead Password Changed Successfully

   Click OK.

   Note: This means the password has been written to the Remote Office 9150 unit's flash memory.

   Click OK.
4 From the menu, choose Upload/Download ➔ Save to Flash.
Result: The Remote Office 9150 unit’s flash memory is updated with the new password.

5 Restart the Remote Office 9150 unit.

Password dialog box field descriptions

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Old Password</td>
<td>Enter the existing password.</td>
</tr>
<tr>
<td>New Password</td>
<td>Enter the new password.</td>
</tr>
<tr>
<td>Retype New Password</td>
<td>Enter the new password again.</td>
</tr>
</tbody>
</table>
Section A: Performing backups and restores

In this section

Creating a backup configuration file 266
Restoring the configuration 268
Creating a backup configuration file

Create a backup copy of the Remote Office 9150 unit’s configuration by downloading the Remote Office 9150 unit’s configuration from flash memory to a text file on your administration PC.

When to create a backup

Nortel Networks recommends that you create a backup of your configuration file whenever you make configuration changes or after you perform a firmware upgrade.

Storing backup configuration files

The Remote Office 9150 unit is an extension of the telecommunications and data network. It is extremely important that you keep a backup copy of the Remote Office 9150 unit’s configuration. If the Remote Office 9150 unit’s flash memory or configuration becomes corrupted or is lost, you can easily restore it.

Store the configuration file in a safe, secure location, such as on backup tape or other media that is stored offsite.

Nortel Networks recommends that you keep the backup files indefinitely.

Getting there  9150 ➔ Configuration Manager

To create the backup file

1. From the menu, choose Upload/Download ➔ Download Configuration.
   Result: The Save As dialog box appears.
2 Navigate to the folder where you want to put the configuration text file.

3 Enter a name for the file in the File name box.
   Note: This configuration file will become your backup file, so ensure the file name is meaningful. The file name’s extension is .TXT.

4 Click Save.
   Result: The Save As box closes, and the following message appears in the status bar at the bottom of the screen:

   **Downloading Config From Board**

   When completed, the following appears:

   ![Configuration Manager](image)

5 Click OK.
Restoring the configuration

Restore the Remote Office 9150 unit’s configuration in flash memory by uploading a configuration text file from your administration PC.

The upload is performed over the IP network using the TFTP protocol. You must have a TFTP server application running on your administration PC. The TFTP server’s base directory must point to the directory that contains the configuration file you want to upload.

Before you begin

Before you can upload the configuration file to the Remote Office 9150 unit, you must do the following:

1. Start the TFTP server application.
2. Ensure the TFTP base directory reflects the directory where the configuration file you want to upload is located.

Getting there  9150 → Configuration Manager

To upload a configuration file over the IP network

1. From the menu, choose → Upload/Download → Upload Configuration.

Result: The Upload Configuration screen appears.
2 In the IP Address boxes, enter the IP address of the TFTP server.  
Note: Since the TFTP server application is running on your administration 
PC, this is the IP address of the PC.

3 Click Browse.

Result: The Open dialog box appears.

4 Ensure the Files of type box shows Text File(*.TXT).
5 Navigate to the folder in which the configuration file is located.

6 Select the file, and then click Open.

Result: You are returned to the Upload Configuration dialog box. The file you selected is shown in the File Name box.

7 Click Upload.

Result: If the file opens successfully, then the upload proceeds. The following message appears in the status bar at the bottom of the screen:

Upload Config to Board

Status messages relating to the upload appear in the middle of the Upload Configuration dialog box. The following is an example.
CAUTION

Risk of incorrect operation due to partial configuration
Do not interrupt the configuration upload. If you interrupt the configuration upload, this results in an incomplete configuration in the Remote Office 9150 unit’s database.
If the configuration upload is interrupted, repeat this procedure immediately.

IF the upload was successful THEN

The following message appears:
CONFIG UPLOAD SUCCESSFUL... USE SAVECFG TO UPDATE FLASH.
Go to step 8.

IF the upload was not successful THEN

the following message appears in the middle of the Upload Configuration dialog box:
CONFIG UPLOAD FAILED
For further instructions, see Chapter 8, “Troubleshooting.”

8 On the Upload Configuration screen, click Save to Flash.

Result: The following dialog box appears:
9 Click Yes.

Result: The following message appears in the status bar at the bottom of the screen:

**Saving to Flash in Progress**

When the save is finished, the following message appears in the middle of the Upload Configuration dialog box:

**CONFIGURATION IS UPDATED INTO FLASH...**

10 Click Close.

11 Restart the Remote Office 9150 unit.

Note: For instructions, see “Performing a system restart or shutdown” on page 177.
Section B: Working with system logs

In this section

Displaying logs 274
Resizing logs 276
Clearing logs 277
Displaying logs

The Remote Office 9150 unit keeps track of system performance through the maintenance of logs. Each line stored in the log represents a separate action completed by the unit.

Use these logs when you want to troubleshoot system problems. You can print the log to a text file by copying the information from the log window, and then pasting it into a text file.

For a description of the Display log messages refer to Appendix D, “Display log definitions.”

Getting there  9150 ➔ Configuration Manager
To display logs

From the menu, choose Alarms/Stats/Logs ➔ Display Logs.

Result: The Remote Office 9150 unit displays the logs it maintains in a window similar to the following. You can use the scroll bar to browse through the logs to find the information in which you are interested.

Note: The information displayed in these logs also appears in the event.dat file on your administration PC.

To print the log to a file

If you are requesting technical support, you might be asked to provide a copy of the logs. To recreate the log in a file on your administration PC, follow this procedure:

1. Position the mouse pointer inside the log window at the beginning of the text you want to copy.
2. Select the text you want to copy, and then press Ctrl-C.
3. Open WordPad or Notepad.
4. Press Ctrl-V to paste the text.
5. Save and close the text file.
Resizing logs

The log maintains a maximum of 1000 lines of text. When the log reaches 1000 text lines, new text lines overwrite existing lines.

You might find that you want the logs to occupy a larger or smaller percentage of memory on the Remote Office 9150 unit. You can use the following procedure to change the size of the logs that the Remote Office 9150 unit keeps.

Getting there  9150 ➔ Configuration Manager

To change the size of Remote Office 9150 unit logs

1. From the menu, choose Alarms/Stats/Logs ➔ Resize Logs.

   Result: The Resize Log dialog box appears.

   ![Resize Log dialog box]

   Note: The queue size, in this case, means the number of text lines in the log. The log currently holds a maximum of 1000 text lines.

2. Enter the maximum number of text lines you want to maintain in the log.

3. Click OK.
Clearing logs

The Remote Office 9150 unit allows you to increase memory by clearing the log queue. Use the following procedure to discard information from the logs that is no longer useful.

Getting there  9150 → Configuration Manager

To clear logs

1. From the menu, choose Alarms/Stats/Logs → Clear Logs.
   Result: The CLEAR LOGS dialog box appears.

<table>
<thead>
<tr>
<th>IF you select</th>
<th>THEN</th>
</tr>
</thead>
<tbody>
<tr>
<td>No or Cancel</td>
<td>the dialog box closes and the logs remain as is.</td>
</tr>
<tr>
<td>Yes</td>
<td>the Remote Office 9150 logs are cleared and the following confirmation dialog box appears:</td>
</tr>
</tbody>
</table>

Click OK.
Section C: Viewing statistics

In this section
- Trunk Connection Statistics screen 280
- Bandwidth Connection Statistics screen 282
- Caller Information Statistics screen 284
- Hardware Statistics screen 287
- DSP screen 289
- Ethernet Interface Statistics screen 292
- BRI Statistics screen 295
- Local Call Statistics screen 297
- Remote Call Statistics screen 299
- Device Information screen 301
- ISDN Module Information screen 303
- Network Statistics screen 305
Trunk Connection Statistics screen

The Trunk Connection Statistics screen allows you to see the amount of traffic that is processed over each B-channel. Use this statistics log to determine which trunks get used the most.

Getting there  9150 ➔ Configuration Manager

To display the trunk connection statistics

1. From the menu, choose Alarms/Stats/Logs ➔ Trunk Connection Statistics.
   Result: The Trunk Connection Statistics screen appears.

2. Wait while Configuration Manager gathers statistics from the Remote Office 9150 unit's system logs.
   Result: The statistics appear. The following is an example.
3 Do one of the following:
- To refresh the statistics, click Refresh.
- To close the statistics screen, click Close.

Trunk Connection Statistics field descriptions

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trunk Number</td>
<td>9150 - Identifies the ISDN BRI module and B-channel used for the call.</td>
</tr>
<tr>
<td>Status</td>
<td>Identifies the current status of the trunk. Valid options are: Active and Idle.</td>
</tr>
<tr>
<td>Call Type</td>
<td>Identifies whether the call is a local call or a remote signaling call. Valid options are: Local and Signaling.</td>
</tr>
<tr>
<td>Remote ID</td>
<td>Identifies the remote unit involved in the call.</td>
</tr>
<tr>
<td>Called Number</td>
<td>Identifies the remote DN regardless of who initiated the call.</td>
</tr>
<tr>
<td>Start Time</td>
<td>Identifies the time that the call began.</td>
</tr>
<tr>
<td>Duration</td>
<td>Identifies the amount of time taken for the call.</td>
</tr>
</tbody>
</table>
Bandwidth Connection Statistics screen

The Bandwidth Connection Statistics screen allows you to see how much bandwidth the Remote Office 9150 unit can use, and how much is actually being used. Use this statistics log to help you determine if you need to add more bandwidth on PSTN or IP connections.

Getting there  9150 ➝ Configuration Manager

To display the bandwidth connection statistics

1. From the menu, choose Alarms/Stats/Logs ➝ BW Connection Statistics.
   Result: The Bandwidth Connection Statistics screen appears.

2. Wait while Configuration Manager gathers statistics from the Remote Office 9150 unit’s system logs.
   Result: The statistics appear. The following is an example.

![Bandwidth Connection Statistics](image-url)
3 Do one of the following:
   ■ To refresh the statistics, click Refresh.
   ■ To close the statistics screen, click Close.

Bandwidth Connection Statistics field descriptions

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote Unit Number</td>
<td>Identifies the remote unit that initiated the call.</td>
</tr>
<tr>
<td>Signaling Status</td>
<td>Identifies whether a connection is up on this unit. Valid options are: Active and Idle.</td>
</tr>
<tr>
<td>No of Voice Calls on IP</td>
<td>Identifies the number of calls in progress on this unit’s IP connection.</td>
</tr>
<tr>
<td>No of Voice Calls on PSTN</td>
<td>Identifies the number of calls in progress on this unit’s PSTN connection.</td>
</tr>
<tr>
<td>Used IP BW</td>
<td>Identifies the IP bandwidth in use on this unit.</td>
</tr>
<tr>
<td>Used Trunk BW</td>
<td>Identifies the PSTN bandwidth in use on this unit.</td>
</tr>
<tr>
<td>Total Up Trunk BW</td>
<td>Identifies the total PSTN bandwidth up and available to this unit.</td>
</tr>
<tr>
<td>IP QoS Status</td>
<td>Identifies the quality of service level on this unit’s IP connection. Valid options are: Good and Bad.</td>
</tr>
</tbody>
</table>
Caller Information Statistics screen

The Caller Information Statistics screen allows you to see the types of calls being made (IP or PSTN), and how often QoS transitions occur. Use this statistics log to help you determine if the voice Quality of Service on your IP network is stable.

Getting there 9150 → Configuration Manager

To display the caller information statistics

1. From the menu, choose Alarms/Stats/Logs → Caller Info Statistics.
   Result: The Caller Info Statistics screen appears.

2. Wait while Configuration Manager gathers statistics from the Remote Office 9150 unit’s system logs.
   Result: The statistics appear. The following is an example.

![Caller Info Statistics Screen](image-url)
3. Do one of the following:
   - To refresh the statistics, click Refresh.
   - To close the statistics screen, click Close.

**Caller Info Statistics field descriptions**

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Call Number</td>
<td>Identifies the number of the call that was processed by the Remote Office 9150 unit.</td>
</tr>
<tr>
<td>Remote ID</td>
<td>Identifies the board ID of the remote site that was involved in the call.</td>
</tr>
<tr>
<td>Connection ID</td>
<td>Identifies the serial number of this call through the lifetime of the logged on unit.</td>
</tr>
<tr>
<td>Remote ID</td>
<td>Identifies the unit ID of the involved remote unit.</td>
</tr>
<tr>
<td>Current Media</td>
<td>Identifies whether the call took place over the PSTN or IP network.</td>
</tr>
<tr>
<td>Type</td>
<td>Identifies the type of call. Valid options are: Signaling, Voice, and Local.</td>
</tr>
<tr>
<td>Priority</td>
<td>Identifies the priority setting of the involved trunk. Valid options are: PSTN Only, IP Only, High, and Normal.</td>
</tr>
<tr>
<td>Call BW</td>
<td>Identifies the amount of bandwidth used by the call.</td>
</tr>
<tr>
<td>Start Time</td>
<td>Identifies the time that the connection initiated.</td>
</tr>
<tr>
<td>Transitions to PSTN</td>
<td>Identifies the number of times the RLC moved the call to the PSTN.</td>
</tr>
<tr>
<td>Transitions to IP</td>
<td>Identifies the number of times the RLC moved the call to the IP network.</td>
</tr>
<tr>
<td>Column</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Last Transition to PSTN</td>
<td>Identifies the last time the RLC moved the call from the IP network to the PSTN.</td>
</tr>
<tr>
<td>Last Transition to IP</td>
<td>Identifies the last time the RLC moved the call from the PSTN to the IP network.</td>
</tr>
</tbody>
</table>
Hardware Statistics screen

The Hardware Statistics screen provides a listing of what modules you have installed in your Remote Office 9150 unit. Use it to determine which module positions in the Remote Office 9150 unit are populated, and what they contain.

Getting there  9150 ➝ Configuration Manager

To display the hardware statistics

1. From the menu, choose Alarms/Stats/Logs ➝ Hardware Statistics.
   Result: The Hardware Statistics screen appears.

2. Wait while Configuration Manager gathers statistics from the Remote Office 9150 unit’s system logs.
   Result: The statistics appear. The following is an example.
3  Do one of the following:
   - To refresh the statistics, click Refresh.
   - To close the statistics screen, click Close.

Hardware Statistics field descriptions

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Module No</td>
<td>Identifies the DSP application module’s position on the Remote Office 9150 motherboard.</td>
</tr>
<tr>
<td>Status</td>
<td>Identifies whether there is a functional DSP application module in the position identified in the Module No field. Valid options are: Equipped, meaning that a DSP application module is installed in the module position, and Unequipped, meaning that there is not a DSP application module installed in the module position.</td>
</tr>
<tr>
<td>Module Type</td>
<td>Identifies the part number of the hardware installed in the module position.</td>
</tr>
<tr>
<td>Version</td>
<td>Identifies the version of DSP application module installed in the module position.</td>
</tr>
</tbody>
</table>
DSP screen

Digital Signal Processor (DSP) Statistics provide information about the DSP application modules installed on the logged-on RLC. Use this screen to determine the module positions that are populated, what type of DSP those positions contain, and the functionality provided by each module.

Getting there 9150 ➔ Configuration Manager

To display DSP statistics

1. From the menu, choose Alarms/Stats/Logs ➔ DSP.
   Result: The DSP screen appears.

2. Wait while Configuration Manager gathers statistics from the Remote Office 9150 unit's system logs.
   Result: The statistics appear. The following is an example.
3. Do one of the following:
   - To refresh the statistics, click Refresh.
   - To close the statistics screen, click Close.

### DSP Statistics field descriptions

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single Digit Device ID</td>
<td>Identifies an internal sequence number for indexing this DSP device among all others on the RLC.</td>
</tr>
<tr>
<td>Module Number</td>
<td>Identifies this DSP Application Module’s module number on the RLC. Valid options are: 0, 1, 2, 3, 4.</td>
</tr>
<tr>
<td>Device Number</td>
<td>Identifies the DSP device that processed the call.</td>
</tr>
<tr>
<td>In Service</td>
<td>Identifies any voice channels operating on this DSP application module.</td>
</tr>
<tr>
<td>Total MIPS</td>
<td>Identifies the total millions of instructions per second (MIPS) capacity for this DSP device.</td>
</tr>
<tr>
<td>Available Mips</td>
<td>Identifies the millions of instructions per second (MIPS) currently available on this DSP device.</td>
</tr>
<tr>
<td>Total Channels</td>
<td>Identifies the total channel capacity for this DSP device.</td>
</tr>
<tr>
<td>Total Voice Channels</td>
<td>Identifies the total voice channel capacity for this DSP device.</td>
</tr>
<tr>
<td>Available Voice Channels</td>
<td>Identifies the number of unused voice channels on this DSP device.</td>
</tr>
<tr>
<td>Total Modem Channels</td>
<td>Identifies the number of channels on this DSP device that can transmit modem calls.</td>
</tr>
<tr>
<td>Available Modem Channels</td>
<td>Identifies the number of unused channels on this DSP that can transmit modem calls.</td>
</tr>
<tr>
<td>Column</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Total Flex Channels</td>
<td>Identifies the number of channels on this DSP that can provide multiple functionalities.</td>
</tr>
<tr>
<td>Available Flex Channels</td>
<td>Identifies the number of channels on this DSP currently available to provide multiple functionalities.</td>
</tr>
<tr>
<td>Total Tones Channels</td>
<td>Identifies the number of channels on this DSP that can transmit tones.</td>
</tr>
<tr>
<td>Total Reserved Channels</td>
<td>Identifies the number of special purpose channels on this DSP reserved for internal use.</td>
</tr>
<tr>
<td>Name</td>
<td>Identifies the name of the DSP load, that is, the combination of DSP algorithms, on the DSP module.</td>
</tr>
</tbody>
</table>
Ethernet Interface Statistics screen

Ethernet Interface Statistics provide information about the connection between the IP network and the logged-on RLC that is achieved over the RLC’s Ethernet interface.

Getting there  
Remote Office 9150 ➔ Configuration Manager

To display the Ethernet Interface statistics

1. From the menu, choose Alarms/Stats/Logs ➔ Ethernet Interface Statistics.
   
   Result: The Ethernet Interface Statistics screen appears

2. Wait while Configuration Manager gathers statistics from the Remote Office 9150 unit’s system logs.

   Result: The statistics appear. The following is an example.
3. Do one of the following:
   - To refresh the statistics, click Refresh.
   - To close the statistics screen, click Close.

### Ethernet Interface Statistics field descriptions

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Channel</td>
<td>Identifies the Ethernet device that the statistics on that line apply to. Valid options are: 1, 2.</td>
</tr>
<tr>
<td>LAN Drv</td>
<td>Identifies the LAN driver used by the call.</td>
</tr>
<tr>
<td>Admin</td>
<td>Identifies the desired state of the port.</td>
</tr>
<tr>
<td>Oper</td>
<td>Identifies the actual state of the port.</td>
</tr>
<tr>
<td>IfcType</td>
<td>Identifies the interface type used by the call.</td>
</tr>
<tr>
<td>IfcNo</td>
<td>Identifies the Ethernet interface used by the call. Valid options are: 0 (ELAN), 1 (CLAN).</td>
</tr>
<tr>
<td>MTUlen</td>
<td>Identifies the Maximum Transmission Unit for this interface.</td>
</tr>
<tr>
<td>Speed</td>
<td>Identifies the data rate of this interface.</td>
</tr>
<tr>
<td>In - Octet</td>
<td>Identifies the number of inbound bytes.</td>
</tr>
<tr>
<td>UPkts</td>
<td>Identifies the number of inbound packets sent only to this recipient.</td>
</tr>
<tr>
<td>MPkts</td>
<td>Identifies the number of inbound packets sent to multiple recipients.</td>
</tr>
<tr>
<td>Disc</td>
<td>Identifies the number of packets discarded by the interface.</td>
</tr>
<tr>
<td>Err</td>
<td>Identifies the number of error packets received by the interface.</td>
</tr>
<tr>
<td>Column</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>------------------------------------------------------------</td>
</tr>
<tr>
<td>Out - Octet</td>
<td>Identifies the number of outbound bytes.</td>
</tr>
<tr>
<td>UPkts</td>
<td>Identifies the number of outbound packets sent only to this recipient.</td>
</tr>
<tr>
<td>MPkts</td>
<td>Identifies the number of outbound packets sent to multiple recipients.</td>
</tr>
<tr>
<td>Disc</td>
<td>Identifies the number of outbound packets discarded by the interface due to resource problems.</td>
</tr>
<tr>
<td>Err</td>
<td>Identifies the number of outbound packets discarded due to errors.</td>
</tr>
<tr>
<td>QLen</td>
<td>Identifies the number of bytes in the interface’s outbound queue.</td>
</tr>
</tbody>
</table>
BRI Statistics screen

The BRI Statistics screen allows you to see the operational BRI channels and the cross connections between those channels and telephone sets.

Getting there 9150 ➔ Configuration Manager

To display the BRI statistics

1. From the menu, choose Alarms/Stats/Logs ➔ BRI Statistics.
   Result: The BRI Statistics screen appears.

2. Wait while Configuration Manager gathers statistics from the Remote Office 9150 unit’s system logs.
   Result: The statistics appear. The following is an example.
3 Do one of the following:
   - To refresh the statistics, click Refresh.
   - To close the statistics screen, click Close.

BRI Statistics field descriptions

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Module Index</td>
<td>Identifies the port on which the call was made. Valid options are: 0-63.</td>
</tr>
<tr>
<td>Module Number</td>
<td>Identifies the module position of the ISDN BRI module. 9150 valid options are: 4, 5, 6 and 7.</td>
</tr>
<tr>
<td>Device Number</td>
<td>Identifies internal sequence number for indexing ISDN BRI devices.</td>
</tr>
<tr>
<td>In Service</td>
<td>Indicates successful initialization of the ISDN BRI module.</td>
</tr>
<tr>
<td>Usage</td>
<td>Bit-encoded field identifying the module as an ISDN BRI module.</td>
</tr>
<tr>
<td>Total Channels</td>
<td>Identifies the ISDN BRI module’s working and non-working channels.</td>
</tr>
<tr>
<td>Available Channels</td>
<td>Identifies the working channels on the ISDN BRI module.</td>
</tr>
<tr>
<td>Cross Connect Type</td>
<td>Identifies the cross-connect type used by the ISDN BRI module. Valid options are: DS30X, AMB, REG and VHD.</td>
</tr>
</tbody>
</table>
Local Call Statistics screen

The Local Call Statistics screen allows you to see how many local calls were processed by the Remote Office 9150 unit, and how long they lasted. Use this statistics log to determine how much traffic is being processed through the local PSTN.

Getting there 9150 ➔ Configuration Manager

To display the local call statistics

1. From the menu, choose Alarms/Stats/Logs ➔ Local Call Stats.
   Result: The Local Call Statistics screen appears.

2. Wait while Configuration Manager gathers statistics from the Remote Office 9150 unit’s system logs.
   Result: The statistics appear. The following is an example.

3. Do one of the following:
To refresh the statistics, click Refresh.
To close the statistics screen, click Close.

Local Call Statistics field descriptions

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port No.</td>
<td>Identifies the Remote Office 9150 port through which the call was processed.</td>
</tr>
<tr>
<td>Call Start Time</td>
<td>Identifies the time when the call started.</td>
</tr>
<tr>
<td>Call Duration</td>
<td>Identifies the length of the call.</td>
</tr>
</tbody>
</table>
Remote Call Statistics screen

The Remote Call Statistics screen allows you to see how many calls were processed by the Remote Office 9150 unit through the host PBX, and how long they lasted. Use this statistics log to determine how much traffic is being processed through the host PBX.

Getting there 9150 ➝ Configuration Manager

To display the remote call statistics

1. From the menu, choose Alarms/Stats/Logs ➝ Remote Call Stats.
   Result: The Remote Call Statistics screen appears.

2. Wait while Configuration Manager gathers statistics from the Remote Office 9150 unit’s system logs.
   Result: The statistics appear. The following is an example.

3. Do one of the following:
To refresh the statistics, click Refresh.
To close the statistics screen, click Close.

### Remote Call Statistics field descriptions

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ROU (Remote Office Unit) Port No.</td>
<td>Identifies the Remote Office 9150 port through which the call was processed.</td>
</tr>
<tr>
<td>Connection ID</td>
<td>A sequential number used for tracking individual calls.</td>
</tr>
<tr>
<td>RLC ID</td>
<td>Identifies the board ID of the RLC that processed the call.</td>
</tr>
<tr>
<td>RLC Port No</td>
<td>Identifies the RLC port that processed the call.</td>
</tr>
<tr>
<td>RCM Callback pointer</td>
<td>Identifies the internal program routine used.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This information is for technical support use only.</td>
</tr>
<tr>
<td>DSP Callback pointer</td>
<td>Identifies the internal program routine used.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This information is for technical support use only.</td>
</tr>
<tr>
<td>Call Start Time</td>
<td>Identifies when the call began.</td>
</tr>
<tr>
<td>Duration</td>
<td>Identifies how long the call lasted.</td>
</tr>
</tbody>
</table>
Device Information screen

Device Information Statistics screens allows you to see all telephones on the Remote Office 9150 unit, their capability and current status.

Getting there  9150 ➝ Configuration Manager

To display device information

1. From the menu, choose Alarms/Stats/Logs ➝ Device Information.
   Result: The Device Information screen appears.

2. Wait while Configuration Manager gathers statistics from the Remote Office 9150 unit’s system logs.
   Result: The statistics appear. The following is an example.
Do one of the following:
- To refresh the statistics, click Refresh.
- To close the statistics screen, click Close.

**Device Information field descriptions**

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port Number</td>
<td>Identifies the RLC port number to which the displayed information pertains.</td>
</tr>
<tr>
<td>Type</td>
<td>Identifies the port type. Valid options are: Remote, Data, or Local TCM.</td>
</tr>
<tr>
<td>Device Type</td>
<td>Identifies whether the telephone connection on the port identified above is Normal or ACD. Valid options are: Normal and ACD.</td>
</tr>
<tr>
<td>Call Status</td>
<td>Identifies whether the port is currently handling a call. Valid options are: Busy and Idle.</td>
</tr>
<tr>
<td>Login Status</td>
<td>Identifies whether the telephone connected to this port is active on the system. Valid options are: Logged on and Logged off.</td>
</tr>
</tbody>
</table>

**Note:** This statistic applies only to ports to which ACD telephones connect.
ISDN Module Information screen

The ISDN Module Information statistics screen provides information about the ISDN BRI line. In particular you can use this statistics screen to determine if the BRI line is currently in use and the status of the link.

Getting there  9150 → Configuration Manager

To display ISDN module information

1. From the menu, choose Alarms/Stats/Logs → ISDN Module Information.
   Result: The ISDN Module Information screen appears.

2. Wait while Configuration Manager gathers statistics from the Remote Office 9150 unit’s system logs.
   Result: The statistics appear. The following is an example.
3 Do one of the following:
   - To refresh the statistics, click Refresh.
   - To close the statistics screen, click Close.

**ISDN Module Information field descriptions**

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Module Number</td>
<td>Identifies the module position of the ISDN BRI module. 9150 valid options are: 4, 5, 6 and 7.</td>
</tr>
<tr>
<td>Module Type</td>
<td>Identifies the type of the ISDN BRI module. Valid options are: BRI-U, BRI-ST and INVALID.</td>
</tr>
<tr>
<td>Link Status</td>
<td>Identifies the current status of the ISDN BRI line. Valid options are: UP, DOWN, and INVALID.</td>
</tr>
<tr>
<td>Usage</td>
<td>Identifies whether the ISDN BRI line is in use or not. Valid options are: IDLE and ACTIVE.</td>
</tr>
</tbody>
</table>
Network Statistics screen

Network Statistics allow you to see the performance over the last 24 hours of the remote units connected to the logged-on RLC. Use these statistics to identify periods when other network activity can adversely affect Remote Office system performance. This screen shows remote unit performance in terms of the transmission and reception of frames and packets.

Getting there  9150 → Configuration Manager

To display network statistics

1. From the menu, choose Alarms/Stats/Logs → Network Statistics.

Result: The Network Statistics screen appears.
2 Wait while Configuration Manager gathers statistics from the Remote Office 9150 unit’s system logs.

Result: The statistics appear. The following is an example.

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hour</td>
<td>Identifies the hour that the statistics on that line apply to. These numbers refer to the most recent 24 hours, such that “1” refers to one hour ago, “2” refers to two hours ago, and so on.</td>
</tr>
<tr>
<td>Column</td>
<td>Description</td>
</tr>
<tr>
<td>----------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Tx Frames</td>
<td>Identifies the number of frames transmitted in the given hour.</td>
</tr>
<tr>
<td>Rx Frames</td>
<td>Identifies the number of frames received in the given hour.</td>
</tr>
<tr>
<td>Rx Error</td>
<td>Identifies the number of frames received in the given hour with an error.</td>
</tr>
<tr>
<td>Rx Dropped</td>
<td>Identifies the number of received frames that the Remote Office system dropped in the given hour.</td>
</tr>
<tr>
<td>Error %</td>
<td>Identifies the percentage of frames received in the given hour with an error.</td>
</tr>
<tr>
<td>BroadCast Packet</td>
<td>Identifies the number of packets broadcast, or sent to all addresses on the network, by this unit in the given hour.</td>
</tr>
<tr>
<td>Tx UCastPkt</td>
<td>Identifies the number of packets unicast, or sent to one specific address, by this unit in the given hour.</td>
</tr>
<tr>
<td>Tx DiscPkt</td>
<td>Identifies the number of packets discarded by this unit in the given hour.</td>
</tr>
<tr>
<td>Rx MultiPkt</td>
<td>Identifies the number of packets received by this unit that were sent to multiple addresses in the given hour.</td>
</tr>
<tr>
<td>Rx UCastPkt</td>
<td>Identifies the number of packets received by this unit that were sent only to this unit in the given hour.</td>
</tr>
<tr>
<td>Rx DiscPkt</td>
<td>Identifies the number of received packets that were discarded by this unit in the given hour.</td>
</tr>
</tbody>
</table>
Section D: Performing upgrades

In this section

Verifying the firmware and software version 310
Obtaining the latest upgrade file 312
Extracting upgrade files from the download file 313
Performing a firmware upgrade 315
Performing a software upgrade 320
Verifying the firmware and software version

This section describes how to determine the version of firmware and software currently installed.

Before you perform a firmware or software upgrade, you should determine what version is currently installed. This ensures that you do not replace the installed firmware or software with an older version.

To verify the software version

From the menu, choose Help ➔ About Configuration Manager.

Result: The following dialog box appears:

![About Configuration Manager](image)

Warning: This computer program is protected by copyright law and international treaties. Unauthorized reproduction or distribution of this program, or any portion of it, may result in severe civil and criminal penalties, and will be prosecuted to the maximum extent possible under the law.
To verify the firmware version

1. From the menu, choose System Information → System Data.
2. The System Configuration Details screen appears.

3. Review the Firmware Version box. This identifies the version of firmware installed on the unit.

To determine the current firmware and software versions

To determine the current firmware and software versions, refer to the Remote Office and RLC Release Notes (NTP 555-8421-102).
Obtaining the latest upgrade file

If you need to upgrade the firmware or software, you can obtain the latest upgrade files by clicking on the Customer Support and Software Distribution links at the following website:

www.nortelnetworks.com

Nortel Networks provides upgrade files in self-extracting executable files. You must extract the upgrade files before you can perform the upgrade.

Types of upgrades

There are two types of upgrades that can be performed for your Remote Office 9150 unit:

- Configuration Manager software upgrade
- firmware upgrades
  - Remote Office 9150 motherboard firmware
    
    **Note:** This includes any firmware updates that have been made for DSP application modules.
  - trunk interface module firmware

The firmware contains the code necessary for operating the Remote Office 9150 unit.

To download the upgrade file

2. Locate the software and firmware you need.
3. Download the files into a temporary location on your PC.
4. Extract the files into a temporary location on your PC by double-clicking the .exe file.
5. Continue with “Extracting upgrade files from the download file” on page 313.
Extracting upgrade files from the download file

Before you perform an upgrade, ensure you have obtained the latest upgrade files from your Nortel Networks distributor. The upgrade files are enclosed in self-extracting executable files. You must extract the upgrade files before you can perform the upgrade.

To perform the extraction using Windows

1. Use Windows Explorer to navigate to the directory that contains the .exe file you received from Nortel Networks.
2. Locate and double-click the .exe file.

   Result: The WinZip Self-Extractor screen similar to the following opens.

3. Review the information presented and make changes as necessary.

   Notes:
   - It is recommended that you extract the files into a temporary directory.
   - If you specify a directory that does not exist, the WinZip Self-Extractor creates it.
4 Click Unzip.

Result: The file extraction begins. A status bar shows the extraction progress. When completed, a message similar to the following appears:

![WinZip Self-Extractor](image)

5 Click OK.


6 Click Close.
Performing a firmware upgrade

This section describes how to perform a firmware upgrade on your Remote Office 9150 unit. You perform the upgrade over the IP network using the TFTP protocol.

You must have a TFTP server application running on the administration PC. The TFTP server’s base directory must point to the directory that contains the upgrade files.

To ensure that the RLC and Remote Office 9150 unit do not experience communication problems during or after the firmware upgrade, Nortel Networks recommends that you perform the upgrades in the steps shown below.

1. Create backup files for the Remote Office 9150 unit and RLC configurations. Refer to “Creating a backup configuration file” on page 266.

2. Upgrade the Configuration Manager software.

3. Disable the slot in which the RLC is installed.

4. Upgrade the RLC firmware.

5. Upgrade the Remote Office 9150 unit firmware.

6. Upgrade the BRI module firmware for each BRI module on your Remote Office 9150 units.

7. Restart both units.

8. Re-enable the RLC slot.
When to perform a firmware upgrade

Perform a firmware upgrade if you have determined that you are using out-of-date firmware. For instructions on determining if you need to perform an upgrade, see “Verifying the firmware and software version” on page 310.

CAUTION
Risk of incorrect operation
You must ensure that the RLC’s firmware has been upgraded before you upgrade the Remote Office 9150 unit’s firmware. This ensures that communication problems between the RLC and Remote Office 9150 unit do not occur.

About firmware upgrades and configuration files
Each time you perform a firmware upgrade, the configuration database is also converted (if necessary) to a format that is compatible with the new firmware. Configuration settings are not affected by the conversion.

Nortel Networks recommends that, each time you perform a firmware upgrade, you create a backup copy of the converted configuration file, and store it in a safe secure location.

Before you begin

1. Obtain the firmware upgrade from Nortel Networks.
   For instructions, see “Obtaining the latest upgrade file” on page 312.
2. Extract the upgrade files from the file you received from Nortel Networks.
   For instructions, see “Extracting upgrade files from the download file” on page 313.
3. Start the TFTP server application.
4. Ensure the TFTP base directory reflects the directory where the firmware upgrade file you want to use is located.

Getting there  9150→ Configuration Manager
To upgrade the firmware

1. From the menu, choose Upload/Download → Upload S/W.
   Result: The Software Upload screen appears.

2. Do one of the following:

   IF you are upgrading motherboard firmware THEN in the Module section, click Application.

   ISDN BRI module firmware do the following:
   a. In the Module section, click ISDN.
   b. Enter the position on the motherboard where the ISDN BRI module is installed.
      Valid values: 4 through 7

3. Enter the IP address of the TFTP server into the IP Address boxes.
   Note: Since the TFTP server application is running on your administration PC, this is the IP address of the PC.
4 Click Browse.  
Result: The Open dialog box appears.

![](image)

5 Ensure the “Files of type” box shows Upgrade Files(*.UPG).
6 Navigate to the folder where the firmware file is located.
7 Select the file, and then click Open.

Examples:
- For motherboard firmware, select 9150-100.upg, and then click Open.
- For ISDN BRI module firmware, select briv15u.upg, and then click Open.

Result: You return to the Software Upload dialog box. The file you selected is shown in the Uploaded File box.

8 Click Upload.

Wait until the file uploads completely before entering any other commands. The Log Report box displays a confirmation message when the upgrade is completed.

9 Restart the Remote Office 9150 unit.
Performing a software upgrade

Perform a software upgrade if you have determined that you are using out-of-date software. For instructions on determining if you need to perform an upgrade, see “Verifying the firmware and software version” on page 310.

To upgrade the Configuration Manager software

1. Use Windows Explorer to navigate to the directory that contains the upgrade files you extracted.
2. Locate and double-click the setup.exe file.
3. Follow the prompts on the screen.

**ATTENTION**

Do not ignore any warning messages that the InstallShield displays about versions of files (such as DLL files) that already exist on your PC. If you overwrite these files, you can inadvertently cause other applications on your PC to stop working.

Result: The InstallShield installs the software on top of the previous version.
Chapter 8
Troubleshooting

In this chapter
Before you begin 322
Remote Office 9150 LEDs 323
Digital telephone 325
Device connectivity 330
Software problems 334
Using Configuration Manager’s Ping 336
Recovering from a catastrophic failure 339
Before you begin

If you experience problems in setting up or running your Remote Office 9150 unit, this chapter will help you to isolate and solve the problem.

Identifying why the problem occurred

Before you begin, ask yourself the questions listed in the following table:

<table>
<thead>
<tr>
<th>Question</th>
<th>IF you answered</th>
<th>THEN do the following:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Is this a new installation?</td>
<td>yes</td>
<td>Perform troubleshooting in the sequence presented in this chapter.</td>
</tr>
<tr>
<td></td>
<td>no</td>
<td>Answer the next question.</td>
</tr>
<tr>
<td>Did the Remote Office 9150 unit work, and then suddenly stop working?</td>
<td>yes</td>
<td>Answer the next question.</td>
</tr>
<tr>
<td></td>
<td>no</td>
<td>Perform troubleshooting in the sequence presented in this chapter.</td>
</tr>
<tr>
<td>Did you modify the configuration or change any hardware components?</td>
<td>yes</td>
<td>1 Verify that changes were done correctly.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2 Check the hardware components to ensure they are in working order.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3 Perform troubleshooting for the specific component.</td>
</tr>
<tr>
<td></td>
<td>no</td>
<td>Contact your telecom or data network administrator. There might be a problem with the network.</td>
</tr>
</tbody>
</table>
Remote Office 9150 LEDs

During a Remote Office 9150 unit power-up cycle, watch the front panel of the Remote Office 9150 unit. The LEDs should appear as follows:

- The Power LED should light and remain lit.
- The Status LED should stay lit after the power-up cycle is completed. When the Status LED is lit all the time, the unit is healthy.
- The remaining LEDs flash whenever there is network activity.

What to do if the LEDs do not display correctly

The following table describes what to do if the LEDs do not display correctly:

<table>
<thead>
<tr>
<th>Symptom</th>
<th>What to do</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Status LED is not lit.</td>
<td>1  Did the Status LED ever illuminate? If not, contact your Nortel Networks distributor. There might be a hardware problem.</td>
</tr>
<tr>
<td></td>
<td>2  Are other LEDs lit or flashing? If no, ensure the power cable is connected to both the power source and the Remote Office 9150 unit. If it has become disconnected, reconnect it.</td>
</tr>
<tr>
<td></td>
<td>3  If the Status LED is still out, contact your Nortel Networks distributor. There might be a hardware problem.</td>
</tr>
<tr>
<td>No LEDs are lit on the Remote Office 9150 unit.</td>
<td>1  Ensure that the Remote Office 9150 unit is connected to a power source.</td>
</tr>
<tr>
<td></td>
<td>2  If you are using an uninterruptible power supply (UPS), ensure the UPS is powered on.</td>
</tr>
<tr>
<td></td>
<td>3  Verify that the AC power source is operational.</td>
</tr>
</tbody>
</table>
The Ethernet COLL LED is lit solid.

<table>
<thead>
<tr>
<th>Symptom</th>
<th>What to do</th>
</tr>
</thead>
<tbody>
<tr>
<td>Network collisions are bound to occur and are normal. However, if this LED is lit solid, do the following:</td>
<td></td>
</tr>
<tr>
<td>1 Check the physical network connection.</td>
<td></td>
</tr>
<tr>
<td>2 Verify that the Remote Office 9150 unit can be pinged.</td>
<td></td>
</tr>
<tr>
<td>3 Check the network configuration (such as routing, traffic load, and so on). Adjust the network configuration, if required.</td>
<td></td>
</tr>
<tr>
<td>4 There should be no broadcast or multicast activity on the telephony LAN (TLAN). Interconnect a hub and a network analyzer to the TLAN and monitor for such activity. Identify the source(s) and isolate them from the TLAN.</td>
<td></td>
</tr>
</tbody>
</table>
Digital telephone

This section identifies some problems that could occur on the digital telephone, and describes what to do to resolve them.

Symptom descriptions

If you are having trouble with digital telephones, perform troubleshooting as described in the following table:

<table>
<thead>
<tr>
<th>Symptom</th>
<th>What to do</th>
</tr>
</thead>
</table>
| There is no dial tone when pressing either the host call appearance or local call appearance keys. | 1  Is this a first-time installation? If yes, perform troubleshooting as described in “What to do if the telephone connection tests do not work” on page 140.  
2  If you are trying to make a host-controlled call, check the IP network and ensure that  
   ■ it is not down  
   ■ traffic is being routed between the Remote Office 9150 unit and RLC on the host PBX  
3  If you are trying to make a host- or locally controlled call, Ensure the ISDN BRI line is working. Ask your service provider to check this.  
4  Restart the RLC, wait one minute, and then restart the Remote Office 9150 unit.  
5  Ensure the RLC is enabled in its host PBX slot.  
   In Load 97 on the Meridian 1 PBX, stat the RLC, disable and enable it, or reseat it if necessary. |
<table>
<thead>
<tr>
<th>Symptom</th>
<th>What to do</th>
</tr>
</thead>
<tbody>
<tr>
<td>There is no dial tone when pressing either the host call appearance or local call appearance keys. (continued)</td>
<td>6 Contact your telecom administrator. There might be problems at the host PBX.</td>
</tr>
</tbody>
</table>
| Lamps or indicators are not lit after completion of a Remote Office 9150 unit power cycle. | 1 Check all cable connections to and from the Remote Office 9150 unit and ensure they are all securely connected.  
  2 Is this a first-time installation? If yes, check the telephone connections. Refer to the Telco 1 and Telco 2 cable pin-out tables in Appendix C, “Connection pin-out tables.”  
  3 Ensure the ISDN BRI line is working. Ask your service provider to check this.  
  4 Check the IP network and ensure that  
    ■ it is not down  
    ■ traffic is being routed between the Remote Office 9150 unit and RLC on the host PBX  
  5 Ping the RLC from the Remote Office 9150 unit to verify IP network connectivity. |
<p>| Lamps or indicators do not reflect the true status of the telephone.    | It is possible that there is a synchronization error between the Remote Office 9150 unit and the host PBX. Contact your telecom network administrator. |
| The display is blank (that is, the time and date are not displayed).     | 1 Take the digital telephone handset off hook and dial the Online SPRE code. The Remote Office 9150 unit attempts to connect to the host PBX. When the connection is established, the time and date appear. |</p>
<table>
<thead>
<tr>
<th>Symptom</th>
<th>What to do</th>
</tr>
</thead>
</table>
| The display is blank (that is, the time and date are not displayed).  | 2 Check the IP network and ensure that  
| (continued)                                                           |   ■ it is not down  
|                                                                       |   ■ traffic is being routed between the Remote Office 9150 unit and RLC on the host PBX  
|                                                                       | 3 Ping the RLC from the Remote Office 9150 unit to verify IP network connectivity.  
|                                                                       | 4 Ensure the ISDN BRI line is working. Ask your service provider to check this.  
|                                                                       | 5 Restart the RLC, wait one minute, and then restart the Remote Office 9150 unit.  
|                                                                       | 6 Ensure the RLC is enabled in its host PBX slot. In Load 97 on the Meridian 1 PBX, stat the RLC, disable and enable it, or reseat it if necessary.  
|                                                                       | 7 Contact your telecom administrator. There might be problems at the host PBX.  
| There are noticeable gaps or poor quality when a voice call is active  | 1 Check the Quality of Service configuration on the RLC. Adjust the configuration, if required. Lower the QoS threshold so that transition occurs earlier.  
| on the IP network.                                                     | 2 Conduct a traffic study on your voice and IP network traffic patterns as described in the Remote Office Network Engineering Guidelines (555-8421-230). It is possible that your IP network capacity cannot accommodate the additional voice data, especially during High Day Busy Hour (HDBH) periods. Make adjustments to your network as required. |
## Troubleshooting

<table>
<thead>
<tr>
<th>Symptom</th>
<th>What to do</th>
</tr>
</thead>
</table>
| **Incoming calls are not being received from the host PBX.** | 1  Ensure your telephone is not on call forward.  
2  Ensure the Remote Office 9150 unit is not in offline mode by entering the Online SPRE code at a digital telephone.  
3  Ensure the Remote Office 9150 unit is powered up. It cannot receive calls from the host PBX if it is not powered up.  
4  Ensure the RLC is correctly configured with your Remote Office 9150 unit’s IP address, telephone number, and security ID (if they are used).  
5  Ensure the ISDN BRI line is working, if it is being used to route host-controlled calls. Ask your service provider to check this.  
6  Check the IP network (if it is being used) and ensure that  
  - it is not down  
  - traffic is being routed between the Remote Office 9150 unit and RLC on the host PBX  
7  Ping the RLC from the Remote Office 9150 unit to verify IP network connectivity.  
8  If the problem persists, contact your telecom administrator or Nortel Networks distributor. |
| **Incoming calls are not being received from the PSTN.** | 1  Ensure your telephone is not on call forward.  
2  Ensure the calling party has your office’s correct telephone number.  
3  Ensure the Remote Office 9150 unit is powered up. It cannot receive calls from the host PBX or the PSTN if it is not powered up. |
### Troubleshooting

<table>
<thead>
<tr>
<th>Symptom</th>
<th>What to do</th>
</tr>
</thead>
</table>
| Incoming calls are not being received from the PSTN. (continued) | 4 Ensure the ISDN BRI line is working. Ask your service provider to check this.  
5 If the problem persists, contact your telecom administrator or Nortel Networks distributor. |
| A call in progress was suddenly disconnected.                | 1 Does your telephone display “Offline Mode?”  
If so, enter the Online SPRE code to go back online.  
2 Contact your telecom and data network administrators. Perhaps network problems caused the call to drop. |
Device connectivity

This section identifies some problems that can occur on the data network, and describes what to do to resolve them.

Symptom descriptions

If you are not able to establish or maintain data network connectivity, perform troubleshooting as described in the following table.

**Note:** To enable valid loopback testing of serial ports and cables, Nortel Networks recommends that you use a breakout box.

<table>
<thead>
<tr>
<th>Symptom</th>
<th>What to do</th>
</tr>
</thead>
</table>
| SERIAL CONNECTION FAILED appears when attempting to connect to the Remote Office 9150 unit. | 1 Ensure that you entered the logon ID and password correctly when trying to establish the connection.  
2 Ensure that someone else is not already logged on to the Remote Office 9150 unit.  
3 Ensure that you selected the correct COM port when trying to establish the connection.  
4 Verify that no other applications on the administration PC are using the COM port.  
5 Verify that the serial connection is good.  
6 Using a breakout box, verify that the COM port is active.  
7 Ensure the Remote Office 9150 unit is powered up.  
8 Power the Remote Office 9150 unit off, and then back on.  
9 Contact your Nortel Networks distributor. There might be a hardware problem. |
<table>
<thead>
<tr>
<th>Symptom</th>
<th>What to do</th>
</tr>
</thead>
</table>
| 10060 TELNET CONNECTION FAILED appears when attempting to connect to the Remote Office 9150 unit. | 1 Ensure that you entered the logon ID and password correctly when trying to establish the connection.  
2 Ensure that you entered the IP address correctly when trying to establish the connection.  
3 Ensure that someone else is not already logged on to the Remote Office 9150 unit.  
4 Verify that the Ethernet cable is connected at both ends (the Remote Office 9150 unit and the network hub).  
5 Check the Ethernet cable and ensure it is good.  
6 Ensure the Remote Office 9150 unit is powered up.  
7 Power the Remote Office 9150 unit off, and then back on.  
8 Ensure the Remote Office 9150 unit’s IP address, network mask, and default gateway are correctly configured in the Remote Office 9150 unit.  
9 Ping the Remote Office 9150 unit to see if it responds.  
10 If the Remote Office 9150 unit does not respond, ping the Remote Office 9150 unit’s gateway to see if it responds.  
11 If the gateway does not respond, ping a known good device on the Remote Office 9150 unit’s network.  
12 If steps 10 and 11 work, but step 9 did not, there might be a gateway configuration error. Contact your data network administrator.  
13 Contact your Nortel Networks distributor. There might be a hardware problem. |
There are many collisions on the Ethernet network, as indicated by a solid Ethernet COLL LED.

Network collisions are bound to occur and are normal. However, if this LED is lit solid, do the following:

1. Check the physical network connection.
2. Verify that the Remote Office 9150 unit can be pinged.
3. Check the network configuration (such as routing, traffic load, and so on). Adjust the network configuration, if required.
4. There should be no broadcast or multicast activity on the TLAN. Interconnect a hub and a network analyzer to the TLAN and monitor for such activity. Identify the source(s) and isolate them from the TLAN.

The Remote Office 9150 unit will not send or receive Ethernet traffic.

1. Ensure that the Remote Office 9150 unit is powered up. The Remote Office 9150 unit cannot send or receive traffic if it is not powered up.
2. Check the Ethernet cable between the Remote Office 9150 unit and the network, and ensure that it is good.
3. Ensure the Ethernet cable is connected.
4. If the Remote Office 9150 unit still will not send or receive traffic, contact your data network administrator.
5. Data network administrator: Ensure that other network devices are configured to allow traffic to and from the Remote Office 9150 unit.

An attempt to log off from the Remote Office 9150 unit does not work.

It is possible that communication has been lost between the administration PC and the Remote Office 9150 unit.

Close Configuration Manager, and then restart it.
The Remote Office 9150 unit cannot establish a connection with the RLC.

<table>
<thead>
<tr>
<th>Symptom</th>
<th>What to do</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Verify security authentication configuration and ensure that it matches at both ends. (For example, if the security identifier security level is used, ensure that the inbound and outbound security identifiers are correctly configured at each end.)</td>
<td></td>
</tr>
<tr>
<td>2. Ensure that the unit IDs have been correctly configured at each end. An incorrect unit ID causes security authentication to fail.</td>
<td></td>
</tr>
<tr>
<td>3. Ensure that the RLC’s IP address and PSTN number are correctly configured on the Remote Office 9150 unit (as appropriate).</td>
<td></td>
</tr>
<tr>
<td>4. Verify that the IP network and PSTN are operational (up and running) as appropriate.</td>
<td></td>
</tr>
<tr>
<td>5. Ensure that the RLC is enabled on the host PBX.</td>
<td></td>
</tr>
<tr>
<td>6. Use the Ping option in Configuration Manager to ping the RLC. For instructions, see “Using Configuration Manager’s Ping” on page 336.</td>
<td></td>
</tr>
<tr>
<td>7. If the RLC does not respond, check the network configuration (such as, routing, traffic load, and so on). Adjust the network configuration, if required.</td>
<td></td>
</tr>
</tbody>
</table>
Software problems

This section identifies some problems that can occur with the Configuration Manager software, and describes what to do to resolve them.

Symptom descriptions

If you are not able to complete a task with Configuration Manager, then perform troubleshooting as described in the following table:

<table>
<thead>
<tr>
<th>Symptom</th>
<th>What to do</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Configuration Manager software installation fails.</td>
<td>Ensure that you close all background applications, including anti-virus checking software before performing the installation.</td>
</tr>
<tr>
<td>When performing one of the following by TFTP, <strong>ERROR: FILE OPEN FAILED</strong> appears:</td>
<td>1. Ensure the TFTP server application is installed and running on your administration PC.</td>
</tr>
<tr>
<td>■ configuration upload</td>
<td>2. Ensure the file you are trying to upload is present in the target directory. That is, either in the TFTP directory, or in the directory that is specified as the base directory in the TFTP server application.</td>
</tr>
<tr>
<td>■ firmware upgrade</td>
<td>3. Review messages displayed by the TFTP server application for clues.</td>
</tr>
<tr>
<td>CONFIG UPLOAD FAILED when attempting to perform a configuration upload by TFTP.</td>
<td>4. Ping the Remote Office 9150 unit to verify that network connectivity exists.</td>
</tr>
</tbody>
</table>
### Troubleshooting

<table>
<thead>
<tr>
<th>Symptom</th>
<th>What to do</th>
</tr>
</thead>
<tbody>
<tr>
<td>CONFIG UPLOAD FAILED when attempting to perform a configuration upload by TFTP. (continued)</td>
<td>2 Ensure that the configuration file you are attempting to upload is compatible with current firmware.</td>
</tr>
<tr>
<td></td>
<td>Perform the configuration upload using a previous configuration file, if necessary.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Each time you perform a firmware upgrade, you should also create a backup of the configuration. The configuration database format in the Remote Office 9150 unit is dependent on the version of firmware installed. If you recently downgraded to a previous version of firmware, you might also need to revert to a previous configuration format.</td>
</tr>
<tr>
<td>System not responding appears when working with Configuration Manager.</td>
<td>It is possible that communication has been lost between the administration PC and the Remote Office 9150 unit.</td>
</tr>
<tr>
<td></td>
<td>Close Configuration Manager, and then restart it.</td>
</tr>
<tr>
<td>Nothing happens when attempting to log off from the Remote Office 9150 unit.</td>
<td>It is possible that communication has been lost between the administration PC and the node to which you were logged on.</td>
</tr>
<tr>
<td></td>
<td>Close Configuration Manager, and then restart it.</td>
</tr>
</tbody>
</table>
Using Configuration Manager’s Ping

This section explains how to use the Ping option provided in Configuration Manager to verify network connectivity. Use this test as a troubleshooting tool to determine if you can reach the RLC, another remote unit, or any other device on the network.

Getting there  9150 ➔ Configuration Manager

To perform a Configuration Manager ping

1. From the menu, choose Tests ➔ Ping.
   Result: The PING Test dialog box appears.

   ![PING Test dialog box]

2. Enter the IP Address of the unit you want to ping.
3. In the Number of Cycles box, enter the number of times you want to ping the unit.
   The number must be in the range of 1–100.
4  Click OK.

Result: The PING test results screen appears, showing the ping results. The following is an example of a successful ping:

![Successful Ping Test]

The following is an example of an unsuccessful ping:

![Unsuccessful Ping Test]

5  Click Close.

Result: The Ping test screen closes.
What to do if the ping did not work

1. Ensure that you entered the IP address correctly.
2. Ensure that the subnet mask and default gateway are properly configured on the device you are pinging.
   Confirm this by viewing the IP Configuration property sheet for the device.
3. Ping the device's gateway.
4. If the gateway does not respond, ping a known good device on the device’s network.
5. Contact your data network administrator. There may be a configuration error elsewhere on the network.
Recovering from a catastrophic failure

For the purposes of this discussion, a *catastrophic failure* is defined as a failure of the equipment to operate.

Inoperative hardware

If your Remote Office 9150 unit fails to operate, consult with your Nortel Networks distributor for hardware replacement.
Appendix A

Planning forms

In this appendix
Overview 342
Completing the Remote Office 9150 forms 344
Overview

This appendix provides several forms that you can use to plan and record the various data necessary for proper configuration of a Remote Office 9150 unit at your site.

Note: RLC forms are provided in the Reach Line Card Installation and Administration Guide (NTP 555-8421-210).

Network planning

To help you plan your Remote Office network, study the network diagram and sample configurations provided in Appendix B, “Sample configuration files.” The information provided in this appendix demonstrates the relationships between RLC and Remote Office 9150 configuration settings.

Remote Office 9150 forms

Use the Remote Office 9150 forms to record information and calculate needed resources for a Remote Office 9150 unit. For more information about using these forms, see “Planning the configuration” on page 87.

Data entry form completion sequence

Information from some forms might need to be copied to other forms. Generally, you should complete the data entry forms in the following sequence:

1. Remote Office 9150 Configuration Information—Stations form
2. Reach Line Card Connection Information (for either the 16-port or 32-port RLC)
3. Remote Office 9150 Configuration Information—Network Connections form
4. Remote Office 9150 Configuration Information—ISDN BRI Modules form
5. Remote Office 9150 Configuration Information—Dialing Plans form
6. Reach Line Card Online/Offline Table Configuration (if required)

For more details, see “Completing the Remote Office 9150 forms” on page 344.
Completing the Remote Office 9150 forms

This section briefly describes how to complete the Remote Office 9150 configuration forms.

To complete the forms

1. Assign each user telephone or fax machine to a port on the Remote Office 9150 unit.
   Record the assignments on the Remote Office 9150 Configuration Information—Stations form. Designate each port as a local port, remote port, or local and remote port.

2. Use the information you received from the ISDN service provider for the Remote Office 9150 site to complete the Remote Office 9150 Configuration Information—ISDN BRI Modules form.
   At the same time, do the following:
   a. Designate a B-channel as a primary trunk. The Remote Office 9150 unit uses primary trunk to establish connections between the Remote Office 9150 unit and the RLC.
      Note: The primary trunk on the Remote Office 9150 unit is defined as follows:
      - the lowest-numbered B-channel defined as Remote only
      - the lowest-numbered B-channel defined as Local and Remote
      Do not include the primary trunk in any trunk groups. Nortel Networks recommends that you define the primary trunk as Remote only.
      Record the primary trunk assignment in the “Connection to RLC information” section on the Remote Office 9150 Configuration Information—Network Connections form.
   b. Assign B-channels to trunk groups. Record the assignments on the ISDN BRI Modules form.
3 Assign an IP address, subnet mask, and gateway to the Remote Office 9150 unit. This information is required if you want to administer the Remote Office 9150 unit over the IP network.

Record the addresses in the “Remote Office 9150 unit identification” section on the Remote Office 9150 Configuration Information—Network Connections form.

4 If the security level chosen is security code, record the security identifier assigned to the Remote Office 9150 unit.

5 In the “Connection to RLC information” section on the Remote Office 9150 Configuration Information—Network Connections form, record the RLC’s
   - IP address
   - telephone number
   - security code

The Remote Office 9150 unit uses this information to establish and authenticate connections with the RLC.

6 If an online/offline table is configured on the RLC, configure the SPRE codes for toggling the online/offline modes on the Remote Office 9150 unit.

Note: This step is optional, because default SPRE codes have already been defined in the software (as indicated on the Remote Office 9150 Configuration Information—Dialing Plans form).

If you choose to change the code, record the new code on the Dialing Plans form.

7 Define the trunk access and Paging SPRE codes.

Trunk access codes are used by Remote Office 9150 unit users to get outside lines.

Note: Default trunk access digits and paging SPRE codes have already been defined. Nortel Networks recommends that you use the defaults.

If you choose to change the predefined codes, record them on the Remote Office 9150 Configuration Information—Dialing Plans form. Also, record the trunk access codes (as required) on the ISDN BRI Modules form.
Remote Office 9150  
Configuration Information—Stations

Notes:
- A maximum of seven MCAs and ATAs can be connected to digital telephones at this site.
- If you are connecting a fax machine or analog device that is not equipped with an ATA, it can be connected only to port 64. If you want to connect a fax machine or analog device to any other port, it must be equipped with an ATA.

<table>
<thead>
<tr>
<th>9150port #</th>
<th>Extension number (DN)</th>
<th>Type</th>
<th>If a remote port, host port number (TN)</th>
<th>MCA or ATA?</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td></td>
<td></td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td>No</td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td>No</td>
</tr>
<tr>
<td>4</td>
<td></td>
<td></td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>5</td>
<td></td>
<td></td>
<td></td>
<td>No</td>
</tr>
<tr>
<td>6</td>
<td></td>
<td></td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>7</td>
<td></td>
<td></td>
<td></td>
<td>No</td>
</tr>
<tr>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>9</td>
<td></td>
<td></td>
<td></td>
<td>No</td>
</tr>
<tr>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>11</td>
<td></td>
<td></td>
<td></td>
<td>No</td>
</tr>
<tr>
<td>12</td>
<td></td>
<td></td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>13</td>
<td></td>
<td></td>
<td></td>
<td>No</td>
</tr>
<tr>
<td>14</td>
<td></td>
<td></td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>15</td>
<td></td>
<td></td>
<td></td>
<td>No</td>
</tr>
<tr>
<td>16</td>
<td></td>
<td></td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>17</td>
<td></td>
<td></td>
<td></td>
<td>No</td>
</tr>
<tr>
<td>18</td>
<td></td>
<td></td>
<td></td>
<td>Yes</td>
</tr>
</tbody>
</table>

Remote Office 9150
Remote Office 9150  
Configuration Information—Stations  

Notes:
- A maximum of seven MCAs and ATAs can be connected to digital telephones at this site.
- If you are connecting a fax machine or analog device that is not equipped with an ATA, it can be connected only to port 64. If you want to connect a fax machine or analog device to any other port, it must be equipped with an ATA.

<table>
<thead>
<tr>
<th>9150 port #</th>
<th>Extension number (DN)</th>
<th>Type</th>
<th>If a remote port, host port number (TN)</th>
<th>MCA or ATA?</th>
</tr>
</thead>
<tbody>
<tr>
<td>19</td>
<td></td>
<td>[ ] Local [ ] Remote [ ] Both</td>
<td></td>
<td>[ ] Yes [ ] No</td>
</tr>
<tr>
<td>20</td>
<td></td>
<td>[ ] Local [ ] Remote [ ] Both</td>
<td></td>
<td>[ ] Yes [ ] No</td>
</tr>
<tr>
<td>21</td>
<td></td>
<td>[ ] Local [ ] Remote [ ] Both</td>
<td></td>
<td>[ ] Yes [ ] No</td>
</tr>
<tr>
<td>22</td>
<td></td>
<td>[ ] Local [ ] Remote [ ] Both</td>
<td></td>
<td>[ ] Yes [ ] No</td>
</tr>
<tr>
<td>23</td>
<td></td>
<td>[ ] Local [ ] Remote [ ] Both</td>
<td></td>
<td>[ ] Yes [ ] No</td>
</tr>
<tr>
<td>24</td>
<td></td>
<td>[ ] Local [ ] Remote [ ] Both</td>
<td></td>
<td>[ ] Yes [ ] No</td>
</tr>
<tr>
<td>25</td>
<td></td>
<td>[ ] Local [ ] Remote [ ] Both</td>
<td></td>
<td>[ ] Yes [ ] No</td>
</tr>
<tr>
<td>26</td>
<td></td>
<td>[ ] Local [ ] Remote [ ] Both</td>
<td></td>
<td>[ ] Yes [ ] No</td>
</tr>
<tr>
<td>27</td>
<td></td>
<td>[ ] Local [ ] Remote [ ] Both</td>
<td></td>
<td>[ ] Yes [ ] No</td>
</tr>
<tr>
<td>28</td>
<td></td>
<td>[ ] Local [ ] Remote [ ] Both</td>
<td></td>
<td>[ ] Yes [ ] No</td>
</tr>
<tr>
<td>29</td>
<td></td>
<td>[ ] Local [ ] Remote [ ] Both</td>
<td></td>
<td>[ ] Yes [ ] No</td>
</tr>
<tr>
<td>30</td>
<td></td>
<td>[ ] Local [ ] Remote [ ] Both</td>
<td></td>
<td>[ ] Yes [ ] No</td>
</tr>
<tr>
<td>31</td>
<td></td>
<td>[ ] Local [ ] Remote [ ] Both</td>
<td></td>
<td>[ ] Yes [ ] No</td>
</tr>
</tbody>
</table>

Use ports 32 through 63 only if this Remote Office 9150 unit connects to a 2-slot RLC on the host PBX.

| 32          |                       | [ ] Local [ ] Remote [ ] Both |                       | [ ] Yes [ ] No |
| 33          |                       | [ ] Local [ ] Remote [ ] Both |                       | [ ] Yes [ ] No |
| 34          |                       | [ ] Local [ ] Remote [ ] Both |                       | [ ] Yes [ ] No |
| 35          |                       | [ ] Local [ ] Remote [ ] Both |                       | [ ] Yes [ ] No |

Installation and Administration Guide  347
**Remote Office 9150**  
**Configuration Information—Stations**

**Notes:**
- A maximum of seven MCAs and ATAs can be connected to digital telephones at this site.
- If you are connecting a fax machine or analog device that is not equipped with an ATA, it can be connected only to port 64. If you want to connect a fax machine or analog device to any other port, it must be equipped with an ATA.

<table>
<thead>
<tr>
<th>9150 port #</th>
<th>Extension number (DN)</th>
<th>Type</th>
<th>If a remote port, host port number (TN)</th>
<th>MCA or ATA?</th>
</tr>
</thead>
<tbody>
<tr>
<td>36</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>37</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>38</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>39</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>40</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>41</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>42</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>43</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>44</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>45</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>46</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>47</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>48</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>49</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>50</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>51</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>52</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>53</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Remote Office 9150
Configuration Information—Stations

Notes:
- A maximum of seven MCAs and ATAs can be connected to digital telephones at this site.
- If you are connecting a fax machine or analog device that is not equipped with an ATA, it can be connected only to port 64. If you want to connect a fax machine or analog device to any other port, it must be equipped with an ATA.

<table>
<thead>
<tr>
<th>9150 port #</th>
<th>Extension number (DN)</th>
<th>Type</th>
<th>If a remote port, host port number (TN)</th>
<th>MCA or ATA?</th>
</tr>
</thead>
<tbody>
<tr>
<td>54</td>
<td>Local</td>
<td>Remote</td>
<td>Both</td>
<td>Yes</td>
</tr>
<tr>
<td>55</td>
<td>Local</td>
<td>Remote</td>
<td>Both</td>
<td>No</td>
</tr>
<tr>
<td>56</td>
<td>Local</td>
<td>Remote</td>
<td>Both</td>
<td>Yes</td>
</tr>
<tr>
<td>57</td>
<td>Local</td>
<td>Remote</td>
<td>Both</td>
<td>No</td>
</tr>
<tr>
<td>58</td>
<td>Local</td>
<td>Remote</td>
<td>Both</td>
<td>Yes</td>
</tr>
<tr>
<td>59</td>
<td>Local</td>
<td>Remote</td>
<td>Both</td>
<td>No</td>
</tr>
<tr>
<td>60</td>
<td>Local</td>
<td>Remote</td>
<td>Both</td>
<td>Yes</td>
</tr>
<tr>
<td>61</td>
<td>Local</td>
<td>Remote</td>
<td>Both</td>
<td>No</td>
</tr>
<tr>
<td>62</td>
<td>Local</td>
<td>Remote</td>
<td>Both</td>
<td>Yes</td>
</tr>
<tr>
<td>63</td>
<td>Local</td>
<td>Remote</td>
<td>Both</td>
<td>No</td>
</tr>
<tr>
<td>64: FAX</td>
<td>Local</td>
<td>Remote</td>
<td>Both</td>
<td>Yes</td>
</tr>
</tbody>
</table>

Installation and Administration Guide 349
### Module 4

<table>
<thead>
<tr>
<th>ISDN line type (variant):</th>
<th>Switch type:</th>
</tr>
</thead>
<tbody>
<tr>
<td>B-channel 1 DN:</td>
<td>SPID:</td>
</tr>
<tr>
<td>__________________________</td>
<td>__________________________</td>
</tr>
<tr>
<td>Trunk group:</td>
<td>Trunk access code:</td>
</tr>
<tr>
<td>__________________________</td>
<td>__________________________</td>
</tr>
<tr>
<td>B-channel 2 DN:</td>
<td>SPID:</td>
</tr>
<tr>
<td>__________________________</td>
<td>__________________________</td>
</tr>
<tr>
<td>Trunk group:</td>
<td>Trunk access code:</td>
</tr>
<tr>
<td>__________________________</td>
<td>__________________________</td>
</tr>
</tbody>
</table>

### Module 5

<table>
<thead>
<tr>
<th>ISDN line type (variant):</th>
<th>Switch type:</th>
</tr>
</thead>
<tbody>
<tr>
<td>B-channel 1 DN:</td>
<td>SPID:</td>
</tr>
<tr>
<td>__________________________</td>
<td>__________________________</td>
</tr>
<tr>
<td>Trunk group:</td>
<td>Trunk access code:</td>
</tr>
<tr>
<td>__________________________</td>
<td>__________________________</td>
</tr>
<tr>
<td>B-channel 2 DN:</td>
<td>SPID:</td>
</tr>
<tr>
<td>__________________________</td>
<td>__________________________</td>
</tr>
<tr>
<td>Trunk group:</td>
<td>Trunk access code:</td>
</tr>
<tr>
<td>__________________________</td>
<td>__________________________</td>
</tr>
</tbody>
</table>
Remote Office 9150
Configuration Information—ISDN BRI Modules

Module 5 (continued)

<table>
<thead>
<tr>
<th>B-channel 2</th>
<th>DN:</th>
<th>SPID:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Connection type:
- Local
- Remote
- Local and Remote

Trunk group: ___________________________
Trunk access code: ___________________________

Module 6

ISDN line type (variant): ___________________________
Switch type: ___________________________

<table>
<thead>
<tr>
<th>B-channel 1</th>
<th>DN:</th>
<th>SPID:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Connection type:
- Local
- Remote
- Local and Remote

Trunk group: ___________________________
Trunk access code: ___________________________

<table>
<thead>
<tr>
<th>B-channel 2</th>
<th>DN:</th>
<th>SPID:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Connection type:
- Local
- Remote
- Local and Remote

Trunk group: ___________________________
Trunk access code: ___________________________
Module 7

<table>
<thead>
<tr>
<th>ISDN line type (variant):</th>
<th>Switch type:</th>
</tr>
</thead>
<tbody>
<tr>
<td>_________________________</td>
<td>_______________</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>B-channel 1</th>
<th>DN:</th>
<th>SPID:</th>
</tr>
</thead>
<tbody>
<tr>
<td>__________________</td>
<td></td>
<td>__________________</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Connection type:</th>
</tr>
</thead>
<tbody>
<tr>
<td>□ Local</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Trunk group:</th>
</tr>
</thead>
<tbody>
<tr>
<td>______________</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>B-channel 2</th>
<th>DN:</th>
<th>SPID:</th>
</tr>
</thead>
<tbody>
<tr>
<td>__________________</td>
<td></td>
<td>__________________</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Connection type:</th>
</tr>
</thead>
<tbody>
<tr>
<td>□ Local</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Trunk group:</th>
</tr>
</thead>
<tbody>
<tr>
<td>______________</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Trunk access code:</th>
</tr>
</thead>
<tbody>
<tr>
<td>__________________</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Trunk access code:</th>
</tr>
</thead>
<tbody>
<tr>
<td>__________________</td>
</tr>
</tbody>
</table>
Remote Office 9150
Configuration Information—Network Connections

Security level:  
☐ No security  ☐ Caller ID  ☐ Provision ID

Remote Office 9150 unit identification

Node number: ______________________  Node name: __________________________

IP address:  
Subnet mask:  
Default gateway:  

If the security level is Provision ID, what is the Remote Office 9150 unit’s security identifier?

Connection to RLC information

IP address to reach the host PBX (for IP network):

Telephone number to reach host PBX (for PSTN):  

If security level is Provision ID, what is the RLC’s security identifier?

Trunk dedicated as the primary trunk:

Note: Refer to the Remote Office 9150 Configuration Information—ISDN BRI Modules form.

<table>
<thead>
<tr>
<th>Module</th>
<th>☐ 4</th>
<th>☐ 5</th>
<th>☐ 6</th>
<th>☐ 7</th>
</tr>
</thead>
<tbody>
<tr>
<td>B-channel</td>
<td>☐ 1</td>
<td>☐ 2</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Notes:
- Nortel Networks recommends that you use the preconfigured default codes listed below.
- The pound sign (# in North America) is mandatory and is automatically preconfigured in Configuration Manager. The pound sign prevents conflicts with the dialing plan on the host PBX.
- You can dedicate all B-channels to one trunk group. You do not have to create a trunk group for each B-channel.

<table>
<thead>
<tr>
<th>Description</th>
<th>Default code</th>
<th>Your code (maximum of 3 digits)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Online SPRE code</td>
<td>#99</td>
<td>#</td>
</tr>
<tr>
<td>Offline SPRE code</td>
<td>#98</td>
<td>#</td>
</tr>
<tr>
<td>Paging SPRE code</td>
<td>#05</td>
<td>#</td>
</tr>
<tr>
<td>Local Calling SPRE code</td>
<td>#8</td>
<td>#</td>
</tr>
<tr>
<td>(for analog or ATA-equipped stations)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Registration SPRE code</td>
<td>#97</td>
<td>#</td>
</tr>
<tr>
<td>(for multi-user or dynamic pool ports only)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Deregistration SPRE code</td>
<td>#96</td>
<td>#</td>
</tr>
<tr>
<td>(for multi-user or dynamic pool ports only)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Access code for trunk group 1</td>
<td>#61</td>
<td>#</td>
</tr>
<tr>
<td>Access code for trunk group 2</td>
<td>#62</td>
<td>#</td>
</tr>
<tr>
<td>Access code for trunk group 3</td>
<td>#63</td>
<td>#</td>
</tr>
<tr>
<td>Access code for trunk group 4</td>
<td>#64</td>
<td>#</td>
</tr>
<tr>
<td>Access code for trunk group 5</td>
<td>#65</td>
<td>#</td>
</tr>
<tr>
<td>Access code for trunk group 6</td>
<td>#66</td>
<td>#</td>
</tr>
<tr>
<td>Access code for trunk group 7</td>
<td>#67</td>
<td>#</td>
</tr>
<tr>
<td>Access code for trunk group 8</td>
<td>#68</td>
<td>#</td>
</tr>
</tbody>
</table>
Remote Office 9150  
System expansion worksheet

Complete one worksheet for each Remote Office 9150 unit.

<table>
<thead>
<tr>
<th>Number of stations:</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1 How many digital telephones will be installed at the Remote Office 9150 site?</td>
<td></td>
</tr>
<tr>
<td>Note: A maximum of 32 digital telephones can be connected to the Remote Office 9150 unit.</td>
<td></td>
</tr>
<tr>
<td>___________</td>
<td></td>
</tr>
<tr>
<td>2 How many Analog Telephone Adapters (ATAs) will be installed?</td>
<td></td>
</tr>
<tr>
<td>___________</td>
<td></td>
</tr>
<tr>
<td>3 How many Meridian Communication Adapters (MCAs) will be installed?</td>
<td></td>
</tr>
<tr>
<td>___________</td>
<td></td>
</tr>
<tr>
<td>4 Add lines 1 and 2 together.</td>
<td></td>
</tr>
<tr>
<td>___________</td>
<td></td>
</tr>
<tr>
<td>Notes:</td>
<td></td>
</tr>
<tr>
<td>■ A maximum of four MCAs and ATAs can be installed when connecting the Remote Office 9150 unit to a 1-slot RLC. A maximum of seven MCAs and ATAs can be installed when connecting to a 2-slot RLC.</td>
<td></td>
</tr>
<tr>
<td>■ The total number of ATAs and digital telephones cannot exceed 32.</td>
<td></td>
</tr>
<tr>
<td>___________</td>
<td></td>
</tr>
<tr>
<td>5 Will a fax machine be used for faxes through the host PBX?</td>
<td></td>
</tr>
<tr>
<td>☐ Yes</td>
<td></td>
</tr>
<tr>
<td>☐ No</td>
<td></td>
</tr>
<tr>
<td>6 If line 5 is Yes, add 1 to line 4.</td>
<td></td>
</tr>
<tr>
<td>___________</td>
<td></td>
</tr>
<tr>
<td>Call blocking:</td>
<td></td>
</tr>
<tr>
<td>7 Do you want to implement call blocking? (Users will receive a fast busy signal when resources are not available.)</td>
<td></td>
</tr>
<tr>
<td>☐ Yes</td>
<td></td>
</tr>
<tr>
<td>☐ No</td>
<td></td>
</tr>
<tr>
<td>8 If line 7 is Yes, calculate the number of calls that can be active at one time.</td>
<td></td>
</tr>
<tr>
<td>Note: A conservative estimate of one call in three being blocked when no resources are available is recommended.</td>
<td></td>
</tr>
<tr>
<td>Multiply line 4 by your call blocking factor. For example, to calculate the number of simultaneous calls that can be supported at a 3:2 blocking ratio, multiply line 6 by 2/3 (0.666). If the result contains a fraction, round up to a whole number.</td>
<td></td>
</tr>
<tr>
<td>Line 6: ___________ x ___________ = _______________</td>
<td></td>
</tr>
<tr>
<td>If line 7 is No, the number of simultaneous calls is the same as the number of stations installed. (Record your response to line 6 here.)</td>
<td></td>
</tr>
<tr>
<td>___________</td>
<td></td>
</tr>
</tbody>
</table>
Remote Office 9150  
System expansion worksheet

Call routing:

9 How do you want to route host-controlled calls?
☐ IP network ☐ Circuit-switched network ☐ Both

Note: If you want to route host-controlled calls over both networks, then the QoS transitioning technology can be used.

10 If line 9 is Circuit-switched network or Both, do you want to support local-controlled calls through the circuit-switched network (that is, support local calling)? ☐ Yes ☐ No

Number of trunk interface modules needed for QoS transition support or routing calls over the circuit-switched network:
Note: If you are routing calls over the IP network only, skip this section.

11 If line 10 is No, enter 0.
If line 10 is Yes, how many simultaneous digital telephone or ATA local calls do you want to support?
Enter a value between 1–7.
Note: Only one active call per ISDN BRI B-channel is allowed in local-controlled mode because local calls are not compressed.

12 Calculate the number of B-channels required for simultaneous calls in host-controlled mode.

Each B-channel can support one MCA call, or up to eight simultaneous voice calls using G.729A compression (where each call is compressed to 8 Kbps). However, when using G.729A compression, the first B-channel can support only six simultaneous calls because 16 Kbps are required for transporting call signaling data for the entire Remote Office 9150 unit (and all of its connected stations) to the host PBX.

Line 3: ________ + ((#) of simultaneous calls: ________ * 8 Kbps) + 16 Kbps) / 64 = __________
Round up the result to a whole number. __________
Remote Office 9150
System expansion worksheet

<table>
<thead>
<tr>
<th>Number of trunk interface modules needed (continued):</th>
</tr>
</thead>
<tbody>
<tr>
<td>13 Calculate the number of B-channels required for both local- and host-controlled calls. Add lines 11 and 12. If the result is greater than 8, then call blocking must be implemented, or the number of simultaneous local calls must be reduced. Recalculate lines 8, 11, 12, and 13.</td>
</tr>
<tr>
<td>14 Calculate the number of trunk interface modules required for local calls. Divide line 13 by 2. If the result contains a fraction, round it up to the next whole number.</td>
</tr>
<tr>
<td>15 How many trunk interface modules are already installed in the Remote Office 9150 unit?</td>
</tr>
<tr>
<td>16 Calculate the number of trunk interface modules you need to purchase. Subtract line 15 from line 14. Note: A maximum of four trunk interface modules can be installed in the Remote Office 9150 unit.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Number of DSP application modules needed:</th>
</tr>
</thead>
<tbody>
<tr>
<td>17 Each DSP application module can support up to eight simultaneous calls over the IP network. Divide line 8 by 8, and then round up the result to a whole number.</td>
</tr>
<tr>
<td>18 Record the number of DSP application modules already installed. Note: The Remote Office 9150 unit ships from Nortel Networks with one DSP module already installed. Your response here must include that module.</td>
</tr>
<tr>
<td>19 Calculate how many DSP modules you need to purchase. Subtract line 18 from line 17. Note: A maximum of three DSP application modules can be installed in the Remote Office 9150 unit.</td>
</tr>
</tbody>
</table>
Appendix B

Sample configuration files

In this appendix

Example of a network ........................................ 360
Voice port configuration on the Meridian 1 PBX .......... 362
Data port configuration on the Meridian 1 PBX .......... 364
RLC configuration .............................................. 366
Remote Office 9150 unit .................................... 370
Example of a network

This section provides an example of a network diagram that shows one host site (RLC installed on the host PBX) and one Remote Office 9150 unit (with one user station). The purpose of this diagram is to demonstrate the relationship between configuration settings on each unit in the network.

Sample configuration printouts

Sample Meridian 1 PBX configuration printouts for the voice and data ports are provided as follows:
- voice port: on page 362
- data port: on page 364

Sample configuration printouts for the RLC and Remote Office 9150 unit are shown as follows:
- RLC: on page 366
- Remote Office 9150 unit: on page 370

Configuration recommendation

The quickest way to configure the RLC and Remote Office 9150 unit is to run the Configuration Wizard. For instructions, see “Using the Configuration Wizard to perform initial configuration” on page 124. For your reference, the Configuration Wizard screen examples are completed using the same information.

Note: The network diagram shows information that cannot be configured through the Configuration Wizard, such as the security identifiers. You must use Configuration Manager to complete the configuration.
Network diagram

Note: This diagram assumes that both the IP and PSTN are being used.

<table>
<thead>
<tr>
<th>IP Configuration</th>
<th>Connection to remote unit information</th>
</tr>
</thead>
<tbody>
<tr>
<td>IP Address: 10.2.1.1</td>
<td>9150's Unit ID: 2</td>
</tr>
<tr>
<td>IP Network Mask: 255.255.0.0</td>
<td>IP Address: 10.1.1.2</td>
</tr>
<tr>
<td>IP Gateway: 10.2.1.10</td>
<td>Network Port: 16</td>
</tr>
<tr>
<td>Management IP Address (optional)</td>
<td>PSTN Number: 606-555-6987</td>
</tr>
<tr>
<td>Management IP Network Mask (optional)</td>
<td>Security Level: ID</td>
</tr>
<tr>
<td>Host PBX</td>
<td>Inbound Security ID: 1234567890</td>
</tr>
<tr>
<td>Host PBX number 613-555-1234</td>
<td>Outbound Security ID: 0987654321</td>
</tr>
<tr>
<td>Port 0 DN (key 0): 8734</td>
<td>Remote Port: 0</td>
</tr>
<tr>
<td>Note: If calls are routed over the IP network, the PSTN number is not used.</td>
<td>DN: 8734</td>
</tr>
<tr>
<td>Remote Office 9150</td>
<td>PSTN Number: 606-555-6987</td>
</tr>
<tr>
<td>Phone number 9150</td>
<td>Security Level: ID</td>
</tr>
<tr>
<td>Remote Office 9150</td>
<td>Inbound Security ID: 0987654321</td>
</tr>
<tr>
<td>Remote Port: 0</td>
<td>Outbound Security ID: 1234567890</td>
</tr>
<tr>
<td>DN: 8734</td>
<td>Remote Port: 0</td>
</tr>
<tr>
<td>Note: If calls are routed over the PSTN, the network port and PSTN number are not used.</td>
<td>DN: 8734</td>
</tr>
</tbody>
</table>
Voice port configuration on the Meridian 1 PBX

This section shows the configuration settings for the voice port on the Meridian 1 PBX. Generally, define voice ports according to the needs of your remote users.

Configuration example

This configuration example uses the settings identified in the network diagram shown on page 361.

Note: This configuration example is from a Meridian 1 Option 11.

```
REQ: prt
TYPE: 2616
MARP NOT ACTIVATED
TN 5 0
DATE
PAGE
DES
DES Bryan Dion
TN 005 0 00 00
TYPE 2616
CDEN 8D
CUST 0
AOM 0
FDN
TGAR 1
LDN NO
NCOS 0
SGRP 0
RNPG 0
SCI 0
SSU
XLST
```
VCE defines the port as a voice port.

9150 unit user’s DN

9150 unit user’s CPND

Installation and Administration Guide 363
Data port configuration on the Meridian 1 PBX

This section shows the configuration settings for the data port on the Meridian 1 PBX. The data port provides the communication path between the RLC and the Remote Office 9150 unit, and must be configured as an MCA adapter.

Configuration example

This configuration example uses the settings identified in the network diagram shown on page 361.

Note: This configuration sample is from a Meridian 1 Option 11.

REQ: prt
TYPE: 2616
TN 5 16
DES
DES Remote site 1
TN 005 0 00 16
TYPE 2616
CDEN 8D
CUST 0
AOM 0
FDN
TGAR 1
LDN NO
NCOS 0
SGRP 0
RNPG 0
SCI 0
SSU
XLST
CLS

Telephone type

ARU defines the port as a data port.

TGAR must be configured to allow trunk access. Refer to your PBX documentation for more details.

DTC defines the port as a data port.
Network ports must be defined as MCA.

The number that the Remote Office 9150 unit needs to connect to the RLC. It must be a DID number.
RLC configuration

This section shows the configuration settings for the RLC. You can obtain a similar configuration printout by performing a configuration download while connected to the RLC.

**Note:** Configuration settings are separated by commas (,).

**Configuration example**

This configuration example uses the settings identified in the network diagram shown on page 361.

**IPCFG**

```
10.2.1.1,255.255.0.0,10.2.1.10,10.3.1.2,255.255.0.0
```

**APPMODCFG**

```
0,NC,NC
1,E,G729,G729
2,NC,NC
3,NC,NC
4,NC,NC
5,NC,NC
6,NC,NC
7,NC,NC
```

**SYSCFG**

```
1,HOST1
```

**RLCCFG**

```
E,E
```

**ACCFG**

```
D
```

**PORTCFG**

```
0,1,0,2,2,D
1,1,0,2,2,D
2,1,0,2,2,D
3,1,0,2,2,D
4,1,0,2,2,D
5,1,0,2,2,D
```

**RLC’s IP address information:**
- IP address
- Subnet mask
- IP gateway
- Management IP address
- Management subnet mask

**DSP application module**

(only module 1 is configured in this case)

**Unit ID and node name**

**Ports configured as remote ports**
Ports configured as local ports

Port configured as network port

Remote unit connection information (unit 1):
- remote unit number
- 9150’s unit ID
- security information (inbound and outbound security IDs)
- remote unit’s IP address
- network port
- PSTN number
Sample configuration files

ONOFFCFG 1,SUN,0 00:00
ONOFFCFG 1,MON,0 00:00
ONOFFCFG 1,TUE,0 00:00
ONOFFCFG 1,WED,0 00:00
ONOFFCFG 1,THU,0 00:00
ONOFFCFG 1,FRI,0 00:00
ONOFFCFG 1,SAT,0 00:00
ONOFFCFG 2,SUN,0 00:00
ONOFFCFG 2,MON,0 00:00
ONOFFCFG 2,TUE,0 00:00
ONOFFCFG 2,WED,0 00:00
ONOFFCFG 2,THU,0 00:00
ONOFFCFG 2,FRI,0 00:00
ONOFFCFG 2,SAT,0 00:00
ONOFFCFG 3,SUN,0 00:00
ONOFFCFG 3,MON,0 00:00
ONOFFCFG 3,TUE,0 00:00
ONOFFCFG 3,WED,0 00:00
ONOFFCFG 3,THU,0 00:00
ONOFFCFG 3,FRI,0 00:00
ONOFFCFG 3,SAT,0 00:00
ONOFFCFG 4,SUN,0 00:00
ONOFFCFG 4,MON,0 00:00
ONOFFCFG 4,TUE,0 00:00
ONOFFCFG 4,WED,0 00:00
ONOFFCFG 4,THU,0 00:00
ONOFFCFG 4,FRI,0 00:00
ONOFFCFG 4,SAT,0 00:00
ONOFFCFG 5,SUN,0 00:00
ONOFFCFG 5,MON,0 00:00
ONOFFCFG 5,TUE,0 00:00
ONOFFCFG 5,WED,0 00:00
ONOFFCFG 5,THU,0 00:00
ONOFFCFG 5,FRI,0 00:00
ONOFFCFG 5,SAT,0 00:00
ONOFFCFG 6,SUN,0 00:00
ONOFFCFG 6,MON,0 00:00
ONOFFCFG 6,TUE,0 00:00
ONOFFCFG 6,WED,0 00:00
ONOFFCFG 6,THU,0 00:00
ONOFFCFG 6,FRI,0 00:00

Online/offline schedule
ONOFFCFG 6, SAT, 0 00:00
ONOFFCFG 7, SUN, 0 00:00
ONOFFCFG 7, MON, 0 00:00
ONOFFCFG 7, TUE, 0 00:00
ONOFFCFG 7, WED, 0 00:00
ONOFFCFG 7, THU, 0 00:00
ONOFFCFG 7, FRI, 0 00:00
ONOFFCFG 7, SAT, 0 00:00
ONOFFCFG 8, SUN, 0 00:00
ONOFFCFG 8, MON, 0 00:00
ONOFFCFG 8, TUE, 0 00:00
ONOFFCFG 8, WED, 0 00:00
ONOFFCFG 8, THU, 0 00:00
ONOFFCFG 8, FRI, 0 00:00
ONOFFCFG 8, SAT, 0 00:00
ONOFFCFG 9, SUN, 0 00:00
ONOFFCFG 9, MON, 0 00:00
ONOFFCFG 9, TUE, 0 00:00
ONOFFCFG 9, WED, 0 00:00
ONOFFCFG 9, THU, 0 00:00
ONOFFCFG 9, FRI, 0 00:00
ONOFFCFG 9, SAT, 0 00:00
ONOFFCFG 10, SUN, 0 00:00
ONOFFCFG 10, MON, 0 00:00
ONOFFCFG 10, TUE, 0 00:00
ONOFFCFG 10, WED, 0 00:00
ONOFFCFG 10, THU, 0 00:00
ONOFFCFG 10, FRI, 0 00:00
ONOFFCFG 10, SAT, 0 00:00

FBQOSCFG 1, E, 5, 6, 5, 10, 10, 32
FBQOSCFG 2, D, 5, 6, 5, 10, 10, 32
FBQOSCFG 3, D, 5, 6, 5, 10, 10, 32
FBQOSCFG 4, D, 5, 6, 5, 10, 10, 32
FBQOSCFG 5, D, 5, 6, 5, 10, 10, 32
FBQOSCFG 6, D, 5, 6, 5, 10, 10, 32
FBQOSCFG 7, D, 5, 6, 5, 10, 10, 32
FBQOSCFG 8, D, 5, 6, 5, 10, 10, 32
FBQOSCFG 9, D, 5, 6, 5, 10, 10, 32
FBQOSCFG 10, D, 5, 6, 5, 10, 10, 32

Item not Configured

Quality of Service settings
(These are default settings)

Caller ID (not configured; one line for each remote unit)
Remote Office 9150 unit

This section shows the configuration settings for the Remote Office 9150 unit. You can obtain a similar configuration printout by performing a configuration download while connected to the Remote Office 9150 unit.

**Note:** Configuration settings are separated by commas (,).

### Configuration example

This configuration example uses the settings identified in the network diagram shown on page 361.

```
IPCFG 10.1.1.2,255.255.0.0,10.1.1.10

9150 unit's IP interface information:
- IP address
- Subnet mask
- IP gateway

APPMODCFG 0,SPARE,TSIDSP
APPMODCFG 1,E,G729,G729
APPMODCFG 2,NC,NC
APPMODCFG 3,NC,NC
APPMODCFG 4,1,1,E,1,1,5556987,60655569870101,E,1,1,
      5556988,60655569880101

On-board DSP module (module 0) and installed DSP application module (module 1)

APPMODCFG 5,NC,NC
APPMODCFG 6,NC,NC
APPMODCFG 7,NC,NC

ISDN BRI module configuration
- module number
- PSTN number for each B-channel
- SPID for each B-channel

SYSCFG 2, Remote site 1

Unit ID and node name

ROUCFG 13:00,0,JAN-13-2000,911,#222,#333,#345,#456,E

System configuration:
- Emergency service number
- System date and time
- SPRE codes
```
Sample configuration files

Host PBX connection information:
- RLC's unit ID
- Security information (inbound and outbound security IDs)
- RLC's IP address
- RLC PSTN number

Port (station) configuration:
- Port number
- Local and remote capability
- CPND
- DN
- Restricted digits

Unconfigured ports
Note: The default capability is Remote.

Fax port configuration:
- Port number
- Local and remote capability
- CPND
- DN
- Restricted digits
Sample configuration files

FKEYCFG 0,2 TRN 12345678,3 CFW 4000,8 LC1 ,9 LC2 ,NC
FKEYCFG 1,2 TRN 12345678,3 CFW 4000,8 LC1 ,9 LC2 ,NC
FKEYCFG 2,2 TRN 12345678,3 CFW 4000,8 LC1 ,9 LC2 ,NC
FKEYCFG 3,2 TRN 12345678,3 CFW 4000,8 LC1 ,9 LC2 ,NC
FKEYCFG 4,2 TRN 12345678,3 CFW 4000,8 LC1 ,9 LC2 ,NC
FKEYCFG 5,2 TRN 12345678,3 CFW 4000,8 LC1 ,9 LC2 ,NC
FKEYCFG 6,8 LC1 ,9 LC2 ,NC
FKEYCFG 7,NC
FKEYCFG 8,NC
FKEYCFG 9,NC
FKEYCFG 10,NC
FKEYCFG 11,NC
FKEYCFG 12,NC
FKEYCFG 13,NC
FKEYCFG 14,NC
FKEYCFG 15,NC
FKEYCFG 16,NC
FKEYCFG 17,NC
FKEYCFG 18,NC
FKEYCFG 19,NC
FKEYCFG 20,NC
FKEYCFG 21,NC
FKEYCFG 22,NC
FKEYCFG 23,NC
FKEYCFG 24,NC
FKEYCFG 25,NC
FKEYCFG 26,NC
FKEYCFG 27,NC
FKEYCFG 28,NC
FKEYCFG 29,NC
FKEYCFG 30,NC
FKEYCFG 31,NC
FKEYCFG 32,NC

Local station feature keys configuration:
- Port number
- Feature key number
- Feature name
- DN (if applicable)
- Locations of local call appearance keys 1 and 2

FKEYCFG 7,NC
FKEYCFG 8,NC
FKEYCFG 9,NC
FKEYCFG 10,NC
FKEYCFG 11,NC
FKEYCFG 12,NC
FKEYCFG 13,NC
FKEYCFG 14,NC
FKEYCFG 15,NC
FKEYCFG 16,NC
FKEYCFG 17,NC
FKEYCFG 18,NC
FKEYCFG 19,NC
FKEYCFG 20,NC
FKEYCFG 21,NC
FKEYCFG 22,NC
FKEYCFG 23,NC
FKEYCFG 24,NC
FKEYCFG 25,NC
FKEYCFG 26,NC
FKEYCFG 27,NC
FKEYCFG 28,NC
FKEYCFG 29,NC
FKEYCFG 30,NC
FKEYCFG 31,NC
FKEYCFG 32,NC

Trunk group configuration:
- Trunk group number
- Trunk access code
- B-channels (ISDN module and B-channel number)
- DN to alert

TRKGRCFG 1,E,#61,4.0.0.0 4.0.1,8739
TRKGRCFG 2,D,#62,1.0.0.0 1.0.1 2.0.0 2.0.1,4002
TRKGRCFG 3,D,#63,1.0.0.0 1.0.1 2.0.0 2.0.1,4004
TRKGRCFG 4,D,#64,1.0.0.0 1.0.1 2.0.0 2.0.1,4006
TRKGRCFG 5,D,#65,1.0.0.0 1.0.1 2.0.0 2.0.1,4008
TRKGRCFG 6,D,#66,1.0.0.0 1.0.1 2.0.0 2.0.1,4010
TRKGRCFG 7,D,#67,1.0.0.0 1.0.1 2.0.0 2.0.1,4012
TRKGRCFG 8,D,#68,1.0.0.0 1.0.1 2.0.0 2.0.1,4014

Item not configured

Caller ID (not configured)
Appendix C

Connection pin-out tables

In this appendix

TELCO 1 connector pin-out table 374
TELCO 2 connector pin-out table 376
Ethernet connector pin-out table 378
Admin (serial) connector pin-out table 379
Power connector pin-out table 380
**TELCO 1 connector pin-out table**

*Note:* The colors shown in this table represent standard telephone cable pin-outs.

<table>
<thead>
<tr>
<th>Port or module</th>
<th>Pin #</th>
<th>Signal</th>
<th>Color</th>
<th>Pin #</th>
<th>Signal</th>
<th>Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>Digital port 0</td>
<td>1</td>
<td>DP 0 RING</td>
<td>BL-W</td>
<td>26</td>
<td>DP 0 TIP</td>
<td>W-BL</td>
</tr>
<tr>
<td>Digital port 1</td>
<td>2</td>
<td>DP 1 RING</td>
<td>OR-W</td>
<td>27</td>
<td>DP 1 TIP</td>
<td>W-OR</td>
</tr>
<tr>
<td>Digital port 2</td>
<td>3</td>
<td>DP 2 RING</td>
<td>GR-W</td>
<td>28</td>
<td>DP 2 TIP</td>
<td>W-GR</td>
</tr>
<tr>
<td>Digital port 3</td>
<td>4</td>
<td>DP 3 RING</td>
<td>BR-W</td>
<td>29</td>
<td>DP 3 TIP</td>
<td>W-BR</td>
</tr>
<tr>
<td>Digital port 4</td>
<td>5</td>
<td>DP 4 RING</td>
<td>SL-W</td>
<td>30</td>
<td>DP 4 TIP</td>
<td>W-SL</td>
</tr>
<tr>
<td>Digital port 5</td>
<td>6</td>
<td>DP 5 RING</td>
<td>BL-R</td>
<td>31</td>
<td>DP 5 TIP</td>
<td>R-BL</td>
</tr>
<tr>
<td>Digital port 6</td>
<td>7</td>
<td>DP 6 RING</td>
<td>OR-R</td>
<td>32</td>
<td>DP 6 TIP</td>
<td>R-OR</td>
</tr>
<tr>
<td>Digital port 7</td>
<td>8</td>
<td>DP 7 RING</td>
<td>GR-R</td>
<td>33</td>
<td>DP 7 TIP</td>
<td>R-GR</td>
</tr>
<tr>
<td>Digital port 8</td>
<td>9</td>
<td>DP 8 RING</td>
<td>BR-R</td>
<td>34</td>
<td>DP 8 TIP</td>
<td>R-BR</td>
</tr>
<tr>
<td>Digital port 9</td>
<td>10</td>
<td>DP 9 RING</td>
<td>SL-R</td>
<td>35</td>
<td>DP 9 TIP</td>
<td>R-SL</td>
</tr>
<tr>
<td>Digital port 10</td>
<td>11</td>
<td>DP 10 RING</td>
<td>BL-B</td>
<td>36</td>
<td>DP 10 TIP</td>
<td>B-BL</td>
</tr>
<tr>
<td>Digital port 11</td>
<td>12</td>
<td>DP 11 RING</td>
<td>OR-B</td>
<td>37</td>
<td>DP 11 TIP</td>
<td>B-OR</td>
</tr>
<tr>
<td>Digital port 12</td>
<td>13</td>
<td>DP 12 RING</td>
<td>GR-B</td>
<td>38</td>
<td>DP 12 TIP</td>
<td>B-GR</td>
</tr>
<tr>
<td>Digital port 13</td>
<td>14</td>
<td>DP 13 RING</td>
<td>BR-B</td>
<td>39</td>
<td>DP 13 TIP</td>
<td>B-BR</td>
</tr>
<tr>
<td>Digital port 14</td>
<td>15</td>
<td>DP 14 RING</td>
<td>SL-B</td>
<td>40</td>
<td>DP 14 TIP</td>
<td>B-SL</td>
</tr>
<tr>
<td>Digital port 15</td>
<td>16</td>
<td>DP 15 RING</td>
<td>BL-Y</td>
<td>41</td>
<td>DP 15 TIP</td>
<td>Y-BL</td>
</tr>
<tr>
<td>Leave open for UL spacing requirements</td>
<td>17</td>
<td>Open</td>
<td>OR-Y</td>
<td>42</td>
<td>Open</td>
<td>Y-OR</td>
</tr>
<tr>
<td>Module 4 (ISDN BRI—ST only)</td>
<td>18</td>
<td>MOD 3 Tip 0+</td>
<td>GR-Y</td>
<td>43</td>
<td>Module 3 Tip 0-</td>
<td>Y-GR</td>
</tr>
<tr>
<td>Port or module</td>
<td>Pin #</td>
<td>Signal</td>
<td>Color</td>
<td>Pin #</td>
<td>Signal</td>
<td>Color</td>
</tr>
<tr>
<td>---------------</td>
<td>-------</td>
<td>----------</td>
<td>-------</td>
<td>-------</td>
<td>----------</td>
<td>-------</td>
</tr>
<tr>
<td>Module 4 (ISDN BRI—U or ST)</td>
<td>19</td>
<td>MOD 3 Ring 0+</td>
<td>BR-Y</td>
<td>44</td>
<td>Module 3 RING 0-</td>
<td>Y-BR</td>
</tr>
<tr>
<td>Module 5 (ISDN BRI—ST only)</td>
<td>20</td>
<td>MOD 4 Tip 0+</td>
<td>SL-Y</td>
<td>45</td>
<td>Module 4 Tip 0-</td>
<td>Y-SL</td>
</tr>
<tr>
<td>Module 5 (ISDN BRI—U or ST)</td>
<td>21</td>
<td>MOD 4 Ring 0+</td>
<td>BL-V</td>
<td>46</td>
<td>Module 4 RING 0-</td>
<td>V-BL</td>
</tr>
<tr>
<td>Module 5 (for future use)</td>
<td>22</td>
<td>MOD 4 Tip 1+</td>
<td>OR-V</td>
<td>47</td>
<td>Module 4 TIP 1-</td>
<td>V-OR</td>
</tr>
<tr>
<td>Module 5 (for future use)</td>
<td>23</td>
<td>MOD 4 Ring 1+</td>
<td>GR-V</td>
<td>48</td>
<td>Module 4 RING 1-</td>
<td>V-GR</td>
</tr>
<tr>
<td>Leave open for UL spacing requirements</td>
<td>24</td>
<td>Open</td>
<td>BR-V</td>
<td>49</td>
<td>UK Ring</td>
<td>V-BR</td>
</tr>
<tr>
<td>Analog port</td>
<td>25</td>
<td>AP TIP</td>
<td>SL-V</td>
<td>50</td>
<td>AP RING</td>
<td>V-SL</td>
</tr>
</tbody>
</table>
### TELCO 2 connector pin-out table

**Note:** The colors shown in this table represent standard telephone cable pin-outs.

<table>
<thead>
<tr>
<th>Port or module</th>
<th>Pin #</th>
<th>Signal</th>
<th>Color</th>
<th>Pin #</th>
<th>Signal</th>
<th>Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>Digital port 16</td>
<td>1</td>
<td>DP 16 RING</td>
<td>BL-W</td>
<td>26</td>
<td>DP 16 TIP</td>
<td>W-BL</td>
</tr>
<tr>
<td>Digital port 17</td>
<td>2</td>
<td>DP 17 RING</td>
<td>OR-W</td>
<td>27</td>
<td>DP 17 TIP</td>
<td>W-OR</td>
</tr>
<tr>
<td>Digital port 18</td>
<td>3</td>
<td>DP 18 RING</td>
<td>GR-W</td>
<td>28</td>
<td>DP 18 TIP</td>
<td>W-GR</td>
</tr>
<tr>
<td>Digital port 19</td>
<td>4</td>
<td>DP 19 RING</td>
<td>BR-W</td>
<td>29</td>
<td>DP 19 TIP</td>
<td>W-BR</td>
</tr>
<tr>
<td>Digital port 20</td>
<td>5</td>
<td>DP 20 RING</td>
<td>SL-W</td>
<td>30</td>
<td>DP 20 TIP</td>
<td>W-SL</td>
</tr>
<tr>
<td>Digital port 21</td>
<td>6</td>
<td>DP 21 RING</td>
<td>BL-R</td>
<td>31</td>
<td>DP 21 TIP</td>
<td>R-BL</td>
</tr>
<tr>
<td>Digital port 22</td>
<td>7</td>
<td>DP 22 RING</td>
<td>OR-R</td>
<td>32</td>
<td>DP 22 TIP</td>
<td>R-OR</td>
</tr>
<tr>
<td>Digital port 23</td>
<td>8</td>
<td>DP 23 RING</td>
<td>GR-R</td>
<td>33</td>
<td>DP 23 TIP</td>
<td>R-GR</td>
</tr>
<tr>
<td>Digital port 24</td>
<td>9</td>
<td>DP 24 RING</td>
<td>BR-R</td>
<td>34</td>
<td>DP 24 TIP</td>
<td>R-BR</td>
</tr>
<tr>
<td>Digital port 25</td>
<td>10</td>
<td>DP 25 RING</td>
<td>SL-R</td>
<td>35</td>
<td>DP 25 TIP</td>
<td>R-SL</td>
</tr>
<tr>
<td>Digital port 26</td>
<td>11</td>
<td>DP 26 RING</td>
<td>BL-B</td>
<td>36</td>
<td>DP 26 TIP</td>
<td>B-BL</td>
</tr>
<tr>
<td>Digital port 27</td>
<td>12</td>
<td>DP 27 RING</td>
<td>OR-B</td>
<td>37</td>
<td>DP 27 TIP</td>
<td>B-OR</td>
</tr>
<tr>
<td>Digital port 28</td>
<td>13</td>
<td>DP 28 RING</td>
<td>GR-B</td>
<td>38</td>
<td>DP 28 TIP</td>
<td>B-GR</td>
</tr>
<tr>
<td>Digital port 29</td>
<td>14</td>
<td>DP 29 RING</td>
<td>BR-B</td>
<td>39</td>
<td>DP 29 TIP</td>
<td>B-BR</td>
</tr>
<tr>
<td>Digital port 30</td>
<td>15</td>
<td>DP 30 RING</td>
<td>SL-B</td>
<td>40</td>
<td>DP 30 TIP</td>
<td>B-SL</td>
</tr>
<tr>
<td>Digital port 31</td>
<td>16</td>
<td>DP 31 RING</td>
<td>BL-Y</td>
<td>41</td>
<td>DP 31 TIP</td>
<td>Y-BL</td>
</tr>
<tr>
<td>Leave open for UL spacing requirements</td>
<td>17</td>
<td>Open</td>
<td>OR-Y</td>
<td>42</td>
<td>Open</td>
<td>Y-OR</td>
</tr>
<tr>
<td>Module 6 (ISDN BRI—ST only)</td>
<td>18</td>
<td>MOD 5 Tip 0+</td>
<td>GR-Y</td>
<td>43</td>
<td>Module 5 Tip 0-</td>
<td>Y-GR</td>
</tr>
<tr>
<td>Port or module</td>
<td>Pin #</td>
<td>Signal</td>
<td>Color</td>
<td>Pin #</td>
<td>Signal</td>
<td>Color</td>
</tr>
<tr>
<td>---------------</td>
<td>-------</td>
<td>-------------------</td>
<td>-------</td>
<td>-------</td>
<td>-------------------</td>
<td>-------</td>
</tr>
<tr>
<td>Module 6</td>
<td>19</td>
<td>MOD 5 Ring 0+</td>
<td>BR-Y</td>
<td>44</td>
<td>Module 5 Ring 0-</td>
<td>Y-BR</td>
</tr>
<tr>
<td>(ISDN BRI—U or ST)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Module 7</td>
<td>20</td>
<td>MOD 6 Tip 0+</td>
<td>SL-Y</td>
<td>45</td>
<td>Module 6 Tip 0-</td>
<td>Y-SL</td>
</tr>
<tr>
<td>(ISDN BRI—ST only)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Module 7</td>
<td>21</td>
<td>MOD 6 Ring 0+</td>
<td>BL-V</td>
<td>46</td>
<td>Module 6 Ring 0-</td>
<td>V-BL</td>
</tr>
<tr>
<td>(ISDN BRI—U or ST)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Module 7</td>
<td>22</td>
<td>MOD 6 Tip 1+</td>
<td>OR-V</td>
<td>47</td>
<td>Module 6 Tip 1-</td>
<td>V-OR</td>
</tr>
<tr>
<td>(for future use)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Module 7</td>
<td>23</td>
<td>MOD 6 Ring 1+</td>
<td>GR-V</td>
<td>48</td>
<td>Module 6 Ring 1-</td>
<td>V-GR</td>
</tr>
<tr>
<td>(for future use)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Leave open for UL</td>
<td>24</td>
<td>Open</td>
<td>BR-V</td>
<td>49</td>
<td>Open</td>
<td>V-BR</td>
</tr>
<tr>
<td>spacing requirements</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fault Relay</td>
<td>25</td>
<td>FLT RLY 1</td>
<td>SL-V</td>
<td>50</td>
<td>FLT RLY 2</td>
<td>V-SL</td>
</tr>
<tr>
<td>Contact 1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## Ethernet connector pin-out table

<table>
<thead>
<tr>
<th>Pin number</th>
<th>Signal name</th>
<th>I/O</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>TX+</td>
<td>O</td>
<td>Transmit Clock +</td>
</tr>
<tr>
<td>2</td>
<td>TXC</td>
<td>I</td>
<td>Transmit Clock Common (Ground)</td>
</tr>
<tr>
<td>3</td>
<td>TX-</td>
<td>O</td>
<td>Transmit Clock -</td>
</tr>
<tr>
<td>4</td>
<td>Chassis Ground</td>
<td>I</td>
<td>Shield</td>
</tr>
<tr>
<td>5</td>
<td>Chassis Ground</td>
<td>I</td>
<td>Shield</td>
</tr>
<tr>
<td>6</td>
<td>RXC</td>
<td>I</td>
<td>Receive Clock Common (Ground)</td>
</tr>
<tr>
<td>7</td>
<td>RX+</td>
<td>I</td>
<td>Receive Clock +</td>
</tr>
<tr>
<td>8</td>
<td>RX-</td>
<td>I</td>
<td>Receive Clock -</td>
</tr>
</tbody>
</table>
Admin (serial) connector pin-out table

<table>
<thead>
<tr>
<th>Pin number</th>
<th>Signal name</th>
<th>I/O</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>MMI-RXD</td>
<td>I</td>
<td>MMI RS-232C Receive Data</td>
</tr>
<tr>
<td>3</td>
<td>MMI-TXD</td>
<td>O</td>
<td>MMI RS-232C Transmit Data</td>
</tr>
<tr>
<td>4</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
<td>I</td>
<td>Logic Ground</td>
</tr>
<tr>
<td>6</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## Power connector pin-out table

<table>
<thead>
<tr>
<th>Pin number</th>
<th>Signal name</th>
<th>I/O</th>
<th>Current</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>+5V</td>
<td>I</td>
<td>5.0 A</td>
<td>+5v</td>
</tr>
<tr>
<td>2</td>
<td>Ground</td>
<td>I</td>
<td></td>
<td>Logic Ground</td>
</tr>
<tr>
<td>3</td>
<td>+24V</td>
<td>I</td>
<td>1.5 A</td>
<td>+24v</td>
</tr>
<tr>
<td>4</td>
<td>-12V</td>
<td>I</td>
<td>0.1 A</td>
<td>+24v</td>
</tr>
</tbody>
</table>
Appendix D

Display log definitions

In this appendix

Display logs 382
Display logs

The display log functionality is significantly improved over prior releases of Remote Office 9150. This appendix lists the 9150 system’s display log error and status messages.

<table>
<thead>
<tr>
<th>Statistic</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOG NUMBER</td>
<td>0</td>
</tr>
<tr>
<td>DESCRIPTION</td>
<td>This is a description of the log that is being generated.</td>
</tr>
<tr>
<td>SEVERITY</td>
<td>NORMAL, WARNING, MINOR, MAJOR, CRITICAL (Assigns one of these levels to the Log.)</td>
</tr>
<tr>
<td>TASK</td>
<td>This is the task that originates the trap. This can be the full name or an abbreviation. (For development use only.)</td>
</tr>
<tr>
<td>PRODUCT</td>
<td>RLC, 9150, 911x (Lists all products that can generate this log.)</td>
</tr>
<tr>
<td>CANCELLATION</td>
<td>This is a cross-reference to another log number that is the complement of the current log (for example, QOS Transition/Recovery, Link Up/Down.) This should be a LOG NUMBER and send Log IDType.</td>
</tr>
<tr>
<td>ACTION TO BE TAKEN:</td>
<td>If the Severity is higher than NORMAL, this should contain information that would help the end user correct the problem, if possible (for example, a Configuration Change), or give them information about where the user should go for help.</td>
</tr>
<tr>
<td>PARAMETERS</td>
<td>1) description of parameter 1</td>
</tr>
<tr>
<td></td>
<td>2) description of parameter 2</td>
</tr>
<tr>
<td></td>
<td>.</td>
</tr>
<tr>
<td></td>
<td>.</td>
</tr>
<tr>
<td></td>
<td>.</td>
</tr>
<tr>
<td></td>
<td>N) description of parameter N</td>
</tr>
<tr>
<td>DISPLAYED TEXT</td>
<td>Formatting String</td>
</tr>
</tbody>
</table>
LOG NUMBER 1
DESCRIPTION This log indicates that system started.
SEVERITY NORMAL
TASK MMI
PRODUCT RLC, 9150, 911x
CANCELLATION None
ACTION TO BE TAKEN None
PARAMETERS None
DISPLAYED TEXT System started

LOG NUMBER 2
DESCRIPTION This logs indicates that there was a failure in allocation of the TCM block
SEVERITY CRITICAL
TASK None
PRODUCT 9150, 911x
CANCELLATION None
ACTION TO BE TAKEN TCM buffer is exhausted. If the problem persists reboot the system and report back to vendor.
PARAMETERS None
DISPLAYED TEXT Out of TCM buffer
### LOG NUMBER 3
DESCRIPTION: This logs indicates that there was a failure in allocation of memory of size \( n \).

SEVERITY: MAJOR

ACTION TO BE TAKEN: Memory buffers exhausted. If the problem persists reboot the system.

PARAMETERS: Size of memory block that the system failed to allocate.

DISPLAYED TEXT: Couldn’t allocate memory of size P1.

### LOG NUMBER 4
DESCRIPTION: This logs indicates that there was a failure in sending a message to a Remote Office unit.

SEVERITY: MAJOR

ACTION TO BE TAKEN: 1) The destination host is unreachable check its status. 2) Check the configuration.

PARAMETERS: Unit ID of remote board for which message was intended.

DISPLAYED TEXT: Couldn’t send message to unit ID: P1
<table>
<thead>
<tr>
<th>Statistic</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOG NUMBER 5</td>
<td>DESCRIPTION: This log indicates that the QoS of the IP network degraded and the system transitioned to the PSTN.</td>
</tr>
<tr>
<td></td>
<td>SEVERITY: NORMAL</td>
</tr>
<tr>
<td></td>
<td>TASK: QoS Transitioning</td>
</tr>
<tr>
<td></td>
<td>PRODUCT: RLC, 9150, 911x</td>
</tr>
<tr>
<td></td>
<td>CANCELLATION: Log number 2 - FB_RECOVERY_LOG_ID</td>
</tr>
<tr>
<td>ACTION TO BE TAKEN</td>
<td>Investigate why the IP network was determined to be below VoIP quality. Review the Engineering Guidelines.</td>
</tr>
<tr>
<td>PARAMETERS</td>
<td>Unit ID of the Remote Office unit for which the IP QoS has degraded.</td>
</tr>
<tr>
<td>DISPLAYED TEXT</td>
<td>Transition to remote site: P1</td>
</tr>
</tbody>
</table>

| LOG NUMBER 6   | DESCRIPTION: This log indicates that the QoS of the IP network recovered and the system transitioned to the IP Network. |
|                | SEVERITY: NORMAL                                                          |
|                | TASK: Fallback                                                           |
|                | PRODUCT: RLC, 9150, 911x                                                  |
|                | CANCELLATION: Log number 1 - FB_FALLBACK_LOG_ID                           |
| ACTION TO BE TAKEN | Investigate why the IP network was determined to be below VoIP quality. Review the Engineering Guidelines. |
| PARAMETERS     | Unit ID of the Remote Office unit for which the IP QoS has recovered.     |
| DISPLAYED TEXT | Recovery to remote site: P1                                              |
### Display log definitions

<table>
<thead>
<tr>
<th>Statistic</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOG NUMBER 7</td>
<td>This log indicates that a user logged onto the system.</td>
</tr>
<tr>
<td>DESCRIPTION</td>
<td></td>
</tr>
<tr>
<td>SEVERITY</td>
<td>NORMAL</td>
</tr>
<tr>
<td>TASK</td>
<td>Session Control</td>
</tr>
<tr>
<td>PRODUCT</td>
<td>RLC, 9150, 911x</td>
</tr>
<tr>
<td>CANCELLATION</td>
<td>Log number 8</td>
</tr>
<tr>
<td>ACTION TO BE TAKEN</td>
<td>None</td>
</tr>
<tr>
<td>PARAMETERS</td>
<td>Connection (serial or Telnet) through which user logged onto system.</td>
</tr>
<tr>
<td>DISPLAYED TEXT</td>
<td>User logged on: P1</td>
</tr>
</tbody>
</table>

<p>| LOG NUMBER 8    |                                                                           |
| DESCRIPTION     | This log indicates that a user logged off from the system.               |
| SEVERITY        | NORMAL                                                                    |
| TASK            | Session Control                                                           |
| PRODUCT         | RLC, 9150, 911x                                                           |
| CANCELLATION    | Log number 7                                                              |
| ACTION TO BE TAKEN | None                                                               |
| PARAMETERS      | Logoff type – normal or terminated.                                       |
| DISPLAYED TEXT  | User logged off: P1                                                       |</p>
<table>
<thead>
<tr>
<th>Statistic</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOG NUMBER 9</td>
<td>This log indicates that logon to the system failed.</td>
</tr>
<tr>
<td>DESCRIPTION</td>
<td>This log indicates that logon to the system failed.</td>
</tr>
<tr>
<td>SEVERITY</td>
<td>WARNING</td>
</tr>
<tr>
<td>TASK</td>
<td>Session Control</td>
</tr>
<tr>
<td>PRODUCT</td>
<td>RLC, 9150, 911x</td>
</tr>
<tr>
<td>CANCELLATION</td>
<td>None</td>
</tr>
<tr>
<td>ACTION TO BE TAKEN</td>
<td>None</td>
</tr>
<tr>
<td>PARAMETERS</td>
<td>Reason – wrong user name, password, device busy etc.</td>
</tr>
<tr>
<td>DISPLAYED TEXT</td>
<td>User login failed: P1</td>
</tr>
</tbody>
</table>

<p>| LOG NUMBER 10    | This log indicates a debug Session Terminated. A debug session that was inactive for more than 15 minutes was automatically logged off from the system. |
| DESCRIPTION      | This log indicates a debug Session Terminated. A debug session that was inactive for more than 15 minutes was automatically logged off from the system. |
| SEVERITY         | NORMAL                                                                    |
| TASK             | Session Control                                                           |
| PRODUCT          | RLC, 9150, 911x                                                            |
| CANCELLATION     | None                                                                       |
| ACTION TO BE TAKEN | None                                                                      |
| PARAMETERS       | Reason for termination                                                     |
| DISPLAYED TEXT   | Debug session terminated: P1                                               |</p>
<table>
<thead>
<tr>
<th>Statistic</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOG NUMBER 11</td>
<td>This log indicates that database reading from flash at Power on failed. This can be caused by corrupted flash. As a result, the system starts with the default configuration.</td>
</tr>
<tr>
<td>SEVERITY</td>
<td>CRITICAL</td>
</tr>
<tr>
<td>TASK</td>
<td>MMI</td>
</tr>
<tr>
<td>PRODUCT</td>
<td>RLC, 9150, 911x</td>
</tr>
<tr>
<td>CANCELLATION</td>
<td>None</td>
</tr>
<tr>
<td>ACTION TO BE TAKEN</td>
<td>1) Reconfigure the system and then save it to Flash. Note: When you save configuration changes to Flash, the system suspends new call processing for approximately 30 seconds. 2) Restart the system and log into the system and check the configured parameters. If the problem persists contact your vendor.</td>
</tr>
<tr>
<td>PARAMETERS</td>
<td>Reason reading from Flash failed.</td>
</tr>
<tr>
<td>DISPLAYED TEXT</td>
<td>Database reading from Flash failed - P1</td>
</tr>
</tbody>
</table>

<p>| LOG NUMBER 12     | This log indicates that user tried saving a new configuration to Flash.                                                                      |
| SEVERITY          | NORMAL                                                                                                                                    |
| TASK              | MMI                                                                                                                                       |
| PRODUCT           | RLC, 9150, 911x                                                                                                                             |
| CANCELLATION      | None                                                                                                                                      |
| ACTION TO BE TAKEN| None                                                                                                                                      |
| PARAMETERS        | Status of Save to Flash – success or failure                                                                                               |
| DISPLAYED TEXT    | Database save to Flash: P1                                                                                                               |</p>
<table>
<thead>
<tr>
<th>Statistic</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOG NUMBER 13</td>
<td>DESCRIPTION: This log indicates that a user defaulted the configuration of the board using the Set default configuration command.</td>
</tr>
<tr>
<td>SEVERITY</td>
<td>NORMAL</td>
</tr>
<tr>
<td>TASK</td>
<td>MMI</td>
</tr>
<tr>
<td>PRODUCT</td>
<td>RLC, 9150, 911x</td>
</tr>
<tr>
<td>CANCELLATION</td>
<td>None</td>
</tr>
<tr>
<td>ACTION TO BE TAKEN</td>
<td>None</td>
</tr>
<tr>
<td>PARAMETERS</td>
<td>None</td>
</tr>
<tr>
<td>DISPLAYED TEXT</td>
<td>Database defaulted</td>
</tr>
</tbody>
</table>

<p>| LOG NUMBER 14     | DESCRIPTION: This log indicates that User tried a configuration upload.     |
| SEVERITY           | NORMAL                                                                      |
| TASK               | MMI                                                                         |
| PRODUCT            | RLC, 9150, 911x                                                             |
| CANCELLATION       | None                                                                        |
| ACTION TO BE TAKEN | None                                                                        |
| PARAMETERS         | 1) Status - success or failure                                              |
|                     | 2) Name of configuration file                                               |
|                     | 3) IP address of source of configuration file                              |
| DISPLAYED TEXT     | Database upload: P1 (P2 from P3)                                            |</p>
<table>
<thead>
<tr>
<th>Statistic</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOG NUMBER</td>
<td>15</td>
</tr>
<tr>
<td>DESCRIPTION</td>
<td>This log indicates that an application module is enabled and not plugged in. This can happen when the user configures a module and then removes it from the system.</td>
</tr>
<tr>
<td>SEVERITY</td>
<td>MAJOR</td>
</tr>
<tr>
<td>TASK</td>
<td>MMI</td>
</tr>
<tr>
<td>PRODUCT</td>
<td>RLC, 9150</td>
</tr>
<tr>
<td>CANCELLATION</td>
<td>None</td>
</tr>
<tr>
<td>ACTION TO BE TAKEN</td>
<td>None</td>
</tr>
</tbody>
</table>
| PARAMETERS       | 1) Module type  
<pre><code>               | 2) Mismatch details |
</code></pre>
<p>| DISPLAYED TEXT   | Application module configuration mismatch: P1 P2. |</p>
<table>
<thead>
<tr>
<th>Statistic</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOG NUMBER</td>
<td>16</td>
</tr>
<tr>
<td>DESCRIPTION</td>
<td>This log indicates that there is a DN clash. This can happen in the following cases:</td>
</tr>
<tr>
<td></td>
<td>- Same DNs configured for multiple ports.</td>
</tr>
<tr>
<td></td>
<td>- Same access codes configured for trunk groups.</td>
</tr>
<tr>
<td></td>
<td>- Same SPRE code is configured for different functions.</td>
</tr>
<tr>
<td></td>
<td>- A longer DN number exists.</td>
</tr>
<tr>
<td>SEVERITY</td>
<td>MAJOR</td>
</tr>
<tr>
<td>TASK</td>
<td>MMI</td>
</tr>
<tr>
<td>PRODUCT</td>
<td>9150</td>
</tr>
<tr>
<td>CANCELLATION</td>
<td>None</td>
</tr>
<tr>
<td>ACTION TO BE TAKEN</td>
<td>Check for duplication of configuration (Use “Get DN List” to see the data) and correct it.</td>
</tr>
<tr>
<td>PARAMETERS</td>
<td>1) Type of Data</td>
</tr>
<tr>
<td></td>
<td>2) First clashing port number</td>
</tr>
<tr>
<td>DISPLAYED TEXT</td>
<td>DN clash: P1 P2 P3</td>
</tr>
</tbody>
</table>
Display log definitions

<table>
<thead>
<tr>
<th>Statistic</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOG NUMBER 17</td>
<td>This log indicates that the User tried to upload software. This could be application software or ISDN module software. After an application software upload, the system is normally restarted. Therefore, it is possible that this log was lost.</td>
</tr>
<tr>
<td>SEVERITY</td>
<td>NORMAL</td>
</tr>
<tr>
<td>TASK</td>
<td>MMI</td>
</tr>
<tr>
<td>PRODUCT</td>
<td>RLC, 9150, 911x</td>
</tr>
<tr>
<td>CANCELLATION</td>
<td>None</td>
</tr>
<tr>
<td>ACTION TO BE TAKEN</td>
<td>None</td>
</tr>
<tr>
<td>PARAMETERS</td>
<td>1) Status - success or failure</td>
</tr>
<tr>
<td></td>
<td>2) Module type - application or ISDN</td>
</tr>
<tr>
<td></td>
<td>3) File name</td>
</tr>
<tr>
<td></td>
<td>4) Source of file (for example, IP address)</td>
</tr>
<tr>
<td>DISPLAYED TEXT</td>
<td>Software upload: P1 (P2, P3 from P4)</td>
</tr>
</tbody>
</table>

<p>| LOG NUMBER 18  | This log indicates that a user tried a cross connection to PBX over RS232 Port using the Xconnect command. |
| SEVERITY       | NORMAL                                                                     |
| TASK           | MMI                                                                         |
| PRODUCT        | RLC, 9150, 911x                                                            |
| CANCELLATION   | None                                                                       |
| ACTION TO BE TAKEN | None                                             |
| PARAMETERS     | Status of cross-connect attempt - success or failure                       |
| DISPLAYED TEXT | User cross connect to PBX: P1                                             |</p>
<table>
<thead>
<tr>
<th>Statistic</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOG NUMBER</td>
<td>19</td>
</tr>
<tr>
<td>DESCRIPTION</td>
<td>This log indicates that a user tried a Remote connection to another system using the Telnet command.</td>
</tr>
<tr>
<td>SEVERITY</td>
<td>NORMAL</td>
</tr>
<tr>
<td>TASK</td>
<td>MMI</td>
</tr>
<tr>
<td>PRODUCT</td>
<td>RLC, 9150, 911x</td>
</tr>
<tr>
<td>CANCELLATION</td>
<td>None</td>
</tr>
<tr>
<td>ACTION TO BE TAKEN</td>
<td>None</td>
</tr>
<tr>
<td>PARAMETERS</td>
<td>1) Status of Telnet attempt - success or failure</td>
</tr>
<tr>
<td></td>
<td>2) Destination (for example, IP address)</td>
</tr>
<tr>
<td>DISPLAYED TEXT</td>
<td>User remote connection: P1 P2</td>
</tr>
</tbody>
</table>

| LOG NUMBER    | 20                                                                        |
| DESCRIPTION   | This log indicates the power on initialization of the ports completed.    |
| SEVERITY      | NORMAL                                                                   |
| TASK          | CallProcessing                                                          |
| PRODUCT       | RLC                                                                       |
| CANCELLATION  | None                                                                     |
| ACTION TO BE TAKEN | None                                                               |
| PARAMETERS    | None                                                                     |
| DISPLAYED TEXT| Power-on initialization of ports completed.                              |
Display log definitions

<table>
<thead>
<tr>
<th>Statistic</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOG NUMBER</td>
<td>21</td>
</tr>
<tr>
<td>DESCRIPTION</td>
<td>This log indicates that the remote site re-initialized upon Remote Office unit configuration change.</td>
</tr>
<tr>
<td>SEVERITY</td>
<td>NORMAL</td>
</tr>
<tr>
<td>TASK</td>
<td>CallProcessing</td>
</tr>
<tr>
<td>PRODUCT</td>
<td>RLC</td>
</tr>
<tr>
<td>CANCELLATION</td>
<td>None</td>
</tr>
<tr>
<td>ACTION TO BE TAKEN</td>
<td>None</td>
</tr>
<tr>
<td>PARAMETERS</td>
<td>Unit ID of the Remote Office unit re-initialized</td>
</tr>
<tr>
<td>DISPLAYED TEXT</td>
<td>Remote site: P1 is re-initialized</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Statistic</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOG NUMBER</td>
<td>22</td>
</tr>
<tr>
<td>DESCRIPTION</td>
<td>This log signals that the link to the specified Remote Office unit went down.</td>
</tr>
<tr>
<td>SEVERITY</td>
<td>MAJOR</td>
</tr>
<tr>
<td>TASK</td>
<td>CallProcessing</td>
</tr>
<tr>
<td>PRODUCT</td>
<td>RLC</td>
</tr>
<tr>
<td>CANCELLATION</td>
<td>None</td>
</tr>
<tr>
<td>ACTION TO BE TAKEN</td>
<td>None</td>
</tr>
<tr>
<td>PARAMETERS</td>
<td>Unit ID of the Remote Office unit to which the link went down</td>
</tr>
<tr>
<td>DISPLAYED TEXT</td>
<td>Link down for remote site: P1</td>
</tr>
<tr>
<td>Statistic</td>
<td>Definition</td>
</tr>
<tr>
<td>-----------</td>
<td>------------</td>
</tr>
<tr>
<td>LOG NUMBER</td>
<td>23</td>
</tr>
<tr>
<td>DESCRIPTION</td>
<td>This log indicates that a Remote Office unit registered.</td>
</tr>
<tr>
<td>SEVERITY</td>
<td>NORMAL</td>
</tr>
<tr>
<td>TASK</td>
<td>CallProcessing</td>
</tr>
<tr>
<td>PRODUCT</td>
<td>RLC</td>
</tr>
<tr>
<td>CANCELLATION</td>
<td>None</td>
</tr>
<tr>
<td>ACTION TO BE TAKEN</td>
<td>None</td>
</tr>
<tr>
<td>PARAMETERS</td>
<td>Unit ID of the Remote Office unit that registered.</td>
</tr>
<tr>
<td>DISPLAYED TEXT</td>
<td>Remote site: P1 is registered.</td>
</tr>
</tbody>
</table>

| LOG NUMBER | 24 |
| DESCRIPTION | This log signals a port registration clash for a dedicated port. |
| SEVERITY | WARNING |
| TASK | CallProcessing |
| PRODUCT | RLC |
| CANCELLATION | None |
| ACTION TO BE TAKEN | Possible mis-configuration on remote. Check the configurations |
| PARAMETERS | 1) port number of first clashing remote port  
2) unit ID of the remote on which first clashing port resides  
3) number of dedicated RLC port for which there is a clash  
4) port number of second clashing remote port  
5) unit ID of the remote on which the second clashing port resides |
<p>| DISPLAYED TEXT | Registration clash for port P1 on remote site: P2 with port P3 on the RLC. Dedicated port P3 is already registered with port P4 of the remote site: P5 |</p>
<table>
<thead>
<tr>
<th>Statistic</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOG NUMBER</td>
<td>25</td>
</tr>
<tr>
<td>DESCRIPTION</td>
<td>This log indicates that a remote port registered with a multiuser/ dynamic RLC port.</td>
</tr>
<tr>
<td>SEVERITY</td>
<td>NORMAL</td>
</tr>
<tr>
<td>TASK</td>
<td>CallProcessing</td>
</tr>
<tr>
<td>PRODUCT</td>
<td>RLC</td>
</tr>
<tr>
<td>CANCELLATION</td>
<td>None</td>
</tr>
<tr>
<td>ACTION TO BE TAKEN</td>
<td>None</td>
</tr>
<tr>
<td>PARAMETERS</td>
<td>1) Port number of remote port registered on multiuser/dynamic port</td>
</tr>
<tr>
<td></td>
<td>2) Unit ID of remote on which remote port resides</td>
</tr>
<tr>
<td></td>
<td>3) Port number of multiuser/dynamic port on RLC</td>
</tr>
<tr>
<td>DISPLAYED TEXT</td>
<td>Port P1 on remote site: P2 is registered with multiuser /dynamic pool port P3.</td>
</tr>
</tbody>
</table>
Display log definitions

<table>
<thead>
<tr>
<th>Statistic</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOG NUMBER</td>
<td>26</td>
</tr>
<tr>
<td>DESCRIPTION</td>
<td>This log indicates a port registration clash for a Multiuser port.</td>
</tr>
<tr>
<td>SEVERITY</td>
<td>MAJOR</td>
</tr>
<tr>
<td>TASK</td>
<td>CallProcessing</td>
</tr>
<tr>
<td>PRODUCT</td>
<td>RLC</td>
</tr>
<tr>
<td>CANCELLATION</td>
<td>None</td>
</tr>
<tr>
<td>ACTION TO BE TAKEN</td>
<td>None</td>
</tr>
</tbody>
</table>
| PARAMETERS      | 1) number of remote port for which there is a registration clash  
|                 | 2) unit ID of the Remote Office unit on which port resides  
|                 | 3) port number of multiuser port on RLC  
|                 | 4) port number of currently registered remote port  
<p>|                 | 5) unit ID of the Remote Office unit on which currently registered port resides |
| DISPLAYED TEXT  | Registration clash for port P1 on remote site: P2 with multiuser port P3. Multiuser port P3 is already registered with port P4 on remote site P5 |</p>
<table>
<thead>
<tr>
<th>Statistic</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOG NUMBER 27</td>
<td>This log indicates that a port registration failed for a dynamic pool port. All ports in this dynamic pool are registered and no port is available for use.</td>
</tr>
<tr>
<td>DESCRIPTION</td>
<td>This log indicates that a port registration failed for a dynamic pool port. All ports in this dynamic pool are registered and no port is available for use.</td>
</tr>
<tr>
<td>SEVERITY</td>
<td>MAJOR</td>
</tr>
<tr>
<td>TASK</td>
<td>CallProcessing</td>
</tr>
<tr>
<td>PRODUCT</td>
<td>RLC</td>
</tr>
<tr>
<td>CANCELLATION</td>
<td>None</td>
</tr>
<tr>
<td>ACTION TO BE TAKEN</td>
<td>None</td>
</tr>
<tr>
<td>PARAMETERS</td>
<td>1) Port number on remote for which there is a registration failure. 2) Unit ID of the Remote Office unit on which port resides</td>
</tr>
<tr>
<td>DISPLAYED TEXT</td>
<td>Registration failed for dynamic pool port P1 on remote site: P2</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Statistic</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOG NUMBER 28</td>
<td>This logs indicates that there was a failure in allocation of a new call register.</td>
</tr>
<tr>
<td>DESCRIPTION</td>
<td>This logs indicates that there was a failure in allocation of a new call register.</td>
</tr>
<tr>
<td>SEVERITY</td>
<td>CRITICAL</td>
</tr>
<tr>
<td>TASK</td>
<td>Device Control, Call Processing</td>
</tr>
<tr>
<td>PRODUCT</td>
<td>RLC, 9150, 911x</td>
</tr>
<tr>
<td>CANCELLATION</td>
<td>None</td>
</tr>
<tr>
<td>ACTION TO BE TAKEN</td>
<td>The system memory allocation has failed and might have been exhausted. If the problem persists reboot the system.</td>
</tr>
<tr>
<td>PARAMETERS</td>
<td>port number</td>
</tr>
<tr>
<td>DISPLAYED TEXT</td>
<td>Call register allocation failed in local calling on Port P1.</td>
</tr>
<tr>
<td>LOG NUMBER</td>
<td>29</td>
</tr>
<tr>
<td>---------------</td>
<td>----</td>
</tr>
<tr>
<td>DESCRIPTION</td>
<td>This log indicates that there were insufficient DSP channels when a voice call was attempted.</td>
</tr>
<tr>
<td>SEVERITY</td>
<td>MINOR</td>
</tr>
<tr>
<td>TASK</td>
<td>Device Control/Call Processing</td>
</tr>
<tr>
<td>PRODUCT</td>
<td>9150, 911x</td>
</tr>
<tr>
<td>CANCELLATION</td>
<td>None</td>
</tr>
</tbody>
</table>
| ACTION TO BE TAKEN | 1) All the DSP channels on the system are in use. Wait for calls to be dropped.  
2) To avoid blocking, either distribute calls onto additional RLCs and 9150s, or add DSP modules to existing equipment, provided there is space available for additional modules. Otherwise action # 1 applies. |
<p>| PARAMETERS    | port number |
| DISPLAYED TEXT | DSP resource allocation failed on Port P1 |</p>
<table>
<thead>
<tr>
<th>Statistic</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOG NUMBER</td>
<td>30</td>
</tr>
<tr>
<td>DESCRIPTION</td>
<td>This log indicates that allocation of a local trunk for a local call failed.</td>
</tr>
<tr>
<td></td>
<td>The possible reasons for failure are:</td>
</tr>
<tr>
<td></td>
<td>1) All the trunks are in use.</td>
</tr>
<tr>
<td></td>
<td>2) There are no Local or Local/Remote trunks configured.</td>
</tr>
<tr>
<td></td>
<td>3) The BRI link may be down or the BRI module might not be plugged in completely.</td>
</tr>
<tr>
<td>SEVERITY</td>
<td>MINOR</td>
</tr>
<tr>
<td>TASK</td>
<td>Device Control</td>
</tr>
<tr>
<td>PRODUCT</td>
<td>9150, 911x</td>
</tr>
<tr>
<td>CANCELLATION</td>
<td>None</td>
</tr>
<tr>
<td>ACTION TO BE TAKEN</td>
<td>1) Confirm that the BRI modules are plugged in properly and the BRI link is UP.</td>
</tr>
<tr>
<td></td>
<td>2) Confirm that the BRI configuration is correct.</td>
</tr>
<tr>
<td>PARAMETERS</td>
<td>port number</td>
</tr>
<tr>
<td>DISPLAYED TEXT</td>
<td>Local trunk allocation failed on port P1.</td>
</tr>
<tr>
<td>Statistic</td>
<td>Definition</td>
</tr>
<tr>
<td>----------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>LOG NUMBER 31</td>
<td>This log indicates that a local call failed because the dialed DN didn't exist.</td>
</tr>
<tr>
<td>SEVERITY</td>
<td>WARNING</td>
</tr>
<tr>
<td>TASK</td>
<td>Device Control</td>
</tr>
<tr>
<td>PRODUCT 9150, 911x</td>
<td></td>
</tr>
<tr>
<td>CANCELLATION</td>
<td>None</td>
</tr>
<tr>
<td>ACTION TO BE TAKEN</td>
<td>Verify the dialed digits with the configuration numbers.</td>
</tr>
<tr>
<td>PARAMETERS</td>
<td>Dialed digits.</td>
</tr>
<tr>
<td>DISPLAYED TEXT</td>
<td>Unassigned number P1</td>
</tr>
</tbody>
</table>

<p>| LOG NUMBER 32  | This log indicates that a local call failed because the sequence of Dialed digits is not allowed on the set that is attempting to place the call. |
| SEVERITY       | WARNING                                                                                                                                   |
| TASK           | Device Control                                                                |
| PRODUCT 9150, 911x |                                                                                                                                         |
| CANCELLATION   | None                                                                                    |
| ACTION TO BE TAKEN | Verify that the dialed digits don't match the disabled outbound digits.                                                                 |
| PARAMETERS     | dialed digits                                                                   |
| DISPLAYED TEXT | Disabled outbound digits blocked P1                                               |</p>
<table>
<thead>
<tr>
<th>Statistic</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOG NUMBER</td>
<td>33Cow indicates that the DSP cross connect failed, which might have resulted in no voice path being established.</td>
</tr>
<tr>
<td>DESCRIPTION</td>
<td>This log indicates that the DSP cross connect failed, which might have resulted in no voice path being established.</td>
</tr>
<tr>
<td>SEVERITY</td>
<td>CRITICAL</td>
</tr>
<tr>
<td>TASK</td>
<td>Device Control</td>
</tr>
<tr>
<td>PRODUCT</td>
<td>9150, 911x</td>
</tr>
<tr>
<td>CANCELLATION</td>
<td>None</td>
</tr>
<tr>
<td>ACTION TO BE TAKEN</td>
<td>Contact the vendor if the problem persists</td>
</tr>
<tr>
<td>PARAMETERS</td>
<td>port number</td>
</tr>
<tr>
<td>DISPLAYED TEXT</td>
<td>DSP cross connect failed on port P1</td>
</tr>
</tbody>
</table>

<p>| LOG NUMBER    | 34Cow indicates a change in the system Mode                                                                                               |
| DESCRIPTION   | This log indicates a change in the system Mode                                                                                           |
| SEVERITY      | NORMAL                                                                                                                                   |
| TASK          | Device Control, Call Processing                                                                                                          |
| PRODUCT       | RLC, 9150, 911x                                                                                                                           |
| CANCELLATION  | None                                                                                                                                     |
| ACTION TO BE TAKEN | None                                                                                                                                         |
| PARAMETERS    | Status: online/offline                                                                                                                     |
| DISPLAYED TEXT | Changing system mode to: P1                                                                                                                |</p>
<table>
<thead>
<tr>
<th>Statistic</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOG NUMBER</td>
<td>35</td>
</tr>
<tr>
<td>DESCRIPTION</td>
<td>This log indicates that there was a failure in registering to a remote RLC. This would indicate that the Host is unreachable through both the IP and the PSTN.</td>
</tr>
<tr>
<td>SEVERITY</td>
<td>MAJOR</td>
</tr>
<tr>
<td>TASK</td>
<td>Device Control</td>
</tr>
<tr>
<td>PRODUCT</td>
<td>9150, 911x</td>
</tr>
<tr>
<td>CANCELLATION</td>
<td>None</td>
</tr>
</tbody>
</table>
| ACTION TO BE TAKEN   | 1) Check for the IP/PSTN connectivity.  
2) Check for the remote Host status.  
3) Check the correctness of configuration. Units should be enabled. |
<p>| PARAMETERS           | Unit ID of remote site to which registration failed.                                                                                       |
| DISPLAYED TEXT       | Failed to register to remote site: P1                                                                                                     |</p>
<table>
<thead>
<tr>
<th>Statistic</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOG NUMBER</td>
<td>36</td>
</tr>
<tr>
<td>DESCRIPTION</td>
<td>This log indicates the success or failure of a Remote Office 9150 unit port’s attempt to register with a Multiuser/Dynamic port on a RLC.</td>
</tr>
<tr>
<td>SEVERITY</td>
<td>NORMAL</td>
</tr>
<tr>
<td>TASK</td>
<td>Device Control</td>
</tr>
<tr>
<td>PRODUCT</td>
<td>RLC, 9150</td>
</tr>
<tr>
<td>CANCELLATION</td>
<td>None</td>
</tr>
<tr>
<td>ACTION TO BE TAKEN</td>
<td>1) Determine if the port was in use.</td>
</tr>
<tr>
<td></td>
<td>2) Configure the port as a Multiuser/Dynamic port.</td>
</tr>
<tr>
<td></td>
<td>3) The host RLC is unreachable.</td>
</tr>
<tr>
<td>PARAMETERS</td>
<td>1) 9150 unit’s port number attempting to register with the multiuser/dynamic port on the RLC</td>
</tr>
<tr>
<td></td>
<td>3) registered or unregistered status of 9150 unit’s port</td>
</tr>
<tr>
<td></td>
<td>4) port number of multiuser/dynamic port on RLC</td>
</tr>
<tr>
<td>DISPLAYED TEXT</td>
<td>ROU port P1, P2 to RLC port P3</td>
</tr>
</tbody>
</table>
LOG NUMBER 37

DESCRIPTION: This log indicates that an attempt to connect to a Remote Office unit on the specified medium failed.

1) If the same message is displayed with both IP and PSTN, in succession, the specified remote cannot be reached.
2) If only one message displays with a specific medium while connections on other medium are fine, it indicates a possible attempt to connect on the medium due to:
   a) Priority of the call that requires only that medium. Voice call would have failed. Check for log number 55
   b) IP QoS state and priority level required a first attempt on the specified medium. A voice call would have succeeded on the other medium, though it cannot be guaranteed.
   c) Attempt was made on receiving a QoS status message.

SEVERITY: MAJOR

TASK: Network Manager

PRODUCT: RLC, 9150, 911x

CANCELLATION: None

ACTION TO BE TAKEN: Verify the following:
1) correctness of configurations
2) whether the network connections are proper
3) status of the remote board

PARAMETERS: 1) Remote Office unit ID
              2) medium on which the attempt failed

DISPLAYED TEXT: Not able to connect to remote site: P1 on P2 medium
**Statistic** | **Definition**  
--- | ---  
LOG NUMBER | 38  
DESCRIPTION | This log indicates that an attempt to bring up an additional trunk failed due to the lack of an unoccupied, configured trunk. This could cause the failure of a voice call depending on the media allowed to communicate to that remote, the priority of the call, and the Extra Bandwidth configured. However, verify the presence of log number 55 on the RLC to see if a voice call did not succeed. Look for the presence of log number 37 on the RLC. It indicates that an attempt was made to connect the voice call on that medium, but that the medium was not reachable.  
SEVERITY | MINOR  
TASK | Network Manager  
PRODUCT | RLC, 9150  
CANCELLATION | None  
ACTION TO BE TAKEN | Verify for the specified log numbers and note them. If this happens frequently, new trunks may have to be added.  
PARAMETERS | Remote Office unit ID  
DISPLAYED TEXT | No free additional trunk available to remote site: P1
LOG NUMBER 39

DESCRIPTION This log indicates that there an attempt was made to get an additional trunk on the PSTN.
This message should have a corresponding message with same number on the Remote Office 9150 unit board. This might cause a voice call to fail, depending on the media allowed to communicate with that remote device and the priority of the call.
However, check for the presence of log number 55 on the RLC to see if a voice call did not succeed. Look for the presence of log number 37 on the RLC. It indicates that an attempt was made to connect the voice call on that medium, but that the medium was not reachable.

SEVERITY MINOR

TASK Network Manager

PRODUCT RLC, 9150

CANCELLATION None

ACTION TO BE TAKEN 1) Ensure the PSTN numbers shown in Trunk Configuration are correct on both the RLC and Remote Office 9150 unit.
2) Ensure the trunk route to that Remote Office unit is not busy.

PARAMETERS 1) Remote Office unit ID
2) PSTN number attempted
3) A flag to indicate whether attempt is made by remote board or local board.
   1 - indicates attempt made by local board
   2 - indicates attempt made by remote board

DISPLAYED TEXT Attempted bring-up additional trunk failed. remote P1, PSTN number P2, flag P3
### Statistic Definitions

<table>
<thead>
<tr>
<th>Statistic</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOG NUMBER 40</td>
<td>This log indicates that an attempt to transition to the PSTN failed. Appearance of this message does not cause a voice call to drop. However, if RLC Log numbers 42 or 56 appear, the system can drop voice calls and not be able to connect to the Remote Office unit temporarily.</td>
</tr>
<tr>
<td>SEVERITY</td>
<td>WARNING</td>
</tr>
<tr>
<td>TASK</td>
<td>Network Manager</td>
</tr>
<tr>
<td>PRODUCT</td>
<td>RLC</td>
</tr>
<tr>
<td>CANCELLATION</td>
<td>None</td>
</tr>
</tbody>
</table>
| ACTION TO BE TAKEN | a) Look for correctness of primary PSTN number. If PSTN is disabled, ignore this message  
                    b) Trunk route might be busy to that remote.  
                    c) If the specified logs also appear, IP network could be down |
<p>| PARAMETERS      | Remote Office unit ID                                                      |
| DISPLAYED TEXT  | Transition did not happen to remote site: P1                               |</p>
<table>
<thead>
<tr>
<th>Statistic</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOG NUMBER</td>
<td>41</td>
</tr>
<tr>
<td>DESCRIPTION</td>
<td>This log indicates the failure of the system to connect to the specified remote on the IP network due to a network problem other than unacceptable QoS.</td>
</tr>
<tr>
<td>SEVERITY</td>
<td>WARNING</td>
</tr>
<tr>
<td>TASK</td>
<td>Network Manager</td>
</tr>
<tr>
<td>PRODUCT</td>
<td>RLC, 9150, 911x</td>
</tr>
<tr>
<td>CANCELLATION</td>
<td>None</td>
</tr>
</tbody>
</table>
| ACTION TO BE TAKEN| 1) Check for problems on IP network.  
                            2) Wait for more attempts because connections can take more time depending on nature of the network. |
<p>| PARAMETERS        | Remote Office unit ID                                                                |
| DISPLAYED TEXT    | Attempt to recover to IP network failed to remote site: P1                                                                             |</p>
<table>
<thead>
<tr>
<th>Statistic</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOG NUMBER 42</td>
<td>This log indicates that the IP network failed abruptly while there were connections routed over IP, dropping active voice calls. To check for dropped voice calls, look for log number 56.</td>
</tr>
<tr>
<td>SEVERITY MAJOR</td>
<td></td>
</tr>
<tr>
<td>TASK Network Manager</td>
<td></td>
</tr>
<tr>
<td>PRODUCT RLC, 9150, 911x</td>
<td></td>
</tr>
<tr>
<td>CANCELLATION None</td>
<td></td>
</tr>
<tr>
<td>ACTION TO BE TAKEN</td>
<td>Check if the IP connection is intact or if there is another problem on the IP network.</td>
</tr>
<tr>
<td>PARAMETERS Remote Office unit ID</td>
<td></td>
</tr>
<tr>
<td>DISPLAYED TEXT</td>
<td>Abnormal failure of IP network. remote site: P1</td>
</tr>
</tbody>
</table>

| LOG NUMBER 43     | This log indicates the failure of a non-primary trunk. This might lead to dropping of voice calls to compensate the BW loss in the absence of an IP connection to the Remote Office unit. Look for log number 56 to see if any calls were dropped. |
| SEVERITY MAJOR    |                                                                                                                                           |
| TASK Network Manager |                                                                                                                                            |
| PRODUCT RLC       |                                                                                                                                           |
| CANCELLATION None |                                                                                                                                           |
| ACTION TO BE TAKEN | 1) Verify that the PSTN connections are OK.                                                                                               |
|                    | 2) If this displays on the RLC, look for log number 46 on the 9150 unit. If this ID is there, it is a genuine closure.                       |
|                    | 3) Link might have failed somewhere in the PSTN.                                                                                           |
| PARAMETERS Remote Office unit ID |                                                                                                                                            |
| DISPLAYED TEXT    | Abnormal failure of one of the trunks. remote site: P1                                                                                   |
### Display log definitions

**LOG NUMBER 44**

**DESCRIPTION**
This log indicates an abnormal failure of the primary signaling link. This leads to the dropping of all active connections to the Remote Office unit.

**SEVERITY**
CRITICAL

**TASK**
Network Manager

**PRODUCT**
RLC, 9150, 911x

**CANCELLATION**
None

**ACTION TO BE TAKEN**
1) Check IP and trunk connections. (physical connections)
2) If this displays on the RLC, look for log number 45 on the 9150 unit. If this log is there, it is a genuine closure.
3) Link might have failed some where in the Public network.

**PARAMETERS**
Remote Office unit ID to which communication is lost

**DISPLAYED TEXT**
Abnormal failure of primary signaling to remote site: P1
### Log Number 45

**Description:** This log indicates that the primary signaling was dropped due to a request for a 911 (emergency) call, resulting in a temporary loss of communication with RLC.

**Severity:** WARNING

**Task:** Network Manager

**Product:** 9150, 911x

**Cancellation:** None

**Action to Be Taken:** This indicates that there are not enough trunks and the primary trunk had to be used for a 911 (emergency) call. Check if number of trunks can be increased (9150 only).

**Parameters:** None

**Displayed Text:** Primary trunk dropped to place 911 call

### Log Number 46

**Description:** This log indicates that the system dropped one of the additional trunks to place a 911 (emergency) call as there were no available trunks.

**Severity:** WARNING

**Task:** Network Manager

**Product:** 9150

**Cancellation:** None

**Action to Be Taken:** None

**Parameters:** None

**Displayed Text:** Closing an additional trunk to place 911 call
<table>
<thead>
<tr>
<th>Statistic</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOG NUMBER</td>
<td>47</td>
</tr>
<tr>
<td>DESCRIPTION</td>
<td>This log indicates that inactivity timer creation failed. This could lead to the primary signaling channel not closing to the remote. If the IP QoS is BAD, the PSTN trunk stays on. Otherwise, IP stay on.</td>
</tr>
<tr>
<td>SEVERITY</td>
<td>WARNING</td>
</tr>
<tr>
<td>TASK</td>
<td>Network Manager</td>
</tr>
<tr>
<td>PRODUCT</td>
<td>RLC</td>
</tr>
<tr>
<td>CANCELLATION</td>
<td>None</td>
</tr>
<tr>
<td>ACTION TO BE TAKEN</td>
<td>To overcome this situation, make sure no one is using the Remote Office unit phones, and then go to offline mode and come back to on-line. Normal operation is restored. Use online/offline spree codes on the 9150, 911x unit.</td>
</tr>
<tr>
<td>PARAMETERS</td>
<td>Remote Office unit ID</td>
</tr>
<tr>
<td>DISPLAYED TEXT</td>
<td>Timer creation failed. Signal will not be closed to remote site: P1</td>
</tr>
</tbody>
</table>
Display log definitions

<table>
<thead>
<tr>
<th>Statistic</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOG NUMBER</td>
<td>48</td>
</tr>
<tr>
<td>DESCRIPTION</td>
<td>This log indicates the failure of a connection because of incorrect security information due to one of the following situations: 1) A Valid remote tried to connect with inappropriate Security data. 2) The Remote Office unit rejected a connection initiated by the local unit. 3) There is a security issue with bringing up an additional trunk.</td>
</tr>
<tr>
<td>SEVERITY</td>
<td>WARNING</td>
</tr>
<tr>
<td>TASK</td>
<td>Network Manager</td>
</tr>
<tr>
<td>PRODUCT</td>
<td>RLC, 9150, 911x</td>
</tr>
<tr>
<td>CANCELLATION</td>
<td>None</td>
</tr>
<tr>
<td>ACTION TO BE TAKEN</td>
<td>1) Check that the security levels and security IDs are correct in configuration. 2) Security issue for additional trunks comes up if security level is CLID security and configuration is improper. 3) This may be an indication of an unauthorized Remote Office unit attempting to connect.</td>
</tr>
<tr>
<td>PARAMETERS</td>
<td>1) Remote Office unit ID 2) media 3) connection type: primary/additional</td>
</tr>
<tr>
<td>DISPLAYED TEXT</td>
<td>Security failure to remote site: P1 on medium P2.</td>
</tr>
<tr>
<td>Statistic</td>
<td>Definition</td>
</tr>
<tr>
<td>-------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>LOG NUMBER</td>
<td>49</td>
</tr>
<tr>
<td>DESCRIPTION</td>
<td>This log indicates that an unknown remote tried to connect and the attempt failed.</td>
</tr>
<tr>
<td>SEVERITY</td>
<td>WARNING</td>
</tr>
<tr>
<td>TASK</td>
<td>Network Manager</td>
</tr>
<tr>
<td>PRODUCT</td>
<td>RLC, 9150, 911x</td>
</tr>
<tr>
<td>CANCELLATION</td>
<td>None</td>
</tr>
<tr>
<td>ACTION TO BE TAKEN</td>
<td>1) Confirm that the configuration of the unit IDs are OK between the units.</td>
</tr>
<tr>
<td></td>
<td>2) This may be an indication of an unauthorized Remote Office unit attempting to connect.</td>
</tr>
<tr>
<td>PARAMETERS</td>
<td>Unit ID of the Remote Office unit</td>
</tr>
<tr>
<td>DISPLAYED TEXT</td>
<td>Message from invalid remote site: P1</td>
</tr>
</tbody>
</table>
LOG NUMBER 50
DESCRIPTION This log indicates that a connection came in on an unconfigured port and was rejected by the system. (PSTN connections)
SEVERITY WARNING
TASK Network Manager
PRODUCT RLC, 9150
CANCELLATION None
ACTION TO BE TAKEN 1) Check for proper port configurations on the RLC and 9150 unit.
2) Check if a local call came in on a remote-only BRI port. Ensure that non-remote only BRI trunk numbers only are given to outsiders to call 9150's local sets.
3) Unauthorized unit may be trying to connect. Verify!
PARAMETERS PSTN number from which the call originates
DISPLAYED TEXT Incoming connection rejected. Address P1
<table>
<thead>
<tr>
<th>Statistic</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOG NUMBER 51</td>
<td>This log indicates that an incoming connection from the specified Remote Office unit failed because the specified medium is not allowed to connect to that Remote Office unit.</td>
</tr>
<tr>
<td>DESCRIPTION</td>
<td>This log indicates that an incoming connection from the specified Remote Office unit failed because the specified medium is not allowed to connect to that Remote Office unit.</td>
</tr>
<tr>
<td>SEVERITY</td>
<td>WARNING</td>
</tr>
<tr>
<td>TASK</td>
<td>Network Manager</td>
</tr>
<tr>
<td>PRODUCT</td>
<td>RLC, 9150, 911x</td>
</tr>
<tr>
<td>CANCELLATION</td>
<td>None</td>
</tr>
</tbody>
</table>
| ACTION TO BE TAKEN | 1) Check the correctness of configurations.  
                         2) Verify that unit trying to connect has needed authorization. |
| PARAMETERS       | 1) Unit ID of the Remote Office unit  
                         2) The medium to which it attempted to connect |
| DISPLAYED TEXT   | Signaling clash to remote site: P1 [on medium: P2]                                                                                      |

<p>| LOG NUMBER 52    | This log indicates that no activity was found on the signaling link and all remote service phones were idle. |
| DESCRIPTION      | This log indicates that no activity was found on the signaling link and all remote service phones were idle. |
| SEVERITY         | NORMAL                                                                                                                                   |
| TASK             | Network Manager                                                               |
| PRODUCT          | RLC                                                                            |
| CANCELLATION     | None                                                                            |
| ACTION TO BE TAKEN | None. This is part of normal system operation. | |
| PARAMETERS       | Remote Office unit ID                                                          |
| DISPLAYED TEXT   | Signaling closed to remote site: P1 due to no activity                           |</p>
<table>
<thead>
<tr>
<th>Statistic</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOG NUMBER 53</td>
<td>This log indicates that the Remote Office unit went Offline. No communication is possible until the unit goes Online again or Online time occurs. In Offline mode, all connections, including permanent trunks, if any, are closed.</td>
</tr>
<tr>
<td>SEVERITY</td>
<td>NORMAL</td>
</tr>
<tr>
<td>TASK</td>
<td>Network Manager</td>
</tr>
<tr>
<td>PRODUCT</td>
<td>RLC</td>
</tr>
<tr>
<td>CANCELLATION</td>
<td>None</td>
</tr>
<tr>
<td>ACTION TO BE TAKEN</td>
<td>None</td>
</tr>
<tr>
<td>PARAMETERS</td>
<td>Remote Office unit ID going offline</td>
</tr>
<tr>
<td>DISPLAYED TEXT</td>
<td>Close signal as unit goes offline. remote site: P1</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Statistic</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOG NUMBER 54</td>
<td>This log indicates an attempt to reach an invalid remote.</td>
</tr>
<tr>
<td>SEVERITY</td>
<td>WARNING</td>
</tr>
<tr>
<td>TASK</td>
<td>Network Manager</td>
</tr>
<tr>
<td>PRODUCT</td>
<td>RLC, 9150, 911x</td>
</tr>
<tr>
<td>CANCELLATION</td>
<td>None</td>
</tr>
</tbody>
</table>
| ACTION TO BE TAKEN | 1) Check for proper configuration  
2) Check for updates completed while system was active.  
3) If the message is consistent, even after proper configuration, report to vendor. |
| PARAMETERS     | unit ID of Remote Office unit to which connection was attempted.         |
| DISPLAYED TEXT | Connection attempted to invalid remote site: P1                           |
### Display log definitions

<table>
<thead>
<tr>
<th>Statistic</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOG NUMBER</td>
<td>55</td>
</tr>
<tr>
<td>DESCRIPTION</td>
<td>This log indicates the system was unable to place a voice call, which could be caused by the following conditions:</td>
</tr>
<tr>
<td></td>
<td>1) No connection to the remote. Attempts failed.</td>
</tr>
<tr>
<td></td>
<td>2) HIGH/NORMAL priority: No BW on trunk and IP not available.</td>
</tr>
<tr>
<td></td>
<td>3) PSTN only call: No BW available, trunk disabled, or trunk not reachable.</td>
</tr>
<tr>
<td></td>
<td>4) IP only call: IP not reachable or not enabled.</td>
</tr>
<tr>
<td></td>
<td>5) Some inconsistency within the system - Synchronization between RLC - 9150/911x.</td>
</tr>
<tr>
<td>SEVERITY</td>
<td>NORMAL</td>
</tr>
<tr>
<td>TASK</td>
<td>Network Manager</td>
</tr>
<tr>
<td>PRODUCT</td>
<td>RLC</td>
</tr>
<tr>
<td>CANCELLATION</td>
<td>None</td>
</tr>
<tr>
<td>ACTION TO BE TAKEN</td>
<td>1) Verify correctness of configurations.</td>
</tr>
<tr>
<td></td>
<td>2) Verify physical connections on the medium as per information in 1), above.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If this happens consistently for all calls, and is not an obvious problem due to configuration or BW limitations, view the statistics and report the problem.</td>
</tr>
<tr>
<td>PARAMETERS</td>
<td>1) Remote Office unit ID</td>
</tr>
<tr>
<td></td>
<td>2) amount of bandwidth the system needs to place the additional call</td>
</tr>
<tr>
<td>DISPLAYED TEXT</td>
<td>Voice call did not succeed to remote site: P1 [BW required P2]</td>
</tr>
<tr>
<td>Statistic</td>
<td>Definition</td>
</tr>
<tr>
<td>------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>LOG NUMBER</td>
<td>56</td>
</tr>
</tbody>
</table>
| DESCRIPTION      | This log indicates an abnormal failure of a call. Possible reasons include:  
1) sudden link failure on the given medium  
2) drop of remote trunks on the 9150/911x side for a 911 (emergency) call  
3) sudden primary signaling failure |
| SEVERITY         | MAJOR                                                                                                                                 |
| TASK             | Network Manager                                                                                                                                 |
| PRODUCT          | RLC, 9150, 911x                                                                                                                                 |
| CANCELLATION     | None                                                                                                                                 |
| ACTION TO BE TAKEN | Look for log numbers 42, 43, and 44 to ascertain the reason active calls were dropped.                                                         |
| PARAMETERS       | 1) bandwidth of the call  
2) unit ID of remote to which call is connected  
3) media on which the call was active at the time of failure |
<p>| DISPLAYED TEXT   | Call of P1 BW got dropped to remote site: P2, medium: P3                                                                                   |</p>
<table>
<thead>
<tr>
<th>Statistic</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOG NUMBER</td>
<td>57</td>
</tr>
<tr>
<td>DESCRIPTION</td>
<td>This log indicates a failed attempt to switch a voice connection to the specified medium. This is an indication of a loss of one of the following: 1) signaling packets 2) synchronization between RLC - 9150, 911x</td>
</tr>
<tr>
<td>SEVERITY</td>
<td>MINOR</td>
</tr>
<tr>
<td>TASK</td>
<td>Network Manager</td>
</tr>
<tr>
<td>PRODUCT</td>
<td>RLC</td>
</tr>
<tr>
<td>CANCELLATION</td>
<td>None</td>
</tr>
<tr>
<td>ACTION TO BE TAKEN</td>
<td>This should not happen in general. If it does, report the problem.</td>
</tr>
</tbody>
</table>
| PARAMETERS          | 1) bandwidth of the call  
                      | 2) medium from which the system attempted to switch the call  
                      | 3) medium to which the system attempted to switch the call  
                      | 4) Remote Office unit ID                                           |
| DISPLAYED TEXT      | Call of P1 BW did not switch from medium: P2 to medium: P3, remote site: P4 |
### LOG NUMBER 58

**DESCRIPTION**: This log indicates that there is no available trunk in the given trunk group to place a local trunk call.

**SEVERITY**: MINOR

**TASK**: Network Manager

**PRODUCT**: 9150

**CANCELLATION**: None

**ACTION TO BE TAKEN**: If this happens consistently, think of reconfiguring B-channel allocations on 9150

**PARAMETERS**: Trunk Group Number

**DISPLAYED TEXT**: Local call did not succeed.

### LOG NUMBER 59

**DESCRIPTION**: This log indicates that a local call was dropped because of an abnormal link failure.

**SEVERITY**: MAJOR

**TASK**: Network Manager

**PRODUCT**: 9150

**CANCELLATION**: None

**ACTION TO BE TAKEN**:  
- Confirm that physical trunk connections are intact  
- Check for failure on the PSTN.

**PARAMETERS**: None

**DISPLAYED TEXT**: Local trunk call abnormally failed.
LOG NUMBER 60
DESCRIPTION This message indicates that a local trunk call was dropped for an emergency (911) call because there were no free trunks.
SEVERITY WARNING
TASK Network Manager
PRODUCT 9150
CANCELLATION None
ACTION TO BE TAKEN None
PARAMETERS None
DISPLAYED TEXT Local call dropped for 911.

LOG NUMBER 61
DESCRIPTION This log indicates that the signaling link to a Remote Office unit was established on the specified medium.
SEVERITY NORMAL
TASK Network Manager
PRODUCT RLC, 9150, 911x
CANCELLATION None
ACTION TO BE TAKEN Nothing. This is part of normal system operation.
PARAMETERS Remote Office unit ID
DISPLAYED TEXT Signaling is UP to remote site: P1 on medium: P2.
<table>
<thead>
<tr>
<th>LOG NUMBER</th>
<th>62</th>
</tr>
</thead>
</table>
| DESCRIPTION | This log indicates that the IDVR server has gone down.  
               (This log is not generated in the 1.2.1 release.) |
| SEVERITY    | MAJOR       |
| TASK        | Device Control, Call processing |
| PRODUCT     | RLC, 9150, IDVR |
| CANCELLATION | None        |
| ACTION TO BE TAKEN | 1) Check for the IP connectivity to server.  
                             2) Check for the IDVR server status. |
<p>| PARAMETERS  | IDVR server’s IP address. |
| DISPLAYED TEXT | IDVR server status: P1 |</p>
<table>
<thead>
<tr>
<th>Statistic</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOG NUMBER 63</td>
<td>This log indicates a PSTN connection to a peer unit failed. This could be caused by several possible problems, including: 1) A cabling issue at the Remote Office unit could keep that unit from being able to connect on the PSTN. 2) The data port on the RLC could be disabled. 3) For BRI connections between a 9150 and an RLC the PSTN path may not be a 64K clear channel (the required path). 4) Incorrect dial numbers could be keeping the circuit from establishing. 5) Bit errors could be occurring preventing communication from working. This could be due to bad cables or a bad connection.</td>
</tr>
<tr>
<td>SEVERITY</td>
<td>MAJOR</td>
</tr>
<tr>
<td>TASK</td>
<td>TP</td>
</tr>
<tr>
<td>PRODUCT</td>
<td>RLC, 9150, 911x</td>
</tr>
<tr>
<td>CANCELLATION</td>
<td>None</td>
</tr>
<tr>
<td>ACTION TO BE TAKEN</td>
<td>To check for the possible problems named above, take the associated action listed below: 1) Check the PSTN connections at the Remote Office unit. 2) Confirm that the RLC’s data port is enabled. 3) Confirm that BRI connections between a 9150 unit and its RLC are 64K clear channel (the required path). 4) Confirm that the correct numbers are configured on both ends. 5) Confirm that cables and connections on both ends are good.</td>
</tr>
<tr>
<td>PARAMETERS</td>
<td>N/A</td>
</tr>
<tr>
<td>DISPLAYED TEXT</td>
<td>PSTN connection failed to initialize.</td>
</tr>
</tbody>
</table>
**Statistic** | **Definition**
--- | ---
LOG NUMBER | 64
DESCRIPTION | This log indicates that the unit attempted a PSTN connection to its peer unit at too slow a bit rate. This severely damages system performance since all bandwidth calculations are incorrect.
SEVERITY | Major
TASK | TP
PRODUCT | RLC, 9150
CANCELLATION | None
ACTION TO BE TAKEN | The PSTN path between a 9150 and RLC requires a clear 64k channel.
If this log occurs every time a PSTN call is made, then
- either the wrong service has been ordered from the telephone company.
- the telephone company has provided the wrong service.
If this log occurs intermittently then the connection through the central office has encountered some sort of problem.
It is still possible, however, that the wrong service has been ordered, or provided, and that the majority of the time the PSTN has had a clear channel by chance. Some customers have reported that they requested the 64k channel, but a 54k channel was provided instead.
Another possible scenario is that bit errors could be occurring, preventing communication from initializing at 64k, but allowing 56k. This is probably the lease frequent cause.
PARAMETERS | Unit ID of the unit that tried to connect.
DISPLAYED TEXT | PSTN connection initialized at 56k clear channel unavailable.
LOG NUMBER 65

DESCRIPTION This log indicates that the unit attempted a PSTN connection to its peer unit, and that the connection attempt succeeded initially at 56K, failed at 65K, and then failed again at 56K.

SEVERITY MAJOR

TASK TP

PRODUCT RLC, 9150

CANCELATION None

ACTION TO BE TAKEN: This problem is most likely related to log number 64 where a clear 64k channel could not be obtained.

It is possible that the attempt to increase speed to 64K caused a problem with the central office, making it impossible to re-establish at 56K. This would increase the likelihood of the problem being due to a high bit error rate on the link.

PARAMETERS N/A

DISPLAYED TEXT PSTN connection failed to re-initiate at 56K
### Display log definitions

<table>
<thead>
<tr>
<th>Statistic</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOG NUMBER</td>
<td>66</td>
</tr>
<tr>
<td>DESCRIPTION</td>
<td>This log indicates that the database has been converted from an older version to the current version. The start and end versions are specified. The status of the conversion is also available.</td>
</tr>
<tr>
<td>SEVERITY</td>
<td>NORMAL</td>
</tr>
<tr>
<td>TASK</td>
<td>MMI</td>
</tr>
<tr>
<td>PRODUCT</td>
<td>9150</td>
</tr>
<tr>
<td>CANCELLATION</td>
<td>None</td>
</tr>
<tr>
<td>ACTION TO BE TAKEN</td>
<td>If the status is Failure, user must re-configure the system.</td>
</tr>
<tr>
<td>PARAMETERS</td>
<td>1) Status 2) Starting version (From version) 3) Current version (To version)</td>
</tr>
<tr>
<td>DISPLAYED TEXT</td>
<td>Database Conversion: P1</td>
</tr>
<tr>
<td>Statistic</td>
<td>Definition</td>
</tr>
<tr>
<td>-------------------</td>
<td>---------------------------------------------------------------------------</td>
</tr>
<tr>
<td>LOG NUMBER</td>
<td>67</td>
</tr>
<tr>
<td>DESCRIPTION</td>
<td>This log indicates that a locally-defined feature clashes with a PBX defined feature.</td>
</tr>
<tr>
<td>SEVERITY</td>
<td>NORMAL</td>
</tr>
<tr>
<td>TASK</td>
<td>Device Control</td>
</tr>
<tr>
<td>PRODUCT</td>
<td>RLC, 9150</td>
</tr>
<tr>
<td>CANCELLATION</td>
<td>None</td>
</tr>
</tbody>
</table>
| ACTION TO BE TAKEN: | 1. In the case of failure, check the key configurations on the switch and the key configurations done on the 911x, 9150, IDVR for the port concerned.  
                        | 2. In case of clash Redefine the local feature on a key which is not being used for a PBX feature. |
| PARAMETERS        | 1. Remote Office unit Port Number  
<pre><code>                    | 2. Key Number                                                            |
</code></pre>
<p>| DISPLAYED TEXT    | Port P1: Local Feature Overrides PBX Feature on key P2.                 |</p>
<table>
<thead>
<tr>
<th>Statistic</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOG NUMBER</td>
<td>68</td>
</tr>
<tr>
<td>DESCRIPTION</td>
<td>This log indicates that a PSTN connectivity test has started to a specified remote, in a specified mode.</td>
</tr>
<tr>
<td>SEVERITY</td>
<td>NORMAL</td>
</tr>
<tr>
<td>TASK</td>
<td>Network Manager</td>
</tr>
<tr>
<td>PRODUCT</td>
<td>RLC</td>
</tr>
<tr>
<td>CANCELLATION</td>
<td>None</td>
</tr>
<tr>
<td>ACTION TO BE TAKEN:</td>
<td>None</td>
</tr>
<tr>
<td>PARAMETERS</td>
<td>1. Remote board ID &lt;br&gt;2. Mode in which test started. &lt;br&gt; a. Disruptive test &lt;br&gt; b. Non disruptive test</td>
</tr>
<tr>
<td>DISPLAYED TEXT</td>
<td>PSTN connectivity test started for remote = P1, in mode = P2</td>
</tr>
</tbody>
</table>
LOG NUMBER 69
DESCRIPTION This log indicates that a PSTN connectivity test is completed or aborted.
SEVERITY NORMAL
TASK Network Manager
PRODUCT RLC
CANCELLATION None
ACTION TO BE TAKEN: None
PARAMETERS 1. Remote board ID
2. Test ended manner
   a. Normal end
   b. Aborted
DISPLAYED TEXT PSTN connectivity test ended for remote = P1 and P2
<table>
<thead>
<tr>
<th>Statistic</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOG NUMBER</td>
<td>70</td>
</tr>
<tr>
<td>DESCRIPTION</td>
<td>This log indicates that there was a failure in adding a DN to the system, since the DN was already in the system. If you want to place a local call to this set, you must use the number configured through Configuration Manager.</td>
</tr>
<tr>
<td>SEVERITY</td>
<td>NORMAL</td>
</tr>
<tr>
<td>TASK</td>
<td>Device Control</td>
</tr>
<tr>
<td>PRODUCT</td>
<td>9150</td>
</tr>
<tr>
<td>CANCELLATION</td>
<td>None</td>
</tr>
<tr>
<td>ACTION TO BE TAKEN:</td>
<td>Do not configure MADN on the primary key if both of the sets are on the 9150.</td>
</tr>
<tr>
<td>PARAMETERS</td>
<td>1. Remote Office unit Port Number</td>
</tr>
<tr>
<td></td>
<td>2. DN which couldn't be added to the system.</td>
</tr>
<tr>
<td>DISPLAYED TEXT</td>
<td>MADN Conflict for DN P1 on Port P2: Could not update local DN.</td>
</tr>
</tbody>
</table>
### Display log definitions

<table>
<thead>
<tr>
<th>Statistic</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOG NUMBER</td>
<td>71</td>
</tr>
<tr>
<td>DESCRIPTION</td>
<td>This log indicates that the PBX has returned an Illegal number error when attempting to dial from the Network port on the RLC to the 9150 Remote Office unit. Most frequently, this error occurs when the dialed number is going to be routed by the PBX, or Central Office, over an analog trunk instead of a clear channel data path.</td>
</tr>
<tr>
<td>SEVERITY</td>
<td>MAJOR</td>
</tr>
<tr>
<td>TASK</td>
<td>DL</td>
</tr>
<tr>
<td>PRODUCT</td>
<td>RLC</td>
</tr>
<tr>
<td>CANCELLATION</td>
<td>None</td>
</tr>
<tr>
<td>ACTION TO BE TAKEN:</td>
<td>1. Verify that the Network port is configured correctly on the PBX 2. Verify that the number dialed from the RLC to the 9150 is correct. 3. Verify that the PBX trunks used allow clear channel data. LD 80 traces of the data port are helpful. 4. Verify that central office is not routing the data call over voice circuits.</td>
</tr>
<tr>
<td>PARAMETERS</td>
<td>1. Network port from which this call was placed 2. Last number dialed by a Network port, usually this port.</td>
</tr>
<tr>
<td>DISPLAYED TEXT</td>
<td>Network Port P1 call to P2 may be routed over Voice circuits.</td>
</tr>
</tbody>
</table>
**Display log definitions**

<table>
<thead>
<tr>
<th>Statistic</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOG NUMBER</td>
<td>72</td>
</tr>
<tr>
<td>DESCRIPTION</td>
<td>This log indicates that a key map update is written into the Flash.</td>
</tr>
<tr>
<td>SEVERITY</td>
<td>NORMAL</td>
</tr>
<tr>
<td>TASK</td>
<td>MMI</td>
</tr>
<tr>
<td>PRODUCT</td>
<td>9150</td>
</tr>
<tr>
<td>CANCELLATION</td>
<td>None</td>
</tr>
<tr>
<td>ACTION TO BE TAKEN:</td>
<td>None</td>
</tr>
<tr>
<td>PARAMETERS</td>
<td>Status - SUCCESS if Save to Flash is successful.</td>
</tr>
<tr>
<td></td>
<td>Status - FAILED if the flash save attempt failed.</td>
</tr>
<tr>
<td>DISPLAYED TEXT</td>
<td>Key Map Save to Flash: P1</td>
</tr>
<tr>
<td>Statistic</td>
<td>Definition</td>
</tr>
<tr>
<td>-------------------</td>
<td>---------------------------------------------------------------------------</td>
</tr>
<tr>
<td>LOG NUMBER</td>
<td>73</td>
</tr>
<tr>
<td>DESCRIPTION</td>
<td>This log indicates an invalid compression type (e.g., G729/Fax or G726) has been configured for the 911x. It is then reset to G729.</td>
</tr>
<tr>
<td>SEVERITY</td>
<td>MINOR</td>
</tr>
<tr>
<td>TASK</td>
<td>MMI</td>
</tr>
<tr>
<td>PRODUCT</td>
<td>911x</td>
</tr>
<tr>
<td>CANCELLATION</td>
<td>None</td>
</tr>
<tr>
<td>ACTION TO BE TAKEN:</td>
<td>None</td>
</tr>
</tbody>
</table>
| PARAMETERS        | P1: Remote Site Number
|                   | P2: Port Number.
|                   | Status - FAILED if the flash save attempt failed.                        |
| DISPLAYED TEXT    | "Remote Site: P1[911x] registered to Port P2 with Invalid Compression, reset to G729" |
### Statistic Definition

<table>
<thead>
<tr>
<th>Statistic</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOG NUMBER</td>
<td>74</td>
</tr>
<tr>
<td>DESCRIPTION</td>
<td>This log indicates a status change (e.g., UP/DOWN) for the BRI line.</td>
</tr>
<tr>
<td>SEVERITY</td>
<td>NORMAL</td>
</tr>
<tr>
<td>TASK</td>
<td>MMI</td>
</tr>
<tr>
<td>PRODUCT</td>
<td>9150</td>
</tr>
<tr>
<td>CANCELLATION</td>
<td>None</td>
</tr>
<tr>
<td>ACTION TO BE TAKEN</td>
<td>None</td>
</tr>
<tr>
<td>PARAMETERS</td>
<td>P1: Describes status change (e.g., UP)</td>
</tr>
<tr>
<td></td>
<td>P2: BRI Module Number</td>
</tr>
<tr>
<td>DISPLAYED TEXT</td>
<td>P1 detected for BRI Module P2.</td>
</tr>
<tr>
<td>Statistic</td>
<td>Definition</td>
</tr>
<tr>
<td>------------------</td>
<td>---------------------------------------------------------------------------</td>
</tr>
<tr>
<td>LOG NUMBER</td>
<td>75</td>
</tr>
<tr>
<td>DESCRIPTION</td>
<td>This log indicates the system is not able to bring up an analog line due to non-availability of modem DSPs.</td>
</tr>
<tr>
<td>SEVERITY</td>
<td>MINOR</td>
</tr>
<tr>
<td>TASK</td>
<td>MMI</td>
</tr>
<tr>
<td>PRODUCT</td>
<td>9150</td>
</tr>
<tr>
<td>CANCELLATION</td>
<td>None</td>
</tr>
<tr>
<td>ACTION TO BE TAKEN</td>
<td>a) Ensure that enough Modem channels are configured on DSPs</td>
</tr>
<tr>
<td>PARAMETERS</td>
<td>P1: Remote Unit ID</td>
</tr>
<tr>
<td>DISPLAYED TEXT</td>
<td>Not able to connect remote: P1 on modem due to non availability of Modem channels</td>
</tr>
<tr>
<td>Statistic</td>
<td>Definition</td>
</tr>
<tr>
<td>-------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>LOG NUMBER</td>
<td>76</td>
</tr>
<tr>
<td>DESCRIPTION</td>
<td>This log indicates that the software version of the remote unit is incompatible with the software version installed in the unit generating this message.</td>
</tr>
<tr>
<td>SEVERITY</td>
<td>MAJOR</td>
</tr>
<tr>
<td>TASK</td>
<td>MMI</td>
</tr>
<tr>
<td>PRODUCT</td>
<td>9150, RLC, 911x</td>
</tr>
<tr>
<td>CANCELLATION</td>
<td>None</td>
</tr>
<tr>
<td>ACTION TO BE TAKEN</td>
<td>Verify software versions on both units.</td>
</tr>
<tr>
<td>PARAMETERS</td>
<td>P1: Remote Unit ID</td>
</tr>
<tr>
<td>DISPLAYED TEXT</td>
<td>Communication with Remote P1 is not possible due to software incompatibility.</td>
</tr>
<tr>
<td>Statistic</td>
<td>Definition</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>LOG NUMBER 77</td>
<td>This log indicates that the RLC’s remote unit config does not match the remote device that is initiating the call. This is probably due to a config error.</td>
</tr>
<tr>
<td>SEVERITY MAJOR</td>
<td></td>
</tr>
<tr>
<td>TASK MMI</td>
<td></td>
</tr>
<tr>
<td>PRODUCT RLC</td>
<td></td>
</tr>
<tr>
<td>CANCELLATION None</td>
<td></td>
</tr>
<tr>
<td>ACTION TO BE TAKEN:</td>
<td>Verify Remote Unit configuration</td>
</tr>
<tr>
<td>PARAMETERS P1:</td>
<td>Remote Unit ID</td>
</tr>
<tr>
<td>DISPLAYED TEXT</td>
<td>Remote Unit = P1 is found to be of incompatible board type. Communication not possible</td>
</tr>
</tbody>
</table>
## Display log definitions

### Standard 2.0

<table>
<thead>
<tr>
<th>Statistic</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOG NUMBER</td>
<td>78</td>
</tr>
<tr>
<td>DESCRIPTION</td>
<td>This log indicates that the keymap version of the PBX software has changed. This is normal when upgrading major PBX versions.</td>
</tr>
<tr>
<td>SEVERITY</td>
<td>NORMAL</td>
</tr>
<tr>
<td>TASK</td>
<td>MMI</td>
</tr>
<tr>
<td>PRODUCT</td>
<td>RLC</td>
</tr>
<tr>
<td>CANCELLATION</td>
<td>None</td>
</tr>
<tr>
<td>ACTION TO BE TAKEN</td>
<td>None</td>
</tr>
<tr>
<td>PARAMETERS</td>
<td>P1, P2: Keymap database version</td>
</tr>
<tr>
<td></td>
<td>P3: Indicates Success or Failure</td>
</tr>
<tr>
<td>DISPLAYED TEXT</td>
<td>PBX Model database conversion from Ver P1 to Ver P2 P3</td>
</tr>
</tbody>
</table>
### Display log definitions

<table>
<thead>
<tr>
<th>Statistic</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOG NUMBER</td>
<td>79</td>
</tr>
<tr>
<td>DESCRIPTION</td>
<td>This log indicates the status of the keymap flash read.</td>
</tr>
<tr>
<td>SEVERITY</td>
<td>NORMAL</td>
</tr>
<tr>
<td>TASK</td>
<td>MMI</td>
</tr>
<tr>
<td>PRODUCT</td>
<td>RLC</td>
</tr>
<tr>
<td>CANCELLATION</td>
<td>None</td>
</tr>
<tr>
<td>ACTION TO BE TAKEN</td>
<td>None</td>
</tr>
<tr>
<td>PARAMETERS</td>
<td>P1: SUCCESS or failure reason.</td>
</tr>
<tr>
<td>DISPLAYED TEXT</td>
<td>P3 PBX Model database read - P1</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Statistic</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOG NUMBER</td>
<td>80</td>
</tr>
<tr>
<td>DESCRIPTION</td>
<td>This log indicates that connectivity on the specified medium to the specified remote unit closed. This is a part of normal system operation.</td>
</tr>
<tr>
<td>SEVERITY</td>
<td>NORMAL</td>
</tr>
<tr>
<td>TASK</td>
<td>Network Manager</td>
</tr>
<tr>
<td>PRODUCT</td>
<td>RLC, 9150, 911x</td>
</tr>
<tr>
<td>CANCELLATION</td>
<td>None</td>
</tr>
<tr>
<td>ACTION TO BE TAKEN</td>
<td>None</td>
</tr>
</tbody>
</table>
| PARAMETERS      | 1) Remote unit  
2) Medium (ISDN, IP)                                                      |
<p>| DISPLAYED TEXT  | Connectivity is closed to Remote: P1 on Media: P2                           |</p>
<table>
<thead>
<tr>
<th>Statistic</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOG NUMBER</td>
<td>81</td>
</tr>
<tr>
<td>DESCRIPTION</td>
<td>This log indicates that connectivity on the specified medium to the specified remote failed abnormally due to an unspecified problem on the network.</td>
</tr>
<tr>
<td>SEVERITY</td>
<td>MAJOR</td>
</tr>
<tr>
<td>TASK</td>
<td>Network Manager</td>
</tr>
<tr>
<td>PRODUCT</td>
<td>RLC, 9150, 911x</td>
</tr>
<tr>
<td>CANCELLATION</td>
<td>A message that indicates that signaling is up on the specified medium.</td>
</tr>
</tbody>
</table>
| ACTION TO BE TAKEN | Check for the following on the specified medium:  
1) Network connectivity both at RLC and the remote site  
2) Check if any problem arose anywhere else on the network between RLC and the remote  
3) Check if any of the units got reset for any reason. |
| PARAMETERS    | 1) Remote unit  
2) Medium (ISDN, IP)                                                                                                                          |
| DISPLAYED TEXT| Abnormal failure of connectivity on Media: P1 to Remote: P2                                                                                     |
### Log Definition

LOG NUMBER 82

**DESCRIPTION**
This log indicates that Network Manager task states for a particular remote unit got reset and all the connections to the remote are cleared. This can happen due to the following reasons:

1) An error occurred in the system to automatically trigger Network Manager reset
2) User has issued a debug command "nrm x" where x is a valid remote unit number.

**SEVERITY** MAJOR

**TASK** Network Manager

**PRODUCT** RLC, 9150, 911x

**CANCELLATION** None

**ACTION TO BE TAKEN** System should work normally after the log is displayed. If not, contact Technical support personal for help. If the log is displayed too frequently, check if anyone is entering debug commands. If not, contact technical support.

**PARAMETERS** Remote unit

**DISPLAYED TEXT** States reset in NM for Remote: P1
<table>
<thead>
<tr>
<th>Statistic</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOG NUMBER</td>
<td>83</td>
</tr>
<tr>
<td>DESCRIPTION</td>
<td>This log indicates the result of DN discovery on RLC. If the result in the log is Failure or Partial Success then the system retries for up to five times at three minute intervals if port(s) is (are) busy during first attempt. The system records the status of the initial attempt as well as the last attempt, if made.</td>
</tr>
<tr>
<td>SEVERITY</td>
<td>NORMAL</td>
</tr>
<tr>
<td>TASK</td>
<td>Call Processing</td>
</tr>
<tr>
<td>PRODUCT</td>
<td>RLC</td>
</tr>
<tr>
<td>CANCELLATION</td>
<td>None</td>
</tr>
<tr>
<td>ACTION TO BE TAKEN</td>
<td>Ensure that LOG shows SUCCESS after every DN Discovery session (either triggered by time-of-day or manually). In case of FAILURE / PARTIAL SUCCESS, check if DN Discovery port is idle, not in set busy, or call forwarded state.</td>
</tr>
<tr>
<td>PARAMETERS</td>
<td>Status: SUCCESS, PARTIAL SUCCESS, FAILURE</td>
</tr>
<tr>
<td>DISPLAYED TEXT</td>
<td>DN Discovery has completed: result - P1</td>
</tr>
</tbody>
</table>
Glossary

10BaseT Ethernet
The Ethernet standard for baseband local area networks using twisted-pair cable carrying 10 megabits per second (Mbps) in a star topology.

A

A-law
A companding technique used in encoding and decoding audio signals in 30-channel pulse code modulated (PCM) systems. A-law companding is the primary method used in Europe. See also Mu-law.

adapter
Hardware required to support a particular device. For example, network adapters provide a port for the network wire. Adapters can be expansion boards or part of the computer’s main circuitry.

administrator
A user who is responsible for maintaining the RLC or its associated remote units.

agent
A person who is responsible for handling customer calls.

analog
The type of signal used by most telephone connections. A modem converts a digital (computer) signal to analog, and vice versa, so that the signal can travel through telephone lines.

API
See application program interface.

application
A program that runs on a computer.
application program interface
A set of routines, protocols, and tools that programmers use to develop software applications. APIs simplify the development process by providing commonly used programming procedures.

Automatic Call Distribution (ACD) applications
A separate system or built-in feature of a PBX that equally distributes incoming calls to agents. As calls come in, they are placed into a queue (or a waiting line) for the next available agent. The RLC and its associated remote units support all of Nortel Networks’ ACD applications.

bandwidth
The amount of data that the network can transmit, usually expressed in Mbytes per second.

baseboard
See motherboard.

Basic Input/Output System
Flash ROM-based code that runs the Power-On Self-Test (POST) and bootstrap loader. BIOS contains low-level access routines for hardware that can be called from DOS.

BIOS
See Basic Input/Output System.

bit
Short for binary digit, the smallest unit of information on a machine. A single bit can hold only one of two values: 0 or 1.

branch station
A phoneset or fax machine located at the Remote Office 9150 site.

BRI
Basic Rate Interface. An ISDN subscriber service that uses two B (64 Kbps) channels and one D (64 Kbps) channel to transmit voice, video, and data signals.
bridge
A protocol-independent device that connects two LANs or two segments of the same LAN. Bridges are faster (and less versatile) than routers because they forward packets without analyzing and rerouting messages.

bus
A collection of wires that connects the microprocessor and main memory to internal computer components. All buses consist of an address bus that transfers data and a data bus that transfers information about where the data should go.

In a network, the bus (also called the backbone) is the main cable that connects all devices on a LAN.

byte
Abbreviation for binary term, a unit of storage capable of holding a single character. On almost all modern computers, a byte is equal to eight bits. Large amounts of memory are indicated in terms of kilobytes (1024 bytes), megabytes (1 048 576 bytes), and gigabytes (1 073 741 824 bytes).

cache
A temporary storage area in computer memory.

call duration timer
Used in circuit-switched mode only, it specifies the minimum length of time that each call to the host PBX remains open, regardless of telephone activity (or lack thereof).

call on demand
A call connection that is opened only when a connection to the host PBX is required. This is different from a permanent connection, which is open all the time.

call treatment
A method of handling applied to a call while it is waiting to be answered or serviced.
Caller ID
Caller ID is used on the RLC to identify the number of the caller requesting access to one of its ports. It is also used on the Remote Office 9150 unit to authenticate incoming calls from the RLC.

Calling Line Identification
An optional service that identifies the telephone number of the caller. This information can then be used to route the call to the appropriate agent or skillset. The caller’s telephone number can also be displayed on a phoneset.

card
A thin, rectangular plate on which chips and other electronic components are placed. Examples of cards include motherboards, expansion boards, daughterboards, controller boards, network interface cards, and video adapters.

CD-ROM
A type of optical disk capable of storing large amounts of data (up to 1 Gbyte), although the most common size is 630 Mbytes. A single CD-ROM has the storage capacity of 700 floppy disks and is particularly well-suited to information that requires large storage capacity.

CLAN
See Customer local area network.

CLID
See Calling Line Identification.

client
The part of a client/server architecture that runs on a personal computer or workstation and relies on a server to perform some operations. For example, an e-mail client is an application that enables you to send and receive e-mail.

codec
An acronym for COder-DECoder. A device that codes analog signals into digital signals for transmission and decodes digital signals into analog signals for receiving.
COM or COMM
Communications port. This usually refers to the Logical Device name of PC serial ports as defined by DOS.

computer-based training
Computer-based training (CBT) is a type of education in which students learn by running special training programs on a computer. CBT is especially effective for training people to use computer applications, because the CBT program can be integrated with the applications.

Configuration Manager
The software application used to configure and administer the Remote Office 9150 unit and the RLC to which it is connected.

controller board
A special type of expansion board that contains a controller for a peripheral device. When you attach new devices to a computer, such as a disk drive, often a controller board must also be added.

CPU
Central processing unit. This is the system unit that holds a PC’s essential components.

crash
A serious computer failure during which the computer stops working or a program closes unexpectedly. A crash indicates a hardware malfunction or a serious software bug.

Customer local area network
The LAN to which your corporate services and resources connect. The RLC and its associated remote units both connect to the CLAN.

daughterboard
Usually used as a synonym for an expansion board, a daughterboard is any printed circuit board that connects directly or indirectly to a motherboard.
DB-9 connector
A 9-pin connector labeled ADMIN that provides the RS-232 serial port interface. This serial port connection can be used to configure a Remote Office 9150 unit that is directly connected to a PC.

DB-25 connector
A 25-pin connector labeled V.35 provides a V.35 serial port connection for voice and signaling. This connection can be used to send voice traffic over a Frame Relay network instead of an Ethernet network.

Note: On the RLC and Remote Office 9150 unit, the V.35 connector is for future use.

DHCP
See dynamic host configuration protocol.

digital signal processor
A special type of coprocessor that manipulates analog data, such as sound or photographs, that has been converted to digital form.

directory number
The number that identifies a phoneset on a switch. The directory number (DN) could be a local extension (local DN), a public network telephone number, or an automatic call distribution directory number (ACD-DN).

DLL
See dynamic link library.

DN
See directory number.

driver
A program that controls a device. Every device, whether it is a printer, disk drive, or keyboard, must have a driver program. A driver acts like a translator between the device and programs that use the device.

DSP
See digital signal processor.
dynamic host configuration protocol
A protocol for dynamically assigning IP addresses to devices on a network.

dynamic link library
A library of executable functions or data that can be used by a Windows application. Typically, a DLL provides one or more particular functions and a program accesses the functions by creating either a static or dynamic link to the DLL. A DLL can be used by several applications at the same time.

dynamic port pool
A RLC feature that is similar to multi-user ports in that multiple stations can share ports on the RLC. However, users sharing ports from a dynamic pool are assigned to the first available port on the RLC.

E

ECC
See error correction code.

EEPROM
See electronically erasable programmable read-only media.

ELAN
See embedded local area network.

electronically erasable programmable read-only media
A memory chip that needs only a higher than normal voltage and current to erase its contents. An EEPROM chip can be erased and reprogrammed without taking it out of its socket. An EEPROM chip gives a computer and its peripherals a means of storing data without the need for a constant supply of electricity.

embedded local area network
This is the network connection from the PBX to the RLC. It is an Ethernet LAN that is segmented from the rest of the Ethernet network and enables signaling and administration access to the RLC. Nortel Networks recommends the following:

- IP traffic should not be routed between the main network and the ELAN.
- An IP route should not be established between the two LANs.
Emergency Service Number
The Remote Office 9150 unit allows you to program an emergency service number (such as 911).

EMI
Electromagnetic interference

error correction code
A scheme that can detect and fix single-bit memory errors without crashing the system. Also known as Error Detection and Correction (EDAC).

Ethernet
A widely used LAN protocol that uses a bus topology and supports data transfer rates of 10 Mbps.

event
An occurrence or action on the RLC or remote unit, such as the sending or receiving of a message, the opening or closing of an application, or the reporting of an error. Some events are for information only, while others can indicate a problem.

expansion board
Any board that plugs in to one of the computer’s expansion slots. Expansion boards include controller boards, LAN cards, and video adapters.

expansion bus
Enables expansion boards to access the microprocessor and memory. See also bus.

F
first-level threshold
The value that represents the lowest value of the normal range for a given field in a threshold class. The system tracks how often the value for the field falls below this value.
G.711
G.711 is the international standard for encoding telephone audio on a 64 Kbps channel. It is a pulse code modulation (PCM) scheme operating at an 8 kHz sample rate, with 8 bits per sample. According to the Nyquist theorem, which states that a signal must be sampled at twice its highest frequency component, G.711 can encode frequencies between 0 and 4 kHz. Telcos can select between two different variants of G.711: A-law and μ-law. A-law is the standard for international circuits.

G.726
G.726 is a standard ADPCM algorithm specified by the International Telecommunication Union (ITU) for reducing the 64 kbps A-Law or μ-law logarithmic data of a normal telephone line to 16, 24, 32, or 40 kbps.

G.729
G.729 is a voice compression International Telecommunications Union (ITU) standard that can be used in a wide range of applications including wireless communications, digital satellite systems, packetized speech, and digital leased lines. G.729 provides 8 Kbps of bandwidth for compressed speech at toll quality (equivalent to G.726 32 Kbps ADPCM under clean channel condition).

gateway
A device that functions as a node on two or more networks, forwarding packets from one network to addresses in the other networks. In Remote Office context, the gateway is the device on the network that directs traffic to and from the Remote Office 9150 unit or RLC.

Gbyte
1,073,741,824 bytes. One Gbyte is equal to 1024 Mbytes.

general protection fault
A computer condition that causes a Windows application to crash. GPFs usually occur when one application attempts to use memory assigned to another application.

GPCP
General purpose computing platform
Glossary

GPF
See general protection fault.

graphical user interface
The information displayed on the monitor when a Windows application (or another non-command-based application) runs. A graphical user interface uses features such as pointers, icons, I-beams, and menus to make the program easier to use.

handshaking
A process involved in establishing a valid connection or signal between two pieces of hardware or communications software.

host call appearance key
An assigned key on the telephone set at the remote site that is used to establish a connection with the host PBX or to receive incoming calls from the host PBX.

host-controlled call mode
When a call is placed to someone at the host site, or when someone from the host site calls the remote site, the call is in host-controlled call mode. Calls in host-controlled mode are routed through the PBX.

host station
A telephone set located at the host PBX site.

host trunk
The ISDN PRI or TI connection located at the host site. Host trunks are used to route calls from the host PBX to remote sites over the PSTN.

hub
A common connection point for all 10Base-T cables connected to a small network. A hub enables data to go from one device to another.

icon
A small picture that represents an object or program in a graphical user interface.
idle timer
Identifies the maximum length of time during which an ISDN connection should remain idle before it can be closed. Idle means that a voice connection does not exist, and buttons are not being pressed on the digital telephone.

input/output
Refers to any operation, program, or device that enters data into a computer or extracts data from a computer.

I/O
See input/output.

IP
Internet Protocol. The protocol within TCP/IP that governs the breakup of data messages into packets, the routing of the packets from sender to destination network, and the reassembly of the packets into the original data messages at the destination.

IP address
Internet Protocol address. An identifier for a computer or device on a TCP/IP network. Networks use the TCP/IP protocol to route messages based on the IP address of the destination. The format of an IP address is a 32-bit numeric address written as four numbers separated by periods. Each number can be 0–255. For example, 1.160.10.240 can be an IP address.

ISDN
Integrated Services Digital Network. A worldwide digital communication protocol that permits telephone networks to carry data, voice, and other source material. There are two kinds of ISDN lines—Primary Rate Interface (PRI) and Basic Rate Interface (BRI). See also BRI.

jumper
A metal bridge that closes an electrical circuit. Typically, a jumper consists of a plastic plug that fits over a pair of protruding pins. Jumpers are sometimes used to configure expansion boards. By placing a jumper plug over a different set of pins, you can change a board’s parameters.
Glossary Standard 2.0

K
kbyte
1024 bytes

L
LAN
See Local area network.

LED
Light emitting diode

Local area network
A computer network that spans a relatively small area. Most LANs connect workstations and personal computers and are confined to a single building or group of buildings.

local call
A call that originates at your site.

local call appearance key
An assigned key on the telephone set at the Remote Office 9150 site that is used to call another station at the branch office, or to make and receive calls through the local PSTN.

locally controlled call mode
When you place a call from a specified local call appearance key, or your call is to another telephone at your branch site, you are in locally controlled call mode. Calls in locally controlled mode are routed through the local PSTN.

local station
A telephone set located at the Remote Office 9150 site.

M
M1
Meridian 1 PBX

MAT
Meridian Administration Tools. This is a Nortel Networks software application that is used to administer the Meridian 1 PBX.
Mbyte
1,048,576 bytes

megahertz
One million cycles per second.

MHz
See megahertz.

RLC
An abbreviation for Reach Line Card. The RLC is installed on the host PBX at the host location and relays voice and signaling information from the digital telephones connected at a remote site to the PBX at the host site.

motherboard
The principal board that has connectors for attaching devices to the bus. Typically, the motherboard contains the CPU, memory, and basic controllers for the system. On PCs, the motherboard is often called the system board.

MTBF
Mean time between failures

Mu-law
A companding method for encoding and decoding audio signals in 24-channel pulse-code-modulated (PCM) systems. Mu-law is the method used in North America and Japan. See also A-law.

Multi-user ports
A RLC port feature that allows multiple stations to time-share a single port on the host PBX. All stations that use a multi-user port are always assigned to the same port number (TN) on the host PBX.

network interface card
An expansion board that enables a PC to be connected to a local area network (LAN).
NIC
See network interface card.

node
A device connected to the network capable of connecting to other network devices. For example, the RLC and Remote Office 9150 unit are both nodes on the network.

NPA
See Number Plan Area.

Number Plan Area
Area code

NVRAM
Non-Volatile Random Access Memory

OA&M
Operations, administration, and maintenance

object linking and embedding
A compound document standard that enables you to create objects with one application and then link or embed them in a second application.

OEM
Original equipment manufacturer

online/offline table
The online/offline table is configured on the RLC. It allows you to schedule times that the host PBX connection is made available to the remote site and at which times all telephones at the remote site can use only the local telephone service.

The online/offline table is used for controlling ISDN BRI costs.

Open System Interconnection
A worldwide communications standard that defines a framework for implementing protocols in seven layers.
OS
Operating Standard

OSI
See Open System Interconnection.

Packetized voice
Digital Signal Processors (DSPs), located in the Remote Office 9150 unit and RLC, convert analog voice into digital data. The data is constructed as a UDP/IP voice packet for transmission over an IP network.

Parity
The quality of being either odd or even. The fact that all numbers have parity is commonly used in data communications to ensure the validity of data.

PBX
See private branch exchange.

Pegging
The action of incrementing statistical counters to track system events.

Pegging threshold
A threshold used to define a cut-off value for statistics such as short call and service level. Pegging thresholds are used in reports and historical statistics.

Personal directory number
A DN on which an agent can be reached directly, usually for private calls.

Ping
Packet Internet Groper. A protocol that can be used to test the Ethernet connection to devices on the network (such as the RLC and its associated remote units).

POST
See Power-On Self-Test.
Power-On Self-Test
Initializes and performs rudimentary tests on baseboard hardware, including CPU, floating point unit, interrupts, memory, real-time clock, video, and auto-initializing PCI and EISA bus.

priority DN
A user station can be configured as a priority DN. There are two levels of priority—high and normal. High priority level allows you to

- ensure a trunk is always available
- use PSTN trunking for the host PBX connections
- move the high priority DN first from the IP network to the PSTN

private branch exchange
A telephone switch, typically used by a business to service its internal telephone needs. A PBX usually offers more advanced features than are generally available on the public network. Users of the PBX share a certain number of outside lines for making telephone calls external to the PBX.

protocol
A standard format used for communication between two devices. The protocol determines the type of error checking to be used, the data compression method (if any), how the sending device indicates that it has finished sending a message, and how the receiving device indicates that it has received a message.

PSTN
Public Switched Telephone Network (also known as the public telephone network).

QoS transitioning technology
Technology that can automatically switch calls from the IP network to the PSTN when the voice Quality of Service falls below a predetermined threshold, and back to the IP network when the Quality of Service returns to normal.
RAM
Random Access Memory. This is the most common type of memory found in computers and other devices, such as printers. The term RAM is usually synonymous with main memory, the memory available to programs. For example, a computer with 8 Mbytes of RAM has approximately 8 million bytes of memory that programs can use.

remote station
A phoneset or fax machine located at the Remote Office 9150 site.

remote trunk
From the RLC’s point of view, remote trunks are the ISDN BRI connections between the PSTN and the Remote Office 9150 unit located at the branch office site.

RJ-45 connector
An 8-position, 8-conductor modular jack that provides the 10BaseT Ethernet connection.

ROM
Read-Only Memory. This is the computer memory on which data has been prerecorded and from which it cannot be removed.

router
A device that connects two LANs. Routers are similar to bridges but provide additional functionality, such as the ability to filter messages and forward them to different places based on various criteria.

second-level threshold
The value used in display thresholds that represents the highest value of the normal range for a given statistic.

security identifier
The remote unit sends the branch office security identifier (password) to the RLC for each connection request. The RLC matches the identifier configured for the RLC port. When it finds a match, it grants access to the port and allows the call to proceed.
serial port
A general-purpose interface that can be used for almost any type of device, including modems, mice, and printers (although most printers are connected to a parallel port). Most serial ports on personal computers conform to the RS-232C or RS-422 standards.

server
A computer or device on a network that manages network resources. Examples of servers include file servers, print servers, network servers, and database servers.

service
A process that adheres to a Windows NT structure and requirements. A service provides system functionality.

Service Control Manager
A Windows NT process that manages the different services on the PC.

silence suppression
A feature that prevents packet transmission during periods when there is no voice data present.

Simple Network Management Protocol
A set of protocols for managing complex networks. SNMP sends messages called protocol data units (PDUs) to different parts of a network, and then analyzes the responses.

single-user ports
A RLC port that supports one remote station.

SNMP

SPID
Service Profile Identifier
SPRE code
A Special Prefix code that is used to initiate use of a PBX feature. In a Remote Office context, SPRE codes are used to

- toggle a remote site between online and offline modes
- use the paging feature
- switch an analog or ATA-equipped station from host-controlled mode to locally controlled mode so that local calls can be made
- register a Remote Office 9150 unit for a multi-user or dynamic port

station
A telephone or fax machine located at a Remote Office 9150 site.

stop bit
In asynchronous communications, a bit that indicates a byte has just been transmitted. Every byte of data is preceded by a start bit and followed by a stop bit.

subnet mask
A subnet mask is the part of the IP address used to represent a subnetwork within a network. A typical IP address might be 192.210.34.144. Each part of this address is made up of eight bits. The subnet mask identifies to the RLC or remote unit what portion of the IP address represents the network (and subnetwork) and what portion represents the host.

switch
In a telecommunications network, a switch is the hardware that receives phone calls and provides connections to phonesets. The switch allows a connection to be established as necessary and terminated when there is no longer a session to support it.

In data networks, a switch is a device that filters and forwards packets between LAN segments. Switches operate at the data link layer (layer 2) of the OSI Reference Model and, therefore, support any packet protocol. LANs that use switches to join segments are called switched LANs or, in the case of Ethernet networks, switched Ethernet LANs.
switch resource
A device that is configured on the switch.

TCP/IP
Transport Control Protocol/Internet Protocol. The communication protocol used to connect devices on the Internet. TCP/IP is the standard for transmitting data over networks.

threshold
A value for a statistic at which system handling of the statistic changes.

threshold class
A set of options that specifies how statistics are treated in reports and real-time displays. See also pegging threshold.

trunk
A communications link between a PBX and the public central office, or between PBXs. Various trunk types provide services such as Direct Inward Dialing (DID), ISDN, and central office connectivity.

trunk access code
A trunk access code is a number that is used by the Remote Office 9150 unit to determine which trunk to use when routing a call. For example, 9 is a common trunk access code used to obtain an outside line.

Note: All trunk access codes are configured on the Remote Office 9150 unit with a pound sign (# in North America) so that there are no conflicts with host PBX numbering plans.

trunk groups
A trunk group consists of one or more trunk lines that are logically grouped. You can configure up to eight trunk groups on the Remote Office 9150 unit.

trunk interface modules
Used to route calls over the PSTN. The number of modules you must install on the Remote Office 9150 unit depends on the number of simultaneous calls you want in host-controlled or locally controlled mode.
U

uninterruptible power supply
A power supply that includes a battery to maintain power in the event of a power outage. Typically, a UPS keeps a computer running for several minutes after a power outage, enabling you to save data that is in RAM and to shut down the computer safely.

UPS
See uninterruptible power supply.

utility
A program that performs a specific task, usually related to managing system resources. Operating systems contain a number of utilities for managing disk drives, printers, and other devices.

V

V.35
An ITU-T standard describing a synchronous, physical layer protocol used for communications between a network access device and a packet network. V.35 is most commonly used in the United States and in Europe, and is recommended for speeds up to 48 Kbps. In practice, V.35 is used for synchronous transmission up to 2048 Mbps.

V.35 interface
The V.35 interface is for future use.

voice compression
Prior to transmission, the voice data is compressed; after transmission, the data is converted back to voice data at the destination. Voice compression means that voice consumes less bandwidth, leaving more bandwidth for data or other voice or fax communications.

voice jitter attenuation
A feature that removes the variable delays from the voice packets sent across the IP network, thus avoiding awkward-sounding speech.

Voice over IP (VoIP)
Technology that uses the IP data network to carry the voice conversation and telephone set control signals between a remote site and the host PBX.
WAN
Wide area network. A computer network that spans a relatively large geographical area. Typically, a WAN consists of two or more local area networks (LANs). The largest WAN in existence is the Internet.
Fields index

A
Add on Module Type 228
Auto Hold 228, 233

B
B Channel 218
B Channel Usage 134
Bandwidth (BW) Connection Statistics
   IP QoS Status 283
   No of Voice Calls on IP 283
   No of Voice Calls on PSTN 283
   Remote Unit Number 283
   Signaling Status 283
   Total Up Trunk BW 283
   Used IP BW 283
   Used Trunk BW 283
Block Incoming Local Call on Primary B Channel 201
Bridge Port 228, 233
Browse (button)
   Software Upload 318
   Upload Configuration 269

C
Call BW 285
Call Duration 298
Call Number 285
Call Start Time
   Local Call Statistics 298
   Remote Call Statistics 300
Call Type 281
Called Number 281
Caller ID 206
Caller Info Statistics
   Call BW 285
   Connection ID 285
   Current Media 285
   Last Transition to IP 286
   Last Transition to PSTN 286
   Priority 285
   Remote ID 285
   Start Time 285
   Transitions to IP 285
   Transitions to PSTN 285
   Type 285
Compression algorithms 237
Connection ID 285, 300
CPND 228
Current Media 285

D
Default (button) 153
Device 218
Disabled Outbound Digit Seq. 229
DN 233
DSP Callback pointer 300
DSP load 237
Duration 281
   Remote Call Statistics 300

E
Emergency Activation Code 186
Enter a node name to recognize the unit 130
Enter the local IP Address of the unit 131
Enter the Local IP Gateway of the unit 131
Enter the Local IP Mask of the unit 131
Enter the PSTN Number 134
Enter the SPID Number 134
Error % 307

F
Forward Busy/No Answer 228, 233
   Number of Rings before transfer 229
   Transfer to DN 229

G
Group No 217

H
Hardware Statistics
   Module No 288
   Module Type 288
   Status 288
   Version 288
Hardware statistics
   Available Channels 290
   Available Flex Channels 291
   Available MIPS 290
   Available Voice Channels 290
   Device Number 290
   In Service 290
   Module Number 290
   Name 291
   Single Dig Dev ID 290
   Total Channels 290
   Total Flex Channels 291
   Total MIPS 290
   Total Reserved Channels 291
   Total Tones Channels 291
   Total Voice Channels 290
Help (button) 154
Hour 306

I
International Tones
   Cadence Time 193
   End Repeat 193
   No of Cycles 193
   Tone Code 193
   Tone Type 193
IP Address
   IP Configuration 196
   RLC Connection Configuration 200
   Software Upload 317
   Upload Configuration 269
IP Connection 200
IP Gateway 196
IP Network Mask 196
IP QoS Status 283
IP Signaling 200
ISDN Line Type 213

L
Last Transition to IP 286
Last Transition to PSTN 286
Local Call Keys 229, 234
Local CPND 233
Local DN 228
Local DNs to Alert 217
Local SwitchOver 189

M
Module
   Software Upload 317
   Trunk Group B-Channel 218
Module # 213
Module Number 237
Module Status 134
### N
- New Password 263
- No of Voice Calls on IP 283
- No of Voice Calls on PSTN 283
- Node Name 186
- Number of devices 237

### O
- OK (button) 153, 159, 163
- Old Password 263
- Optional Feature Keys 230

### P
- Paging 228, 233
- Phone Type 228
- Port No.
  - Local Call Statistics 298
  - Remote Call Statistics 300
- Port Type 226, 232
- Priority 285
- Provision ID 207
- PSTN Connection 200
- PSTN Number 214

### R
- RCM Callback pointer 300
- Remote ID 281, 285
  - Caller Info Statistics 285
- Remote Unit Number 283
- Retrieve (button) 154, 160, 163
- Retype New Password 263
- RLC ID 300
- RLC Port 226, 233
- RLC Port No. 300
- Rx Dropped 307
- Rx Error 307
- Rx Frames 307

### S
- Security Level 205
- Select the Country Type 134
- Select the Protocol Type 134
- Send (button) 153, 160, 163
- Set the unique Unit ID of the unit 130
- Set the Unit ID of the RLC to connect to 132
- Signaling Status 283
- SPID 214
- SPRE Codes
  - DeRegistration 188
  - Local Calling 188
  - Offline 187
  - Online 187
  - Paging 187
  - Registration 187
- Start Time 281, 285
- statistics
  - Bandwidth (BW) Connection Statistics
    - IP QoS Status 283
    - No of Voice Calls on IP 283
    - No of Voice Calls on PSTN 283
    - Remote Unit Number 283
    - Signaling Status 283
    - Total Up Trunk BW 283
    - Used IP BW 283
    - Used Trunk BW 283
  - Caller Info Statistics
    - Call BW 285
    - Connection ID 285
    - Current Media 285
    - Last Transition to IP 286
    - Last Transition to PSTN 286
    - Priority 285
    - Remote ID 285
    - Start Time 285
    - Transitions to PSTN 285
    - Transitions to IP 285
    - Type 285
  - Trunk Connection Statistics
    - Call Type 281
    - Called Number 281
W
Which module would you wish to configure 134
Wish to configure Multiple 9150 Ports 133
Wish to Enable IP Voice Connection to Remote 132
Wish to Enable PSTN Connection to RLC 132

T
Time Offset 186
Total Up Trunk BW 283
Total Voice Channels 290
Transitions to IP 285
Transitions to PSTN 285
Trunk Access Code 217
Trunk Connection Statistics
  Call Type 281
  Called Number 281
  Duration 281
  Remote ID 281
  Start Time 281
  Status 281
  Trunk Number 281
Trunk Group B Channels 218
Trunk Number 281
Tx Frames 307
Type 213, 285

U
Unit ID
  9150 System Configuration 186
  RLC Connection Configuration 200
UPkts 294
Used IP BW 283
Used Trunk BW 283
Index

Numerics

10BaseT Ethernet
  as a component 2
  connection option 17
25-pair connector 13
9150 Port Configuration property sheet 225

A

add-on modules
  DSP application modules 16
  trunk interface modules 15
Admin 293
Admin connector pin-out table 379
administration
  backups and restores, performing 265
  password, changing 260
  Configuration Manager 260
  Remote Office 9150 unit 262
PC
  connection options 61
  Meridian Administration Tools and
  Configuration Manager 65
software
  command line interface 49
  Configuration Manager 48
  connection options 48
statistics, viewing 279
upgrades, performing 309
analog port 18
configuring 232
ATA equipped stations 224
Auto Hold 228, 254
auto logoff 170
Automatic Call Distribution (ACD) applications
  36

B

backup
  configuration file, creating 266
bandwidth
  allocating 72
  allocation, description 32
  extra 43
  priority reserved 43
Bandwidth Connection statistics 282
BRI Configuration property sheet 211
Bridge Ports 219

C

call appearance keys
  defined 222
  host call appearance key 241
  local call appearance key 241
call blocking 68
  calculating system requirements 69
  defined 68
  reducing between Remote Office 9150 unit
  and host PBX 69
Call Forward 228, 256
Call Transfer 255
Call Waiting 254
caller identification (security level) 30
Caller Information statistics 284
calling permissions and restrictions 223
calls
  emergency service 253
  host-controlled calls 245
  methods for placing outgoing calls 245
  outgoing locally controlled calls 246
  placing 244
  receiving 244
  station-to-station calls 247
Channel 293
circuit only priority 42

circuit-switched mode, implementing 83

clearing logs 277

components
10BaseT Ethernet connection 2
Digital Signal Processor (DSP) 2
ISDN BRI trunk interface modules 2
Reach Line Card (RLC) 2
Remote Office 9150 unit 2
compression algorithms 37, 74
and ATA devices 224
and MCA devices 224
Computer Telephony Integration (CTI)
applications 35
Conference calling 256
configuration
backup
creating 266
when to create 266
DSP Configuration property sheet 235
recommendation 360
samples
Meridian 1 data port 364
Meridian 1 voice port 362
Remote Office 9150 370
RLC 366
Configuration Manager
check boxes 151
closing 180
command buttons 153
configuration
downloading 166
uploading 166
configuration file
creating 164
opening 165
description of 9
device type, selecting 167
file operations
description 159
diagram 156
logging off from a unit 176
logging on to a unit 169
menus 147
option buttons 151
parts of the screen 147

password 260
property sheets 148
scroll boxes 152
shutdown, performing 177
starting 144
system restart, performing 177
system tree 148

Configuration Wizard
how it works 124
introduction 124
starting 125

compressing Remote Office 9150 unit
9150 Port Configuration sheet 225, 232
BRI Configuration sheet 211
BRI trunks, configuring 211
Cadence Time 193
Compressing Algorithm 189
emergency number 186
End Repeat 193
fax station, defining 231
International Tones 190
IP addresses 196
local switchover 189
Multiple Subscriber Number 189
No of cycles 193
RLC Connection Configuration sheet 198
RLC connection information 198
security level 204
SPRE codes, defining 187–188
system identification information 186
Tone Code 193
Tone type 193
Trunk Group Configuration sheet 215
trunk groups, configuring 215

cropping the Remote Office 9150 unit
cables you must provide 113
connection panel diagram 115
pin-out references 114

connection bandwidth
extra bandwidth 43
priority reserved bandwidth 43
connection history 170
connection options
10BaseT Ethernet interface 17
analog port for fax machines 18
ethernet connection 62
IP Quality of Service transitioning technology 17
ISDN BRI lines to PSTN 17
serial connection 61
connection types 32
connector pin-outs
  Admin 379
  Ethernet 378
  Power 380
  Telco 1 374
  Telco 2 376
connectors
  25-pair 13
  DB-25 13
  DB-9 13
  RJ-45 13
cover, removing the Remote Office 9150 97

D

DB-25 connector 13
DB-9 connector 13
deploying Remote Office 9150 unit
  circuit-switched mode, implementing 83
  overview 82
  port and station assignment 82
  Quality of Service transitioning technology 85
  Voice over IP mode, implementing 84
device connectivity 330
Digital Signal Processor (DSP) 2
digital telephones
  display messages 250
  supported 35
  troubleshooting 325
Disabled Outbound Digit Seq. 229
Disc 293, 294
display messages 250
displaying logs 274
DLL files 123
documentation, related
  Meridian 1 xvii
  MIG RLC xvii
  obtaining xviii
  Remote Office 9150 xvii
Download Configuration 162, 163
DSP
  DSP Configuration property sheet 235
DSP modules
  adding 79
  installing 103
  removing 103
  what they do 100
  when to install 101
  where they can be installed 101
DSP Statistics 290
DSP Statistics screen 289
dynamic port pooling 40

electrostatic discharge 93
emergency
  activation code
    description of 47
  calls, placing 253
  service calls 253
  service number 186
EPROM checksum validation 119
Err 293, 294
Ethernet
  connector pin-out table 378
  LED 12
Ethernet Interface Statistics
  Admin 293
  Channel 293
  Disc 293, 294
  Err 293, 294
  IFC No 293
  IFC Type 293
  In - Octet 293
  LAN Drv 293
  MPkts 293, 294
  MTU Len 293
  Oper 293
  Out - Octet 294
  QLen 294
  Speed 293
  UPkts 293
  extra bandwidth 43
F
fax port, configuring 232
fax support 47
File Open 159, 163
File Save As 159, 163
firmware
  types of 312
  upgrade files
    downloading 312
    extracting 313
  upgrade, performing 315
  version, verifying 310
flash checksum validation 119
future growth
  DSP modules, adding 79
  maximum configurations 80
  trunk interface modules, adding 80

G
general safety
  electrostatic discharge safety precautions 93
  introduction 92
  precautionary messages 92
  safety precautions 92
GUI
  DSP Configuration property sheet 235

H
hardware description
  connectors 13
  LEDs 11
    mounting options 13
  universal power supply 13
hardware installation tools 94
Hardware Statistics 287
host-controlled mode 240
  and Call Transfer feature 255
  and Call Waiting feature 254
  and Hold feature 254
calls, placing 245
  external corporate call, example 24
  indicator updates 248
  internal corporate call, example 22

I
idle timer 33
IFC No 293
IFC Type 293
In - Octet 293
incoming call process 20
incoming calls, receiving 244
indicators, telephone
  host-controlled indicator updates 248
  introduction 248
  locally controlled indicator updates 248
installing the Remote Office 9150 unit
  Configuration Wizard 124
  connecting 113
  cover, removing 97
  general safety 92
  mounting 106
  network connections, testing 138
  powering up 119
  required tools 94
  software, installing 122
  unpacking and inspecting 95
  interface loopbacks 119
International Tones 190
IP
  addresses 89
  addressing and routing 66
  interface, configuring 195
IP Configuration property sheet 196
IP only priority 41
ISDN BRI
  BRI Configuration sheet 211
  connection option 17
  planning for 88
  trunks groups, configuring 215
  trunks, configuring 211

K
Key Feature Configuration property sheet 230
L
LAN Drv 293
LEDs
  Ethernet 12
  Module 12
  Power 12
  Status 12
  troubleshooting 323
  V.35 12
when powering up 119
local calling
  Bridge Port 45
  call restrictions 45
  local calls through PSTN 45
  local extension calling 44
  telephone features
    supported 45
    unsupported 45
Local Profile Configuration property sheet 227
local switchover 189
locally controlled mode 21, 241
  and Call Transfer feature 255
  and Call Waiting feature 254, 255
  and Hold feature 254
  calls, placing 246
  indicator updates 248
  local call, example 26
logging off from a unit 176
  auto logoff 170
logging on to a unit
  connection history 169, 170
  connection types 169
  default logon ID and password 169
  from Configuration Manager 169
  through serial port 174
  through Telnet 172
logon ID (to a unit) 169
logs
  clearing 277
  displaying 275
  overview 273
  printing 275
  resizing 276
M
MCA equipped stations 224
Meridian 1
  data port configuration (example) 364
  voice port configuration (example) 362
Meridian Administration Tools (MAT) 65
messages, telephone display 250
minimum call duration timer 33
Module LEDs 12
mounting the Remote Office 9150 unit
  choosing a suitable location 106
  installing in a rack 110
  installing on a desk 107
  installing the unit on the wall 108
MPkts 293, 294
MSN 189
MTU Len 293
multi-user ports 40
N
network
  connecting the Remote Office 9150 unit to 117
  considerations
    call blocking 68
    IP addressing and routing 66
    network diagram 67
    numbering plans 68
    Quality of Service 67
    diagram (example) 361
  no security (security level) 30
  normal priority 41
O
offline mode
  defined 242
  importance of 242
  what controls offline mode 242
OK 159, 163
online help (accessing) 155
online mode
  defined 242
Index

what controls online mode 242
online/offline
  automatic offline event, overriding 258
  scheduling 71
  SPRE codes, using 257
online/offline mode
  changing 71
  offline, description 242
  online, description 242
online/offline table
  configuration 46
  description 46
  how the table works 46
Oper 293
optional modules
  DSP application module 16
  trunk interface module 15
Out - Octet 294
outgoing calls, placing 244
  description 20

P
packet loss handling techniques 37
Paging 228, 256
password (for a unit) 169
PC
  connection options 61
  Meridian Administration Tools and Configuration Manager 65
physical environment 56
  cables, included 59
  cables, not included 59
  connections 58
  mounting options 58
Ping, using 336
pin-out tables, connector
  Admin 379
  Ethernet 378
  Power 380
  Telco 1 374
  Telco 2 376
planning
  configuration 87
  data entry form completion sequence 87
deployment options 82
future growth 79
network considerations 66
numbering plan 90
online/offline schedule 89
physical environment 56
security 77
station configuration 73
trunk configuration 90
trunk connection management 70
port management
  dynamic port pool 40
  multi-user ports 40
  single-user ports 40
ports, types of 75
Power
  connector pin-out table 380
  LED 12
precautionary messages 92
priority level
  circuit only priority 42
  IP only priority 41
  normal priority 41
priority reserved bandwidth 43
private lines, creating 222
provision ID (security level) 30
Q
QLen 294
Quality of Service transitioning technology
  connection option 17
  defined 39
  implementing 85
  log reports and statistics 39
  transport connections 39
R
rack installation 110–112
RAM memory test 119
Reach Line Card
  as a component 2
  configuration (example) 366
description of 8
related documentation
Meridian 1 xvii
MIG RLC xvii
obtaining xvii
Remote Office 9150 xvii
Remote Call Statistics 299
remote configuration
  configuring the remote connection settings 236
  property sheet 235
Remote Office 9150 unit
  add-on modules 15
  administering 259–320
  as a component 2
  cables you must obtain 113
  configuration (example) 370
  Configuration Wizard 124
  configuring 236–234
  connecting to the network 117
  connection options 17
  cover
    removing 97
    replacing 99
  description 8, 9, 11
  how it works 19
  LEDs 323
  mounting 106
  network connections, testing 138
  password, changing 262
  port management 40
  powering up 119
  software, installing 122
  station priority and connection bandwidth 41
    stations, using 239–258
  troubleshooting 322
  restarting the system
    performing a restart 177
    when to perform a restart 177
  restoring the configuration
    before you begin 268
    upload, performing 268
  Retrieve 160, 163
  RJ-45 connector 13
  RLC Connection Configuration property sheet 198

S
safety precautions 92
Save to Flash 160
security
  data network security 77
  description 77
  identifier 30, 204
  RLC Connection Configuration sheet 202, 205
  security level, configuring 204
  system configuration 78
  toll fraud 77
Send 160, 163
Send All 160, 163
serial port, logging on to a unit 174
shutting down the system
  performing a system shutdown 178
  when to perform a shutdown 177
silence suppression 38
single-user ports 40
software
  installing 122
  troubleshooting 334
  upgrades
    performing 320
    version, verifying 310
Speed (statistic) 293
SPRE codes
  configuring 187–188
  controlling online and offline modes 243
stations
  9150 Device Configuration sheet 225
  assignment and configuration 87
  ATA and MCA-equipped stations and
    bandwidth requirements 224
  call appearance keys 222
  call processing capabilities and station
    settings 220
  calling permissions and restrictions 223
  configuration overview
    Remote Office 9150 settings 75
    RLC setting 73
  Configuring Bridge Ports 219
  defining 225
  display messages 250
going online and offline 257
modes
  controlling online and offline 242
  host-controlled 240
  importance of 242
  locally controlled mode 241
of operation 240
offline mode 242
online mode 242
relationship between host-controlled and
locally controlled modes 241
placing and receiving calls 244
priority
  circuit only priority 42
  IP only priority 41
  normal priority 41
private lines 222
telephone features 253
telephone indicators 248
station-to-station calls 247
statistics
  Bandwidth Connection Statistics screen 282
  Caller Information Statistics screen 284
  DSP Statistics screen 289, 290
Ethernet Interface Statistics
  Admin 293
  Channel 293
  Disc 293, 294
  Err 293, 294
  IFC No 293
  IFC Type 293
  In - Octet 293
  LAN Drv 293
  MPkts 293, 294
  MTU Len 293
  Oper 293
  Out - Octet 294
  QLen 294
  Speed 293
  UPkts 293
Hardware Statistics screen 287
overview 279
Remote Call Statistics screen 299
  Trunk Connection Statistics screen 280
  viewing 279
Status LED 12

System Configuration sheet 184
system security
  caller identification 30
  no security 30
  security identifier 30
system tree 148

T
Telco 1, connector pin-out table 374
Telco 2, connector pin-out table 376
telephone features
  Call Forward 256
  Call Transfer 255
  Call Waiting 254
  Conference 256
  emergency service calls 253
  Hold 254
  Paging 256
telephone modules (supported) 35
telephones
  Automatic Call Distribution (ACD) 36
  Computer Telephony Integration (CTI)
    applications 35
digital telephones 35
  supported modules 35
  See also stations
Telnet, using to log on to unit 172
TFTP
  and upgrades 315
  server 64
tools required
  hardware installation tools 94
  software installation or upgrade tools 94
troubleshooting
  before you begin 322
device connectivity 330
digital telephone 325
  overview 322
  Ping option 336
  recovering from a catastrophic failure 339
  Remote Office 9150 LEDs 323
  software problems 334
  trunk access codes 209
  Trunk Connection Statistics 280
trunk connections 32
  bandwidth allocation 72
  changing online/offline mode 71
  online/offline schedule 71
  QoS transitioning technology 70
Trunk Group Configuration property sheet 215
trunk groups 209
  configuring 215
trunk groups, configuring 215
trunk interface modules
  adding 80
  installing 103
  removing 103
  what they do 100
  when to install 101
  where they can be installed 101
trunking
  and idle timer 33
  and minimum call duration timer 33
  bandwidth allocation 32
  connection types 32
  types 32
trunks
  configuring 211
  local and remote trunk 208
  local trunk 208
  managing trunk connections 70
  remote trunk 208
  trunk access codes 209
  trunk groups 209
    configuring 215

U
universal power supply 13
upgrades, performing
  extracting upgrade files from the download file 313
  firmware upgrade 315
  firmware version, verifying 310
  obtaining the latest upgrade file 312
  software upgrade 320
  software version, verifying 310
  upgrades and configuration files 316

V
V.35 LED 12
voice jitter 37
Voice over IP
  implementing 84
  packetized voice 37
  QoS transitioning technology 39

W
wall mounting
  installing 108–110